Contents

Chapter 1  Introduction
Introduction............................................................................................... 14
Starting Discovery Manager (both editions)............................................ 27
Exiting Discovery Manager (both editions)............................................ 28
Overview of application window........................................................... 29
Overview of ribbon pane....................................................................... 30
Overview of navigation pane............................................................... 47
Refreshing the display........................................................................ 55
Understanding connection status......................................................... 56
Viewing error information................................................................. 57
What happens during backup of servers?........................................... 58

Chapter 2  Managing Users and Application-Wide Roles
Introduction............................................................................................... 62
Prerequisites........................................................................................... 63
Adding the first user .............................................................................. 63
Adding users ......................................................................................... 64
Removing users..................................................................................... 66
Assigning application-wide roles ......................................................... 67
Adding or removing Personal Matters.................................................. 70

Chapter 3  Configuring Discovery Manager
Introduction............................................................................................... 74
Procedure: Configuring Discovery Manager........................................... 74
Configuring general settings................................................................. 75
Configuring search settings................................................................. 81
Configuring export settings................................................................. 83
Partitioning the Discovery Manager database....................................... 85
Chapter 4 Using Discovery Manager Express Edition
Introduction .......................................................................................... 94
Step 1: Start Discovery Manager express edition .................................. 95
Step 2: Create a search in your Personal Matter ................................... 96
Step 3: Specify the folders to search ..................................................... 97
Step 4: Specify search criteria ............................................................ 99
Step 5: Run the search ....................................................................... 99
Step 6: Export search results and metadata ....................................... 99

Chapter 5 Managing Identities
Introduction ......................................................................................... 102
Best practices for identity management ............................................. 104
Viewing list of identity records ......................................................... 105
Adding identity records ................................................................. 108
Editing identity records .................................................................... 111
Deleting identity records ............................................................... 112
Managing identity elements (addresses) in identity records ......... 113

Chapter 6 Managing Default Tags
Introduction ......................................................................................... 128
Adding custom default tags ............................................................ 130
Editing tags ....................................................................................... 132
Deleting tags .................................................................................... 133

Chapter 7 Managing Matters
Introduction ......................................................................................... 136
About hold folders ............................................................................ 136
Prerequisites: Standard matters in Discovery Manager .................. 138
Best practices for managing standard matters ................................. 139
Best practices for creating matters on new partitions ..................... 139
Creating a Personal Matter ............................................................... 140
Creating a standard matter ............................................................ 140
Removing and placing standard matters in My Matters ............... 146
Editing matter properties ............................................................... 148
Managing items in a standard matter ............................................. 172
Viewing a matter summary report ................................................. 173
Closing standard matters ............................................................... 177
Reopening standard matters ........................................................ 177
Deleting matters ............................................................................ 177
Chapter 8 Collecting Content for Matters

Prerequisites ................................................................. 180
Checklist: collecting content for a matter ...................... 180
Viewing list of collection searches for a matter .............. 182
Viewing a collection summary report .......................... 184
Creating a collection search ...................................... 188
Adding and removing columns .................................... 190
Editing search properties .......................................... 191
Specifying folders to search ...................................... 196
Specifying search criteria ......................................... 198
Scheduling a search .................................................... 199
Viewing a collection search ....................................... 201
Copying a collection search ....................................... 202
Renaming a collection search .................................... 202
Using folders to organize collection searches ............... 203
Running a collection search ...................................... 207
Re-running a collection search ................................... 207
Monitoring search progress ....................................... 208
Viewing search errors .............................................. 210
Viewing search history ............................................. 213
Viewing results of a collection search ......................... 215
Selecting results ....................................................... 226
Assigning collection search results to a standard matter .. 227
Deleting a search ....................................................... 229
Monitoring status of operations for a matter ................. 230

Chapter 9 Specifying Search Criteria

Overview: Specifying collection search criteria .............. 234
Specifying item types (content types) ......................... 237
Customizing search fields ........................................ 240
Summary: How to search for text .............................. 242
Searching on keywords ............................................ 249
Cutting and pasting paragraphs in text fields ............... 249
How to AND and OR search terms ......................... 250
Specifying attachment name .................................... 251
Specifying recipient, sender, or owner for email items .... 252
Searching for archived files using the Owner field ....... 264
Performing domain searches .................................... 265
Specifying a date ..................................................... 270
Specifying an item size ............................................ 272
Using "Indexing Error" and "Any Unindexed Content" .... 273
Searching on custom metadata ............................... 274
### Contents

Clearing values from all search fields ........................................ 278

#### Chapter 10 Using the Search Expression Field

- Introduction ............................................................................. 280
- Adding the Search Expression field ........................................ 280
- Best practices: Search Expression field .................................. 281
- Using the proximity operator in the Search Expression field .. 281
- Using Boolean operators in the Search Expression field ........ 283
- Using the tense conflation operator in the Search Expression field 284
- Using wildcards in the Search Expression field .................... 286
- Reserved words ..................................................................... 287
- Specifying multiple words in the Search Expression field ..... 288
- Precedence of operators in the Search Expression field ........ 289
- Using parentheses in the Search Expression field ................. 289
- Using quotation marks in the Search Expression field .......... 291
- Characters ........................................................................... 292

#### Chapter 11 Reviewing Content in Matters

- Introduction ............................................................................. 296
- Prerequisites .......................................................................... 296
- Viewing messages assigned to a standard matter ............... 296
- Applying tags to items ......................................................... 298
- Assigning custodians to items ............................................. 302
- Working with in-matter searches ....................................... 306
- Removing items from Matter Review .................................. 315
- Viewing status of pending actions in Matter Review .......... 317

#### Chapter 12 Exporting Content and Metadata

- Introduction ............................................................................. 320
- Content types and export containers .................................. 321
- Specifying results to export .............................................. 322
- Specifying export settings ................................................. 325
- About export processing ................................................... 331
- Viewing status of pending exports for a matter ................. 331
- Viewing export information and contents ......................... 332
- Using folders to organize exports .................................... 360
- Deleting an export ........................................................... 362

#### Chapter 13 Using Discovery Manager Utilities
Contents

Introduction: Discovery Manager utilities .................................. 364
Prerequisites: Discovery Manager utilities .................................. 364
Installation: Discovery Manager utilities ..................................... 365
Permissions: Discovery Manager utilities ................................... 365
Discovery Manager workflows ..................................................... 366
Syntax common to all Discovery Manager utilities ................... 368
Creating identity records ............................................................... 370
Creating custodians ................................................................. 377
Collecting email for custodians .................................................... 381
Chapter 14 Accessibility Features for Discovery Manager

Accessibility features ................................................................. 390
Keyboard shortcuts ................................................................. 391
As part of an effort to improve its product lines, EMC periodically releases revisions of its software and hardware. Therefore, some functions described in this document might not be supported by all versions of the software or hardware currently in use. The product release notes provide the most up-to-date information on product features.

Contact your EMC technical support professional if a product does not function properly or does not function as described in this document.

Note: This document was accurate at publication time. Go to EMC Online Support (https://support.emc.com) to ensure that you are using the latest version of this document.

Audience

This document is part of the EMC SourceOne Email Management and Discovery Manager documentation sets. It is intended for all users of Discovery Manager, including users of the express edition provided with SourceOne Email Management.

Related documentation

- EMC SourceOne Discovery Manager Installation and Administration Guide
- EMC SourceOne Discovery Manager Release Notes
- EMC SourceOne Discovery Manager Localized Product Release Notes
- EMC SourceOne Email Management Installation Guide
- EMC SourceOne Email Management Administration Guide
- EMC SourceOne Email Management Release Notes
Conventions used in this document

EMC uses the following conventions for special notices.

**Note:** A note presents information that is important, but not hazard-related.

**CAUTION**
A caution contains information essential to avoid data loss or damage to the system or equipment.

**IMPORTANT**
An important notice contains information essential to operation of the software.

**WARNING**
A warning contains information essential to avoid a hazard that can cause severe personal injury, death, or substantial property damage if you ignore the warning.

**DANGER**
A danger notice contains information essential to avoid a hazard that will cause severe personal injury, death, or substantial property damage if you ignore the message.

**Typographical conventions**
EMC uses the following type style conventions in this document:

<table>
<thead>
<tr>
<th>Normal</th>
<th>Used in running (nonprocedural) text for:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Names of interface elements (such as names of windows, dialog boxes, buttons, fields, and menus)</td>
</tr>
<tr>
<td></td>
<td>• Names of resources, attributes, pools, Boolean expressions, buttons, DQL statements, keywords, clauses, environment variables, filenames, functions, utilities</td>
</tr>
<tr>
<td></td>
<td>• URLs, pathnames, filenames, directory names, computer names, links, groups, service keys, file systems, notifications</td>
</tr>
</tbody>
</table>
Bold: Used in running (nonprocedural) text for:
- Names of commands, daemons, options, programs, processes, services, applications, utilities, kernels, notifications, system call, man pages

Used in procedures for:
- Names of interface elements (such as names of windows, dialog boxes, buttons, fields, and menus)
- What user specifically selects, clicks, presses, or types

Italic: Used in all text (including procedures) for:
- Full titles of publications referenced in text
- Emphasis (for example a new term)
- Variables

Courier: Used for:
- System output, such as an error message or script
- URLs, complete paths, filenames, prompts, and syntax when shown outside of running text

Courier bold: Used for:
- Specific user input (such as commands)

Courier italic: Used in procedures for:
- Variables on command line
- User input variables

< > Angle brackets enclose parameter or variable values supplied by the user

[] Square brackets enclose optional values

| Vertical bar indicates alternate selections - the bar means “or”

{} Braces indicate content that you must specify (that is, x or y or z)

... Ellipses indicate nonessential information omitted from the example

Where to get help

EMC support, product, and licensing information can be obtained as follows:

Product information — For documentation, release notes, software updates, or information about EMC products, go to EMC Online Support at:

https://support.emc.com

Technical support — Go to EMC Online Support and click Service Center. You will see several options for contacting EMC Technical Support. Note that to open a service request, you must have a valid support agreement. Contact your EMC sales representative for details
about obtaining a valid support agreement or with questions about your account.

**Your comments**  
Your suggestions will help us continue to improve the accuracy, organization, and overall quality of the user publications. Send your opinions of this document to:

techpubcomments@emc.com
This chapter contains the following topics:

- Introduction ........................................................... 14
- Starting Discovery Manager (both editions) ..................... 27
- Exiting Discovery Manager (both editions) ...................... 28
- Overview of application window .................................... 29
- Overview of ribbon pane ............................................. 30
- Overview of navigation pane ........................................ 47
- Refreshing the display .................................................. 55
- Understanding connection status ................................... 56
- Viewing error information .......................................... 57
- What happens during backup of servers? ....................... 58
Introduction

Refer to:

◆ “Two editions of Discovery Manager” on page 14
◆ “Licensing” on page 16
◆ “Types of matters” on page 16
◆ “Email read/return receipts” on page 16
◆ “Display of time” on page 16

Two editions of Discovery Manager

There are two editions of Discovery Manager: express and full. Refer to:

◆ “Discovery Manager express edition” on page 14
◆ “Discovery Manager, full edition” on page 15
◆ “Discovery Manager Editions” on page 437 for a detailed comparison of the two editions.

Discovery Manager express edition

EMC SourceOne Email Management includes an edition of Discovery Manager that has a subset of functionality. To distinguish this version from the full edition, the documentation uses the term "Discovery Manager express edition." Screens in both editions are labeled "Discovery Manager."

Use Discovery Manager express edition to search for a user’s email items (such as messages and calendar items) and to export the results to supported formats. Refer to “Using Discovery Manager Express Edition” on page 93 for more information.

IMPORTANT

Discovery Manager express edition is intended for administrators, supervisors, or legal users to search the archive for other users’ email and export the results. It is not intended for end-users who want to export their own archived items.
**Introduction**

Note: Some features of the full edition are grayed out in Discovery Manager express edition. For full functionality, you must upgrade to the full EMC SourceOne Discovery Manager.

**Discovery Manager, full edition**

Use the full edition of Discovery Manager to search for, collect, preserve, review, and export archived email, SharePoint content, and files in response to legal or regulatory notice, or corporate policy complaint.

The full edition of Discovery Manager is designed for accepted eDiscovery processes and practices and:

- Supports matter lifecycle management
  - Legal hold to prevent spoliation
  - Auditing and reporting
- Enables timely response to discovery requests
  - Formalizes discovery process
  - Moves more of the process in-house
- Reduces discovery time and cost
  - Accurate, comprehensive searching
  - Efficient high-volume collection
  - Effective review, culling, and tagging
  - Supports the EDRM XML 1.0 and 1.2 standards

Discovery Manager does not modify the original archived item.

Refer to:

- “Discovery Manager phases” on page 18
- “Lifecycle of a matter - Discovery Manager” on page 19
- “User roles in the matter lifecycle - Discovery Manager” on page 19
- “Sample scenario - Discovery Manager” on page 20
- “Roles: Details” on page 23
Introduction

Licensing

Discovery Manager express edition is included in the SourceOne Email Management software kit. No license is required.

Discovery Manager full edition requires a license.

Types of matters

There are two types of matters:

- Personal Matters - In Discovery Manager express edition, each user has one Personal Matter, which only that user can work on. In Discovery Manager full edition, Personal Matters are optional.
- Standard matters - In the full edition of Discovery Manager, standard matters can be shared among several Investigators.

Email read/return receipts

This section applies to both editions of Discovery Manager.

By design, when an investigator opens email in either edition of Discovery Manager, read/return receipts are not triggered so that senders are not aware that they are being investigated. There is no need to disable read/return receipts for either Microsoft Exchange/Outlook or IBM Lotus Domino/Notes.

Display of time

This section applies to both editions of Discovery Manager.

Discovery Manager converts the UTC date stored in the server to a local time to display in the client, according to the current time zone of the client.

Note the following considerations:

- When the Discovery Manager client computer and the SQL server are in different time zones, the creation date/time displayed for a search instance is not converted from the SQL server date/time to client date/time. The search instance tree node reflects the time that the search was created; the time is not converted to local
time. The date in the tree is actually the name of the search and it is static after it is created. Outside of the tree nodes, the creation date is converted to local time, (for example, in reports).

- When you view a message natively, the times displayed in Outlook and Notes may be different from what is displayed in Discovery Manager. Outlook and Notes display the Sent time of the message, while Discovery Manager displays the Received time of the message.
Discovery Manager phases

Note: This section applies to the full edition of Discovery Manager.

In Discovery Manager, users are assigned roles that specify the actions they can perform during phases of legal discovery.

The following diagram shows an example of Discovery Manager phases, and the user roles at each phase.

![Diagram of Discovery Manager phases and roles](image)

Figure 1: Discovery Manager phases and roles
Lifecyle of a matter - Discovery Manager

Note: This section applies to the full edition of Discovery Manager.

The lifecycle of a matter in Discovery Manager includes:

- Creation - The matter is created and properties are specified, including the hold folder. Discovery Manager users are selected to work on the matter, and are assigned matter-specific roles. The matter is in an Open state.
- Collection - Items are collected. Selected items are assigned to the matter. Items placed on legal hold are preserved to prevent charges of spoliation or inadvertent destruction (disposition from the archive).
- Review - Assigned items are reviewed and tagged. Items are culled to determine the responsive set of items.
- Export - Items of interest are exported to a specified format. Metadata may also be exported.
- Closing - Final phase of a matter. After a matter is closed, the matter is read-only. Authorized users can view properties and reports. Searches cannot be created or run. Properties cannot be changed. Items cannot be assigned or tagged. Exports cannot be run. To modify a closed matter, the Matter Manager must change the state to Open.
- Deletion - The matter and all items associated with the matter are deleted, including items on hold. Only a user who is both the Matter Owner and the Matter Manager can delete a matter.

User roles in the matter lifecycle - Discovery Manager

Note: This section applies to the full edition of Discovery Manager.

In Discovery Manager, roles control access to a matter, and define the actions a user can perform on a matter during its lifecycle:

- Matter Owners create the matter.
- Matter Managers:
  - Assign and remove Matter Managers and Investigators to the matter.
Introduction

- Specify and modify matter properties.
- Monitor progress and status of the matter.
- Close the matter.
- Reopen the matter.
- Delete the matter. (Matter Managers must also have the Matter Owner role to delete matters.)

 Investigators:
- Collect, review, and export within the matter.
- Delete items from the matter.
- Apply and remove tags.

Refer to “Roles: Details” on page 23 for more information about roles in Discovery Manager.

Sample scenario - Discovery Manager

Note: This section applies to the full edition of Discovery Manager.

This example describes how Discovery Manager might be used in a simple investigation.

Start of investigation

The Human Resources department has requested that an investigation (matter) be opened regarding employee misconduct. The employee’s email must be searched.

Prepare Discovery Manager

- The User Administrator specifies the users who are able to work with Discovery Manager, and assigns the Matter Owner role to users who can create matters.
- The Identity Administrator creates aliases (identity records) that simplify searching email. Each identity record contains all of the email addresses for a particular person of interest (custodian). In this scenario, the custodian is the employee suspected of misconduct. This Identity Administrator has pro-actively prepared an identity record for each employee. Otherwise, the Matter Owner would request that an identity record be created for the custodian.
- The Tag Administrator creates tags that are available to all matters. Investigators will apply tags to specific items collected for the matter, to label the items for further review and to indicate
whether or not the items are responsive. If more tags are needed for this matter only, then the Matter Manager can add them to the matter.

**Prepare hold folders**
The EMC SourceOne Email Management administrator creates a hold folder, if needed for the matter. The hold folder must be full-text indexed. Refer to the *EMC SourceOne Discovery Manager Installation and Administration Guide*, Chapter 3, "Configuring EMC SourceOne for Discovery Manager" for more information.

**Create a matter**
The Matter Owner creates a matter, specifying:

- Name of matter
- Description
- Folder to hold copies of items (legal hold)
- Due date
- Custodians (in this scenario, one custodian)
- Matter Managers (in this scenario, two Matter Managers -- the second one is a backup)
- Investigators (in this scenario, three Investigators)

**Search and hold content**
Matter Managers and Investigators monitor the All Matters area of Discovery Manager for new matters. They see only the matters assigned to them by a Matter Manager.

The Matter Manager coordinates and monitors the work of the Investigators. When the new matter appears in Discovery Manager, he edits the matter’s properties to specify additional resources and some criteria:

- Add a third Investigator.
- Specify the folders to search.
- Specify the date range of emails to search.
- Specify keywords on which to search.
- Add a tag specific to this matter.

**Note:** A matter can have as many Matter Managers and Investigators as you need. To clarify workflow in this scenario, there is one investigator for each phase: collection, review, and production. You could have one Investigator for all three phases. You should have a second Matter Manager as a backup in case the first one is not available.
Introduction

The Investigator (Collector) searches for and collects relevant email for the matter.

- She creates a collection search using the information specified by the Matter Owner and the Matter Manager, and the identity record of the custodian created by the Identity Administrator.
- After the search runs, she views items in the preview pane to determine the items that are relevant to the matter.
- She selects items from the search results and assigns them to the matter for review. In this case, the matter has a hold folder, so the assigned items are copied automatically to the hold folder that the Matter Owner specified. These copied items are now on legal hold, and will be kept beyond their original retention dates.

Review and tag content

The Investigator (Reviewer) reviews and tags the items that were assigned to the matter by the Investigator (Collector).

She performs an in-matter search to further refine the list of items, views items in the preview pane, and then assigns tags to appropriate items to indicate which items are responsive and should be exported.

Export content from matter

The Investigator (Producer) is responsible for exporting the items that were identified by the Investigator (Reviewer).

She exports the items in the format (in this case, a PST file) requested by Human Resources.

End of investigation

When the investigation is finished, the Matter Manager closes the matter. The Matter Owner can delete the matter.
Roles: Details

The actions you can perform depend on your role(s).

Discovery Manager uses two types of roles:

◆ “Application-wide roles” on page 23
◆ “Matter-specific roles” on page 24

Application-wide roles

An application-wide role exists outside of a matter.

Only User Administrators can manage application-wide roles.

Refer to Chapter 2, “Managing Users and Application-Wide Roles.”

The following table describes application-wide roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Actions</th>
</tr>
</thead>
</table>
| Application Administrator | Available in both editions of Discovery Manager. Manages the Discovery Manager application:  
• Can assign himself to any role, by first assigning himself the User Administrator role.  
• Sees list of all matters and current matter status (OPEN, CLOSED), but no matter summary report.  
• Configures Discovery Manager settings.                                                                 |
| User Administrator    | Available in both editions of Discovery Manager. Manages users and application-wide roles:  
• Adds users to Discovery Manager.  
• Assigns application-wide roles to users.                                                                 |
| Identity Administrator | Note: This role is available in the full edition of Discovery Manager.  
Manages identities (aliases used in searches):  
• Creates and edits identity records.  
• Deletes unused identity records and associated identity elements (addresses).  
Note: In Discovery Manage full edition, ensure that at least one Investigator in each standard matter is also an Identity Administrator. |
| Tag Administrator     | Note: This role is available in the full edition of Discovery Manager.  
Creates and manages default tags that are available for all standard matters. |
Introduction

Table 1  Application-wide roles (continued)

<table>
<thead>
<tr>
<th>Role</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup Operator</td>
<td>Available in both editions of Discovery Manager.</td>
</tr>
<tr>
<td></td>
<td>Assigned to the account that can pause the Web Service and the Discovery Manager Windows Service in preparation for backing up Discovery Manager servers, and can resume the services after backup is complete. By default, the SourceOne service account is a backup operator. Refer to the EMC SourceOne Discovery Manager Installation and Administration Guide for information about backing up Discovery Manager servers.</td>
</tr>
<tr>
<td>Matter Owner</td>
<td><strong>Note:</strong> This role is available in the full edition of Discovery Manager.</td>
</tr>
<tr>
<td></td>
<td>Creates new standard matters:</td>
</tr>
<tr>
<td></td>
<td>• Views all standard matters created by him, or to which he is assigned the matter-specific role(s) Matter Manager or Investigator.</td>
</tr>
<tr>
<td></td>
<td>• By default, becomes the first Matter Manager and Investigator in the standard matter.</td>
</tr>
<tr>
<td></td>
<td>• As Matter Manager, can assign other Matter Managers and Investigators to the standard matter.</td>
</tr>
<tr>
<td></td>
<td>• Can remove himself as Matter Manager or Investigator from the standard matters he creates.</td>
</tr>
<tr>
<td></td>
<td>• If also the Matter Manager, can delete closed standard matters.</td>
</tr>
</tbody>
</table>

Matter-specific roles

*Matter-specific roles* are available in the full edition of Discovery Manager for standard matters. These roles are displayed and can be assigned only from within a matter.

Refer to Chapter 7, “Managing Matters” for more information about managing matter-specific roles.
The following table describes the roles that only apply within a standard matter.

**Table 2  Matter-specific roles in Discovery Manager (full edition)**

<table>
<thead>
<tr>
<th>Role</th>
<th>Sub-role</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Matter Manager</td>
<td></td>
<td><strong>Note:</strong> This role is available in the full edition of Discovery Manager.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Manages standard matters:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Views assigned standard matters, including matter summary reports.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Defines standard matter properties: search folders, dates, keywords, custodians.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Assigns other users to the Matter Manager and Investigator roles for a standard matter.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Creates, modifies, and deletes matter-specific tags.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Changes status of the standard matter.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Specifies a hold folder for a standard matter.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Views matter collection activity, including the status of a running search.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Views matter tagging activity.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Views matter production activity, including the status of a running export.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Manages lifecycle state of standard matters (Open, Closed).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If also the Matter Owner, can delete closed standard matters.</td>
</tr>
</tbody>
</table>

**Note:** To preview items in collection searches or in review (in-matter) searches, a Matter Manager must also have the Investigator role.
Table 2  Matter-specific roles in Discovery Manager (full edition) (continued)

<table>
<thead>
<tr>
<th>Role</th>
<th>Sub-role</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Investigator</td>
<td><strong>Note:</strong> In this release, an Investigator has all sub-roles.</td>
<td><strong>Note:</strong> This role is available in the full edition of Discovery Manager. Searches, collects, views and opens items, assigns custodian, applies tags, and exports results. Can preview items in collection searches and in review (in-matter) searches.</td>
</tr>
<tr>
<td></td>
<td><strong>Producer</strong></td>
<td>1. Views assigned standard matters, including matter summary reports. 2. Views all items and search jobs in a standard matter. 3. Selects items to export. 4. Exports items.</td>
</tr>
</tbody>
</table>

EMC SourceOne 7.0 Discovery Manager User Guide
Starting Discovery Manager (both editions)

This section applies to both editions of Discovery Manager.

To start the Discovery Manager application, do one of the following steps:

◆ Double-click the Discovery Manager icon on your desktop.
◆ Click the Discovery Manager icon in the Quick Launch bar.
◆ Select the path from the Start menu:
  • Start menu > Programs > EMC SourceOne Discovery Manager > EMC Discovery Manager.

The Discovery Manager splash screen displays.

Figure 2  Discovery Manager splash screen

Language packs

To display online help and error messages in the appropriate language based on your computer’s settings, both editions of Discovery Manager use language packs. When you start either application for the first time, it may download a language pack from the Discovery Manager server. The splash screen displays the message: Retrieving language pack.

After the language pack downloads, the Discovery Manager express edition or Discovery Manager application restarts automatically.

If the language pack is unavailable, the Discovery Manager express edition or Discovery Manager application displays online help and errors in English.
# Errors at startup

If the Discovery Manager express edition or the Discovery Manager application cannot connect to the Discovery Manager server, then an error message appears: *Unable to connect to the Discovery Manager server: <IP address or host name>.*

If you are not authorized to use Discovery Manager, then an error message appears: *You are not authorized to use this application.*

In either case, do the following steps:

1. Contact your Discovery Manager administrator.
2. Click **OK** to close the error dialog box.

# Exiting Discovery Manager (both editions)

This section applies to both editions of Discovery Manager.

To exit and close the Discovery Manager application, select **File tab > Exit.**
Overview of application window

The Discovery Manager window has the following main areas:

- **Ribbon pane (top)** - Use to access some menus, commands, and properties. Refer to “Overview of ribbon pane” on page 30.

- **Navigation pane (left)** - Use to access tasks appropriate to your role. Refer to “Overview of navigation pane” on page 47.

- **Work pane (middle right)** - Use to perform tasks and view lists of items. The contents of the work pane change according to the task you are performing and the items you are viewing. For example, the following illustration shows a list of items under **My Matters**.

- **Preview pane (bottom right)** - Displays the contents of a message or details about an item that you selected in the work pane.

**Note:** The functions available to you depend on the edition of Discovery Manager and your role. Not all functions are available in Discovery Manager express edition.
Overview of ribbon pane

You can perform most actions by right-clicking an item, then selecting an action from the shortcut menu.

Alternatively, you can select an item, then select an action in the ribbon pane.

Note:

◆ Some functions on the ribbon are grayed out in Discovery Manager express edition. All ribbon functions are available in Discovery Manager full edition.

◆ The actions available to you in the ribbon also depend on your assigned roles and permissions.

◆ Some commands on the ribbon pane are context-sensitive. They are available only when you select a certain item, such as a matter or a search.

◆ Starting in version 7.0 of Discovery Manager, tabs have been added, replaced, and removed. Some commands have been moved from one tab to another.

The ribbon pane in Discovery Manager is similar to the ribbon panes in Microsoft Office 2010. It contains several tabs. Refer to:

◆ “Introduction to the ribbon pane” on page 31
◆ “File tab” on page 34
◆ “Home tab” on page 36
◆ “Matter tab” on page 38
◆ “Search/Export tab” on page 41
◆ “Identities tab” on page 43
◆ “Administration tab” on page 44
◆ “Results tab” on page 45
Introduction to the ribbon pane

This topic describes the parts of a ribbon pane, and how to use ribbon panes in general.

Refer to:
- “Tabs, groups, and commands” on page 31
- “Quick Access Toolbar” on page 31
- “Key Tips and badges” on page 32
- “Navigating the ribbon pane using the keyboard” on page 33
- “Hiding the ribbon pane” on page 33

Tabs, groups, and commands

The ribbon pane has several tabs.

After you select a tab, it moves in front of the other tabs and becomes the active tab.

Each tab contains commands organized in groups. For example, the Home tab has two groups: Actions and Views.

A command can be an action, a field, or a link to a dialog box.

Note: Some functions are available only in the full edition of Discovery Manager.

Quick Access Toolbar

The Quick Access Toolbar is an area above the ribbon pane.

You can add frequently-used commands to the Quick Access Toolbar.
Introduction

By default, it is empty.

To add a command to the Quick Access Toolbar:

1. In the ribbon pane, right-click the command that you want to add.
2. Select Add to Quick Access Toolbar.

To remove a command from the Quick Access Toolbar:

1. In the Quick Access Toolbar, right-click the command that you want to remove.
2. Select Remove from Quick Access Toolbar.

**Key Tips and badges**

*Key Tips* is the new term for what were called hot keys, shortcut keys, or accelerator keys on menus in older Windows applications.

To display Key Tips, press and release the **ALT** key or the **F10** key.

Key Tips are shown superimposed on the ribbon pane. Each boxed letter is called a *badge*.

![Figure 5 Key Tips - top level](image)

To use a key shown in a badge, press that key.

To access a command on a tab, press the key for that tab first, then press the key for the command.

The following example shows the key tips for the Home tab.

![Figure 6 Key Tips - Home tab](image)
To hide the display of Key Tips, press and release the ALT key or the F10 key again.

For a complete list of ribbon Key Tips, refer to “Keyboard shortcuts” on page 391.

Navigating the ribbon pane using the keyboard

The following table describes how to use the keyboard to move through tabs and commands in the ribbon pane.

<table>
<thead>
<tr>
<th>Table 3</th>
<th>Navigation keys for ribbon pane</th>
</tr>
</thead>
<tbody>
<tr>
<td>To do this</td>
<td>Press this key</td>
</tr>
<tr>
<td>Move through tabs.</td>
<td>Press and release ALT or F10, then press LEFT ARROW or RIGHT ARROW.</td>
</tr>
<tr>
<td>Move through commands.</td>
<td>• Press and release ALT or F10, then press TAB or SHIFT- TAB.  • Press the ARROW keys.</td>
</tr>
<tr>
<td>Activate or open an item in the ribbon pane.</td>
<td>Press SPACE BAR or ENTER.</td>
</tr>
</tbody>
</table>

Hiding the ribbon pane

You can hide all commands on the ribbon, leaving only the tabs displayed.

To hide the ribbon, do one of the following steps:

◆ Double-click the active (selected) tab.
◆ Press Ctrl-F1.
◆ Click the dropdown arrow in the Quick Access Toolbar, then select Minimize the Ribbon.

Figure 7 Minimize the ribbon

To redisplay the ribbon, repeat the step that you used to hide the ribbon.
Introduction

File tab

Note: Starting with Discovery Manager 7.0, the File tab replaces the Application Button.

Use the commands on the File tab to:

◆ Create matters, identities, and users.

Figure 8 File tab - New

◆ Access help, display information about the version of Discovery Manager, and access log files and system information.

Figure 9 File tab - Help

◆ Exit Discovery Manager.

The following table describes the commands in the File tab.
### Table 4  
**File tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Command on Submenu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td></td>
<td><strong>Note</strong>: This function is available in the full edition of Discovery Manager. Use to create a matter, identity, or user.</td>
</tr>
<tr>
<td>New Identity</td>
<td></td>
<td><strong>Note</strong>: This function is available in the full edition of Discovery Manager. Available when you click the Identities button in the navigation pane. Opens the Identity window. Use to create an identity.</td>
</tr>
<tr>
<td>New Matter</td>
<td></td>
<td><strong>Note</strong>: This function is available in the full edition of Discovery Manager. Opens the Matter Creation wizard. Use to create a matter.</td>
</tr>
<tr>
<td>New User</td>
<td></td>
<td>Available to User Administrators while working in the Administration &gt; User Manager screen. Opens the Select Users dialog box. Use to add new Discovery Manager users.</td>
</tr>
<tr>
<td>Help</td>
<td>Help</td>
<td>Displays the online help for Discovery Manager.</td>
</tr>
<tr>
<td>About</td>
<td></td>
<td>Displays the IP address and version of the Discovery Manager server, the version of the Discovery Manager client, and links to log files and system information.</td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td>Closes the Discovery Manager window and exits the application.</td>
</tr>
</tbody>
</table>
Home tab

Use the Home tab for:

- Common actions, such as copy and delete
- Customizing views
- Managing tags (available in the full edition of Discovery Manager)
- Managing users

**Figure 10** Ribbon pane - Home tab

The following table describes the menus and commands in the Home tab.

**Table 5** Ribbon pane - Home tab

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actions</td>
<td>Delete</td>
<td>Use to delete any selected objects in Discovery Manager that can be deleted, such as matters, identities, searches, users, and exports.</td>
</tr>
<tr>
<td>Grid Views</td>
<td></td>
<td>Available when a grid is displayed. Use to customize the display of search results and lists of items,</td>
</tr>
<tr>
<td></td>
<td>Sort A to Z</td>
<td>Sorts in ascending order (alphabetical).</td>
</tr>
<tr>
<td></td>
<td>Sort Z to A</td>
<td>Sorts in descending order.</td>
</tr>
<tr>
<td></td>
<td>Remove Sorting</td>
<td>Removes the last-applied sort order.</td>
</tr>
</tbody>
</table>
### Table 5  Ribbon pane - Home tab (continued)

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Field Chooser</td>
<td>Opens the Field Chooser dialog box. Use to add or remove columns in grids. Column changes are independent for Collection, Review and Export grids so that each node can have its own set of columns. Columns changes persist after you close Discovery Manager.</td>
</tr>
<tr>
<td></td>
<td>Duplicates</td>
<td>Toggles the display of duplicates in collection search results. It is applied to all 7.0 or later collection search grids, not just to the collection search grid that you are currently viewing. The toggle stays in effect for the entire session until you change it. It is not available for collection searches that were created before version 7.0 of Discovery Manager. Although the Duplicates command is available when other grids are displayed (such as the Export grid), it toggles the display of duplicates only in collection search grids. It is not available when you click the Administration button or the Identities button in the navigation pane.</td>
</tr>
<tr>
<td>Reports</td>
<td>Preview Pane</td>
<td>Toggles the display of the preview pane at the bottom of the Discovery Manager window.</td>
</tr>
</tbody>
</table>
Matter tab

In Discovery Manager express edition, only the Search Folders option is available on the Matter tab.

In the full edition of Discovery Manager, you must have the Matter Owner, Matter Manager, Search Export, or Investigator role to use the Matter tab:

- Matter Owners use the Matter tab to create standard matters.
- Matter Managers use the Matter tab to edit properties of standard matters.

Figure 11  Ribbon pane - Matter tab
The following table describes the menus and commands in the **Matter** tab.

**Table 6  Ribbon pane - Matter tab**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Description</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actions</td>
<td>New Matter</td>
<td><strong>Note:</strong> This function is available in the full edition of Discovery Manager. Available to Matter Owner. Starts the Matter Creation wizard. Use to create a new matter.</td>
<td>&quot;Creating a standard matter&quot; on page 140</td>
</tr>
<tr>
<td></td>
<td>New Folder</td>
<td>Use to create an organizing folder for searches.</td>
<td>&quot;Using folders to organize collection searches&quot; on page 203</td>
</tr>
<tr>
<td></td>
<td>Copy</td>
<td>Use to copy a selected search or an organizing folder.</td>
<td>&quot;Copying a collection search&quot; on page 202</td>
</tr>
<tr>
<td></td>
<td>Rename</td>
<td>Use to rename a selected search or an organizing folder.</td>
<td>&quot;Renaming a collection search&quot; on page 202</td>
</tr>
<tr>
<td></td>
<td>View Running Jobs</td>
<td>Opens the Running Jobs window. Use to view the progress of searches and exports.</td>
<td>&quot;Viewing running jobs&quot; on page 231</td>
</tr>
</tbody>
</table>
| Properties|                 | **Note:** All properties are available in the full edition of Discovery Manager. Accesses properties of the selected matter. (Available to Matter Managers.)
To access individual tabs in the Matter Properties dialog box, click the appropriate command, as described below.
To access the entire Matter Properties dialog box, click the dialog launcher (the small square to the right of the word "Properties." | "Editing matter properties" on page 148 |
| General |                 | **Note:** This function is available in the full edition of Discovery Manager. Opens the General tab in the Matter Properties dialog box for the selected matter. Use to edit the name, description, and state of the matter. | "General tab" on page 150                     |
### Table 6  Ribbon pane - Matter tab (continued)

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Description</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users</td>
<td></td>
<td><strong>Note:</strong> This function is available in the full edition of Discovery Manager.</td>
<td>“User Management tab” on page 152</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Opens the User Management tab in the Matter Properties dialog box for the selected matter. Use to specify Discovery Manager users to work on the matter and to assign matter-specific roles.</td>
<td></td>
</tr>
<tr>
<td>Search Folders</td>
<td></td>
<td>Opens the Search Folders tab in the Matter Properties dialog box for the selected matter. Use to specify the folders to search.</td>
<td>“Search Folders tab” on page 154</td>
</tr>
<tr>
<td>Tags</td>
<td></td>
<td><strong>Note:</strong> This function is available in the full edition of Discovery Manager.</td>
<td>“Tags tab” on page 160</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Opens the Tags tab in the Matter Properties dialog box for the selected matter. Use to create, edit, and delete matter-specific tags.</td>
<td></td>
</tr>
<tr>
<td>Custodians</td>
<td></td>
<td><strong>Note:</strong> This function is available in the full edition of Discovery Manager.</td>
<td>“Custodians tab” on page 164</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Opens the Custodians tab in the Matter Properties dialog box for the selected matter. Use to select or create custodian tags for the matter.</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td></td>
<td><strong>Note:</strong> This function is available in the full edition of Discovery Manager.</td>
<td>“Closing standard matters” on page 177 and “Reopening standard matters” on page 177</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use to change the state of a matter (Open or Closed).</td>
<td></td>
</tr>
<tr>
<td>Metadata</td>
<td></td>
<td><strong>Note:</strong> This function is available in the full edition of Discovery Manager.</td>
<td>“Metadata tab” on page 156</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Opens the Metadata tab in the Matter Properties dialog box for the selected matter. Use to specify custom metadata for searching.</td>
<td></td>
</tr>
<tr>
<td>Dates</td>
<td></td>
<td><strong>Note:</strong> This function is available in the full edition of Discovery Manager.</td>
<td>“Dates tab” on page 157</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Opens the Dates tab in the Matter Properties dialog box for the selected matter. Use to specify a due date and a suggested date range for searches.</td>
<td></td>
</tr>
</tbody>
</table>
Introduction

The Search/Export tab is available for:
- Search Export users in Discovery Manager express edition
- Investigators in the full edition of Discovery Manager

Use the Search tab to:
- Create, edit, and manage searches.
- Create and manage exports.

---

**Table 6  Ribbon pane - Matter tab (continued)**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Description</th>
<th>Refer to</th>
</tr>
</thead>
</table>
|       | Keywords | **Note:** This function is available in the full edition of Discovery Manager.  
 | | Opens the Keywords tab in the Matter Properties dialog box.  
 | | Use to specify keywords on which to search. | “Keywords tab” on page 163 |

---

Search/Export tab

The Search/Export tab is available for:
- Search Export users in Discovery Manager express edition
- Investigators in the full edition of Discovery Manager

Use the Search tab to:
- Create, edit, and manage searches.
- Create and manage exports.
The following table describes the menus and commands in the **Search/Export** tab.

**Table 7  Ribbon pane - Search/Export tab**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Description</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search</td>
<td>Use to create and manage searches, assign all items to a standard matter, and export all results.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>New Search</strong></td>
<td>Use to create a search.</td>
<td>“Creating a collection search” on page 188</td>
</tr>
<tr>
<td></td>
<td><strong>Start</strong></td>
<td>Use to start a selected search.</td>
<td>“Changing search status” on page 209</td>
</tr>
<tr>
<td></td>
<td><strong>Stop</strong></td>
<td>Use to stop a selected, running search.</td>
<td>“Changing search status” on page 209</td>
</tr>
<tr>
<td>Schedule</td>
<td><strong>Note:</strong> This function is available in the full edition of Discovery Manager. Use to schedule a selected search.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>General</strong></td>
<td>Opens the Search Properties dialog box. Use to edit properties of a selected search, including selecting search folders.</td>
<td>“Editing search properties” on page 191</td>
</tr>
<tr>
<td></td>
<td><strong>Expand/ Collapse</strong></td>
<td>Toggles the display of the search criteria area.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Export all results</strong></td>
<td>Use to export all search results. Opens the Export dialog box.</td>
<td>“Specifying export settings” on page 325</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To export selected search results, use the Results tab.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Assign all results to matter</strong> Available to Investigators in a collection search to assign all results to a standard matter.</td>
<td>“Assigning collection search results to a standard matter” on page 227</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To assign selected results to a standard matter, use the Results tab.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Assign all results to matter with custodians</strong> Available to Investigators in a collection search to assign all results to a standard matter with custodians.</td>
<td>“Assigning collection search results to a standard matter” on page 227</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To assign selected results to a standard matter with custodians, use the Results tab.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Introduction**

Identities tab

*Note:* The Identities tab is available in the full edition of Discovery Manager.

The Identities tab is available for Identity Administrators.

Use the Identities tab to manage address aliases used in searches.

---

Table 7  Ribbon pane - Search/Export tab (continued)

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Description</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export</td>
<td></td>
<td>Use to manage exports.</td>
<td></td>
</tr>
<tr>
<td>Stop</td>
<td></td>
<td>Not available in pre-GA release.</td>
<td></td>
</tr>
<tr>
<td>Retry All</td>
<td></td>
<td>For a specific export, use to retry exporting all items listed under the Failures node.</td>
<td>“Retrying export of failed items” on page 357</td>
</tr>
</tbody>
</table>

---

**Identities tab**

*Note:*  The Identities tab is available in the full edition of Discovery Manager.

The Identities tab is available for Identity Administrators.

Use the Identities tab to manage address aliases used in searches.

---

**Figure 13  Ribbon pane - Identities tab**

*Note:*  Ensure that at least one Investigator per standard matter is also an Identity Administrator.

The following table describes the menus and commands in the Identities tab.
Introduction

The Administration tab is available for:

- Application Administrators when working in the User Manager screen to add and remove users, and to add and remove Personal Matters in the express edition and the full edition of Discovery Manager
- Tag Administrators when working in the Tag Manager screen to add, edit, and remove tags in the full edition of Discovery Manager

The following table describes the menus and commands in the Administration tab.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Description</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actions</td>
<td></td>
<td>Actions you can perform on identities.</td>
<td>Chapter 5, &quot;Managing Identities.&quot;</td>
</tr>
<tr>
<td></td>
<td>New Identity</td>
<td>Use to create an identity.</td>
<td>&quot;Adding identity records&quot; on page 108</td>
</tr>
<tr>
<td></td>
<td>Edit Identity</td>
<td>Available when you are working in the Identities window. Use to edit a selected identity.</td>
<td>&quot;Editing identity records&quot; on page 111</td>
</tr>
<tr>
<td></td>
<td>Delete Identity</td>
<td>Available when you are working in the Identities window. Use to delete a selected identity.</td>
<td>&quot;Deleting identity records&quot; on page 112</td>
</tr>
</tbody>
</table>

Administration tab

The Administration tab is available for:

- Application Administrators when working in the User Manager screen to add and remove users, and to add and remove Personal Matters in the express edition and the full edition of Discovery Manager
- Tag Administrators when working in the Tag Manager screen to add, edit, and remove tags in the full edition of Discovery Manager

Figure 14  Administration tab

The following table describes the menus and commands in the Administration tab.
Introduction

Use the Results tab to apply actions to selected search results:

- All of the commands are available for Investigators in the full edition of Discovery Manager.
- Only the Export command is available for Search Export users in the express edition of Discovery Manager.

The following table describes the menus and commands in the Results tab.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Description</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users</td>
<td>Add User</td>
<td>Use to add a user to Discovery Manager.</td>
<td>“Adding users” on page 64</td>
</tr>
<tr>
<td></td>
<td>Remove User</td>
<td>Use to remove a user from Discovery Manager.</td>
<td>“Removing users” on page 66</td>
</tr>
<tr>
<td></td>
<td>Add Personal Matter</td>
<td>Use to add a Personal Matter to a user who does not have one.</td>
<td>“Adding or removing Personal Matters” on page 70</td>
</tr>
<tr>
<td></td>
<td>Remove Personal Matter</td>
<td>Use to remove a Personal Matter from a user.</td>
<td>“Adding or removing Personal Matters” on page 70</td>
</tr>
<tr>
<td>Tags</td>
<td>Add Tag</td>
<td>Use to add a default tag.</td>
<td>“Adding custom default tags” on page 130</td>
</tr>
<tr>
<td></td>
<td>Edit Tag</td>
<td>Use to edit a default tag.</td>
<td>“Editing tags” on page 132</td>
</tr>
<tr>
<td></td>
<td>Remove Tag</td>
<td>Use to remove a default tag.</td>
<td>“Deleting tags” on page 133</td>
</tr>
</tbody>
</table>

Results tab

Table 9 Ribbon pane - Administration tab

Figure 15 Result Actions tab
<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Description</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment</td>
<td>Assign results to matter</td>
<td>Available to Investigators in a collection search to assign selected results to a standard matter.</td>
<td>“Assigning collection search results to a standard matter” on page 227</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> To assign all results to a standard matter, use the Search/Export tab.</td>
<td></td>
</tr>
<tr>
<td>Remove results from matter</td>
<td></td>
<td>Available to Investigators in Matter Review to remove selected assigned results from a standard matter.</td>
<td>“Removing items from Matter Review” on page 315</td>
</tr>
<tr>
<td>Assign results to matter with custodians</td>
<td></td>
<td>Available to Investigators in a collection search to assign selected results to a standard matter with custodians.</td>
<td>“Assigning collection search results to a standard matter” on page 227</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> To assign all results to a standard matter with custodians, use the Search/Export tab.</td>
<td></td>
</tr>
<tr>
<td>Export</td>
<td>Export</td>
<td>Use to export selected search results. Opens the Export dialog box.</td>
<td>Chapter 12, “Exporting Content and Metadata”</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> To export all search results, use the Search/Export tab.</td>
<td></td>
</tr>
<tr>
<td>Retry failed items</td>
<td></td>
<td>Use to retry selected items that failed to export.</td>
<td>“Retrying export of failed items” on page 357</td>
</tr>
<tr>
<td>Tags</td>
<td>Tags</td>
<td>Available to Investigators when working with selected items in the Matter Review node (All items or an in-matter search). Displays list of available tags. Use to assign tags to selected items.</td>
<td>“Applying tags to items” on page 298</td>
</tr>
<tr>
<td>Custodians</td>
<td>Custodians</td>
<td>Available to Investigators when working with selected items in the Matter Review node (All items or an in-matter search). Displays list of available custodians. Use to assign custodians to selected items.</td>
<td>“Assigning custodians to items” on page 302</td>
</tr>
</tbody>
</table>
Overview of navigation pane

Depending on the edition of Discovery Manager and your role(s), you can use one or more of the following buttons at the bottom of the navigation pane:

- “Customizing the display of the navigation pane” on page 47
- “My Matters” on page 49
- “Identities” on page 52
- “All Matters” on page 52
- “Administration” on page 53

Customizing the display of the navigation pane

To add or remove buttons from the navigation pane, and to change their order:

1. Click the Configure Buttons dropdown arrow at the lower right corner of the navigation pane.

   The navigation pane menu displays.
2. Do one of the following steps:

- Select **Show More Buttons** or **Show Fewer Buttons** to add or remove buttons from the navigation pane.
- Select **Add or Remove Buttons** to display a submenu. Click the name of the button to toggle the display of it on or off.
a. Select the checkbox next to each button that you want to display. Clear the checkbox next to each button that you do not want to display.

b. To change the order of a button, select the button, then click Move Up or Move Down.

c. Click OK.

My Matters

In Discovery Manager express edition, each user sees only his Personal Matter in the My Matters area. In the full edition of Discovery Manager, Personal Matters are optional.

In the full edition of Discovery Manager, to view standard matters in the My Matters area, you must have one of the following roles: Matter Owner, Matter Manager, or Investigator.

To view My Matters:

1. Click the **My Matters** button in the navigation pane.

   The navigation pane lists the matters that have been assigned to you, or that you created. To remove or re-add matters in My Matters, refer to “Removing and placing standard matters in My Matters” on page 146.
2. In the navigation pane, select a matter.
   The work pane displays information about the selected matter.

3. In the navigation pane, expand the matter by clicking on the plus sign (+) next to the name of the matter.
   The selected matter displays three nodes.

   Figure 22 Matter subnodes

   Each matter subnode represents related tasks that Investigators can perform on the selected matter, as described in the following table.

   Note: If you are not an Investigator, you can view the matter subnodes, but not perform tasks in them.
Table 11  Matter subnodes

<table>
<thead>
<tr>
<th>Node</th>
<th>Description</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collection Area</td>
<td>Use to:</td>
<td>Chapter 8, “Collecting Content for Matters”</td>
</tr>
<tr>
<td></td>
<td>• Create and run searches to collect content for a matter.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Organize searches in folders.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View collected items.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Assign collected items to a matter. (Available in Discovery Manager.)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Place content on hold. (Available in Discovery Manager.)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Assign custodians while assigning items to a matter. (Available in Discovery Manager.)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Export collected items.</td>
<td></td>
</tr>
<tr>
<td>Matter Review</td>
<td><strong>Note:</strong> Available in the full edition of Discovery Manager.</td>
<td>Chapter 11, “Reviewing Content in Matters”</td>
</tr>
<tr>
<td></td>
<td>Use to:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Review content collected for a matter.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Refine searches by performing in-matter searches.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Organize searches in folders.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Apply or remove tags.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Filter content.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Assign or remove custodians.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Delete items.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Export items.</td>
<td></td>
</tr>
<tr>
<td>Export</td>
<td>Use to view export information.</td>
<td>Chapter 12, “Exporting Content and Metadata,”</td>
</tr>
</tbody>
</table>

**Note:** If you are removed from a matter, and you click on the matter or any of its subnodes, then an error message displays. To remove the matter from the list, refresh the screen manually (collapse or expand the My Matters root node).

To create a matter, refer to “Creating a standard matter” on page 140.
Identities

Note: Identities are available in the full edition of Discovery Manager.

The Identities button in the navigation pane is available for Identity Administrators.

To view or define identities, you must have the Identity Administrator role.

To navigate to Identities, click the Identities button in the navigation pane.

Refer to Chapter 5, "Managing Identities" for more information.

All Matters

Note: The All Matters button/area is available in the full edition of Discovery Manager.

To view All Matters, click the All Matters button in the navigation pane.

The navigation pane displays the All Matters node, with existing matters displayed as subnodes.

The work pane lists all matters that have been assigned to you.

What you see depends on your role:

- Application Administrators do not see any matters in the All Matters area. They can see matters by clicking the Administration button in the navigation pane, then expanding the All Matters node. Refer to “Administration” on page 53.
- In the full edition of Discovery Manager, Matter Managers and Investigators see a list of matters. They can click a matter to see its summary report.

For each matter, the work pane displays information about the matter that was supplied when the matter was created. Only the name of the matter is required during matter creation; all other fields are optional and may be blank.
Introduction

Figure 23: All Matters

Note: If you are removed from a matter, and you click on the matter or any of its subnodes, then an error message displays. To remove the matter from the list, refresh the screen manually (collapse or expand the All Matters root node).

To create a matter, refer to “Creating a standard matter” on page 140.

Administration

The Administration button is available for the following roles:

- Application Administrator
- User Administrator
- Tag Administrator (available in the full edition of Discovery Manager)

Application Administrators can perform the following tasks:

- Configure application settings for Discovery Manager express edition and for the full edition of Discovery Manager.
See a list of all matter names and state, even if the Application Administrator has no rights to them. Application Administrators cannot see matter summary reports.

To access administration tasks, in the navigation pane, click the Administration button.
Each node displayed in the Administration pane represents an administration task, as described in the following table.

<table>
<thead>
<tr>
<th>Node</th>
<th>Description</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Manager</td>
<td>Use to add users to Discovery Manager express edition or to the full edition of Discovery Manager, and to assign application-wide roles to those users.</td>
<td>Chapter 2, &quot;Managing Users and Application-Wide Roles&quot;</td>
</tr>
<tr>
<td>Tag Manager</td>
<td><strong>Note</strong>: Tag Manager is available in the full edition of Discovery Manager. Use to configure application-wide default matter tags.</td>
<td>Chapter 6, &quot;Managing Default Tags&quot;</td>
</tr>
<tr>
<td>All Matters</td>
<td><strong>Note</strong>: All Matters is available in the full edition of Discovery Manager. Use to view a list of all matters and the state of each matter.</td>
<td></td>
</tr>
<tr>
<td>Configuration</td>
<td>Use to specify settings such as the maximum number of search results to return.</td>
<td>Chapter 3, &quot;Configuring Discovery Manager&quot;</td>
</tr>
</tbody>
</table>

### Refreshing the display

In the full edition of Discovery Manager, multiple investigators in the same standard matter, or investigators in other standard matters, can view or open the same item at the same time.

**Matters**

To refresh the display of matters listed under the My Matters node or the All Matters node, collapse or expand the My Matters root node or the All Matters root node.

**Items**

If two or more investigators are viewing the same item, and one of the investigators tags the item or deletes the item, the second investigator will not see the change immediately.

To refresh the display, change focus (for example, move to a different item, select the same item again, or move to a different area).
Understanding connection status

To search, export, assign items to matters, or to delete items, you must be connected to the Discovery Manager server.

To see if you are connected to the server, look at the icon in the lower right corner of the application window.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Connected]</td>
<td>Connected</td>
<td>The unbroken chain icon indicates that you are connected the Discovery Manager server.</td>
</tr>
<tr>
<td>![Limited Availability]</td>
<td>Limited Availability</td>
<td>The broken chain icon indicates that you are not connected to the server. You cannot search, export, assign items, or delete items until the server becomes available. Operations that were in progress will resume when the server becomes available.</td>
</tr>
</tbody>
</table>
Viewing error information

General errors If an error occurs, an Error dialog may open, for example:

![Error - Show Details](image)

To see detailed information that may be useful to your system administrator, click **Show Details**.

The Error dialog box expands to display detailed information, if any.

![Error - Copy to Clipboard](image)

To copy the detailed information to your clipboard so that you can paste it into an email message to your system administrator, click **Copy to Clipboard**.

*Note:* For information about viewing errors during searches, refer to “Viewing search errors” on page 210.
**Report errors**

An error that occurs when you are viewing a report is displayed at the bottom of the Discovery Manager window.

---

**A problem has occurred!**

Description: Sql exception: a network-related or instance-specific error occurred while establishing a connection to SQL Server. The server was not found or was not accessible. Verify that the instance name is correct and that SQL Server is configured to allow remote connections. (provider: TCP Provider, error: 0 - No connection could be made because the target machine actively refused it.)

---

Figure 27  Example - Error viewing reports

---

**What happens during backup of servers?**

This section applies to both editions of Discovery Manager.

- If you try to start the Discovery Manager application during the backup of the Discovery Manager servers, then an error dialog box opens displaying the message: *Discovery Manager server is backing up. Please wait until backup is complete.*

---

**Figure 28  Error - Starting Discovery Manager during backup**

Click **OK** to close the dialog box. Wait to start the Discovery Manager application until your system administrator notifies you that the backup is complete.

- If you are already working in the Discovery Manager application when the backup of the Discovery Manager servers starts, and you are performing an operation that involves the servers, then a dialog box opens displaying the message: *Discovery Manager server <IP address> is backing up. Please wait until backup is complete or close the application.*
What happens during backup of servers?

Figure 29 Server is backing up

Do one of the following steps:

- Wait until the backup is complete before you continue working in the Discovery Manager application.
- Click **Close Application** to close the Discovery Manager application. Wait to restart the Discovery Manager application until your system administrator notifies you that the backup is complete.
This chapter contains the following topics:

- Introduction ................................................................. 62
- Prerequisites ............................................................................. 63
- Adding the first user ............................................................ 63
- Adding users ............................................................................. 64
- Removing users ........................................................................ 66
- Assigning application-wide roles ........................................ 67
- Adding or removing Personal Matters ................................. 70
Introduction

This section applies to both editions of Discovery Manager, except where noted.

IMPORTANT

Before the Discovery Manager application is installed on all client computers, you must define the first user, and assign all Discovery Manager roles to that user. To do that, you can use the Discovery Manager client application installed on any computer. Refer to “Adding the first user” on page 63 for details.

Discovery Manager includes several default application-wide roles, as described in “User roles in the matter lifecycle - Discovery Manager” on page 19 and “Roles: Details” on page 23.

Note: Matter-specific roles are displayed and assigned within a standard matter in the full edition of Discovery Manager. Refer to “Managing Matters” on page 135.

Before users can work in Discovery Manager, the User Administrator must:

1. Add users.
   
   In Discovery Manager express edition, a Personal Matter is created automatically for each user.
   
   In Discovery Manager full edition, these users become the pool of available staff for assignment to standard matters by Matter Owners and Matter Managers. Discovery Manager users can be employees in IT, Legal, HR, Compliance, or in a line of business.
   
   Refer to “Adding the first user” on page 63 and “Adding users” on page 64.

2. Assign application-wide roles, as appropriate, to users. Refer to “Assigning application-wide roles” on page 67.

   Note: You do not need to assign every Discovery Manager user to an application-wide role. However, you need to assign at least one user to each application-wide role.
Prerequisites

This section applies to both editions of Discovery Manager.

Users who will be using the Discovery Manager client application must be in Active Directory. Email users, whose email will be searched, do not need to be in Active Directory.

Adding the first user

This section applies to both editions of Discovery Manager.

Before the Discovery Manager client application is installed on client computers, you must define the first user.

To perform the following steps, you can use the Discovery Manager client application running on either the Discovery Manager Server host computer (express edition of full edition) or on another computer:

1. Log on to the computer as the service account that you specified in the Logon Information screen during installation of the Discovery Manager Server software (express edition or full edition.)

   The service account is implicitly a Discovery Manager user, but with limited functionality: it has the User Manager role, which can only add users and assign roles.

2. Start the Discovery Manager client application.

3. Add the first Discovery Manager user. Refer to “Adding users” on page 64.

4. Assign all Discovery Manager express edition or Discovery Manager roles to this first user. Refer to “Assigning application-wide roles” on page 67.

After the Discovery Manager client application is installed on client computers, the first Discovery Manager user can add other users and assign roles. He can also remove himself from roles after other users are assigned those roles.
Adding users

This section applies to both editions of Discovery Manager.

IMPORTANT
After Discovery Manager is installed, add the first user. Refer to “Adding the first user” on page 63.

Considerations and limitations

◆ To add users, you must have the User Administrator role.
◆ In the Discovery Manager client application, the User Administrator selects users from Active Directory. These users are added to the Discovery Manager database. Only users that are listed in the Discovery Manager database can use the client application.
◆ You cannot add the service account as a Discovery Manager user.
◆ You must specify individual users, not groups or distribution lists.

Procedure
To specify the users who can work in Discovery Manager:
1. Start the Discovery Manager client application on the client computer.
2. In the navigation pane:
   a. Click the Administration button.
   b. Click the User Manager node.

The work pane lists the users already added to Discovery Manager.

By default, the Has Personal Matter column for each user is:
• Yes in Discovery Manager express edition
• No in Discovery Manager full edition

For more information about Personal Folders, refer to “Adding or removing Personal Matters” on page 70.

3. In the work pane, click **Add**.

The Active Directory Select Users dialog box opens.

![Select Users](Figure 31)

4. To specify where to search for names, click **Location**.

5. In the **Enter the object name to select** field, type the name of the user, according to the formats described in the examples link.

6. Click **Check Names**.

7. If more than one name matches, then the Multiple Names Found dialog box opens.
   a. Select the name(s) you want.
   b. Click **OK** to close the Multiple Names Found dialog box.

8. Click **OK** to close the Select Users dialog box.

The work pane lists the name of the user you added.
Removing users

This section applies to both editions of Discovery Manager, except where noted.

If you remove a user from Discovery Manager, then the user will not be able to start the application.

You can remove a user, then re-add that user later.

Refer to:

◆ “Procedure: Removing users” on page 66
◆ “About removing users who are Matter Managers or Investigators” on page 66

Procedure: Removing users

To remove a user from the User Manager screen and from all assigned roles:

1. In the navigation pane:
   a. Click the Administration button.
   b. Click the User Manager node.
2. Select the user in the work pane.
3. Click Remove.

About removing users who are Matter Managers or Investigators

Note: The Matter Manager role and the Investigator role are available in the full edition of Discovery Manager.

The User Manager screen shows all users and their application-wide roles, but it does not show their matter-specific roles.

When you remove a user who has been assigned a matter-specific role (Matter Manager or Investigator), the user is removed from all assigned standard matters.

A user record is kept for auditing, but it is marked as deleted.

You can re-add the user to the list in the User Manager screen, but the user will not be re-added automatically to standard matters.
Assigning application-wide roles

This section applies to both editions of Discovery Manager, except where noted.

Refer to:
- “Assigning application-wide roles to a user” on page 67
- “Adding or removing roles from yourself (User Administrator)” on page 69

Assigning application-wide roles to a user

Note: You do not need to assign every Discovery Manager user to an application-wide role. However, you need to assign at least one user to each application-wide role.

To assign application-wide roles to a user:

1. In the navigation pane:
   a. Click the Administration button.
   b. Click the User Manager node.

2. Add users, as described in “Adding users” on page 64.

3. In the work pane:
   a. Select the user in the list. (You can select only one user at a time.)

      The checkboxes indicate the roles assigned to the selected user.

For more information about matter-specific roles, refer to “Specify persons to work on the standard matter” on page 143.
Managing Users and Application-Wide Roles

Discovery Manager full edition has all application-wide roles available. For descriptions of these roles, refer to “Roles: Details” on page 23.

Discovery Manager express edition lists the following application-wide roles: Application Administrator, Backup Operator, and User Administrator. For descriptions of these roles, refer to “Roles: Details” on page 23.

**Note:** By default, the Search and Export role is assigned automatically to each Discovery Manager express edition user. This role is not displayed in the list of roles in the User Manager window, but is displayed in the matter report for the Personal Matter.

b. Do one of the following steps:
   - To assign a role, select the checkbox next to that role.
   - To unassign a role, clear the checkbox next to that role.
   - To assign all roles, click the checkbox at the top of the Roles column.

**Note:** If you remove a user from an application-wide role, then that user can no longer perform that role and may not be able to see the corresponding parts of the user interface.
Adding or removing roles from yourself (User Administrator)

If you are the User Administrator, and you add or remove roles from yourself, then a warning appears: You are changing your role (<role>). Click OK to restart the application to apply the changes.

Click OK to close the warning dialog box.

The Discovery Manager application closes and restarts automatically.
Adding or removing Personal Matters

Each Discovery Manager user can have one Personal Matter.
In Discovery Manager express edition, each user has one Personal Matter that is created automatically by default.
After an upgrade from Discovery Manager express edition to the full edition of Discovery Manager:

◆ The Personal Matters that existed in Discovery Manager express edition are retained.

**Note:** Personal Matters cannot be upgraded to standard Discovery Manager matters. After upgrading Discovery Manager express edition to full edition, some full edition features will not be available for retained Personal Matters. Search criteria and results cannot be copied or moved between matters.

◆ Personal Matters are not created automatically for new full edition Discovery Manager users added after the upgrade. The Discovery Manager User Administrator can create one Personal Matter manually for each new user.

Refer to:

◆ “Adding a Personal Matter” on page 70
◆ “Removing a Personal Matter” on page 71

Adding a Personal Matter

This section applies to both editions of Discovery Manager.
In Discovery Manager, the User Administrator can add one Personal Matter for each user, if the user does not have a Personal Matter.

To add a Personal Matter:
1. In the navigation pane:
   a. Click the Administration button.
   b. Click the User Manager node.
2. In the work pane:
Adding or removing Personal Matters

Managing Users and Application-Wide Roles

a. Select a user in the list that does not have a Personal Matter, indicated by No in the Has Personal Folder column. (You can select only one user at a time.)

b. Right-click the selected user, and select Add Personal Matter. The value in the Has Personal Folder column changes from No to Yes for the selected user.

Removing a Personal Matter

This section applies to both editions of Discovery Manager.

In Discovery Manager, the User Administrator can remove any Personal Matter.

You cannot delete a matter that has jobs running.

IMPORTANT

When a Personal Matter is deleted for a user, all of the searches and exports associated with that matter will be removed from the system. Auditing information remains in the database.

To remove a Personal Matter:

1. In the navigation pane:
   a. Click the Administration button.
   b. Click the User Manager node.

2. In the work pane:
   a. Select a user in the list that has a Personal Matter, indicated by Yes in the Has Personal Folder column. (You can select only one user at a time.)
   b. Right-click the selected user, and select Remove Personal Matter. The value in the Has Personal Folder column changes from Yes to No for the selected user.
This chapter contains the following topics:

- Introduction ................................................................. 74
- Procedure: Configuring Discovery Manager .................. 74
- Configuring general settings ........................................... 75
- Configuring search settings ............................................ 81
- Configuring export settings ........................................... 83
- Partitioning the Discovery Manager database ............... 85
Introduction

This section applies to both editions of Discovery Manager.

In the Discovery Manager client application, you can edit settings that affect the behavior of the application, such as the maximum number of search results returned. You can also configure database partitioning.

The settings are saved to a configuration file in the Discovery Manager database.

To configure the Discovery Manager application, you must have the Application Administrator role.

Procedure: Configuring Discovery Manager

This section applies to both editions of Discovery Manager.

To edit Discovery Manager configuration settings:

1. Start the Discovery Manager client application.
2. In the navigation pane:
   a. Click the Administration button.
   b. Click the Configuration node.
3. In the middle pane, click the category of configuration settings that you want to edit:
   - General - Continue to “Configuring general settings” on page 75
   - Search - Continue to “Configuring search settings” on page 81
   - Export - Continue to “Configuring export settings” on page 83
   - Partitioning - Continue to “Partitioning the Discovery Manager database” on page 85
4. Do one of the following steps:
   - If you did not edit any settings, then the OK and Cancel buttons are not available. To exit the Configuration screen, click on any other button or node in the navigation pane.
   - To save your changes:
     a. Click OK.
b. At the following confirmation prompt, click Yes.
   All settings will be applied. Are you sure?

- To cancel your changes:
  a. Click Cancel.
  b. At the following confirmation prompt, click Yes.
     All unsaved data will be lost. Are you sure?

Configuring general settings

This section applies to both editions of Discovery Manager.

To configure general settings for Discovery Manager:

1. Access the General settings, as described in “Procedure: Configuring Discovery Manager” on page 74.

2. Edit the General settings, as described in the following table.
### Table 13  Discovery Manager Configuration - General

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status Polling Interval</td>
<td>Specifies the interval between service calls to retrieve status, in seconds. Range of valid values: 1 to 25 seconds. Default = 5.</td>
</tr>
</tbody>
</table>
| Maximum Item Retrieval Count | Specify the maximum number of items returned from successive web service requests.  
**Note:** Discovery Manager returns only the number specified in the Maximum Item Retrieval Count per web service request. Additional web service requests are made only when the user scrolls or requires additional data to fill the grid.  
Range of valid values: 100 to 5,000 messages. Default = 500. |
| Maximum Item Assignment Count | Specify the maximum number of items to assign to a standard matter per web service request. For example, if 500,000 items have been assigned to a standard matter, and the Maximum Item Assignment Count = 100,000, then there will be 5 calls to assign items.  
Range of valid values: 50,000 to 1,000,000 items. Default = 100,000. |
| Insert Trusted Sites Zone | Specify whether or not to prompt for credentials when users view summary reports. Select one option:  
• **Prompt for credentials** = Users must enter credentials before viewing summary reports.  
• **Do not prompt for credentials** = Users do not enter credentials before viewing summary reports. (Default)  
**Note:** Changes do not take effect until users restart the Discovery Manager application.  
This option enables/disables a registry update. Refer to "Controlling the display of the credentials login for reports" on page 77 for details. |
Table 13  Discovery Manager Configuration - General (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Enhanced EmailXtender Duplicate Tracking     | Review "Enhanced EmailXtender Duplicate Tracking (EEDT)" on page 79 before using this option. Select this option only if you have legacy EmailXtender data and you want to see valid header information in the collection search results grid. Clear this option in any of the following situations:  
  • Items were archived only by SourceOne and not by EmailXtender.  
  • You have EmailXtender data that was ingested after the “Bulk Mailer” issue was fixed. Refer to “Exchange Message ID Algorithm for Handling Bulk Emails” in the EMC EmailXtender 4.8 SP1 Installation Guide for more information about this issue.  
  • You are not concerned about the duplicates that could have resulted due to the EmailXtender “Bulk Mailer” issue.  
  Default = Cleared. Collection searches that were created before Discovery Manager 7.0 have EEDT disabled by default. |
| Restricted Extensions                        | List the extensions of attachment file types that you do not want users to open in Discovery Manager. Use commas to separate extensions in the list. The total maximum number of characters = 1024. If a user tries to open a file with an extension that matches one in this list, then an error displays. |

Controlling the display of the credentials login for reports

This section applies to both editions of Discovery Manager.

Credentials login

Reports (matter summary, collection detail, message preview, and export) are pages hosted on the Discovery Manager server and are displayed in a web browser control. The web browser control is an instance of Internet Explorer (IE) and inherits the IE security settings. The Discovery Manager server uses Windows Authentication, which causes IE to display a credentials dialog when a user tries to view a report. The user is challenged once at the start of a session.
Configuring Discovery Manager

**Figure 35** Credentials login

To control the display of the credentials login, edit the Insert Trusted Sites Zone setting on the Discovery Manager Configuration screen. If you select the Do not prompt for credentials option, then on startup, either edition of the Discovery Manager client application adds server information to the registry:

HKCU\Software\Microsoft\Windows\CurrentVersion\Internet Settings\ZoneMap\

**Figure 36** Registry keys used by the Insert Trusted Sites Zone setting

The registry keys and values depend on what was specified when the client was installed:

- If the server is a NetBIOS name, then the server name is added to one of the following registry keys:
  - EscDomains key if Internet Explorer 8 is in enhanced security mode.
  - Domains key if Internet Explorer 8 is not in enhanced security mode.
- If the server is an IP address, then the IP address is added to one of the following registry keys:
  - EscRanges key if Internet Explorer 8 is in enhanced security mode.
Configuring Discovery Manager

- Ranges key if Internet Explorer 8 is not in enhanced security mode.

  Each unique IP address is placed in a RangeN key where N is the index in which the IP address was added.

This implementation prevents issues when IPv6 is enabled on a local area connection.

The registry key remains when the user exits either edition of the Discovery Manager client application. This retains the server in Internet Explorer’s Local Intranet list for use by EMC SourceOne Search.

**IMPORTANT**

In addition to the Insert Trusted Sites Zone setting, the display of the credentials login is also controlled by Trusted Site settings in Internet Explorer and the Microsoft setspn utility, as described in the *EMC SourceOne Discovery Manager Installation and Administration Guide*.

---

**Enhanced EmailXtender Duplicate Tracking (EEDT)**

This section applies to both editions of Discovery Manager.

Each archive provider (EmailXtender, SourceOne Native Archive, SourceOne In Place Migration) assigns an Entry ID to an item when the item is archived. The Entry ID is intended to be unique for each item.

However, items in or migrated from legacy EmailXtender archives may contain duplicates: multiple instances of an archive item with the same Entry ID.

If you will be searching EmailXtender archives that are in co-existence with SourceOne, or EmailXtender items that were migrated using In Place Migration, you may want to consider enabling the Enhanced EmailXtender Duplicate Tracking (EEDT) option. EEDT is only recommended if you believe that you have legacy messages with duplicate Entry IDs but with different content, and you need to inspect each one.

**Considerations and limitations: EEDT**

- Enhanced EmailXtender Duplicate Tracking (EEDT) is off by default for the following reasons:
Configuring Discovery Manager

- EEDT requires significant additional database records that affect disk space.
- EEDT requires additional information processing that affects performance.
- If you enable EEDT, then collection searches (and copies of collection searches) will be able to track information about duplicates.
- The Matter Review area has no concept of duplicates. When duplicate items are assigned to a matter, Discovery Manager collapses the unique archive attributes and metadata of all selected instances of the duplicate into one assigned instance. This happens whether or not the matter has a hold folder.
- Legacy items assigned before Discovery Manager 7.0 may display different properties in result grids in the Collection Area and the Matter Review Area.
Configuring search settings

This section applies to both editions of Discovery Manager.

To configure search settings:

1. Access the Search settings, as described in “Procedure: Configuring Discovery Manager” on page 74.

2. Edit the Search settings, as described in the following table.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Search Hits</td>
<td>Specify the maximum number of items returned from a search. This value is displayed in the Max search results field in the Search Properties dialog box. Changes to this value are applied to new searches. An existing search retains the value that was in effect when the search was created. Existing searches do not pick up the new value automatically. If this value increases, then Investigators can manually change the Max search results field in Search Properties for a search that has been run, then rerun the search with the new value. Range of valid values: 1 to 999,999,999 items. Default = 100,000.</td>
</tr>
</tbody>
</table>
Specify whether or not to force full-text searches. Specifies the default setting for the Always search full text indexes checkbox in the Search Properties dialog box:

- Yes = Forces full-text searches. (Default)
- No = Does not force full-text searches.

**Note:** Not forcing full-text searches may provide some performance gains in certain situations, at the expense of complete search results. If investigators want to gather information quickly to begin case assessment, then clearing the Always search full text indexes checkbox is useful. However, they may receive many false positives (items that are not actually relevant) or they may not receive items that are relevant.

**Note:** If the Always search full text indexes checkbox is cleared, Discovery Manager may still perform full-text searches in certain cases. For example, by default, search fields such as Keyword, Subject, Body, Sender Domain, and Recipient Domain perform a full-text index search on messages in the EMC SourceOne Native Archive. A full-text index search also occurs if you manually enter values in an address field.

**Note:** In versions of Discovery Manager before 7.0, this option was labeled Search Embedded Messages, and was disabled by default.

Refer to “Editing search properties” on page 191 for information about the Always search full text indexes checkbox in the Search Properties dialog box.

---

**Table 14  Discovery Manager Configuration - Search (continued)**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Search Full Text Indexes** | Specify whether or not to force full-text searches. Specifies the default setting for the Always search full text indexes checkbox in the Search Properties dialog box:  
- Yes = Forces full-text searches. (Default)  
- No = Does not force full-text searches.  

**Note:** Not forcing full-text searches may provide some performance gains in certain situations, at the expense of complete search results. If investigators want to gather information quickly to begin case assessment, then clearing the Always search full text indexes checkbox is useful. However, they may receive many false positives (items that are not actually relevant) or they may not receive items that are relevant.  
**Note:** If the Always search full text indexes checkbox is cleared, Discovery Manager may still perform full-text searches in certain cases. For example, by default, search fields such as Keyword, Subject, Body, Sender Domain, and Recipient Domain perform a full-text index search on messages in the EMC SourceOne Native Archive. A full-text index search also occurs if you manually enter values in an address field.  
**Note:** In versions of Discovery Manager before 7.0, this option was labeled Search Embedded Messages, and was disabled by default.  
Refer to “Editing search properties” on page 191 for information about the Always search full text indexes checkbox in the Search Properties dialog box. |
Configuring export settings

This section applies to both editions of Discovery Manager.

To configure export settings:

1. Access the Export settings, as described in “Procedure: Configuring Discovery Manager” on page 74.

2. Edit the Export settings, as described in the following table.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Export Split Size</td>
<td>Specify the default maximum value for the Split by file size field in the Export dialog. Used for Native Container, PST, and NSF container types. This value does not apply when the container type is File System.</td>
</tr>
</tbody>
</table>

**Note:** In early releases of Discovery Manager, if you specified an NSF export file size that was less than the default NSF size on the client computer (typically around 15-25 MB), Discovery Manager created one job for every message. To prevent this from happening, later releases of Discovery Manager set the minimum size for NSF export files to 50 MB. To export to NSF, the value in the Split by file size field must be greater than 49 MB and less than or equal to 4700 MB. (SDR 3656)

- Valid range: 50 - 4700 (MB).
- Default: 4700 (MB).
### Export Container Overhead (for split by files size to improve size estimates)

When you export data to container files, the actual disk size and the stored compressed size may vary. In certain cases, this may result in container sizes that exceed the specified maximum. You can specify an adjustment factor to close the export containers at a threshold below the final size, resulting in export containers smaller than the Maximum Export Split Size value. Specify a percent to which the export containers are to be filled before starting a new export container. Valid range: 1 - 100 (percent) Default: 90 (percent)

### Maximum Export Files Per Folder

Specify the maximum number of files to export to a folder when exporting to a file system. This value applies only when the Container type field in the Export dialog is set to File System. Valid range: 500 - 5,000 (files) Default: 2,500 (files)

### Maximum Errors Allowed Per Export Job

Specify the maximum number of errors that can occur before an export job terminates. System errors or infrastructure errors count towards the error limit. Examples of such errors include:
- Connection failures to the network, database, or file storage.
- Inability to communicate with archive servers because the service is not running.

Errors caused by problems specific to an item do not count towards the error limit for a job. Examples of such errors include:
- Inability to convert specific properties from the native format to the export format, for example, some Domino messages cannot be converted to Exchange format.
- The export format does not support certain items. For example, Domino messages cannot be exported to the file system.

Valid range: 5 - 50 (errors) Default: 10 (errors)

### Handling of BCC Routes During Export

By default, Discovery Manager includes all BCC recipients on the exported copy of the message. To improve processing and prevent MAPI errors, you can select this option to not populate the BCC list in cases where the BCC includes a large distribution list.

Valid values:
- **Selected** = Remove BCC routes from messages when exporting.
- **Cleared** = Include all BCC routes in exported messages when exporting to a PST or NSF container, or exporting to the file system as MSG files. (Default)
Partitioning the Discovery Manager database

Partitioning is the horizontal splitting of rows in a database table, or in an index defined on a table, into separate, smaller logical units that act as one table or index.

Refer to:
- “Prerequisites for partitioning the Discovery Manager database” on page 85
- “Benefits of partitioning the Discovery Manager database” on page 86
- “Considerations for partitioning the Discovery Manager database” on page 86
- “Understanding partition types in the Discovery Manager database” on page 87
- “Guidelines for using matter-based partitioning” on page 88
- “Configuring partition settings for the Discovery Manager database” on page 89
- “Viewing status of recent partitioning attempts” on page 92

Prerequisites for partitioning the Discovery Manager database


If the Discovery Manager database is installed on the Standard edition of Microsoft SQL Server, then the partitioning settings are not available in the Discovery Manager Configuration screen.

Note: Unpartitioned tables in the Standard edition of Microsoft SQL Server cannot be partitioned even if you move the database to the Enterprise edition. Similarly, the partitioned tables created in the Enterprise edition cannot be attached to the Standard edition of Microsoft SQL Server. The underlying schema and capabilities of the databases are different.
Benefits of partitioning the Discovery Manager database

Benefits of partitioning include improvements to database management. Partitioning may reduce backup times, index maintenance, and defragmentation. Older partitions can be moved to cheaper storage.

Considerations for partitioning the Discovery Manager database

Partitioning may not improve database management or application search performance in the following situations:

- Small databases (less than 50GB). Generally, SQL Server is efficient in query optimization and execution. For small databases, the partitioning may not provide any visible performance improvements on a well-tuned system.
- A large number of partitions (for example, 100 or more partitions) may affect memory and CPU.
- DBCC data integrity checks across the entire database run slower on a database with a large number of partitions.
Understanding partition types in the Discovery Manager database

Discovery Manager provides three partition types, described in the following table.

Table 16

<table>
<thead>
<tr>
<th>Partition type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Matter         | Matter-based table partitioning creates a new partition for each new matter. The following database tables are partitioned:  
  - Matters  
  - MatterXMessages  
  - MatterXMessagesXTags  
  - MatterFolders  
  - MatterXIdentities  
  - MatterXUsersXRoles  
  - Tags  
  - Roles  
  - RolesX Policies  
  - Results  
  - Requests  
  - WorkItems  
  - ResultSets  
  - Operations  
  - CollectionSources  
  - ExportActions  
  - Containers  
  - MessagesExtension  
  - AuditRecords  
  Use the Administration > Configuration > Partitioning > Matter Partitioning Options section. |
| Message        | Database tables that are not associated with matters can grow to be very large, such as the Messages table. You can partition this table based on size.  
  Use the Administration > Configuration > Partitioning > Message Partitioning Options section. |
| Audit          | Auditing records can grow to be very large. You can partition the database tables used for auditing.  
  Use the Administration > Configuration > Partitioning > Audit Partitioning Options section. |
Guidelines for using matter-based partitioning

Depending on the edition of Discovery Manager that you installed, one of the following matter-based partitioning options is available in Discovery Manager Configuration:

- Full edition includes the **Allow new matters to be created on new partitions** option.
- Express edition includes the **Create new matters on new partitions** option.

**IMPORTANT**

Before enabling either option, review the following guidelines. Failing to follow this guidance will cause an unnecessary number of partitions to be created, which will affect system performance.

- Use the options only for large matters that you estimate will include at least 30 million items.
- Enable the options temporarily only when necessary:
  - In Discovery Manager express edition, enable the **Create new matters on new partitions** option only for a small number of users (for example, five to ten users). Enable the option just before you add each user and Personal Matter, then disable the option immediately afterward.
  - In Discovery Manager full edition, enabling the **Allow new matters to be created on new partitions** option makes the **Create matter on new storage partition** option available in the Matter Creation wizard. Work with Matter Owners who create standard matters to decide whether they should use the **Create matter on new storage partition** option when they create a matter. Enable the **Allow new matters to be created on new partitions** option just before a Matter Owner creates a matter, then disable the **Allow new matters to be created on new partitions** option immediately afterward.
Configuring partition settings for the Discovery Manager database

To configure partition settings:

1. Access the Partition settings, as described in “Procedure: Configuring Discovery Manager” on page 74.

---

**Figure 39 Discovery Manager (full edition) Configuration - Partitioning**

There is one section for each type of partitioning: Matter, Message, and Audit. Refer to “Understanding partition types in the Discovery Manager database” on page 87 for descriptions of these partition types.

**Note:** In the Matter Partitioning Options section, Discovery Manager express edition has the Create new matters on new partitions option instead of the Allow new matters to be created on new partitions option.

2. Edit the settings in the appropriate Partitioning Options section, as described in the following table.
### Table 17  Discovery Manager Configuration - Partitioning

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Maximum partition size (GB)   | Specify how large the current partition can be before a new partition is created. Valid values and defaults:  
  • For Matter partitioning, 5 - 50 (GB), default = 15 (GB)  
  • For Message partitioning, 50 - 150 (GB), default = 100 (GB)  
  • For Audit partitioning, 10 - 50 (GB), default = 50 (GB)    |
| Data files location           | Specify the location of the data files on the SQL Server computer for the new partition. Since this is a local path that resides on another computer, the Discovery Manager client cannot validate the path. You must verify and ensure the accuracy of this path.  
  When you change focus away from this field, a confirmation prompt displays:  
  *The Data Files Location must be a valid location in SQL Server. Do you want to continue?*  
  If you click No, focus remains in this field so that you can edit the path. Default = the same directory used by the primary data file that has a file extension of .mdf, for example:  
  *Program Files\Microsoft SQL Server\MSSQL10_50.MSSQLSERVER\MSSQL\DATA*  
  **Important!** If you enable the *Allow new matters to be created on new partitions* option or the *Create new matters on new partitions* option and if this location is full or invalid, then matter creation will fail. |
| InitialSize (MB)              | Specify the size of the underlying physical data files created for the new partition. Valid values: 100 - 10240 (MB) Default = 512 (MB)                                                                                                                                 |
| Data file count               | Specify the number of data files to create for the new partition. Valid values: 1 - 4 (files) Default = 1 (file)                                                                                                                                                   |
| File growth factor (MB)       | Specify how much each partition data file can increment in size from its initial size each time the data file needs to grow. Valid values: 512 - 1024 (MB)  
  For example, If you specified an *Initial Size* of 512 MB and a *File Growth Factor* of 512 MB, then the first time each data file needs to grow, it will grow to 1024 MB (512 + 512). The second time each data file needs to grow, it will grow to 1536 MB (1024+ 512). Default = 512 (MB) |
3. To restore partitioning defaults, click **Restore Defaults** in the appropriate section.

### Table 17  Discovery Manager Configuration - Partitioning (continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Allow new matters to be created on new partitions | Available in the Matter Partitioning Options section for Discovery Manager full edition.  
**Important!** Review “Guidelines for using matter-based partitioning” on page 88 before selecting this option.  
This option affects both standard matters and Personal Matters in Discovery Manager full edition.  
Valid values:  
• Selected = The **Create matter on new storage partition** option will be available in the Matter Creation wizard for standard matters. Each Personal Matter will be created on its own database partition.  
• Cleared = The **Create matter on new storage partition** option will be not not be available in the Matter Creation wizard for standard matters. Personal Matters will not be created on individual database partitions.  
If you select this option, the following warning displays:  
*Creating new database partitions for each matter affects SQL Server resources and performance, and database maintenance and administration. Review the Discovery Manager User Guide or online help for more information on partitioning choices.*  
*Continue with this selection? [Y]es [N]o*  
Default = Cleared |
| Create new matters on new partitions         | Available in the Matter Partitioning Options section for Discovery Manager express edition.  
**Important!** Review “Guidelines for using matter-based partitioning” on page 88 before selecting this option.  
Valid values:  
• Selected = Each new Personal Matter will be created on its own partition.  
• Cleared = Personal Matters will not be created on individual partitions.  
If you select this option, the following warning displays:  
*Creating new database partitions for each matter affects SQL Server resources and performance, and database maintenance and administration. Review the Discovery Manager User Guide or online help for more information on partitioning choices.*  
*Continue with this selection? [Y]es [N]o*  
Default = Cleared |
Viewing status of recent partitioning attempts

Each section in the Partitioning screen displays information about recent attempts to create new partitions:

◆ If attempts were successful, then the section displays *No recent errors identified*.

◆ If errors occurred, then the section displays *Errors identified while creating recent partitions. See status for more details.*

To view a list of the most recent partitioning attempts, click **Recent Status** in the appropriate section.

The Partitioning Status dialog opens.

![Partitioning Status - example](image)

**Figure 40** Partitioning Status - example
This chapter contains the following topics:

- Introduction .......................................................... 94
- Step 1: Start Discovery Manager express edition .............. 95
- Step 2: Create a search in your Personal Matter ................. 96
- Step 3: Specify the folders to search ............................. 97
- Step 4: Specify search criteria .................................... 99
- Step 5: Run the search ............................................. 99
- Step 6: Export search results and metadata ...................... 99
Using Discovery Manager Express Edition

Introduction

What is Discovery Manager express edition?

EMC SourceOne Email Management includes an edition of Discovery Manager that has a subset of functionality.

IMPORTANT

Discovery Manager express edition is intended for administrators, supervisors, or legal users to search the archive for other users’ email and export the results. It is not intended for end-users who want to export their own archived email.

Note:

- The documentation uses the term “Discovery Manager express edition” to distinguish this edition from the full edition. However, all screens in the express edition are labeled “Discovery Manager.”
- Some features of the full edition are grayed out in Discovery Manager express edition. For complete functionality, upgrade to the full edition of EMC SourceOne Discovery Manager. Refer to “Discovery Manager Editions” on page 437.

What can I do with the express edition?

Use Discovery Manager express edition to search for a user’s email items (such as messages and calendar items) and export the results. You can also export metadata to TSV format.

Note: Export of metadata to CSV and EDRM XML is available in the full edition of Discovery Manager.

What are the prerequisites?

Before you can use Discovery Manager express edition, the Discovery Manager User Administrator must add you as a user. Refer to “Managing Users and Application-Wide Roles” on page 61.

What is a Personal Matter?

Every user in Discovery Manager express edition has one Personal Matter. It contains all of the searches and exports that you create. Only you can see the contents of your Personal Matter.

What are the main steps?

To use Discovery Manager express edition, follow these steps:

- “Step 1: Start Discovery Manager express edition” on page 95
- “Step 2: Create a search in your Personal Matter” on page 96
Step 1: Start Discovery Manager express edition

To start Discovery Manager express edition, do one of the following steps:

- Double-click the Discovery Manager icon on your desktop.
- Click the Discovery Manager icon in the Quick Launch bar.
- Select the path from the Start menu:
  
  - Start menu > Programs > EMC SourceOne Discovery Manager > EMC Discovery Manager.

The Discovery Manager express edition window opens to display your Personal Matter.

Note: Some functions are grayed out and are available only in the full edition of Discovery Manager. Other functions are available in Discovery Manager express edition, but may be grayed out depending on your role and the context.

For a complete overview of the main window and the ribbon, refer to “Overview of application window” on page 29.
Step 2: Create a search in your Personal Matter

Note: Refer to “Collecting Content for Matters” on page 179 for complete information about creating and managing searches.

To create a search in your Personal Matter:

1. In the navigation pane on the left, expand the Personal Matter - <Your name> node.
2. Do one of the following steps:
   - If no searches exist, then click the New Search (Ctrl-S) link.
   - If no searches exist, click in the work pane, then press Ctrl-S.
   - Right-click the Collection Area node for the matter, then select New Search.
   - Click New in the Search tab in the ribbon pane.

A search named New Search appears under the Collection Area node. If a search by that name already exists, then the number (1) is appended to New Search.

3. Edit the name of the new search, then press Enter.

Note: The names of collection searches do not have to be unique within the Collection Area of a matter.

4. Click the newly named search node.

   The work pane displays the search criteria area, containing default search fields.
Step 3: Specify the folders to search

**Specifying folders for all searches**

To specify the search folders for all searches in your Personal Matter:

1. Click the matter in the navigation pane.
2. In the ribbon pane, click the **Matter** tab.
3. Click the **Search Folders** icon in the Matter tab.

   The Search Properties dialog box opens to the Search Folders tab, which lists all the folders that you can search.

4. Do one of the following steps:
   - To specify all folders, select the **Folders** checkbox at the top of the checkbox column (default).
   - To specify selected folders, select the checkboxes next to individual folders. You must select at least one folder.

5. Click OK to save your changes and close the dialog box.

**Selecting folders for a specific search**

You can select different folders for each search.

*Note:* Refer to “Editing search properties” on page 191 and “Specifying folders to search” on page 196 for complete information.

To select the folders for a specific search:

1. Do one of the following steps:
Using Discovery Manager Express Edition

- In the navigation pane under the **Collection Area** node, click the search to select it. Then in the work pane, click the dropdown arrow at the right of the keyword field, and select **Search Properties**.

- In the navigation pane under the **Collection Area** node, right-click the search, then select **Properties**.

- In the navigation pane under the **Collection Area** node, click the search, then in the ribbon, select **Search/Export tab > General**.

  The Search Properties dialog box opens.

2. Do one of the following steps:

   - To search all folders, select the **Search all matter folders** checkbox.

   - To select folders:
     a. Clear the **Search all matter folders** checkbox.
     b. Select the checkbox next to each folder that you want to search.
     c. Clear the checkbox next to each folder that you do not want to search.

3. Click **OK** to close the Search Properties dialog box.
Step 4: Specify search criteria

To add, remove, and use search criteria fields, refer to “Specifying Search Criteria” on page 233 and “Using the Search Expression Field” on page 279.

Step 5: Run the search

Note: Refer to “Running a collection search” on page 207 and “Re-running a collection search” on page 207 for complete information.

To run a search, click the Find button.

If you did not specify any search criteria, then the following prompt displays: No search criteria was specified. Running this search will return all items in the archive. Are you sure you want to continue?

If you did not select at least one folder to search, then you are prompted to select folders.

Step 6: Export search results and metadata

Refer to “Exporting Content and Metadata” on page 319 for complete information about exporting email content and metadata.

Note: Some export functionality is available only in the full edition of Discovery Manager.
This chapter contains the following topics:

- Introduction ................................................................. 102
- Best practices for identity management ...................... 104
- Viewing list of identity records ................................ 105
- Adding identity records ............................................... 108
- Editing identity records .............................................. 111
- Deleting identity records ........................................... 112
- Managing identity elements (addresses) in identity records .... 113

Note: Identities are available in the full edition of Discovery Manager.
### Introduction

*Note: Identities are available in the full edition of Discovery Manager.*

Refer to:
- “Why use identity management?” on page 102
- “What is involved in managing identities?” on page 102
- “Which roles can manage identities?” on page 103
- “What is a typical identity management scenario?” on page 103
- “How are identities used in Discovery Manager?” on page 104

### Why use identity management?

In an email environment, many email addresses may be associated with a single user’s mailbox: a primary address, SMTP addresses, distribution lists, and historical addresses. The same user may also have Instant Messaging (IM) buddy names, and Bloomberg addresses in multiple repositories.

Discovery Manager must be able to search:
- Across the entire group of these addresses as an entity, to provide accurate, consistent, and reliable results. Without a means of using all addresses, searches may be inconsistent or incomplete, failing to deliver all responsive email.
- For the email of users who are no longer in the address book.

Identity management addresses these requirements.

### What is involved in managing identities?

Managing identities involves working with two types of objects: identity records and identity elements.

#### What is an identity record?

An identity record:
- Is an alias for multiple email addresses.
- Can be used in place of an e-mail address anywhere an email address is valid within a search.
- Is available for all matters.
What is an identity element?

- Is not matter-specific.

An identity element:

- Is a single email address associated with a user, and which is included in an identity record.
- Can take many different forms, such as:
  - Microsoft Exchange address
  - IBM Lotus Domino/Notes address
  - SMTP address
  - IM buddy name
  - Bloomberg address
  - Custom metadata that was associated with messages during ingestion through SourceOne, such as EmployeeID or Department.

Properties of an identity element include the date range for which the address is valid for the user. This date range is:

- A form of documentation for the identity element.
- For use by people working on the matter
- Not used by Discovery Manager for search criteria

Which roles can manage identities?

To manage identities, you must have the Identity Administrator role.

What is a typical identity management scenario?

A typical scenario for managing identities may include the following steps:

1. A person is named as a person of interest for an investigation.
2. If an identity record exists, the Identity Administrator checks the address book to see if there are any updates to add to the identity record.
3. If no identity record exists, the Identity Administrator creates one and verifies that all known addresses for the person are entered as identity elements.
4. During the course of the investigation, if additional identity elements become known, the Identity Administrator updates the identity record. Then the relevant searches are re-run.

How are identities used in Discovery Manager?

Matter Managers and Investigators can use identities in Discovery Manager wherever they can use an address:

- Custodians - One way to add custodians to a matter is to select them from a list of identity records.
- Search criteria - Identity records are valid in the address fields (Sender, Recipient, Owner, Sender or Recipient) when specified through the Address Book. Refer to “Selecting names from the Address Book or specifying identities” on page 256.

Best practices for identity management

Note: Identities are available in the full edition of Discovery Manager.

- Create identities for all persons of interest:
  - Anyone being investigated
  - Anyone who is significant in the matter
- Create identities for all Matter Managers and Investigators.
- Create identities for all employees likely to be involved in legal discoveries (for example, key executives, Human Resources department, Research and Development department)
- Use identities for all searches where possible.
- Ensure that at least one user assigned to a matter has the Identity Administrator role, to handle matter-specific needs for identities.

Note: Identities are available to all standard matters. Identities are not matter-specific.
Viewing list of identity records

Note: Identities are available in the full edition of Discovery Manager.

To view the list of identity records in the Identities area, you must have the Identity Administrator role.

To view the list of available identity records:

1. In the navigation pane, click the **Identities** button.

The work pane lists existing identity records, if any.

The status bar indicates the number of identities in the list, and the number of selected identities.

If you click the Identities button in the navigation pane when no identities exist, then the work pane displays a link labeled New Identity (Ctrl-I) and the message "There are no items to show in this view."
2. To change the view, in the navigation pane, select one of the following options:
   - “Summary view” on page 106
   - “Detailed view” on page 106

Refer to:
   - “Adding identity records” on page 108
   - “Editing identity records” on page 111
   - “Deleting identity records” on page 112

---

**Summary view**

The Summary view is the default view. Identity records are displayed in a list, sorted on the Display Name column.

The following table describes the columns in the Summary view.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icon</td>
<td>The card icon indicates that the listed item is an identity record.</td>
</tr>
<tr>
<td>Display Name</td>
<td>The name of the identity (person or group) as you want it to appear in Discovery Manager. To change the format, refer to “Specifying name information for an identity record” on page 110.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the identity (person or group) makes it easier to distinguish among identity records with similar names.</td>
</tr>
</tbody>
</table>

---

**Detailed view**

In the Detailed view, identity records are displayed in a list, sorted on the Display Name column.
Managing Identities

Figure 44  Identities - Detailed view

The following table describes the columns in the Detailed view.

Table 19  Detailed view

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icon</td>
<td>The card icon indicates that the listed item is an identity record.</td>
</tr>
<tr>
<td>Display Name</td>
<td>The name of the identity (person or group) as you want it to appear in Discovery Manager.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the identity (person or group) makes it easier to distinguish among identity records.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>The date and time on which the identity record was created.</td>
</tr>
<tr>
<td>Modified Date</td>
<td>The date and time on which the identity record was last modified.</td>
</tr>
</tbody>
</table>
Managing Identities

Adding identity records

Note: Identities are available in the full edition of Discovery Manager.

To add a new identity record:
1. In the navigation pane, click the Identities button.
2. Do one of the following steps:
   - If there are no identity records, click the New Identity (Ctrl-I) link in the work pane.
   - If there are no identity records, click in the work pane, then press Ctrl-I.
   - If there are existing identity records, right-click anywhere in the work pane, then select New.
   - In the ribbon pane, do one of the following steps:
     - Click Identities tab > New Identity.
     - Click File tab > New > New Identity.

The Identity window opens.
Managing Identities

Adding identity records

For information about the Identity ribbon at the top of the Identity window, refer to “Keyboard shortcuts” on page 391.

**Note:** The bottom left corner of the Identity window displays information after you add identity records, and close and reopen the Identity window.

3. Specify name information, as described in “Specifying name information for an identity record” on page 110.

4. Specify elements (addresses), as described in “Adding identity elements to an identity record” on page 113.

5. Do one of the following steps:
   - To save your changes, do one of the following steps:
     - In the Identity tab in the ribbon pane, click **Save & New** to save your changes and to clear the Identity window in preparation for a new identity.
Managing Identities

- In the Identity tab in the ribbon pane, click **Save & Close** to save your changes and to close the Identity window.

  - To close the Identity window without saving any changes, do one of the following steps:
    - In the ribbon pane at the top of the Identity window, select **File tab > Exit.**
    - Click the X in the upper right corner of the Identity window.

**Specifying name information for an identity record**

To specify name information for an identity record, in the Identity window:

1. In the **Identity name** field, type the unique name of the identity as you want it to appear in Discovery Manager. The maximum number of characters is 256. The recommended number of characters is in the range 80 - 100 for optimal display.

2. In the **Comments** field, type a description of the identity. This helps to distinguish among similar names, and to make it easier for Matter Managers to use identity records as a source of custodians. The maximum number of characters is 1024.

3. Continue to “Adding identity elements to an identity record” on page 113.
Editing identity records

**Note:** Identities are available in the full edition of Discovery Manager.

To edit an identity record:
1. In the navigation pane, click the **Identities** button.
2. In the work pane, do one of the following steps:
   - Double-click the identity record.
   - Right-click the identity record, then select **Open**.
     To open several identity records at the same time, select them before right-clicking.
   - Select one or more identity records, then click **Edit Identity** in the Identities tab in the ribbon pane.
   - Select one or more identity records, then press **Enter**.

The Identity window opens.

The bottom left corner of the Identity window displays the following information:

- The **Valid identity ranges** field indicates the date range for all identity elements in the list. Refer to “Specifying effective dates of identity elements” on page 124
- The **Created on** field displays the date on which the identity record was created.

3. To edit name information, refer to “Specifying name information for an identity record” on page 110.

4. To edit identity elements, refer to “Managing identity elements (addresses) in identity records” on page 113.

5. Do one of the following steps:
   - In the Identity tab in the ribbon pane, click **Save & New** to save your changes and to clear the Identity window in preparation for a new identity.
   - In the Identity tab in the ribbon pane, click **Save & Close** to save your changes and to close the Identity window.
   - Click the X in the upper right corner of the Identity window to discard your changes.
Deleting identity records

Note: Identities are available in the full edition of Discovery Manager.

Note: You cannot delete an identity that is being used as a custodian in a matter.

To delete an identity record:

1. In the navigation pane, click the Identities button.
   The work pane lists existing identity records.
2. Select the identities you want to delete.
3. Do one of the following steps:
   - Right-click the identity records, then select Delete.
   - Click Delete on the Identity tab in the ribbon pane.
   - Press the Delete key.
4. At the Identity Delete prompt, do one of the following steps:
   - Click OK to confirm the delete.
   - Click Cancel to cancel the delete.

If you try to delete an identity that is being used as a custodian in a matter, then an error message displays: Cannot delete an identity that is in use.
Managing identity elements (addresses) in identity records

Note: Identities are available in the full edition of Discovery Manager.

An identity element is an address or metadata that is associated with a name in an identity record. An identity record can contain more than one identity element.

Refer to:
- “Adding identity elements to an identity record” on page 113
- “Viewing identity elements” on page 122
- “Specifying effective dates of identity elements” on page 124
- “Deleting identity elements (addresses) from an identity record” on page 125

Adding identity elements to an identity record

You can specify addresses or metadata in an identity element.

Refer to:
- “Specifying an address in an identity element” on page 113
- “Specifying route metadata in an identity element” on page 121

Specifying an address in an identity element

To specify addresses in an identity element:

1. Open the Identity window, as described in the appropriate topic:
   - “Adding identity records” on page 108
   - “Editing identity records” on page 111

2. In the Identity Elements area:
   a. Do one of the following steps:
      - Click the dropdown arrow.
      - Click in the Identity Element field, then press the Down arrow key.
   b. Select an address type:
Managing Identities

![Identity Elements - address types](image)

**Figure 46**  Identity Elements - address types

**Table 20**  Address types - Identity Element field

<table>
<thead>
<tr>
<th>Address type</th>
<th>Description</th>
<th>Continue to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exchange</td>
<td>Use to select addresses from the Exchange global address book.</td>
<td>“Methods to add identity elements for Exchange or Domino” on page 115</td>
</tr>
<tr>
<td>Domino</td>
<td>Use to select addresses from the IBM Domino address book/directory. In a Domino environment that uses the Domino native directory, this address type is labelled Domino &lt;Choose Directory&gt;. If you chose Domino &lt;Choose Directory&gt; previously, then the first Domino directory is selected by default.</td>
<td>“Methods to add identity elements for Exchange or Domino” on page 115</td>
</tr>
<tr>
<td>AD Object</td>
<td>Use to specify a user or group from Active Directory as an identity element.</td>
<td>“Specifying an Active Directory object as an identity element,”</td>
</tr>
<tr>
<td>Address</td>
<td>Use to add addresses manually (such as SMTP, IM, and Bloomberg addresses). Also use it to add EmailXtender 4.8 User Identity Mapping entries (for example, [Badge=5678]).</td>
<td>“Typing an address for an identity element,”</td>
</tr>
<tr>
<td>Metadata</td>
<td>Use to add route metadata that was defined in EMC SourceOne.</td>
<td>“Specifying route metadata in an identity element” on page 121</td>
</tr>
<tr>
<td>File Location</td>
<td>Use to specify the UNC path from which file content was originally archived. For archived files, an “owner” is the UNC path from which the file was originally archived. Investigators can use identities that include File Location elements to search for owners of archived files.</td>
<td>“Specifying a file location as an identity element,”</td>
</tr>
</tbody>
</table>

**Note:** The address type you select becomes the default for the rest of the session.

3. To specify effective dates for the identity elements, refer to “Specifying effective dates of identity elements” on page 124.
4. In the Identity tab in the ribbon pane, do one of the following steps to save the identity record:

- Click **Save & New** to save your changes and to clear the Identity window in preparation for another new identity.
- Click **Save & Close** to save your changes and to close the Identity window.

**Methods to add identity elements for Exchange or Domino**

If you selected **Exchange** or **Domino** in Step 2 of “Adding identity elements to an identity record” on page 113, use any of the following methods to add identity elements.

- “Method 1: Address Book” on page 115
- “Method 2: Exact name or address” on page 118
- “Method 3: Partial name or address” on page 118
- “Method 4: Any name or address” on page 119

**Method 1: Address Book**

To pick the address in the address book:

1. In the Identity window, after you select **Exchange** or **Domino** from the address type dropdown, the dropdown displays the address type you chose, and acts like a button. Click the **Exchange** or **Domino** button.

   The Address Book dialog box opens.

[Figure 47 Address Book]
2. In a Domino environment that uses the Domino native directory, in the Source field under Domino <Choose Directory>, select a Domino directory.

![Address Book - Domino <Choose Directory>](image)

Figure 48 Address Book - Domino <Choose Directory>

3. Do one of the following steps:
   - In the Search field, type the full or partial name of the person, then click Find.

     Note: In a Domino environment that uses the Domino native directory, you are searching the display name, which is listed by last name. If you type the person’s first name, you will not get any results. If you type the last name, the name of the person is returned.

   - To search for names using additional fields, click the dropdown arrow next to the Find button, then select Advanced Find. In the Advanced Find dialog box, type your search criteria, then click OK.

     Note: The Advanced Find dialog box is only available for Exchange environments and for Domino environments that use LDAP. It is not available for Domino environments that use the Domino native directory.
4. If multiple matches are found, then the Select Address dialog box opens.

5. Select the correct names from the Select Address dialog box.

6. Click OK.

The Select Address dialog closes, and the selected names are listed in the Address Book.
7. To close the Address Book, do one of the following steps:
   
   - Click OK.
   - With the focus on either the OK button or in the list of names, press Enter.

   The identity elements are listed in the Identity window.

   In Exchange and Domino LDAP environments, when you select duplicate names to use as identity elements, the display name and the distinguished name are displayed with a vertical bar between them.

   ![Identity Elements]({{image_url}})

   **Figure 51  Identities - duplicate names**

   **Method 2: Exact name or address**
   
   To type an exact name or address
   
   1. In the **Identity Elements** field, type a name or address exactly as it exists in the address book.
   2. Press Enter. (Alternatively, press Ctrl-K or click the icon at the right of the **Identity Elements** field.)

   The resolved addresses are added to the list of identity elements.

   **Method 3: Partial name or address**
   
   To enter a partial name or address and have it resolved:
   
   1. In the **Identity Elements** field, type a name or partial address.
   2. Press Enter. (Alternatively, instead of Enter, press Ctrl-K or click the icon at the right of the **Identity Elements** field.)
   3. Select the correct addresses from the Select Address dialog box.
Managing identity elements (addresses) in identity records

119

Managing Identities

Figure 52 Select Address

Note: For Exchange, the Select Address book displays the Company column instead of the Location column.

4. Click OK.

   The Select Address dialog closes, and the identity elements for the selected names are listed in the Identity window.

Method 4: Any name or address

If you selected Address in Step 2 of “Adding identity elements to an identity record” on page 113, whatever you type in the Identity Elements field will be added to the list of identity elements. The maximum number of characters is 256.

If you selected Exchange or Domino in Step 2 of “Adding identity elements to an identity record” on page 113:

1. In the Identity Elements field, type any name or address.

2. Press Enter. (Alternatively, instead of Enter, click CTRL-K or click the icon at the right of the Identity Elements field.)

   If the name or address cannot be resolved, the No Entries Found dialog box opens.
Managing Identities

Figure 53  No Entries Found

3. Do one of the following steps:
   • Click Yes to add the name or address exactly as you typed it to the list of identity elements.
   • Click No to cancel the action.

Specifying an Active Directory object as an identity element

If you selected AD Object in Step 2 of “Adding identity elements to an identity record” on page 113:

1. Click the AD Object field label.
2. In the Select Users or Groups dialog:
   a. Find and select the appropriate user.
   b. Click OK.

The Active Directory object is added to the list of identity elements.

Typing an address for an identity element

If you selected Address in Step 2 of “Adding identity elements to an identity record” on page 113, whatever you type in the Identity Elements field will be added to the list of identity elements.

To enter a delimited list of addresses:

1. Use one of the following methods:
   • Copy and paste a delimited list of addresses from any text file.
   • Type a delimited list of addresses.
Managing identity elements (addresses) in identity records

**IMPORTANT**

Use a vertical bar (|) as the delimiter between addresses. A vertical bar is used as a delimiter instead of a semicolon to support X400 addresses that could contain semicolons.

The maximum number of characters for each address is 256. If you exceed the maximum number of characters for an address, then an error occurs.

![Identity Elements - example of delimited list of addresses](image)

**Specifying route metadata in an identity element**

Route metadata is site-specific, and is defined in EMC SourceOne outside of Discovery Manager. Examples of metadata are employee ID, location, or department. Route metadata can be useful in companies that re-use email addresses.

To specify metadata in an identity element:

1. Open the Identity window, as described in the appropriate topic:
   - “Adding identity records” on page 108
   - “Editing identity records” on page 111
2. In the Identity Elements area, click the dropdown arrow or press Down Arrow, then select Metadata.
3. In the second field, click the dropdown arrow or press Down Arrow, then select the metadata from the dropdown list.
4. In the third field, click the dropdown arrow or press Down Arrow, then select one of the following comparison operators:
   - Equal To
   - Not Equal To
5. In the fourth field, type the value for the metadata.
Managing Identities

6. Press **Enter**. (Alternatively, click **CTRL-K** or click the icon at the right of the **Identity Elements** field.)

The metadata entry is added to the list of identity elements.

7. To specify effective dates for the identity elements, refer to “Specifying effective dates of identity elements” on page 124.

8. In the Identity tab in the ribbon pane, do one of the following steps to save the identity record:
   - Click **Save & New** to save your changes and to clear the Identity window in preparation for another new identity.
   - Click **Save & Close** to save your changes and to close the Identity window.

**Specifying a file location as an identity element**

For archived files, an "owner" is the UNC path from which the file was originally archived. Investigators can use identities that include File Location elements to search for owners of archived files.

If you selected **File Location** in Step 2 of “Adding identity elements to an identity record” on page 113:

1. Type a UNC path in the Identity Element field:
   \fileservershare

2. Press **Enter**. (Alternatively, click **CTRL-K** or click the icon at the right of the **Identity Elements** field.)

   The UNC path is added to the list of identity elements.

**Viewing identity elements**

To change the view of identity elements listed at the bottom of the Identity window, in the Identity ribbon, select one of the following options in the **Element View** field:
Managing identity elements (addresses) in identity records

**Figure 56** Element View

- **Summary** (default) - Displays the following columns: Address, Start Date, End Date, and Type.

<table>
<thead>
<tr>
<th>Identity name</th>
<th>Comments</th>
<th>Exchange</th>
<th>Address</th>
<th>Start Date</th>
<th>End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>John Smith</td>
<td>Manager</td>
<td>Office</td>
<td>Address</td>
<td>5/25/2022</td>
<td>9/20/2023</td>
</tr>
<tr>
<td>Alice Johnson</td>
<td>Office</td>
<td>Home</td>
<td>Address</td>
<td>6/15/2023</td>
<td>12/30/2023</td>
</tr>
<tr>
<td>Bob Brown</td>
<td>Manager</td>
<td>Office</td>
<td>Address</td>
<td>7/10/2022</td>
<td>11/20/2022</td>
</tr>
</tbody>
</table>

**Figure 57** Summary view - identity elements

- **Detailed** - Displays the following columns: Address, Start Date, End Date, Creation Date, Modified Date, and Type.

<table>
<thead>
<tr>
<th>Identity name</th>
<th>Comments</th>
<th>Exchange</th>
<th>Address</th>
<th>Start Date</th>
<th>End Date</th>
<th>Creation Date</th>
<th>Modified Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>John Smith</td>
<td>Manager</td>
<td>Office</td>
<td>Address</td>
<td>5/25/2022</td>
<td>9/20/2023</td>
<td>6/15/2022</td>
<td>9/10/2023</td>
</tr>
<tr>
<td>Alice Johnson</td>
<td>Office</td>
<td>Home</td>
<td>Address</td>
<td>6/15/2023</td>
<td>12/30/2023</td>
<td>7/10/2022</td>
<td>11/20/2022</td>
</tr>
<tr>
<td>Bob Brown</td>
<td>Manager</td>
<td>Office</td>
<td>Address</td>
<td>7/10/2022</td>
<td>11/20/2022</td>
<td>8/15/2022</td>
<td>10/20/2022</td>
</tr>
</tbody>
</table>

**Figure 58** Detailed view - identity elements
Managing Identities

Specifying effective dates of identity elements

You should specify the date range during which an identity element is in effect. This date range is:

- A form of documentation for the identity element
- For use by people working on the matter
- Not used by Discovery Manager as search criteria

Best practice is to add date ranges to identity elements to track historical address information. This is useful documentation when employees have the same name or the company re-uses email addresses.

To specify the effective date range for an identity element:

1. Open the Identity window, as described in the appropriate topic:
   - “Adding identity records” on page 108
   - “Editing identity records” on page 111

2. Do one of the following steps:
   - Right-click an identity element in the list, then select Edit Dates.
   - Select the identity element in the list, then select Edit Element Dates in the Identity ribbon.

3. In the Edit Dates dialog box:
   - In the Start Date field or the End Date field or both, type a date, or click the dropdown arrow and select a date from the calendar.
Managing identity elements (addresses) in identity records

Note: The End Date must be equal to or greater than the Start Date.

The minimum for start and end dates is 1/1/1970. If you enter a value that is less than the minimum date, the value is corrected to 1/1/1970.

There is no maximum date.

b. To clear a date field, click the red hyphen next to that field.

c. Click OK.

Note: To specify a non-contiguous date range for the same identity element, add the same identity element twice. Refer to “Adding identity elements to an identity record” on page 113. Assign one date range to the first instance of the identity element, and another date range to the second instance of the identity element.

Deleting identity elements (addresses) from an identity record

To delete identity elements (addresses) from an identity record:

1. Open the Identity window, as described in the appropriate topic:
   • “Adding identity records” on page 108
   • “Editing identity records” on page 111

2. At the bottom of the Identity window, do one of the following steps:
   • Right-click an identity element in the list, then select Delete.
   • Select the identity element in the list, then select Delete Element in the Identity ribbon.
This chapter describes how to manage default tags for Discovery Manager, and contains the following topics:

- **Introduction** ................................................................. 128
- **Adding custom default tags** ........................................... 130
- **Editing tags** ............................................................... 132
- **Deleting tags** ............................................................... 133

**Note:** Tags are available in the full edition of Discovery Manager.
Managing Default Tags

Introduction

Note: Tags are available in the full edition of Discovery Manager.

What are tags?
Tags are flags applied to items in a standard matter to indicate the results of a review.

Investigators assign tags to items in a standard matter. Investigators can sort and search based on tags. For example, Investigators can use a tag to mark items for export, sort items on that tag, and then select only those tagged items for export.

Matter Managers use tags to facilitate their case strategy and for reporting and monitoring.

Types of tags
Discovery Manager has two types of tags that Investigators can assign to items in a standard matter:

- Default tags are automatically added to new standard matters. Some default tags are supplied with Discovery Manager. Tag Administrators can create custom default tags. This chapter explains how to manage default tags.
- Matter-specific tags can be assigned only to the standard matter in which they are created, by Matter Managers. Refer to “Editing matter properties” on page 148.

Required role
To manage default tags, you must have the Tag Administrator role.

Note: To manage matter-specific tags as described in “Editing matter properties” on page 148, you must have the Matter Manager role for that standard matter.
The following table describes the default tags supplied with Discovery Manager full edition:

### Default tags supplied with Discovery Manager

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bookmark</td>
<td>bookmarks the item for later review.</td>
</tr>
<tr>
<td>Junk Mail</td>
<td>indicates that the item is junk mail or spam, likely to be removed from the standard matter.</td>
</tr>
<tr>
<td>Non-responsive</td>
<td>indicates that the item is not relevant to the standard matter.</td>
</tr>
<tr>
<td>Proprietary</td>
<td>indicates that the item contains proprietary information.</td>
</tr>
<tr>
<td>Responsive</td>
<td>indicates that the item is relevant to the standard matter.</td>
</tr>
</tbody>
</table>

**Note:** By design, the names and descriptions of the default tags are not localized to prevent edited tags from being overwritten if you change language packs.

### Custom tags

You can add custom tags, and specify a color for each tag. You can also edit the default tags supplied with Discovery Manager. Refer to:

- “Adding custom default tags” on page 130.
- “Editing tags” on page 132.
- “Deleting tags” on page 133.

### Assigning tags to matter content

Refer to “Applying tags to items” on page 298.
Adding custom default tags

Note: Tags are available in the full edition of Discovery Manager.

There are sixteen colors available for tags. You can re-use colors. You may want to reserve specific colors for certain types of tags, for consistency in matter review and processing. For example, you may want to reserve blue for any financial tag.

To add a new custom default tag:

1. In the navigation pane:
   a. Click the Administration button.
   b. Click the Tag Manager node.

   The work pane lists the default tags and existing custom tags.

2. In the work pane, click New.

   The Tag Create dialog box opens.
3. (Required) In the **Name** field, type a unique name for the tag.
4. (Optional) In the **Description** field, type a description for the tag.
5. (Optional) In the **Color** field, select a color for the tag, to make the tag easier to recognize.
6. Click **OK** to save your changes and to close the Tag Create dialog box.

**Note:** New tags are available only to standard matters that are created after you created the tag. New tags are not available to existing standard matters.
Managing Default Tags

Editing tags

**Note:** Tags are available in the full edition of Discovery Manager.

You can edit the default tags you created and the default tags supplied with Discovery Manager.

To rename a tag, or to edit other properties:

1. In the navigation pane:
   a. Click the Administration button.
   b. Click the Tag Manager node.
   The work pane lists the default tags and existing custom tags.

2. In the work pane:
   a. Select the tag you want to edit.
   b. Click Edit.
   The Tag Edit dialog box opens.

3. To rename the tag, edit the **Name** field. The new name must be unique.

4. (Optional) In the **Description** field, type a description for the tag.

5. (Optional) In the **Color** field, select a color for the tag, to make the tag easier to see.
6. Click **OK** to save your changes and to close the Tag Edit dialog box.

**Note:** Changes to a tag are available only to standard matters that are created after you edited the tag. Changes to a tag are not available to existing standard matters.

### Deleting tags

**Note:** Tags are available in the full edition of Discovery Manager.

**Note:** You cannot delete a tag that is assigned to an item. You must remove the tag from all items before you can delete the tag.

To delete a tag:

1. In the navigation pane:
   a. Click the **Administration** button.
   b. Click the **Tag Manager** node.
      
      The work pane lists the default tags and existing custom tags.

2. In the work pane:
   a. Select the tag you want to delete.
   b. Click **Delete**.
This chapter contains the following topics:

- Introduction ................................................................. 136
- About hold folders .......................................................... 136
- Prerequisites: Standard matters in Discovery Manager .......... 138
- Best practices for managing standard matters ..................... 139
- Best practices for creating matters on new partitions .......... 139
- Creating a Personal Matter ............................................... 140
- Creating a standard matter .............................................. 140
- Removing and placing standard matters in My Matters .......... 146
- Editing matter properties ................................................. 148
- Managing items in a standard matter ................................. 172
- Closing standard matters ............................................... 177
- Viewing a matter summary report .................................... 173
- Reopening standard matters .......................................... 177
- Deleting matters ........................................................... 177

Note: All matter management functionality is available in the full edition of Discovery Manager.
Introduction

A *matter* is a case, litigation, investigation, or regulatory audit in which email or other relevant files must be found and provided to an interested party in a timely and defensible manner.

Discovery Manager has two types of matters:

- **Personal Matters** - In Discovery Manager express edition, each user has one Personal Matter, which only that user can work on. In the full edition of Discovery Manager, Personal Matters are optional.
- **Standard matters** - In the full edition of Discovery Manager, standard matters can be shared among several Investigators.

In Discovery Manager express edition:

- Only Personal Matters are available. One Personal Matter is created automatically for each user.
- You cannot create standard matters.
- Only the Search Folders property is available for Personal Matters. Refer to “Search Folders tab” on page 154.

In the full edition of Discovery Manager, matter management is the process of overseeing the lifecycle of a standard matter.

Refer to:

- “Lifecycle of a matter - Discovery Manager” on page 19
- “User roles in the matter lifecycle - Discovery Manager” on page 19

About hold folders

This section applies to the full edition of Discovery Manager.

A hold folder stores copies of items that have been assigned to the standard matter. If you require copies of items for legal hold, associate a hold folder with a standard matter. If you intend to perform full-text index searches on items that have been assigned to a standard matter, you should assign the items to a hold folder. Having a hold folder ensures that the items have been full-text indexed and keyword search results are consistent. If you do not associate a hold folder with a standard matter, then only a few search fields will be
available for an in-matter search. Refer to “Effects of associating a hold folder with a standard matter” on page 137.

You can specify a hold folder when you create a standard matter or later in Matter Properties. Once you specify a hold folder, you cannot remove it from the standard matter.

You can specify the same hold folder for several standard matters (a shared hold folder).

**Effects of associating a hold folder with a standard matter**

This section applies to the full edition of Discovery Manager.

Associating a hold folder with a standard matter affects the fields on which an Investigator can perform a search in the Matter Review area (an in-matter search):

- If a standard matter has an associated hold folder, then the fields on which an Investigator can search are the same as for collection searches. In addition, the Tags, Exclude Tags, Custodians, and Exclude Custodians fields are also available.

- If a standard matter does not have an associated hold folder, then the fields on which an Investigator can search are limited to Tags, Exclude Tags, Custodians, Exclude Custodians, and Message Date.

- For all search fields to be available in an in-matter search, the standard matter must be associated with a hold folder, and the items in that hold folder must be full-text indexed.
Prerequisites: Standard matters in Discovery Manager

This section applies to the full edition of Discovery Manager.

The following table describes the prerequisites that must be completed before you can create standard matters in the full edition of Discovery Manager.

<table>
<thead>
<tr>
<th>Prerequisite</th>
<th>Reason</th>
<th>Who is responsible</th>
<th>Refer to</th>
</tr>
</thead>
</table>
| Create hold folders.                | If you will be using hold folders, then hold folders must be available for selection during creation or editing of matters. | EMC SourceOne administrator. | • EMC Discovery Manager Installation and Administration Guide, "Configuring EMC SourceOne for Discovery Manager"
  • EMC SourceOne Email Management Administration Guide, "Configuring Mapped Folders" |
| Specify users allowed to work in Discovery Manager. | Discovery Manager users must be specified before you can assign Matter Managers and Investigators in a matter. | Discovery Manager User Administrator | Chapter 2, “Managing Users and Application-Wide Roles” |
| (Optional) Define custom default tags | If you want to use custom default tags, define them before creating the matters that will use the tags. | Discovery Manager Tag Administrator | Chapter 6, “Managing Default Tags” |
Best practices for managing standard matters

This section applies to the full edition of Discovery Manager.

- Consider using a numerical code name for the matter if there is a concern about confidentiality, because the matter name is displayed to the Application Administrator, who might not work on the matter.
- Assign a minimum of two Matter Managers to each matter. The second Matter Manager can act as a backup in case the primary Matter Manager is not available.
- Create a custodian for each person of interest in the matter.
- Ensure that at least one user specified in the User Management tab of Matter Properties also has the application-wide role of Identity Administrator.
- The EMC SourceOne Email Management administrator should ensure that the EMC SourceOne archive folders used for legal hold are full-text indexed. For more information about legal hold folder requirements and best practices, refer to:
  - EMC SourceOne Discovery Manager Installation and Administration Guide
  - EMC Source One Email Management Administration Guide.

Best practices for creating matters on new partitions

If your Discovery Manager Application Administrator enabled it, the Matter Creation Wizard includes the Create matter on new storage partition option.

**IMPORTANT**

Discuss with your Discovery Manager Application Administrator whether you should use the "Create matter on new storage partition" option. Use it only for matters that you estimate will be large (30 million items minimum).
Creating a Personal Matter

To create a Personal Matter in Discovery Manager express edition or in the full edition of Discovery Manager, refer to “Adding or removing Personal Matters” on page 70.

Creating a standard matter

This section applies to the full edition of Discovery Manager.

To create a standard matter, you must have the Matter Owner role.

To create a standard matter:

1. Do one of the following steps.
   - In the navigation pane, click the All Matters button, then do one of the following steps:
     - If there are no matters, click the New Matter (Ctrl-M) link in the work pane.
     - If there are no matters, click in the work pane, then press Ctrl-M.
     - Right-click the All Matters node, then select New Matter.
   - In the navigation pane, click the My Matters button, then do one of the following steps:
     - If there are no matters, click the New Matter (Ctrl-M) link in the work pane.
     - If there are no matters, click in the work pane, then press Ctrl-M.
     - Right-click the My Matters node, then select New Matter.
   - In the ribbon pane, do one of the following steps:
     - Click Matter tab > New Matter.
     - Click File tab > New > New Matter.

The Matter Creation Wizard starts.

2. Continue to “Specify general settings” on page 141.

New matters are listed in the All Matters node and the My Matters node.
Note: The Matter Creation wizard includes some, but not all, matter properties. To set additional properties for a new matter, refer to “Editing matter properties” on page 148.

Specify general settings

This section applies to the full edition of Discovery Manager.

1. On the first page of the Matter Creation wizard, specify general settings as described in the following table.

![Matter Creation Wizard - first page - example](image)
### Table 23  Matter Creation Wizard - first page

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Name       | (Required) In the **Name** field, type a name for the matter, as you want it to appear throughout Discovery Manager. You can change the name at any time in Matter Properties.  
  
  **Note:** You may want to use a code name or naming convention, particularly if the matter is sensitive. Matter names are visible to Application Administrators, who may not work on matters.  
  
  Characters in matter names are not validated. You can enter letters, numbers, spaces, punctuation, parentheses, hyphens, underscores, and brackets. However, since matter names are used to name exports, it is recommended that you do not use `/ : * ? " < > |` characters in matter names, because they are invalid in export names.  
  
  **Note:** Duplicate names are allowed. If you create a matter using the name of an existing matter, you are not notified. This is by design for security reasons, to prevent users from finding out about matters for which they do not have permissions. |
| Description| (Optional) In the **Description** field, type a comment or note about the matter. You can add or edit the description at any time in Matter Properties. You can use this field to capture details about the history of the matter, such as reasons for changing the state of the matter.  
  
  **Note:** The description is visible to everyone working on the matter and is included in the matter summary report. |
| Hold Folder| If you require copies of messages for legal hold, specify a hold folder in which to store messages that have been assigned to the matter. You can specify a hold folder later in Matter Properties if you do not specify one now.  
  
  1. Click **Browse** or press **Ctrl-Enter**.  
  2. In the Select a Hold Folder dialog box, select a hold folder for the matter, then click **OK**.  
  
  **Note:** Once you specify a hold folder during matter creation, you cannot remove it from the matter in Matter Properties. |
Managing Matters

2. Click Next to continue to the next page.

3. Continue to “Specify persons to work on the standard matter” on page 143.

Specify persons to work on the standard matter

This section applies to the full edition of Discovery Manager.

On the second page of the Matter Creation wizard, specify persons who can work on this matter, and their matter-specific roles.

Best practices:

- Ensure that at least one of the users assigned to the matter has the Identity Administrator role, to handle requests for matter-specific identity records quickly.

- Assign a minimum of two Matter Managers to each matter.
By default, the Matter Owner is listed with both matter-specific roles: Matter Manager and Investigator.

**IMPORTANT**

Each standard matter must have at least one Matter Manager and one Investigator. The person creating the matter is the default Matter Manager and the default Investigator. Best practice is to specify a second Matter Manager in case the first Matter Manager is not available. If you do not want to add more Investigators or change the default Investigator, then you can click Finish.

To specify Matter Managers and Investigators:

1. Click **Add**.

   The Select Users dialog box opens.
2. To change how users are displayed in the Select Users dialog box, use the dropdown menu in the upper right corner.

3. Select users from the Select Users dialog box.
   (Only those users defined by the User Administrator are displayed in the Select Users dialog box. If a name you need is not available, contact the User Administrator.)

4. Click OK.

5. Assign matter-specific roles:
   a. Select the user in the list. You can select one user at a time.
   b. Select or clear one or both of the following checkboxes, as appropriate:
      - Matter Manager
      - Investigator

   You must assign each user at least one matter-specific role. Otherwise, an error dialog box appears.
Managing Matters

Figure 66  Error - User without matter-specific role

Click OK to close the error dialog box.

6. To remove users, select the users in the list, then click **Remove**.

   You can remove your name from the list if you will not be an investigator.

7. Click **Finish** to close the wizard.

8. To see the new standard matter listed in All Matters, refresh the display by navigating away from All Matters, then navigating back to All Matters.

Removing and placing standard matters in My Matters

This section applies to the full edition of Discovery Manager.

Matter Managers and Investigators assigned to a new standard matter will see it listed in the All Matters area and the My Matters area.

My Matters is intended as the location for active matters (matters on which you are working).

You can remove standard matters from the My Matters area, and you can place standard matters back into the My Matters area.

Refer to:

◆ “Removing a standard matter from My Matters” on page 147
◆ “Placing a standard matter in My Matters” on page 147
Removing and placing standard matters in My Matters

Note: Removing a standard matter from My Matters simply removes the matter from the list. To permanently delete the standard matter from the system, refer to “Deleting matters” on page 177. Only users who are both the Matter Owner and the Matter Manager can delete a standard matter from the system.

Removing a standard matter from My Matters

This section applies to the full edition of Discovery Manager.

To remove a standard matter from the My Matters area:

1. Click the My Matters button in the navigation pane.
2. Under the My Matters node, right-click the matter, then select Remove from My Matters.

The standard matter is still listed in the All Matters area.

You can place it back into My Matters at any time.

Placing a standard matter in My Matters

This section applies to the full edition of Discovery Manager.

To place standard matters in the My Matters area:

1. To view all the standard matters to which you are assigned, click the All Matters button in the navigation pane.
2. Under the All Matters node, right-click the standard matter, then select Add to My Matters.

To verify, click the My Matters button in the navigation pane.

Note: Placing a standard matter in the My Matters area does not remove it from the All Matters area.
Managing Matters

Editing matter properties

Introduction

The edition of Discovery Manager and the type of matter determine the properties that are available for editing:

- In Discovery Manager full edition, the matter properties indicate the strategy of the investigation or case, such as known keywords and who was assigned to the standard matter.

  Matter Managers can:
  - Edit properties that were specified when the standard matter was created.
  - Specify additional properties that are not available in the Matter Creation wizard.

- In Discovery Manager express edition, only the Search Folders property is available for Personal Matters. Refer to “Search Folders tab” on page 154.

Procedure

To edit the properties of a matter, in the navigation pane:

1. In the navigation pane, click the My Matters button or the All Matters button.

2. Do one of the following steps:

   - To access all properties for a standard matter, right-click the matter in the navigation pane, then select Properties. The Matter Properties dialog box opens.

   - To access specific matter properties:
     a. Click the matter in the navigation pane.
     b. In the ribbon pane, click the Matter tab.
     c. Click one of the following icons in the Matter tab:
### Table 24 Matter property icons in ribbon pane

<table>
<thead>
<tr>
<th>Icon</th>
<th>Opens this tab in the Matter Properties dialog box</th>
</tr>
</thead>
</table>
| ![General](image) General | “General tab” on page 150.  
**Note:** The General tab is available in the full edition of Discovery Manager. |
| ![Tags](image) Tags | “Tags tab” on page 160.  
**Note:** Tags are available in the full edition of Discovery Manager. |
| ![Search Folders](image) Search Folders | “Search Folders tab” on page 154. |
| ![User Management](image) User Management | “User Management tab” on page 152.  
**Note:** The User Management tab is available in the full edition of Discovery Manager. |
| ![Metadata](image) Metadata | “Metadata tab” on page 156.  
**Note:** The Metadata tab is available in the full edition of Discovery Manager. |
| ![Dates](image) Dates | “Dates tab” on page 157.  
**Note:** The Dates tab is available in the full edition of Discovery Manager. |
| ![Keywords](image) Keywords | “Keywords tab” on page 163  
**Note:** The Keywords tab is available in the full edition of Discovery Manager. |
| ![Custodians](image) Custodians | “Custodians tab” on page 164.  
**Note:** Custodians are available in the full edition of Discovery Manager. |

3. To save your changes and close the Matter Properties dialog box, click **OK**.
Managing Matters

**Note:** If you enter invalid information in the Matter Properties dialog box, then the OK button is not available.

**General tab**

**Note:** The General tab is available in the full edition of Discovery Manager.

Use the General tab in Matter Properties to edit the name, description, due date, and state of a standard matter.

![Figure 68 Matter Properties - General tab - Discovery Manager](image)

The General tab displays information supplied when the standard matter was created or edited. Refer to
### Table 25  Matter Properties - General tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td><em>(Required)</em> In the <strong>Name</strong> field, type a name for the matter, as you want it to appear throughout Discovery Manager. You can change the name at any time in Matter Properties.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You may want to use a code name or naming convention, particularly if the matter is sensitive. Matter names are visible to Application Administrators, who may not work on matters.</td>
</tr>
<tr>
<td></td>
<td>Characters in matter names are not validated. You can enter letters, numbers, spaces, punctuation, parentheses, hyphens, underscores, and brackets. However, since matter names are used to name exports, it is recommended that you do not use `/:*?&quot;&lt;&gt;</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Duplicate names are allowed. If you create a matter using the name of an existing matter, you are not notified. This is by design for security reasons, to prevent users from finding out about matters for which they do not have permissions.</td>
</tr>
<tr>
<td>Description</td>
<td><em>(Optional)</em> In the <strong>Description</strong> field, type a comment or note about the matter. You can add or edit the description at any time in Matter Properties. You can use this field to capture details about the history of the matter, such as reasons for changing the state of the matter.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The description is visible to everyone working on the matter and is included in the matter summary report.</td>
</tr>
<tr>
<td>Hold Folder</td>
<td>If a hold folder was not specified when the standard matter was created, then you can specify a hold folder now. You cannot edit the hold folder if one is already specified. If you require copies of items for legal hold, specify a hold folder in which to store items that have been assigned to the standard matter. If you intend to perform full-text index searches on items assigned to a standard matter, then the matter should have a hold folder. If you assign a hold folder to a standard matter that already has items assigned, then those items are automatically copied to the hold folder. Once you select a hold folder, you cannot remove it from the standard matter. To specify a hold folder:</td>
</tr>
<tr>
<td></td>
<td>1. Click <strong>Browse</strong> or press <strong>Ctrl-Enter.</strong></td>
</tr>
<tr>
<td></td>
<td>2. In the Select a Hold Folder dialog box, select a hold folder for the standard matter, then click <strong>OK.</strong></td>
</tr>
</tbody>
</table>
Managing Matters

Table 25  Matter Properties - General tab (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create matter on new storage partition</td>
<td>Available if your Discovery Manager Application Administrator allows.</td>
</tr>
<tr>
<td>Note:</td>
<td>Consult your Discovery Manager administrator before selecting this option.</td>
</tr>
<tr>
<td>Valid values:</td>
<td>Valid values:</td>
</tr>
<tr>
<td></td>
<td>• Selected = Each new Personal Matter will be created on its own partition.</td>
</tr>
<tr>
<td></td>
<td>• Cleared = Personal Matters will not be created on individual partitions.</td>
</tr>
<tr>
<td>If you select this option, the following warning displays:</td>
<td>Creating new database partitions for each matter affects SQL Server resources and performance, and database maintenance and administration. Review the Discovery Manager User Guide or online help for more information on partitioning choices.</td>
</tr>
<tr>
<td></td>
<td>Continue with this selection? [Y]es [N]o</td>
</tr>
<tr>
<td>State</td>
<td>To change the state of a standard matter, select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• Open</td>
</tr>
<tr>
<td></td>
<td>• Closed</td>
</tr>
<tr>
<td></td>
<td>The default state of a new standard matter is Open.</td>
</tr>
</tbody>
</table>

User Management tab

Note: The User Management tab is available in the full edition of Discovery Manager.

Use the User Management tab in Matter Properties to:

- Specify users to work on the standard matter.
- Assign matter-specific roles (Matter Manager and Investigator) to those users.
- A user can have both the Matter Manager role and the Investigator role in the same standard matter.

Best practices:

- Assign a minimum of two Matter Managers to each standard matter.
- Ensure that at least one user specified in the User Management tab also has the application-wide role of Identity Administrator.
IMPORTANT

In Discovery Manager, each standard matter must have at least one Investigator until the work on the matter is completed.

Figure 69 Matter Properties - User Management tab - Discovery Manager

The User Management tab displays information supplied when the standard matter was created or edited.

To edit matter-specific users, refer to “Specify persons to work on the standard matter” on page 143, steps 1 through 6.

Users removed from a standard matter will no longer see the matter listed in All Matters or My Matters.

Note: You cannot change the matter state to Closed and remove yourself from the matter in the same operation. If you attempt to do both actions in the same operation, then the following error message displays: Warning: The matter state has been changed to CLOSED. You cannot remove yourself from a matter in a closed state. When you click OK to close the error dialog box, the matter is set to the Closed state, but you are still listed on the User Management tab. You must reopen the matter, remove yourself, then have another Matter Manager who is assigned to the matter close the matter.
Managing Matters

Search Folders tab

The Search Folders tab is available in both editions of Discovery Manager.

Use the Search Folders tab in Matter Properties to specify the folders that will be available to search in a matter.

Refer to:

- “Considerations and limitations” on page 154
- “Procedure: Specifying search folders in Matter Properties” on page 155
- “Procedure: Removing invalid search folders in Matter Properties” on page 155

Considerations and limitations

- Only those folders for which the EMC SourceOne primary service account has Read All permission are available to search. (EMC SourceOne Email Management administrators configure permissions on search folders, as described in the EMC SourceOne Discovery Manager Installation and Administration Guide and the EMC SourceOne Email Management Administration Guide.)

- The non-hold folders you specify apply only to collection searches.

- Review searches only apply to items that have been assigned to a standard matter. Review searches do not search non-hold folders. Refer to “Reviewing Content in Matters” on page 295).

  Note: Review searches are available in the full edition of Discovery Manager.

- You do not have to specify a hold folder as a collection source, unless you want to perform collection searches against items that are on hold in other standard matters.

  Note: Hold folders are available in the full edition of Discovery Manager.

- In Discovery Manager express edition, users performing a search can select folders from the list of folders for which the EMC SourceOne primary service account has Read All permission. Users cannot add folders.
In Discovery Manager full edition, Investigators performing a search can select folders from the ones that you specify, but cannot add folders.

In Discovery Manager, Matter Managers can add or remove folders from the Search Folders tab at any time during the investigation. However, removing a search folder from the Search Folders tab after an Investigator has selected it in a collection search will affect those search results. Removing a search folder does not affect searches that have already run.

![Matter Properties - Discovery Manager - Search Folders tab](image)

**Procedure: Specifying search folders in Matter Properties**

To specify folders to search, do one of the following steps:

* To search all folders, select the **Folders** checkbox at the top of the checkbox column.
* To search selected folders, select the checkboxes next to individual folders.

**Note:** You must select at least one folder.

**Procedure: Removing invalid search folders in Matter Properties**

If a specified search folder is later removed from EMC SourceOne Email Management, or if the permissions change on the search folder, then the Search Folders tab in Matter Properties lists that folder in red.
Managing Matters

To remove the invalid search folder from the matter:
1. Clear the checkbox next to the folder in red.
2. Click OK.

Metadata tab

Note: The Metadata tab is available in the full edition of Discovery Manager.

Use the Metadata tab in Matter Properties to suggest the custom item metadata on which to search.

Custom item metadata:
- Is information about the item that was captured during archiving or later processing.
- Is site-specific.
- Has already been applied to items in the archiving system using a third-party product, not in Discovery Manager.

![Metadata tab in Matter Properties](image)

Figure 71  Matter Properties - Metadata tab - Discovery Manager

The Field Name field displays Retrieving while it is being populated.

To specify custom item metadata on which to search:
1. In the Field Name field, select the item metadata field on which to search.
2. In the **Condition** field, select one of the following conditions:
   - **Equals**
   - **Not Equals**

3. In the **Value** field, type the value for the metadata. The maximum number of characters is 250.

4. Click **Add** to add the metadata search criteria to the list.

   **Note:** In the Operator column, the `!=` symbol means Not Equals.

5. Repeat steps 1 through 4 for each metadata field you want to specify.

6. To remove a metadata entry from the list, select the entry, then click **Remove**.

   **Note:** You can select only one entry at a time.

7. To edit a metadata entry:
   a. Select the entry in the list.
   b. Click **Edit**.
   c. Edit the metadata properties in the Edit Metadata dialog box.

---

**Dates tab**

**Note:** The Dates tab is available in the full edition of Discovery Manager.

Use the Dates tab in Matter Properties to specify a due date and to suggest a collection date range.
Suggested Collection Date Range

You can suggest date ranges to guide Investigators in Discovery Manager. Date ranges are not used as default criteria in collection searches.

If you do not want to specify a collection date range, in the Condition field, select None (default).

To specify a collection date range:

1. In the Condition field, select one of the following options:
   - Before
   - After
   - On
   - Between

2. In the Value field, do one of the following steps:
   - Click the dropdown arrow, then select a date from the calendar.
   - Click in the field, then type the date.

3. If you selected Between in step 1, then:
   - The Value field defaults to today’s date.
   - The And field defaults to the Value date plus one day.

For example, if you set the Value field to 1/1/2010 (January 1, 2010), then the And field defaults to 1/2/2010 (January 2, 2010).
Specify the start date of the range in the **Value** field, and the end date of the range in the **And** field.

**Figure 73** Matter Properties - Dates tab - example of suggested collection date range

**Matter Due Date**

Note the following considerations about the **Due Date** field:

- The due date is optional. It could be the date of the scheduled meet-and-confer before which all preliminary collection searches must be run and assigned. It could be the date of the scheduled SEC audit. For example, use the due date to tell Investigators when export results should be available.

- The matter does not close automatically when the due date is reached.

- Valid dates are today’s date or any date after today.

- If you type a due date that is invalid, then the due date defaults to today’s date.

To specify a due date, click the dropdown arrow in the **Due Date** field, then select a due date from the calendar.
Managing Matters

**Tags tab**

*Note:* Tags are available in the full edition of Discovery Manager.

Use the Tags tab in Matter Properties to create, edit, and delete matter-specific tags. A tag is metadata applied to an item in the review phase, such as Responsive or Bookmark.

Default tags are available for all standard matters. You can remove them from the list if you do not want them to be available for the standard matter.

![Matter Properties - Tags tab - Discovery Manager](image)

Refer to:

- “Adding matter-specific tags” on page 160
- “Editing matter-specific tags” on page 161
- “Deleting matter-specific tags” on page 162

**Adding matter-specific tags**

To add a new matter-specific tag:

1. In the **Tags** tab of Matter Properties, click **New**.
   
The Tag Create dialog box opens.
2. (Required) In the **Name** field, type a unique name for the tag.
3. (Optional) In the **Description** field, type a description for the tag.
4. (Optional) In the **Color** field, select a color for the tag, to make the tag easier to recognize.
5. Click **OK** to save your changes and to close the Tag Create dialog box.

**Editing matter-specific tags**

To rename a matter-specific tag, or edit other properties:

1. In the **Tags** tab of Matter Properties:
   a. Select the matter-specific tag you want to edit.
   b. Click **Edit**.

The Tag Edit dialog box opens.
Managing Matters

Figure 76  Tag Edit - Discovery Manager

2. To rename the tag, edit the Name field. The new name must be unique.

3. (Optional) In the Description field, type a description for the tag.

4. (Optional) In the Color field, select a color for the tag, to make the tag easier to see.

5. Click OK to save your changes and to close the Tag Edit dialog box.

Deleting matter-specific tags

To delete a matter-specific tag, in the Tags tab of Matter Properties:

1. Select the tag you want to delete.

2. Click Delete.

Note: Default tags are listed for all standard matters. When you delete a default tag from the list in a standard matter, the default tag still exists in the system and is available for other standard matters. To define custom default tags, refer to Chapter 6, “Managing Default Tags.”
Keywords tab

**Note:** The Keywords tab is available in the full edition of Discovery Manager.

**Note:** Keyword searching works on items that are full-text indexed.

Use the Keywords tab in Matter Properties to specify keywords for collection searches.

![Figure 77 Matter Properties - Keywords tab - Discovery Manager](image)

The keywords will be automatically included in the search criteria of any collection search created in the standard matter. Investigators can delete these keywords from search criteria if desired.

To specify keywords, type them in the **Keywords** text box. Separate keywords with a space.
Custodians tab

Note: Custodians are available in the full edition of Discovery Manager.

Use the Custodians tab in Matter Properties to create, edit, and delete custodians for a standard matter.

Figure 78 Matter Properties - Custodians tab - Discovery Manager

A custodian is a legal discovery term that refers to the "owner" of a document or piece of evidence, or who had the item in his possession at any time.

Investigators will assign the custodian to items, as described in “Assigning custodians to items” on page 302. Investigators can sort items during review based on custodians, and separate export files into individual user sets.

Refer to:
- “Adding custodians” on page 164
- “Deleting custodians” on page 172

Adding custodians

Note: Best practice is to add custodians to a standard matter by selecting from the list of identities, as described in Step 2.
Note: If you select an identity to use as a custodian, and then another user deletes that identity from Discovery Manager, an error displays when you click OK to close Matter Properties: Cannot resolve the Identity entry <identity>.

To add a new custodian:

1. In the **Custodians** tab of Matter Properties, click **New**.
   The Custodian Create dialog box opens.

   ![Custodian Create - Discovery Manager](image)

   **Figure 79** Custodian Create - Discovery Manager

2. In the **Name** field:
   a. Do one of the following steps:
      - Click the dropdown arrow.
      - Press the **Down** arrow key
   b. Select one of the following sources for the name of the custodian:
      - **Exchange** - Continue to “Selecting custodian using Address Book” on page 166 or “Typing a custodian name” on page 170.
      - **Domino** - Continue to “Selecting custodian using Address Book” on page 166 or “Typing a custodian name” on page 170.
      - **Identities** - (Recommended) Continue to “Selecting custodian using Address Book” on page 166 or “Typing a custodian name” on page 170.
      - **Manual** - Continue to “Typing a custodian name” on page 170.
Managing Matters

Note: The source that you select becomes the default for the rest of the session.

3. Click OK to save your changes and to close the Custodian Create dialog box.

Selecting custodian using Address Book
After you select Exchange, Domino, or Identities in the Name dropdown list, the label on the dropdown button changes to show your choice.

1. Click the dropdown button.

   The Address Book dialog box opens.

   The Source field displays the name of the source that you selected previously in the Custodian Create dialog box.

![Address Book](image)

Figure 80 Address Book

2. In a Domino environment that uses the Domino native directory, in the Source field under Domino <Choose Directory>, select a Domino directory.
Managing Matters

3. Continue to the appropriate topic:
   - “Address Book: Exchange or Domino” on page 167
   - “Address Book: Identities” on page 169

Address Book: Exchange or Domino

For Exchange or Domino:

1. Do one of the following steps:
   - Type the full or partial name of the person in the Search field, then do one of the following steps:
     - Click Find.
     - With the focus in the Search field, press Enter.
   
   If a name is found that exactly matches your criteria, then the name is added to the list automatically. The Search field regains focus and the Search field clears so that you can look up multiple entries quickly.
   
   - In a Domino environment that uses the Domino native directory, you are searching the display name, which is listed by last name. If you type the person’s first name, you will not get any results. If you type the last name, the name of the person is returned.
   
   - To search for names using additional fields, click the dropdown arrow next to the Find button, then select Advanced Find. In the Advanced Find dialog box, type your search criteria, then click OK.

   Note: The Advanced Find dialog box is only available for Exchange environments and for Domino environments that use LDAP. It is not available for Identities or for Domino environments that use the Domino native directory.
2. If multiple matches are found, then the Select Address dialog box opens.

a. Select the correct name from the Select Address dialog box.

   **Note:** When you are using the Select Address dialog box to select custodians, you can select only one custodian at a time.

b. Click **OK**.

The Select Address dialog closes, and the selected name is listed in the Address Book.
Address Book: Identities

For Identities:

1. Do one of the following steps in the Search field:
   - To view all identities, leave the Search field blank.
   - To filter identities, type the full or partial name of the identity.
2. Do one of the following steps:
   - Click Find.
   - With the focus in the Search field, press Enter.
3. Click OK to close the Address Book dialog box.
4. If there is more than one name listed in the Address Book dialog box, then the Multiple Entries In Use dialog box opens: Cannot create a custodian using more than one entry. Please remove entries until only one is left.

Figure 84 Multiple Identities Found

a. Click OK to close the Multiple Entries In Use dialog box.
b. Delete all but one entry from the list in the Address Book dialog box.
c. To close the Address Book, do one of the following steps:
   – Click OK.
Managing Matters

– With the focus on either the OK button or in the list of names, press **Enter**.

The name is listed in the Custodians tab in the Matter Properties dialog box.

**Typing a custodian name**

After you select an option in the **Name** dropdown list, you can enter a custodian name directly without going through an Address Book dialog box:

1. In the **Name** field, type a unique name containing only alphanumeric characters. Special characters (such as `~!@#$%^`) are not valid.

   **Note:** You cannot edit the custodian name after you save your changes.

2. Either press **Ctrl-K** or click the icon to the right of the **Name** field.

   The result depends on what you selected in the **Name** dropdown list:
   
   - If you selected **Exchange** or **Domino**, then the name you typed is resolved against the address book.
     
      If the name cannot be resolved, the No Entries Found dialog box opens.

   - If you selected **Identities**, then the name you type is resolved against the Discovery Manager identity records.

   ![No Entries Found](image)

   **Figure 85 No Entries Found**

   Select **Yes** to add the name exactly as you typed it to the list of custodians.

   - If you selected **Identities**, then the name you type is resolved against the Discovery Manager identity records.
If the name or address cannot be resolved, the No Entries Found dialog box opens. Select Yes to add the name or address exactly as you typed it to the list of custodians.

- If you selected Manual, then the name you type is not resolved against either the address book or the identity records. Whatever you type will be added to the list of custodians after you do step 3.

3. In the Custodian Create dialog box, click OK to add the name to the list of custodians.

**Editing custodian description**

*Note:* You cannot edit the name of a custodian.

You can use the custodian description to distinguish between custodians with similar names.

To edit the description for a custodian:

1. In the **Custodians** tab of Matter Properties:
   a. Select the custodian you want to edit.
   b. Click **Edit**.

   The Custodian Edit dialog box opens.

![Custodian Edit - Discovery Manager](image)

2. Edit the description.

3. Click **OK** to save your changes and to close the Edit Custodian dialog box.
Managing Matters

Deleting custodians

*Note:* You cannot delete a custodian that is assigned to an item. You must remove the custodian from all items before you can delete that custodian.

To delete a custodian, in the **Custodians** tab of Matter Properties:

1. Select the custodian that you want to delete.
2. Click **Delete** or press the **Delete** key.

Managing items in a standard matter

*Note:* This section applies to the full edition of Discovery Manager.

Refer to:

- “Adding messages to a standard matter” on page 172
- “Reviewing messages in a standard matter” on page 172
- “Removing items from a standard matter” on page 172

Adding messages to a standard matter

To add messages to a standard matter, refer to Chapter 8, “Collecting Content for Matters.”

*Note:* Assigning messages to a standard matter is available in the full edition of Discovery Manager.

Reviewing messages in a standard matter

To review messages in a standard matter, refer to Chapter 11, “Reviewing Content in Matters.”

*Note:* Matter Review is available in the full edition of Discovery Manager.

Removing items from a standard matter

You can remove items from a standard matter in the Matter Review area after you assign them to the matter, not in the Collection Search.
area. To delete items from the Matter Review area, refer to “Removing items from Matter Review” on page 315.

Note: Matter Review is available in the full edition of Discovery Manager.

### Viewing a matter summary report

**Introduction**

In Discovery Manager express edition or the full edition of Discovery Manager, a user can view or print the summary report for his Personal Matter.

In Discovery Manager full edition, a Matter Manager or Investigator can view or print the matter summary report for a standard matter. The matter summary is a useful guide to Investigators.

**Note:** For matters created before Discovery Manager 7.0, matter summary reports may show “data unavailable” for new information introduced with 7.0.

**Procedure**

To view summary information about a matter:

1. In the navigation pane, click the **My Matters** button or the **All Matters** button.

   **Note:** The All Matters button is available in the full edition of Discovery Manager.

2. Select the matter in the navigation pane or the work pane.

   **Note:** While a matter is being deleted, you cannot select it in the navigation pane. The matter node is labeled “Deleting...” and remains in a disabled state.

The matter summary report displays in the preview pane.
Managing Matters

**Matter Summary: Matter1**

- **Created by:** EM Admin (admin@emc.com)
- **Created:** 12/01/2012 2:05 PM
- **Due date:** <name specified>
- **Host:** 22/01/2012 4:27 PM
- **Description:**
  - **State:** Open
  - **Host folder:** <name specified>

**Matter Properties**

**Search folders:**

- Email Business Folder
- File Business Folder

**Custodians:**

- Alan E. Geyer
- Alan B. Taylor
- Alan E. Chaff
- John E. Miller

**Suggested search criteria:**

- **Collector:** <name specified>
- **Date range:**
- **Keywords:**
- **Custom:** <name specified>

---

**Information displayed**

The following table describes the information shown in a matter summary report.

Some sections in the report are expanded and displayed by default. Other sections are collapsed by default. To display a collapsed section, click the arrow button on the far right of the section label.

**Report toolbar**

Use the icons in the toolbar above the matter summary report to refresh the report, save the report as an XPS file, print the report, or display a print preview.

---

**Note:** In Discovery Manager express edition, only the Name and Description columns display at the top of the My Matters or **VERIFY All Matters area.**

**Note:** After a matter has been deleted and is no longer available, the matter summary report “Matter no longer exists” in gray italics.
### Table 26  Matter Summary report

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Matter Summary</td>
<td>The name of the matter.</td>
</tr>
<tr>
<td></td>
<td>Created</td>
<td>Name of the Discovery Manager user who created the matter.</td>
</tr>
<tr>
<td></td>
<td>Created Date</td>
<td>Date on which the matter was created.</td>
</tr>
<tr>
<td></td>
<td>Due date</td>
<td>Due date for the matter, specified in the Matter Creation wizard or the General tab of the Matter Properties dialog box.</td>
</tr>
<tr>
<td></td>
<td>Modified Date</td>
<td>Date on which the matter properties were last modified.</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>Description of the matter.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For Personal Matters, this field is blank.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In Discovery Manager standard matters, this is specified in the Matter Creation wizard or the General tab of the Matter Properties dialog box.</td>
</tr>
<tr>
<td></td>
<td>State</td>
<td>State of the matter (Open or Closed).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In Discovery Manager standard matters, this is specified in the General tab of the Matter Properties dialog box or in the ribbon pane (Material tab &gt; State field).</td>
</tr>
<tr>
<td></td>
<td>Hold folder</td>
<td>In Discovery Matter standard matters, the name of the legal hold folder is specified in the Matter Creation wizard or the General tab of the Matter Properties dialog box.</td>
</tr>
<tr>
<td></td>
<td>Search folders</td>
<td>List of the folders to search, specified in the Search Folders tab of the Matter Properties dialog box.</td>
</tr>
<tr>
<td></td>
<td>Custodians</td>
<td>(Discovery Manager full edition) List of custodians, specified in the Custodians tab of the Matter Properties dialog box.</td>
</tr>
<tr>
<td></td>
<td>Suggested search criteria</td>
<td>(Discovery Manager full edition)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Collection date range - Date range for collection, specified in the Criteria tab of the Matter Properties dialog box.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Keywords - Keywords on which to search, specified in the Criteria tab of the Matter Properties dialog box.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Custom metadata - Metadata on which to search, specified in the Metadata tab of the Matter Properties dialog box.</td>
</tr>
<tr>
<td></td>
<td>Matter-specific tags</td>
<td>(Discovery Manager full edition) List of tags defined for the standard matter, specified in the Tags tab of the Matter Properties dialog box.</td>
</tr>
</tbody>
</table>
Managing Matters

Staff
For Personal Matters, this field lists the name of the user, along with the role "Search and Export." This role is assigned automatically to each user, and is not visible in the User Manager screen.
For standard matters, this field lists the Discovery Manager users assigned to work on the matter, specified in the User Management tab of the Matter Properties dialog box.

Statistics

Current message counts
(Discovery Manager full edition) Total number of items and the total associated storage for items (in KB) in the following states:
• Assigned to matter
• Items on hold
• Items not tagged
• Items with no custodians

Custodian counts
(Discovery Manager full edition) List of custodians, their names, the total number of items to which each custodian has been assigned, the total associated storage (in KB), and descriptions.

Tag counts
(Discovery Manager full edition) List of tag names, the total number of items to which each tag has been assigned, the total associated storage (in KB), and descriptions.

Status
List the names and the status of:
• Collection searches
• Review searches
• Export jobs
For descriptions of search status, refer to Table 26 on page 183.
For Collection searches and Review searches, the report also shows the organizing folder in which the search resides.
For Collection searches, the report also shows the number of times the search ran.
For descriptions of job status, refer to "Viewing running jobs" on page 231.

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Staff</td>
<td>For Personal Matters, this field lists the name of the user, along with the role &quot;Search and Export.&quot; This role is assigned automatically to each user, and is not visible in the User Manager screen. For standard matters, this field lists the Discovery Manager users assigned to work on the matter, specified in the User Management tab of the Matter Properties dialog box.</td>
<td></td>
</tr>
</tbody>
</table>

| Statistics |
|-----------|--------------------------------------------------|
| Current message counts | (Discovery Manager full edition) Total number of items and the total associated storage for items (in KB) in the following states:  
• Assigned to matter  
• Items on hold  
• Items not tagged  
• Items with no custodians |
| Custodian counts | (Discovery Manager full edition) List of custodians, their names, the total number of items to which each custodian has been assigned, the total associated storage (in KB), and descriptions. |
| Tag counts | (Discovery Manager full edition) List of tag names, the total number of items to which each tag has been assigned, the total associated storage (in KB), and descriptions. |

| Status |
|--------|--------------------------------------------------|
| List the names and the status of:  
• Collection searches  
• Review searches  
• Export jobs  
For descriptions of search status, refer to Table 26 on page 183.  
For Collection searches and Review searches, the report also shows the organizing folder in which the search resides.  
For Collection searches, the report also shows the number of times the search ran.  
For descriptions of job status, refer to “Viewing running jobs” on page 231. |
Managing Matters

Closing standard matters

Note: This section applies to the full edition of Discovery Manager.

To close a selected standard matter, change its state to Closed in one of the following State fields:

- On the General tab of Matter Properties, described in “Editing matter properties” on page 148.
- On the Matter tab of the ribbon pane.

Reopening standard matters

Note: This section applies to the full edition of Discovery Manager.

To reopen a selected standard matter, change its state to Open in one of the following State fields:

- On the General tab of Matter Properties, described in “Editing matter properties” on page 148.
- On the Matter tab of the ribbon pane.

Deleting matters

Deleting Personal Matters

In Discovery Manager express edition or in the full edition of Discovery Manager, the User Administrator can delete any Personal Matter from the User Manager screen.

When a Personal Matter is deleted for a user, all of the searches and exports associated with that matter will be removed from the system. Auditing information remains in the database.

Refer to “Adding or removing Personal Matters” on page 70.

Deleting standard matters

In the full edition of Discovery Manager, a user who is both the Matter Owner and Matter Manager can delete a standard matter.

When a standard matter is deleted:

- It disappears from the list of matters for all users assigned to work on the matter.
Managing Matters

- Any items on hold for the standard matter are disposed.

You cannot delete a matter that has jobs running.

To delete a standard matter:
1. In the navigation pane, click the My Matters button or the All Matters button.
2. Do one of the following steps:
   - Right-click the standard matter, then select Delete.
   - Click the standard matter, then click Delete in the Home tab in the ribbon pane.
3. At the Matter Delete confirmation prompt, click OK to confirm the delete.
This chapter describes how to create and manage searches, and how to add content to a matter.

Refer to:

- Prerequisites................................................................. 180
- Checklist: collecting content for a matter ...................... 180
- Viewing list of collection searches for a matter ............... 182
- Viewing a collection summary report............................ 184
- Creating a collection search......................................... 188
- Adding and removing columns ..................................... 190
- Editing search properties............................................. 191
- Specifying folders to search........................................ 196
- Specifying search criteria .......................................... 198
- Scheduling a search ................................................... 199
- Viewing a collection search.............................. 201
- Copying a collection search.............................. 202
- Renaming a collection search.................................... 202
- Using folders to organize collection searches ............. 203
- Running a collection search .................................... 207
- Re-running a collection search .................................. 207
- Monitoring search progress..................................... 208
- Viewing search errors................................................ 210
- Viewing search history............................................... 213
- Viewing results of a collection search........................ 215
- Selecting results..................................................... 226
- Assigning collection search results to a standard matter.. 227
- Deleting a search........................................................ 229
- Monitoring status of operations for a matter ................ 230
Prerequisites

In Discovery Manager express edition, a Personal Matter is created for each user automatically. By default, each user has the Search and Export role.

In the full edition of Discovery Manager:

- To create a standard matter, refer to Chapter 7, “Managing Matters.”
- To collect and assign content for a standard matter, you must have the Investigator role.
- Personal Matters are optional.

Checklist: collecting content for a matter

The following table outlines the main steps to collect content for a matter.

Table 27  Checklist: collecting content for a matter

<table>
<thead>
<tr>
<th>Step</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Does the matter have an existing search you can use?</td>
</tr>
<tr>
<td></td>
<td>- If no, then create one.</td>
</tr>
<tr>
<td></td>
<td>- If yes, then copy the existing search.</td>
</tr>
<tr>
<td>2</td>
<td>Are the default/existing search fields suitable?</td>
</tr>
<tr>
<td></td>
<td>- If no, then customize them.</td>
</tr>
<tr>
<td></td>
<td>- If yes, then specify search criteria.</td>
</tr>
<tr>
<td>3</td>
<td>Specify search properties and the folders to search.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Checklist: collecting content for a matter (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Refer to</th>
</tr>
</thead>
</table>
| 4    | Specify when to run the search.  
  **Note:** Scheduling searches is available in the full edition of Discovery Manager. | “Scheduling a search” on page 199 |
| 5    | Run the search. | • “Running a collection search” on page 207  
  • “Monitoring search progress” on page 208 |
| 6    | Assign search results to the matter.  
  **Note:** Assigning search results to a standard matter is available in the full edition of Discovery Manager. | • “Viewing results of a collection search” on page 215  
  • “Assigning collection search results to a standard matter” on page 227 |
Viewing list of collection searches for a matter

To view a list of existing collection searches for a matter, in the navigation pane:

1. Click the My Matters button or the All Matters button.

   **Note:** The All Matters button is available in the full edition of Discovery Manager.

2. Expand the matter node.

3. Click the Collection Area node.

   If no searches or search folders exist for the matter, then the work pane displays two links:

   - **New Search (Ctrl-S)** - Refer to “Creating a collection search” on page 188.
   - **New Folder (Ctrl-F)** - Available in the full edition of Discovery Manager. Refer to “Using folders to organize collection searches” on page 203.

   ![Collection Area - no searches or search folders](image)

   If searches exist, the work pane lists the collection searches for the matter, including any searches that you have organized in folders.

   Searches that encountered errors are shown in red in the work pane. To see information about the error, click the red entry to expand the search node.
To organize searches in folders, refer to “Using folders to organize collection searches” on page 203. Organizing folders are available in the full edition of Discovery Manager.

The following table describes the information shown for each search in a selected Collection Area node.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the collection search.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the collection search:</td>
</tr>
<tr>
<td></td>
<td>• Created - The new search has not been run or scheduled to run.</td>
</tr>
<tr>
<td></td>
<td>• Waiting - The search is waiting to start processing items.</td>
</tr>
<tr>
<td></td>
<td>• Queued - The search has been queued due to backend load.</td>
</tr>
<tr>
<td></td>
<td>• Running - The search is actively processing items.</td>
</tr>
<tr>
<td></td>
<td>• Suspended - The running search has been paused.</td>
</tr>
<tr>
<td></td>
<td>• Resuming - The suspended search is continuing.</td>
</tr>
<tr>
<td></td>
<td>• Stopping - The running search is in the process of being terminated.</td>
</tr>
<tr>
<td></td>
<td>• Stopped - The running search has been terminated.</td>
</tr>
<tr>
<td></td>
<td>• Stopped due to search limits - The running search has been terminated because the maximum number of search results was returned.</td>
</tr>
<tr>
<td></td>
<td>• Incomplete - The search returned incomplete results.</td>
</tr>
<tr>
<td></td>
<td>• Complete - The search finished successfully.</td>
</tr>
<tr>
<td></td>
<td>• Failed - The search was unable to finish successfully.</td>
</tr>
<tr>
<td></td>
<td>• Deleting - The search is in the process of being deleted.</td>
</tr>
<tr>
<td></td>
<td>• Unknown - The status of the search is not known.</td>
</tr>
</tbody>
</table>

Note: To update grids, navigate away from the grid (for example, select another search node), and then navigate back to the grid.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation Date</td>
<td>Date and time on which the collection search was created</td>
</tr>
<tr>
<td>Items Processed</td>
<td>Total number of items returned in search results.</td>
</tr>
</tbody>
</table>

Note: Each time a search runs, a new subnode is created below the search node. Each subnode represents a past occurrence of the search. Refer to “Viewing search history” on page 213 for more information.
Collecting Content for Matters

Viewing a collection summary report

You can view two types of collection search summary reports:

- A report that displays information for all instances (executions) of a collection search
- A report that displays information for a single instance (execution) of a collection search

Use the icons in the toolbar above the matter summary report to refresh the report, save the report as an XPS file, print the report, or display a print preview.

Figure 90 Report toolbar

**Note:** For collection searches created before Discovery Manager 7.0, collection summary reports may show "data unavailable" for new information introduced with 7.0.

Viewing report for all instances of a collection search

To view a summary report for all instances of a collection search:

1. In the navigation pane:
   a. Click the My Matters button or the All Matters button.

   **Note:** The All Matters button is available in the full edition of Discovery Manager.

   b. Expand the matter that contains the search by clicking on the plus sign (+) next to the name of the matter.

   c. Expand the Collection Area node.

   d. Select the named search node for which you want a report.

2. In the work pane, click the Summary tab to display the report.
Collecting Content for Matters

Figure 91 Example - Collection summary report - all instances of a search

The following table describes the information displayed about the selected collection search.

Table 29 Collection summary report for all search instances

<table>
<thead>
<tr>
<th>Field or area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collection Search</td>
<td>Name of the search.</td>
</tr>
<tr>
<td>Creation date</td>
<td>Date on which the search was created.</td>
</tr>
<tr>
<td>Created by</td>
<td>Name of the Discovery Manager user who created the search.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the search after the last time it ran. For descriptions of search status, refer to Table 28 on page 183.</td>
</tr>
<tr>
<td>Criteria</td>
<td>Lists the search fields used and their values. The Criteria section of the report displays the search criteria used most recently. It does not track changes to search criteria.</td>
</tr>
</tbody>
</table>
Collecting Content for Matters

To view a summary report for a single instance of a collection search:

1. In the navigation pane:
   a. Click the My Matters button or the All Matters button.
      
      **Note:** The All Matters button is available in the full edition of Discovery Manager.

   b. Expand the matter that contains the search by clicking on the plus sign (+) next to the name of the matter.

   c. Expand the Collection Area node.

   d. Expand the appropriate search name node.

   e. Select the search instance (date) node for which you want a report.

2. In the work pane, click the Summary tab to view the report.

---

### Executions

<table>
<thead>
<tr>
<th>Field or area</th>
<th>Description</th>
</tr>
</thead>
</table>
| Executions    | Lists the search history. Each row contains information about an occurrence (instance) of the search, equivalent to a dated subnode of the search displayed in the navigation pane (described in “Viewing search history” on page 213). Each row displays the following information for a search instance:  
  * No. - The order in which the instance ran.  
  * Run by - The name of the Discovery Manager user who ran that instance.  
  * When - The date and time on which the instance ran.  
  * Status - The status of the instance.  
  * Items processed - The number of items processed by the search instance.  
A red entry indicates an error occurred when the search was run. Expand the entry to view details about the error.  
  
**Note:** When you change the Maximum search results value in Search Properties before you run or rerun a search, and the search stops because it reaches the maximum number of search results, the search summary report displays the “Stopped due to hit limit” status only for the first search instance. Specify a low value for Maximum search results only when you are testing search criteria. Specify a high value for Maximum search results in a production environment. Refer to “Editing search properties” on page 191. |

---

**Table 29 Collection summary report for all search instances (continued)**
The following table describes the information displayed about the selected instance of the collection search.

### Table 30  
Collection summary report for single search instance

<table>
<thead>
<tr>
<th>Field or area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Collection Search</strong></td>
<td>Name of the search to which this instance belongs.</td>
</tr>
<tr>
<td><strong>Execution date</strong></td>
<td>Date an time on which this search instance ran.</td>
</tr>
<tr>
<td><strong>Run by</strong></td>
<td>Name of the Discovery Manager user who ran this search instance.</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>Status of the search after the last time it ran. For descriptions of search status, refer to Table 28 on page 183.</td>
</tr>
<tr>
<td><strong>Items processed</strong></td>
<td>The number of items processed in this search instance.</td>
</tr>
<tr>
<td><strong>Max hits</strong></td>
<td>The maximum number of search results, configured in the Search Properties dialog. <strong>Note:</strong> When you change the Maximum search results value in Search Properties before you run or rerun a search, and the search stops because it reaches the maximum number of search results, the search summary report displays the &quot;Stopped due to hit limit&quot; status only for the first search instance. Specify a low value for Maximum search results only when you are testing search criteria. Specify a high value for Maximum search results in a production environment. Refer to “Editing search properties” on page 191.</td>
</tr>
<tr>
<td><strong>Folders</strong></td>
<td>The number of folders searched and their names.</td>
</tr>
<tr>
<td><strong>Addresses</strong></td>
<td>The number of address found, and the list of found addresses.</td>
</tr>
</tbody>
</table>
Creating a collection search

To create a collection search, in the navigation pane:

1. Click the **My Matters** button or the **All Matters** button.

   **Note:** The All Matters button is available in the full edition of Discovery Manager.

2. Expand the matter for which you want to create a search.

3. Do one of the following steps:
   - If no searches exist, then click the **New Search (Ctrl-S)** link.
   - If no searches exist, click in the work pane, then press **Ctrl-S**.
   - Right-click the **Collection Area** node for the matter, then select **New Search**.
   - In the ribbon pane, click Search/Export tab > **New Search**.
   - Right-click on a folder used to organize searches. For information on creating folders, refer to “Using folders to organize collection searches” on page 203. Organizing folders are available in the full edition of Discovery Manager.

(Alternatively, for a matter without any searches, you can select the **Collection Area** node in the navigation pane, then click the **New Search** link in the work pane.)

A search named New Search appears under the Collection Area node. If a search by that name already exists, then the number (1) is appended to New Search.

4. Edit the name of the new search, then press **Enter**.

   **Note:** The names of collection searches do not have to be unique within the Collection Area of a matter.
5. Click the newly named search node.

The work pane displays the search criteria area, containing default search fields for the default content type (All).

The top of the search criteria area displays:

- For a collection search:
  - The name of the search
  - The names of the search folders selected for the search, or **All Folders**
  - The keywords defined for the matter in the unlabeled **Keyword** field

- For a review search (performed in the Matter Review node, as described in “Reviewing Content in Matters” on page 295):
  - The name of the search
  - The name of the hold folder, if one is assigned to the matter.

Adding and removing columns

Note: This section applies to both editions of Discovery Manager.

To add or remove columns from the search results grid:

1. In the ribbon pane, select Field Chooser in the Home tab.

   The Field Chooser dialog box opens. It lists all available columns for the content types that you selected in the Search dropdown.

2. Do one of the following steps for each checkbox:
   - To add a column to search results, select the checkbox next to the name of the column.
   - To remove a column from search results, clear the checkbox next to the name of the column.

Figure 94 Field Chooser

Note: The columns in the grid automatically fit to the visible area. There is no horizontal scrollbar. If you resize a column width, all other column widths adjust.
Editing search properties

Refer to:
- “Considerations and limitations” on page 191
- “About the "Always search full text indexes" checkbox” on page 191
- “Procedure: Editing search properties” on page 193
- “Warning when multiple users are working with the same search” on page 195

Considerations and limitations

- You can edit all properties for a current search that has not yet run.
- You can edit only the Maximum search results field for a current search that has run.
- You cannot edit search properties while a current search is running.
- You cannot edit search properties for a search instance (a past occurrence of a search). For more information about past occurrences of searches, refer to “Viewing search history” on page 213.

About the "Always search full text indexes" checkbox

In the Search Properties dialog, use the Always search full text indexes checkbox to specify whether to search full-text indexes:
- Select the Always search full text indexes checkbox if you want to find items by searching full-text indexes (a full-text search). Refer to “Searching for senders or recipients on embedded messages” on page 192 for an example of a full-text index search.
- Clear the Always search full text indexes checkbox if you want to find items by only searching the database (a relational search).

The Application Administrator can specify the default for the Search Full Text Indexes option in Administration > Configuration. That setting becomes the default for the Always search full text indexes checkbox in Search Properties.
Collecting Content for Matters

Note: If you want to gather information quickly to begin case assessment, then clearing the **Always search full text indexes** checkbox is useful. However, you may receive many false positives (items that are not actually relevant) or you may not receive items that are relevant.

Note: If the **Always search full text indexes** checkbox is cleared, Discovery Manager may still perform full-text searches in certain cases. By default, some search fields (such as Keyword, Subject, Body, Sender Domain, and Recipient Domain) perform a full-text index search on messages in the EMC SourceOne Native Archive. A full-text index search also occurs if you manually enter values in an address field.

Note: In versions of Discovery Manager before 7.0, this option was labeled **Always search embedded messages**. Discovery Manager 7.0 retains your existing setting on old searches until you manually change it.

**Searching for senders or recipients on embedded messages**

The **Always search full text indexes** checkbox affects results of searches involving the Sender and/or Recipient search fields:

- If you select the **Always search full text indexes** checkbox when using Sender and/or Recipient search fields, then Discovery Manager:
  - Performs a **full-text index search** on the Sender and/or Recipient fields.
  - Returns items with embedded messages that match the specified criteria.

- If you clear the **Always search full text indexes** checkbox when using Sender and/or Recipient search fields, then Discovery Manager:
  - Performs a database search (relational search) on the Sender and/or Recipient fields.
  - Does not return items with embedded messages that match the specified criteria.

**Example**

For this example, assume the following two messages are in the archive:

- Message1 has recipient C, and does not contain an embedded message.
Message2 has recipients A and B, and contains an embedded message that has recipient C.

If you specify recipient C in the Recipient field, then the search results depend on whether you selected the **Always search full text indexes** checkbox:

- If you selected the **Always search full text indexes** checkbox, then both Message 1 and Message 2 are returned.
- If you cleared the **Always search full text indexes** checkbox, then only Message1 is returned.

**Procedure: Editing search properties**

To edit search properties, including specifying the folders to search:

1. Do one of the following steps:
   - In the navigation pane under the **Collection Area** node, right-click the search node, then select **Properties**.
   - In the work pane, click the dropdown arrow at the right of the unlabeled keyword field, then select **Search Properties**.
   - Click the search node under the **Collection Area** node, then in the ribbon pane, select **Search/Export** tab > **General**.

The Search Properties dialog box opens.
Collecting Content for Matters

Figure 95 Search Properties

2. (Optional) To specify the maximum number of search results, edit the Maximum search results field. The default is set by the Application Administrator.

Typically, you would adjust this value after testing search criteria. For example, you could run the search using the default value. If you are satisfied with the results, you could increase the Maximum search results value and re-run the search.

Refer to “Behavior of Maximum Search Hits (Maximum Search Results)” on page 194.

3. Do one of the following steps:
   - To perform a full-text index search, select the Always search full text indexes checkbox.
   - To perform only a database search (relational search), clear the Always search full text indexes checkbox.

Refer to “About the ”Always search full text indexes” checkbox” on page 191.

4. To specify folders to search, refer to “Specifying folders to search” on page 196.

Behavior of Maximum Search Hits (Maximum Search Results)

The Application Administrator can specify the Maximum Search Hits value in Administration > Configuration. This value becomes the default for the Maximum Search Results in Search Properties.
Investigators can change the Maximum Search Results value in Search Properties.

However, the maximum number of results you get depends on whether the Maximum Search Results value you specify is less than, greater than, or an exact multiple of 5,000 (the internal batch size used to put search results into the database).

Refer to the following table.

<table>
<thead>
<tr>
<th>Value of Maximum Search Results setting</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Less than 5,000</td>
<td>The number of results will not exceed the Maximum Search Results value, as expected.</td>
</tr>
<tr>
<td>Equals an exact multiple of 5,000</td>
<td>The number of results will not exceed the Maximum Search Results value, as expected.</td>
</tr>
<tr>
<td>Greater than 5,000 but not an exact multiple of 5,000</td>
<td>The number of results may exceed the Maximum Search Results value, up to an extra 4,999 results.</td>
</tr>
</tbody>
</table>

**Warning when multiple users are working with the same search**

In the full edition of Discovery Manager, more than one user can work with a search at the same time.

For example:

1. User1 creates a search called Search1 and opens the Search Properties dialog box.
2. User2 starts Discovery Manager and runs Search1.
3. User1, who still has the Search Properties dialog box open for Search1, makes some changes and clicks OK to close dialog box.
4. User1 sees the following warning: *This search has already been executed. Only the "Max Search Results" value will be saved.*
5. User1 clicks OK to close the warning dialog.

Only the **Maximum search results** value is saved because the search was run by User2 before User1 clicked OK. That is the only value that can be changed after a search runs.
Specifying folders to search

In Discovery Manager express edition, the user sees a list of all folders for which the SourceOne service account has Read All permission. The user can select one or more folders from those in the list.

In the full edition of Discovery Manager:

- The Matter Manager specified the available folders to search for the standard matter.
- An Investigator can select one or more folders to search from the available folders for the matter.

Refer to:

- “Considerations and limitations” on page 196
- “Procedure: Specifying folders to search” on page 197

Considerations and limitations

- You must select at least one folder to search.
- You can select search folders before a search runs. You cannot select different search folders after a search runs.
- The non-hold folders you specify apply only to collection searches.

Note: Hold folders are available in the full edition of Discovery Manager.

- Review searches only apply to messages that have been assigned to a matter. For a review search, any associated hold folder is automatically selected, and you cannot deselect it. Review searches do not search non-hold folders. Refer to “Reviewing Content in Matters” on page 295.

Note: Matter Review and review searches are available in the full edition of Discovery Manager.

- If you check the Search all matter folders checkbox in Search Properties, and then the Matter Manager changes the selected search folders in Matter Properties, the search results will reflect the folders selected in Matter Properties. Any folder added by the
Matter Manager to Matter Properties will be included in the search. Any folder removed by the Matter Manager from Matter Properties will be excluded by the search.

**Note:** The Matter Manager role is available in the full edition of Discovery Manager.

- If you check the **Search all matter folders** checkbox in Search Properties, any changes to the matter folder properties will be reflected in the search properties dialog of the search root node. You cannot open the properties of a search instance (a search that has run).

**Procedure: Specifying folders to search**

To specify search folders:

1. Do one of the following steps:
   - In the work pane, click the dropdown arrow at the right of the keyword field, then select **Search Properties**.
   - In the navigation pane under the **Collection Area** node, right-click the search node, then select **Properties**.
   - In the navigation pane under the **Collection Area** node, click the search node, then select **Search/Export** tab > **General** in the ribbon pane

The Search Properties dialog box opens.
Collecting Content for Matters

Figure 96 Search Properties

2. Do one of the following steps:
   
   • To search all folders, select the **Search all matter folders** checkbox.

   **Note:** The **Search all matter folders** checkbox is available for collection searches, not in-matter (review) searches.

   • To select folders:
     a. Clear the **Search all matter folders** checkbox.
     b. Select the checkbox next to each folder that you want to search.
     c. Clear the checkbox next to each folder that you do not want to search.

3. Click **OK** to close the Search Properties dialog box.

**Specifying search criteria**

Refer to:

- “Specifying Search Criteria” on page 233
- “Using the Search Expression Field” on page 279
Scheduling a search

Note: You can schedule searches in the full edition of Discovery Manager.

You can run a search immediately using the Find button, or you can schedule a search to run later.

IMPORTANT
Before you schedule a search, ensure that you specify all of the search criteria. Once you schedule the search, you cannot change the search criteria unless you perform the steps described in “Procedure: Reverting a scheduled search” on page 200.

Procedure: Scheduling a search

To specify a schedule for a search:

1. Do one of the following steps:
   - Click the search node under the Collection Area node, then select Search/Export tab > Schedule in the ribbon pane.
   - In the work pane, click the Find dropdown arrow, then select Find Later.

The Schedule Search dialog box opens.
2. In the **Execute search on** field, specify the date and time at which the scheduled search should start:
   a. To specify a date, click the dropdown arrow in the first field, then select a date from the calendar.
   b. To specify a time, edit the default time.
3. Click **Schedule** to save your changes and to close the Schedule Search dialog box.

The word "Scheduled" next to the search indicates that the search is scheduled to run in the future.

**Note:** The name of the scheduled search instance is the creation date. To view the scheduled start date, first go to the Collection Area node or a folder node to display the grid that contains the search. Then add the scheduled start date column using the Field Chooser as described in “Adding and removing columns” on page 190.

For more information, refer to “Running a collection search” on page 207.

**Procedure: Reverting a scheduled search**

Before you schedule a search, ensure that you specify all of the search criteria. Once you schedule the search, you cannot change the search criteria unless you perform the following steps:

1. Delete the scheduled search instance.
2. Collapse/expand the Collection Area node.
You can now change the search criteria.

**Viewing a collection search**

**Note:** This section applies to both editions of Discovery Manager.

To view an existing collection search for a matter, in the navigation pane:

1. **Click the My Matters button or the All Matters button.**
   
   **Note:** The All Matters button is available in the full edition of Discovery Manager.

2. Expand the matter.

3. Do one of the following steps:
   
   - Expand the **Collection Area** node (and the folder, if necessary), then click the search.
   - Click the **Collection Area** node, then double-click the search in the list in the work pane.

   The work pane displays the search criteria and the latest search results, if any.

If you navigate away from a new search that has not run and then navigate back to the new search, then the search criteria is hidden. If the search has run, then the search criteria area is hidden and not editable.

To display the search criteria area, click the double arrow at the far right of the Search field.

![Figure 98 Toggle display of search criteria (far right of Search field)](image-url)
Collecting Content for Matters

Copying a collection search

Note: This section applies to both editions of Discovery Manager.

To copy a collection search for a matter, in the navigation pane:

1. Click the My Matters button or the All Matters button.

   Note: The All Matters button is available in the full edition of Discovery Manager.

2. Expand the matter.
3. Expand the Collection Area node.
4. Select the search you want to copy under the Collection Area node, then do one of the following steps:
   - Right-click the search, then select Copy from the shortcut menu.
   - In the ribbon, select Matter tab > Copy.

   A new search appears under the Collection Area node.
5. Edit the name of the new search.

   Note: The names of collection searches do not have to be unique within the Collection Area of a matter.
6. Press Enter.
7. In the work pane, specify search criteria as described in “Overview: Specifying collection search criteria” on page 234.

Renaming a collection search

Note: This section applies to both editions of Discovery Manager.

To rename a collection search for a matter, in the navigation pane:

1. Click the My Matters button or the All Matters button.
Using folders to organize collection searches

Note: The All Matters button is available in the full edition of Discovery Manager.

2. Expand the matter.
3. Expand the Collection Area node.
4. Select the search under the Collection Area node, then do one of the following steps:
   • Right-click the search, then select Rename from the shortcut menu.
   • In the ribbon, select Matter tab > Rename.
5. Right-click the search, then select Rename from the shortcut menu.
   The name of the search is highlighted.
6. Edit the name of the search.

Note: The names of collection searches do not have to be unique within the Collection Area of a matter.

8. Press Enter.

Using folders to organize collection searches

Note: Folders to organize collection searches are available in the full edition of Discovery Manager.

To organize collection searches, you can create folders under the Collection Area node in the navigation pane. For example, Investigators may want to create folders to organize their work.

These organizing folders:
◆ Are optional
◆ Can be only one level deep (no nested folders)

You can:
◆ Create organizing folders at any time.
Collecting Content for Matters

- Rename organizing folders.
- Drag-and-drop searches from one organizing folder to another within a matter:
  - You can drag a collection search from one folder to another folder in the Collection Area.
  - You can drag a review search from one folder to another folder in the Matter Review area.
  - You cannot drag a collection search from the Collection Area to Matter Review, or a review search from Matter Review to the Collection Area.
  - You cannot drag searches from one matter to another matter.

Refer to:
- “Creating folders to organize searches: Collection Area” on page 204
- “Renaming organizing folders: Collection Area” on page 205
- “Deleting organizing folders: Collection Area” on page 206

Creating folders to organize searches: Collection Area

Note: Folders to organize searches are available in the full edition of Discovery Manager.

To create a folder to organize collection searches, in the navigation pane:

1. Click the My Matters button or the All Matters button.

   Note: The All Matters button is available in the full edition of Discovery Manager.

2. Expand the matter for which you want to create the folder.

3. Do one of the following steps:
   - Click the Collection Area node in the navigation pane, then select Matter tab > New Folder.
     If there are no organizing folders or searches, then you can do one of the following steps:
Using folders to organize collection searches

Collecting Content for Matters

– Click the New Folder (Ctrl-F) link in the work pane.
– Click in the work pane, then press Ctrl-F.

• Right-click the Collection Area node, then select New Folder.
A folder named New Folder appears in the navigation pane, under the Collection Area node.

4. Edit the name of the new folder.

Note: The names of organizing folders do not have to be unique within the Collection Area of a matter.

Figure 99 New Folder

5. Press Enter.

Renaming organizing folders: Collection Area

Note: Folders to organize collection searches are available in the full edition of Discovery Manager.

To rename a folder used to organize collection searches:

1. Click the My Matters button or the All Matters button.

Note: The All Matters button is available in the full edition of Discovery Manager.

2. Expand the matter and the Collection Area node containing the folder you want to rename.
3. Right-click the folder, then select Rename.
4. Edit the highlighted name of the folder.
5. Press Enter.
Collecting Content for Matters

Deleting organizing folders: Collection Area

**Note:** Folders to organize collection searches are available in the full edition of Discovery Manager.

**Note:** You can delete empty organizing folders. You cannot delete organizing folders that contain searches.

To delete a folder used to organize collection searches, in the navigation pane:

1. Click the **My Matters** button or the **All Matters** button.
   
   **Note:** The All Matters button is available in the full edition of Discovery Manager.

2. Expand the matter and the **Collection Area** node containing the folder you want to delete.

3. Right-click the folder, then select **Delete**.
Running a collection search

You can run multiple searches at the same time in a matter, and in the full edition of Discovery Manager, in multiple matters.

Searches continue to run after you exit the Discovery Manager application.

To run a collection search immediately, click the **Find** button.

In the full edition of Discovery Manager, to schedule a search to run at the date and time you specify, refer to “Scheduling a search” on page 199.

If you did not specify any search criteria, then the following prompt displays: No search criteria was specified. Running this search will return all items in the archive. Are you sure you want to continue?

If you did not select at least one folder to search, then you are prompted to select folders.

Re-running a collection search

Note: This section applies to both editions of Discovery Manager.

You can rerun a collection search. However, you cannot edit the search criteria or the search folders for a collection search that has run.

Re-running a search produces differential search result sets. Successive runs of the same search will report only messages that were not found in the previous run. If no new results are found when you re-run a search, then the work pane displays No new results were found.

To view the previous result sets for a search that has been run multiple times, refer to “Viewing search history” on page 213.

**Example**

Assume that you create an open-ended search to collect all messages with message dates after 1/1/08, and that you run the search in an environment that is ingesting new mail.

In this example:

- The first time you run the search, 1,000 messages meet the criteria. The search results will list 1,000 messages.
Collecting Content for Matters

◆ The next time you run the same search, 10 new messages meet the search criteria.
  ◆ The results for the search name node shows a total of 1,010 messages (1000+10).
  ◆ The results for the first search instance shows 1,000 messages.
  ◆ The results for the second search instance shows 10 messages.

Monitoring search progress

Note: This section applies to both editions of Discovery Manager.

Refer to:
◆ “Search-in-progress indicators” on page 208
◆ “Stopping a running search” on page 209

Search-in-progress indicators

Note: This section applies to both editions of Discovery Manager.

While a search is running:
◆ The Collection Area displays the search status in the list of searches.
◆ Under the Collection Area node, the name of the search is italicized.
◆ The status of the search (Created, Waiting, Queued, Running, Completed) is displayed next to the search node and in the list of searches.
◆ The label on the Find button changes to Stop Search.
◆ A progress bar displays below the search criteria area.
◆ The word Searching... displays in the search results area.

To monitor the status of all operations in progress for a selected matter, including searches, refer to “Monitoring status of operations for a matter” on page 230.
Stopping a running search

**Note:** This section applies to both editions of Discovery Manager.

To stop a running search, click the **Stop Search** button in the search criteria area.

When you click the Stop Search button, the search does not stop immediately. It can take up to two minutes for a search to stop.

Also refer to “Changing search status” on page 209.

Changing search status

**Note:** This section applies to both editions of Discovery Manager.

To view search status, refer to “Viewing a collection summary report” on page 184.

You can stop a running search, and start a stopped search. When you start a stopped search, the search starts over again from the beginning; it does not resume.

To change the status of a collection search, in the navigation pane:

1. Click the **My Matters** button.
2. Expand the matter.
3. Expand the **Collection Area** node.
4. Do one of the following steps:
   - Right-click the search, then select the appropriate action (**Start** or **Stop**) from the shortcut menu.
   - Click the search, then click the appropriate action (**Start** or **Stop**) in the Search/Export tab in the ribbon pane.

**Note:** The available actions vary, depending on the current state of the search.

Also refer to “Stopping a running search” on page 209.
Viewing search errors

Note: This section applies to both editions of Discovery Manager.

If an error occurs when you specify search criteria or when you run the search, then an error message displays in the search error bar (a yellow area below the search criteria).

Figure 100 Search error bar - example 1

The search error bar displays if you:

- Click on a past occurrence of a search that failed.
- Click Find, and the current search results in an error.

The search error bar does not persist for a completed current search after you navigate away from the current search, and then return to the current search. Click on the past occurrence of the search to see the errors for that occurrence. Refer to “Viewing search history” on page 213 for more information about viewing past occurrences of a search.

Refer to:

- “Errors when specifying search criteria” on page 210
- “Errors when running a search” on page 211
- “Saving error information” on page 212

Errors when specifying search criteria

For example, errors can occur when you specify search criteria if:

- You specify an identity, but Discovery Manager was unable to retrieve the associated addresses, or the identity does not have any associated addresses.

Note: Identities are available in the full edition of Discovery Manager.
You select a name from the Address Book dialog box, but Discovery Manager cannot resolve that name.

Errors when running a search

Note: This section applies to both editions of Discovery Manager.

If errors occur when you run a search, an error message displays in the search error bar.

Figure 101  Search error bar - example 2

Click the search error bar to view error details in the Search Errors dialog box.

Figure 102  Search Errors
Saving error information

Note: This section applies to both editions of Discovery Manager.

The Search Error dialog box displays more detailed error information if errors or warnings are encountered when a search runs. You can save the error information as plain text or as XML. EMC personnel can use the XML file for troubleshooting purposes.

- The Copy To Clipboard button saves the error information to the clipboard as plain text.
- The Save button opens a Save As dialog box. By default, the file format is XML, and the filename is `SearchErrors_<today's date>`.

Contents of XML file

For each search error, the XML file lists:

- `<Type>` - the specific search task error code, as an integer
- `<DisplayName>` - the localized error message associated with the error code
- `<Value>` - the error returned from the search engine

Example: XML file

```xml
<?xml version="1.0" encoding="utf-16"?>
<SearchErrors>
  <SearchError Type="22">
    <DisplayName>Missing items in index</DisplayName>
    <Values>
      <Value>Error Detail: 16:(archivefolder1_201004_001) (1 / 10) Search results may be be incomplete, \sql2005\emc\index\archivefolder1\201004\001 is incomplete. (0x86042D09) (0x86044109)</Value>
    </Values>
  </SearchError>
  <SearchError Type="10">
    <DisplayName>Index is inconsistent</DisplayName>
    <Values>
      <Value>Error Detail: 04:(archivefolder1_200807_001) (10 / 10) Search results may be incomplete, \sql2005\emc\index\archivefolder1\200807\001 is corrupt. (0x86042D08) (0x86044109)</Value>
    </Values>
  </SearchError>
</SearchErrors>
```
Viewing search history

Note: This section applies to both editions of Discovery Manager.

You can:
◆ View a list of all the dates and times on which a search ran.
◆ Select a past occurrence of the search and display the results.

Note: Search results are incremental. Refer to “Re-running a collection search” on page 207.

To view the history of a search, in the navigation pane:
1. Click the My Matters button.
2. Expand the matter > Collection Area node > optional folder > search.

Each icon indicates an occurrence of the search. Also displayed are the date and time for each occurrence.

Note: When the Discovery Manager client computer and the SQL server are in different time zones, the creation date/time displayed for a search instance is not converted from the SQL server date/time to client date/time. The search instance tree node reflects the time that the search was created; the time is not converted to local time. The date in the tree is actually the name of the search and it is static after it is created. Outside of the tree nodes, the creation date is converted to local time, (for example, in reports).

3. To view the results of a past occurrence of the search, click on the occurrence.

The work pane displays the results for that occurrence. The search criteria are dimmed.
Collecting Content for Matters

Figure 103  Viewing search history
Viewing results of a collection search

Note: This section applies to both editions of Discovery Manager.

When a collection search completes successfully, the Results tab in the work pane displays the search results.

![Search results - example](image)

Figure 104 Search results - example

Refer to:
- “Refreshing grids” on page 215
- “Displaying duplicates in search results” on page 215
- “Understanding collection search results” on page 217
- “Customizing display of search results” on page 217
- “Previewing items” on page 220
- “Opening items” on page 224

Refreshing grids

To update grids, navigate away from the grid (for example, select another search node), and then navigate back to the grid.

Displaying duplicates in search results

Note: This section applies to both editions of Discovery Manager.
Collecting Content for Matters

Note: You can display duplicate messages in collection search results, not in in-matter (review) search results.

Note: Collection searches created before Discovery Manager 7.0 do not allow the display of duplicates. Rerunning old collection searches will not enable them to display duplicates. You must copy old collection searches and run them before you can display duplicates in those search results.

The concept of "duplicates" has two meanings in SourceOne and in this chapter, depending on the archive:

- Duplicate messages with the same Entry ID may exist in legacy EmailXtender archives.
- SourceOne allows for instances of an item to be archived to different mapped folders. Each copy has different metadata.

By default, duplicate messages are not displayed in collection search results:

- All instances of the duplicate item are collapsed and displayed as a single row in search results.
- To see a list of all of the source folders in which the duplicate item was found, select the item, then expand the Additional Information section.

To enable the display of duplicate messages in collection search results, in the ribbon select Home tab > Duplicates > Show.

Note: The Duplicates toggle is applied to all 7.0 or later collection search grids, not just to the collection search grid that you are currently viewing. The toggle stays in effect for the entire session until you change it. It is not available for collection searches that were created before version 7.0 of Discovery Manager.

Although the Duplicates command is available when other grids are displayed (such as the Export grid), it toggles the display of duplicates only in collection search grids.

It is not available when you click the Administration button or the Identities button in the navigation pane.

When duplicate messages are displayed in search results:

- In the work pane, the Results tab displays Showing duplicates.
- Each instance of the duplicate item is displayed on a separate row in search results.
The expanded Additional Information section shows the name of the source folder in which the selected instance was found.

Understanding collection search results

By default, not all columns that are available for the selected item type are displayed in search results. To add or remove columns in search results, refer to “Adding and removing columns” on page 190.

For a list of columns available for each item type, refer to “Columns in search results” on page 423.

Customizing display of search results

Note: This section applies to both editions of Discovery Manager.

Refer to:
- “Increasing size of search results area” on page 217
- “Adding and removing columns” on page 190
- “Changing order of columns” on page 218
- “Changing sort column and sort order” on page 218
- “Changes to grids are saved automatically” on page 219

Increasing size of search results area

Note: This section applies to both editions of Discovery Manager.

To increase the size of the search results area, do any combination of the following steps:
- Maximize the application window.
- Minimize the ribbon pane by doing one of the following steps:
  - Double-click a tab in the ribbon pane.
  - Press Ctrl-F1.
  - In the Quick Access Toolbar, click the down arrow, then select Minimize the Ribbon from the shortcut menu.
Collecting Content for Matters

- Minimize the navigation pane by clicking the double arrow (<<) at the top of the navigation pane.

- Toggle the display of the search criteria area by doing one of the following steps:
  - In the ribbon pane, select **Expand/Collapse** in the Search/Export tab.
  - Click the double arrow to the right of the Search field.

- Drag the bottom edge of the work pane down over the detail pane.

## Changing order of columns

**Note:** This section applies to both editions of Discovery Manager.

To change the order of columns in search results, drag-and-drop a column label to the left or right, as appropriate. Red arrows indicate where to drop the column label.

## Changing sort column and sort order

**Note:** This section applies to both editions of Discovery Manager.

To specify the column on which to sort results, click that column header.

To toggle between ascending order and descending order, do one of the following steps:

- Click that column header again.
- Use the sort options on the Home tab in the ribbon pane.

**The State column does not sort alphabetically in the collection grid**

The **Sort A to Z** and **Sort Z to A** options in the Home tab of the ribbon do not sort alphabetically on the State column in the collection grid.
All entries with the same state are grouped together. For example, all entries with the "Copying" state are grouped together in the list, as are entries for the "On Hold" state. However, the groups may not appear in the correct alphabetical order. For example, all of the entries with the "On Hold" state may be listed before all of the entries with the "Copying" state:

```
On Hold
On Hold
On Hold
On Hold
Copying
Copying
```

### Changes to grids are saved automatically

**Note:** This section applies to both editions of Discovery Manager.

The changes you make to columns (size, width, order) are saved automatically to your computer for the following grids:

- All Matters (available in the full edition of Discovery Manager)
- My Matters
- My Matters > matter > Collection Area
- My Matters > matter > Collection Area > search folder
- My Matters > matter > Collection Area > search
- My Matters > matter > Collection Area > search > past occurrence of a search
- My Matters > matter > Matter Review > All Items

Column settings are applied to the appropriate content type. For example, changes you make to columns in an Email Message view will not be applied to a File view.

Changes to a grid in one matter are automatically applied to the same grid in all of your matters in My Matters.

Changes to the sort order on a column in one grid are automatically applied to the same column in all other grids that contain that column in the matter. For example, if you change the sort order on the Name column in one grid, then the sort order on the Name column in other grids will change.

Changes are retained after you log out.
Collecting Content for Matters

Previewing items

Discovery Manager express edition can search for and preview email content.

Discovery Manager full edition can search for and preview all content types, except where noted.

The information displayed in the preview pane depends on the content type of the selected item.

Refer to:

◆ “Previewing email messages” on page 220
◆ “Previewing other email content types” on page 221
◆ “Previewing files” on page 222
◆ “Previewing SharePoint content” on page 223

General considerations

◆ When you use the up and down arrow keys to move through the search results, the preview pane waits for 200 milliseconds after you release the key before updating.

◆ If an item has an attachment, then the preview pane displays a link to the attachment. Click on the link to open the attachment. If you do not have an application associated with the attachment’s file type, then an error displays: Unable to open file. No application associated with this file type.

Previewing email messages

In Discovery Manager express edition, all users have the Search and Export role, and can preview email messages.

In Discovery Manager full edition, you must have the Investigator role to preview email messages.

To preview a message, click the message in the search results.

If Discovery Manager cannot preview the message, then Unable to obtain the preview for this message – double-click on it to open it in the native viewer displays.

If Discovery Manager can preview the message, then the preview pane displays the message header (message metadata) and the message body.
To view more metadata and routes, expand the Additional Routes and Metadata section. Additional routes includes the message owner and recipients (To, Cc, Bcc). The owner depends on the method used to archive the message:

- If the message was archived using Journaling, then everyone who receives the message is an owner.
- If the message was archived using Historical Archiving, then the mailbox is the owner.

**Figure 105 Preview message - additional routes and metadata**

Tags and custodians are listed in the message header, if they have been assigned to the message.

**Figure 106 Preview message - tags assigned**

The header also displays the names of attachments. To open attachments, open the message first, as described in “Opening email messages” on page 224.

**Previewing other email content types**

To preview email items other than messages, such as contacts or tasks, click the item in the search results.

The preview pane displays the metadata and links to attachments. Expand the Additional Information section to view:

- The name of the search folder in which the item was found
- The names of additional recipients
Previewsing files

**Note:** You can preview files in the full edition of Discovery Manager.

To preview a file, click the file in the search results.
The preview pane displays the file metadata and a link to the file.
To view the locations of the file, expand the Additional Information section.
Collecting Content for Matters

Previewing SharePoint content

Note: You can preview SharePoint content in the full edition of Discovery Manager.

To preview a SharePoint item, click the item in the search results.
The preview pane displays the item metadata and, if the item has an attachment, a link to the attachment.
Opening items

Discovery Manager express edition can search for and open email content.

Discovery Manager full edition can search for and open email and files.

Refer to:
◆ “Opening email messages” on page 224
◆ “Opening files” on page 225

Opening email messages

Note: This section applies to both editions of Discovery Manager.

Considerations and limitations: Opening email messages
◆ To open a message, the native email client application must be installed on the Discovery Manager client computer. To view attachments, the message must be opened in its native format.
◆ The ONM Viewer does not support the viewing of repeating Notes Notices. If you attempt to view a repeating Notice, an error message displays: Restore or viewing of repeated Notes messages from the archive is not currently supported.
◆ When you view a message natively, the times displayed in Outlook and Notes may be different from what is displayed in Discovery Manager (express edition or full edition). Outlook and Notes displays the Sent time of the message, while Discovery Manager displays the Received time of the message.
◆ Messages are read-only when downloaded and opened.

Procedure: Opening email messages
To open a message in the native email client application, double-click the message in the search results.
◆ A copy of the message is downloaded to the Discovery Manager express edition or Discovery Manager client computer and temporarily placed in the Message directory in the application install directory.
◆ The copy of the message is opened read-only in the native email client.
After a minute passes, if the file is not in use, the temporary copy of the message is removed from the Message directory.

If you edit the opened message and try to save the modified message, an error dialog box appears: Your changes cannot be saved because you don’t have permission to modify some or all of the items in this folder. Do you want to save a copy of this item in the default folder for the item?

Do one of the following steps:

◆ To retain the copy of the unedited message in the Message directory and prevent it from being removed, click Yes.

◆ To allow the copy of the unedited message to be removed as usual, click No.

Opening files

Note: You can open files in the full edition of Discovery Manager.

Considerations: Opening files

◆ To open a file in Discovery Manager full edition, the file’s native client application must be installed on the Discovery Manager client computer. For example, to open a Microsoft Word .doc file, you must have Microsoft Word installed on the Discovery Manager client computer.

◆ If your system manager excluded a file type from opening, then an error displays when you attempt to open files of that type.

Procedure: Opening files

To open a file in its native application, double-click the file in search results.
Collecting Content for Matters

Selecting results

Before you can perform certain actions on results (such as assigning to a matter or deleting), you must select them, as described in the following table.

Table 31  Selecting results

<table>
<thead>
<tr>
<th>To select</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single result</td>
<td>Click</td>
</tr>
<tr>
<td>Multiple contiguous results</td>
<td>Shift-Click</td>
</tr>
<tr>
<td>Multiple non-contiguous results</td>
<td>Ctrl-Click</td>
</tr>
<tr>
<td>All results</td>
<td>Ctrl-A</td>
</tr>
<tr>
<td>All results from current selection to end of set</td>
<td>Click-Shift-End</td>
</tr>
<tr>
<td>All results from current selection to beginning of set</td>
<td>Click-Shift-Home</td>
</tr>
</tbody>
</table>

The status bar displays the total number of items in the search results, and the number of selected items.
Assigning collection search results to a standard matter

**Note:** Assigning results to a standard matter is available in the full edition of Discovery Manager.

Search results that are assigned to a standard matter with a hold folder are copied to the hold folder and then re-indexed.

Assigning duplicate instances to a matter rolls up all selected instances into one instance. The metadata for all selected instances is rolled up into one assigned instance.

**Note:** Custodians are available in the full edition of Discovery Manager. If there are no custodians assigned to the matter, then the Assign All Results to Matter with Custodians and the Assign Result to Matter with Custodians options are not available.

To assign search results to a standard matter, do one of the following steps:

- To assign all search results, right-click the search name node or a search date node, then select one of the following options:
  - Assign All Results to Matter
  - Assign All Results to Matter with Custodians - Then select the appropriate custodian from the All Custodians dialog box and click OK.

  A progress bar displays.

- To assign selected search results:
  a. Select the results you want to assign, as described in “Selecting results” on page 226.

  Selected results are shaded.

  b. Right-click anywhere in the search results, then select one of the following options:

    - Assign Result to Matter
    - Assign Result to Matter with Custodians - Then select the appropriate custodian from the All Custodians dialog box and click OK.

  A progress bar displays.
If the results are assigned to a standard matter that does not have a hold folder, then the status of each result changes from Unassigned to Assigned.

If the results are assigned to a standard matter that does have a hold folder, then the status of each result changes from Unassigned to Copying.

To view the final status of the results after the progress bar completes, click another node, then click the search node again. (There is no Refresh option.) If the copy process completes, then the status of the results assigned to a standard matter with a hold folder changes from Copying to On Hold.

To monitor the status of all operations in progress for a selected standard matter, including assignments, refer to “Monitoring status of operations for a matter” on page 230.

To review results that have been assigned to a standard matter, refer to Chapter 11, “Reviewing Content in Matters.”
Deleting a search

Note: This section applies to both editions of Discovery Manager.

Considerations and limitations

◆ You can delete a search that has not run or a search that has completed. You cannot delete a search that is running.
◆ You can delete the most recent search instance (the most recent of the past occurrences of a search). If you try to delete any search instance other than the most recent one, then an error message displays: Cannot delete the search instance. Only the last search instance can be deleted. Refer to “Viewing search history” on page 213 for information about viewing past occurrences of a search.
◆ You cannot delete a collection search while items in it are being copied to a hold folder. If you attempt to do so, an error displays: Cannot delete a collection search containing items that are copying or failed to copy to the hold folder.

Procedure

To delete a collection search (current or most recent past occurrence) from a matter, in the navigation pane:

1. Click the My Matters button.
2. Select the matter from the dropdown list.
3. Expand the Collection Area node (and the search node if you are going to delete the most recent past occurrence of the search).
4. Do one of the following steps:
   • Right-click the search, then select Delete from the shortcut menu.
   • Select the search, then click Home tab > Delete on the ribbon.
5. At the Search Delete or Search Instance Delete confirmation prompt, click OK to confirm the delete.
Collecting Content for Matters

Monitoring status of operations for a matter

Note: This section applies to both editions of Discovery Manager, except as noted.

Refer to:
- “Understanding status” on page 230
- “Viewing running jobs” on page 231

Understanding status

In the results grid, the Status column indicates the status of items assigned to a matter, copied to a hold folder, or deleted from a matter.

- Unassigned - The item has not been assigned to a matter.
- Copying - The item is in the process of being copied to the matter hold folder.
- On Hold - The item has been copied to the matter hold folder.
- Assigned - The item has been assigned to a matter.
- Deleting - The item is in the process of being deleted from the matter.

Note: Hold folders and assigning messages are available in the full edition of Discovery Manager.

An item can display multiple states, as listed in the following table.

<table>
<thead>
<tr>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unassigned</td>
</tr>
<tr>
<td>Assigned</td>
</tr>
<tr>
<td>Assigned, OnHold</td>
</tr>
<tr>
<td>Assigned, Copying to Hold</td>
</tr>
<tr>
<td>Assigned, Copying to Hold Failure</td>
</tr>
</tbody>
</table>
Collecting Content for Matters

Monitoring status of operations for a matter

1. In the navigation pane, under All Matters or My Matters, select the matter node or any of its subnodes (Collection Area, Matter Review, Export, or search nodes).

   Note: The All Matters area is available in the full edition of Discovery Manager.

2. In the ribbon, click Matter tab > View running jobs.

   In the Running Jobs window:
   • The operations are listed for the matter.
   • The list refreshes every 5 seconds
   • Possible job states include:

<table>
<thead>
<tr>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned, Deleting</td>
</tr>
<tr>
<td>Assigned, OnHold, Deleting</td>
</tr>
<tr>
<td>Assigned, Delete Failed</td>
</tr>
<tr>
<td>Assigned, OnHold, Delete Failed</td>
</tr>
</tbody>
</table>

In the grid, a red entry indicates a failed operation, such as a copy to hold folder failure.

Note: To update grids, navigate away from the grid (for example, select another search node), and then navigate back to the grid.

### Table 32 Status column, multiple states

<table>
<thead>
<tr>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned, Deleting</td>
</tr>
<tr>
<td>Assigned, OnHold, Deleting</td>
</tr>
<tr>
<td>Assigned, Delete Failed</td>
</tr>
<tr>
<td>Assigned, OnHold, Delete Failed</td>
</tr>
</tbody>
</table>

---

**Viewing running jobs**

To monitor the status of all operations (jobs) for a selected matter, including searches, result assignments, and exports:

1. In the navigation pane, under All Matters or My Matters, select the matter node or any of its subnodes (Collection Area, Matter Review, Export, or search nodes).

   Note: The All Matters area is available in the full edition of Discovery Manager.

2. In the ribbon, click Matter tab > View running jobs.

   In the Running Jobs window:
   • The operations are listed for the matter.
   • The list refreshes every 5 seconds
   • Possible job states include:
Completed operations are removed automatically from the list, so you may not see the state "Complete" displayed.

<table>
<thead>
<tr>
<th>Job state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waiting</td>
<td>The job is waiting to start processing items.</td>
</tr>
<tr>
<td>Queued</td>
<td>The job has been queued due to backend load.</td>
</tr>
<tr>
<td>Running</td>
<td>The job is actively processing items.</td>
</tr>
</tbody>
</table>

3. To view the status of operations for a different matter, select the matter in the Discovery Manager navigation pane.

The Running Jobs window updates to show the operations for the selected matter.

4. To close the Progress window, click OK.
This chapter describes how to use the fields in the search criteria area for collection searches.

Note: Most of this information also applies to in-matter searches (review searches). If you are performing an in-matter search, read “Working with in-matter searches” on page 306 first. In-matter searches are available in the full edition of Discovery Manager.

Note: The Search Expression field is not covered in this chapter. Refer to “Using the Search Expression Field” on page 279.

Refer to:

- Overview: Specifying collection search criteria........................... 234
- Specifying item types (content types) ........................................... 237
- Customizing search fields............................................................... 240
- Summary: How to search for text.................................................. 242
- Searching on keywords................................................................... 249
- Cutting and pasting paragraphs in text fields............................. 249
- How to AND and OR search terms............................................... 250
- Specifying attachment name .......................................................... 251
- Specifying recipient, sender, or owner for email items .............. 252
- Searching for archived files using the Owner field............... 264
- Performing domain searches.......................................................... 265
- Specifying a date .............................................................................. 270
- Specifying an item size................................................................. 272
- Using "Indexing Error" and "Any Unindexed Content"................. 273
- Searching on custom metadata ...................................................... 274
Specifying Search Criteria

- Clearing values from all search fields........................................... 278

For a complete list of available search criteria fields, refer to “Search Criteria Fields” on page 401.

Overview: Specifying collection search criteria

Note: This section applies to both editions of Discovery Manager.

Item type (content type)

The Search field displays the item type (content type) on which to search. The default is All.

You can select a different item type to search. Refer to “Specifying item types (content types)” on page 237.

Note: Discovery Manager express edition can search for email items. Discovery Manager full edition can search for all content types (email, files, SharePoint).

Search fields

The item type that you select in the Search field determines the default search fields. For a list of search fields available for each item type, refer to “Search Criteria Fields” on page 401.

You can:

- Change, add, and remove search fields. Refer to “Customizing search fields” on page 240.

- Clear the values from all search fields. Refer to “Clearing values from all search fields” on page 278.

Also refer to “Using the Search Expression Field” on page 279.

Considerations and limitations

- If you do not specify any search criteria in search fields, then all items in the archives will be returned for the selected content type, limited by the following values in Search Properties:
  - Maximum search results
  - Always search full text indexes

- For standard matters in the full edition of Discovery Manager, keywords that are defined by the Matter Manager in Matter Properties are displayed in the keyword field. The search will look for these keywords in the subject of the message. If you do
not want to search on a keyword, delete it from the keyword field. You can also add keywords. Refer to “Searching on keywords” on page 249.

◆ To search on text fields (such as Keyword, Subject, Body, or Attachment Content) the items must be full-text indexed. For more information on searching on text fields, refer to “Summary: How to search for text” on page 242.

◆ To search for content in attachments, including embedded email addresses, you must perform a full-text index search. Type a full or partial email address in an address field. Do not select addresses from the address book. Due to the way in which SourceOne Native Archive indexing treats attachments, addresses selected from the address book match only archived items, not their attachments.

◆ Multiple values in a search field are automatically ORed. To AND values, add a second, duplicate field. For example, to AND two senders, add a second Senders field. Refer to “How to AND and OR search terms” on page 250.

Note: The Search Expression field behaves differently. Refer to “Using the Search Expression Field” on page 279.

◆ Some characters are not indexed and are not searchable. Other characters are reserved. Refer to “Characters” on page 292.

◆ Consider the following differences in searching EmailXtender 4.8 SP1 archives and EMC SourceOne archives:

- If you search for messages archived in EmailXtender, the Attachment Content field and the Keyword field do not return results when used with other criteria. For example, if you search for a message that has an attachment and you use only the Attachment Content field, then the message is returned in search results. However, if you search for the same message using other fields in addition to the Attachment Content field (for example, the Body or Subject field), then the message is not returned in search results. Due to the way attachments are indexed in EmailXtender, you cannot search a keyword in attachments and any other part of the message at the same time in SourceOne.
Specifying Search Criteria

- The forward slash character (/) is a significant character in EMC SourceOne for compliance reasons. Searches will not be consistent across EmailXtender 4.8 SP1 servers that identify the forward slash character (/) as an insignificant character in the isys.cfg file.

- EmailXtender 4.x does not support multi-byte characters (MBCS) in IBM Lotus Domino messages. If a multi-byte Domino message is archived in EmailXtender 4x, Discovery Manager express edition or Discovery Manager may have problems finding the message in the EmailXtender archive when you perform searches by subject or keyword.

- You can specify multiple addresses in a single Sender field and/or in a single Recipient field. However, you should not use multiple Sender fields or multiple Recipient fields when searching against an EmailXtender archive. This is not supported as of SourceOne 6.5.2 and later.

- Searches that use the Owner field with the Sender field, the Recipient field, or the Sender Or Recipient field are not supported against an EmailXtender archive.

- Searches of EmailXtender archives may result in slow response times if you specify search criteria that is only supported by SourceOne (for example, the Sent Date field). Searches of EmailXtender archives are faster if you specify only the search criteria that EmailXtender supports:
  - Keyword
  - Date
  - Sender
  - Recipient
  - Owner
  - Subject
  - Body
  - Attachment Name
  - Attachment Content
  - Has Attachment
  - Size
  - Importance
  - Sensitivity
You cannot search for words in a Thai or Korean message because there are no spaces between words in a Thai or Korean sentence. Searches do not recognize the individual words because there are no spaces.

Search for Thai or Korean messages using a method other than searching words in the body of the message.

For searches against the EMC SourceOne Native Archive or the EMC EmailXtender 4.8 archive, the maximum number of search terms is 1024. For example, search criteria containing 1,000 addresses and 25 keywords would exceed the limit. This is an indexing limit.

**Specifying item types (content types)**

**Note:** This section applies to both editions of Discovery Manager, except where noted.

Refer to:
- “Introduction: Specifying item types (content types)” on page 237
- “Procedure: Specifying item types (content types)” on page 238

**Introduction: Specifying item types (content types)**

The item types that you select determine the search criteria fields that are available. For a list of the search fields available for each item type, refer to “Search Criteria Fields” on page 401.

**Considerations and limitations**

- Discovery Manager express edition can search for email items. Discovery Manager full edition can search for all content types (email, files, SharePoint).
- For Domino/Notes, all appointments, meetings, and events map to the Appointment type. For example, to search for Notes Meeting items, select Calendar Item > Appointment in the Search dropdown, not Calendar Item > Meeting. Alternatively, select Calendar Item in the Search dropdown, which returns all calendar items regardless of the platform.
- If you are searching email content that was journaled from an Office 365 environment, you must search for that content using the Email Message type (since that is how it was archived) and
not as the item type appearing in Outlook, such as a meeting request or a task request. The search of Office 365 email messages may return meeting request and task request results as well as email message results.

Procedure: Specifying item types (content types)

Use the Search dropdown to specify the item types on which to search. The default item type is **All**.

![Search dropdown - default "All"](image)

To specify item types in the Search dropdown:

1. Click the dropdown arrow.
2. Select the checkbox next to each item type that you want to search.
3. Clear the checkbox next to each item type that you do not want to search.

   If you clear all item types, then the Search dropdown defaults to **All**.

**Note:** Only email item types are available in the express edition of Discovery Manager.
Specifying item types (content types)

Specifying Search Criteria

If you select one item type or the All item type, then the label on the Search dropdown displays that item type.

If you select multiple item types, then the Search dropdown label changes to **Multiple Objects**. The names of the selected item types display at the top of the Results tab and in a tooltip.
Customizing search fields

Note: This section applies to both editions of Discovery Manager.

You can change, add, and remove search fields.

Refer to:

♦ “Changing existing search fields” on page 240
♦ “Adding search fields” on page 240
♦ “Removing search fields” on page 241

For descriptions of the search fields, refer to “Descriptions of search criteria fields” on page 411.

Changing existing search fields

Note: This section applies to both editions of Discovery Manager.

Refer to “Search Criteria Fields” on page 401 for descriptions of all available search fields.

To change a search field in the work pane:

1. Click the dropdown arrow on the label of the field.
2. Select the new field from the dropdown list.

   The item type that you selected in the Search field determines the available search fields.

Adding search fields

Note: This section applies to both editions of Discovery Manager.

Refer to “Search Criteria Fields” on page 401 for descriptions of all available search fields.

To add a search field to the work pane:

1. Click Add Criteria.
2. Select the field from the dropdown list.
The item type that you selected in the Search field determines the available search fields.

New search fields are added from top to bottom.

If you add more fields than can be displayed at one time, a vertical scroll bar appears on the right side of the search criteria area.

Removing search fields

Note: This section applies to both editions of Discovery Manager.

To remove a search field from the work pane:
1. Click the dropdown arrow on the label of the field.
2. Select Remove from the dropdown list.
Summary: How to search for text

Note: This section applies to both editions of Discovery Manager.

Note: This section does not apply to the Search Expression field, described in “Using the Search Expression Field” on page 279.

“Descriptions of search criteria fields” on page 411 lists the data type of each search field.

To search in fields of the Text data type, refer to the following table.

<table>
<thead>
<tr>
<th>Table 33 How to search for text</th>
</tr>
</thead>
<tbody>
<tr>
<td>To find text that ______ the specified value</td>
</tr>
</tbody>
</table>
| Contains | ∙ To search on a number or word, type the value or word.  
            ∙ To search on an exact phrase, enclose the phrase in double quotes.  
            Example: "Human Resources"  
            Refer to “Searching for words and phrases” on page 243 for details. |
| Does not contain | Enclose the number, word, or phrase in double quotes, then type a minus sign before the first quote.  
                      Example: -"Human Resources"  
                      Note: Do not type a space between the minus sign and the first double quote.  
                      Refer to “Using the Does Not Contain (-) operator” on page 243 for details. |
| Begins with | Type the asterisk wildcard character after the number or word.  
                Example: manage*  
                Note: Do not type a space between the wildcard and the number or word.  
                Refer to “Using wildcards” on page 245 for details. |
| Ends with | Type the asterisk wildcard character before the number or word.  
               Example: *23  
               Note: Do not type a space between the wildcard and the number or word.  
               Refer to “Using wildcards” on page 245 for details. |
Searching for words and phrases

Note: This section applies to both editions of Discovery Manager.

Note: This section does not apply to the Search Expression field described in “Using the Search Expression Field” on page 279.

Refer to:

◆ “Exact words and phrases” on page 243
◆ “Multiple words or phrases” on page 243

Exact words and phrases
To search for an exact word or phrase, enclose the text in double quotes.

For example, the search term "John Kennedy" will return items only if the exact phrase John Kennedy is found in its entirety. The text John F. Kennedy would not result in a match, nor would Ken.

Multiple words or phrases
You can search on multiple words and/or phrases. The words and phrases will be ORed automatically.

For example, if you search on sales quota Q3, the words are ORed. Results will be returned that partially match at least one of the words.

You can search on a mix of words and phrases, such as Chicago "internal sales" Q1.

To search on exact words and phrases, enclose the words and phrases in double quotes.

Note: The words AND and OR do not act as operators.

Using the Does Not Contain (-) operator

Note: This section applies to both editions of Discovery Manager.

Note: This section does not apply to the Search Expression field. Refer to “Using the Search Expression Field” on page 279.
Specifying Search Criteria

Note: Address fields (Sender, Recipient, Sender or Recipient, Owner) and domain fields (Sender Domain and Recipient Domain), the Attachment Name field, and the File Name field do not support the Does Not Contain operator (-).

A minus sign at the beginning of a word or number acts as a Does Not Contain operator.

Examples

- If you enter `-closed` in the Subject search field, then the search will not return messages containing the word `closed` in the subject.
- If you enter `trade -closed` in the Subject field, then the terms are ORed, as described in “Multiple words or phrases” on page 243. The search will find messages that have the word `trade` or that do not have the word `closed`. A message that has the word `closed` in the subject would be returned if it also has the word `trade` in the subject.

Note: The word NOT does not act as an operator.
Using wildcards

Note: This section applies to both editions of Discovery Manager.

SourceOne Search uses the asterisk as a wildcard to represent one or more characters.

IMPORTANT

Only the asterisk is supported as a wildcard. Do not use other reserved characters (such as question marks) as wildcards in a search term, otherwise unintended results may be returned. Refer to “Characters” on page 292 for a list of reserved characters.

Note: For information about using wildcards in the Search Expression field, refer to “Using the Search Expression Field” on page 279. For information about using wildcards in the Sender Domain and Recipient Domain fields, refer to “Performing domain searches” on page 265.

You can use an asterisk (*) as a wildcard character in search terms in the fields listed in “Summary: How to search for text” on page 242, and in the Sender, Recipient, and Sender or Recipient address fields, according to the guidelines described in the following topics:

- “Supported uses of asterisk wildcards” on page 245
- “Non-supported uses of asterisk wildcards” on page 247
- “Specifying attachment name” on page 251

Supported uses of asterisk wildcards

Note: This section applies to both editions of Discovery Manager.

Asterisk wildcards are supported in the following cases:

- “An asterisk wildcard at the beginning or end of a word or phrase” on page 246
- “An asterisk wildcard before the period character” on page 246
- “ORing multiple words in the same text field” on page 247
- “ANDing multiple words using duplicate text fields” on page 247
An asterisk wildcard at the beginning or end of a word or phrase

You can use an asterisk wildcard at the beginning or at the end of a word.

Use of an asterisk wildcard is relatively efficient at the end of a word, and much more computer-intensive if used at the beginning of a word.

The following guidelines apply:

- **End of a word** – If you enter an asterisk wildcard at the end of a word, the search finds all words that start with the letters appearing before the asterisk wildcard character.
  
  Examples:
  
  • *over* finds over, overpay, overdraft, overstock, and so forth.
  • *stock* finds stock, stockbroker, stockholder, and so forth.

- **Beginning of a word** – If you enter an asterisk wildcard at the beginning of a word, the search finds all words that end with the specified letters. (This option may significantly increase the search time required.)
  
  Examples:
  
  • *over* finds over, turnover, holdover, and so forth.
  • *stock* finds stock, overstock, livestock, and so forth.

You can also use an asterisk wildcard at the beginning or end of a phrase that is enclosed in double quotes. The asterisk wildcard must be inside the double quotes.

Examples:

- "*quarterly dividend"
- "quarterly dividend*"

An asterisk wildcard before the period character

As of EMC Source One 6.6, the asterisk wildcard character is valid when used immediately before a period character (.)

This applies to all manual entry text fields, including the Attachment Name field and the Keyword field.

Refer to “Specifying attachment name” on page 251 for examples.
**Specifying Search Criteria**

**ORing multiple words in the same text field**
To OR multiple words in the same text field, put a space between the words.

---

**Note:** Do not put the word OR between words. The word OR does not act as an operator.

Do not enclose the OR’ed words in double quotes. If you do, the enclosed phrase will be interpreted as an exact match.

**Example**
For example, assume you enter `over* *stock` in the **Subject** field.
Matching terms would be those that begin with `over` OR end with `stock`.
Matches could include `over`, `overpay`, `overdraft`, `overstock`, `stock`, and `livestock`, but would not include `turnover`, `holdover`, `stockbroker`, or `stockholder`.

**ANDing multiple words using duplicate text fields**
To AND multiple words, use duplicate text fields.

---

**Note:** Do not put the word AND between words. The word AND does not act as an operator.

Do not enclose the AND’ed words in double quotes. If you do, the enclosed phrase will be interpreted as an exact match.

**Example**
For example, to AND two email subjects, add two **Subject** fields to the search criteria area. Assume you add a second **Subject** field and enter the following values:

First Subject field: `over*`

Second Subject field: `*stock`

Matching terms would be those that begin with `over` AND end with `stock`.
Matches could include `overstock`, but would not include `over`, `overpay`, `overdraft`, `stock`, or `livestock`.

**Non-supported uses of asterisk wildcards**

---

**Note:** This section applies to both editions of Discovery Manager.

Asterisk wildcards are not supported in the following cases:
Specifying Search Criteria

- Embedded asterisk wildcard characters
  Examples: over*pay, stock*holder
- A single asterisk wildcard character on its own
  Example: *
- An asterisk wildcard used as an operator on a phrase if the asterisk is outside of the double quotes
  Example: **"quarterly dividend"
- An asterisk wildcard in a phrase other than at the beginning or end of the phrase
  Example: "quarterly * dividend"
- In the Owner field
  If you use the asterisk wildcard in unsupported cases, then the search criteria area displays an error message.

Using asterisk wildcards in address fields

Note: This section applies to both editions of Discovery Manager.

- The asterisk wildcard is not supported in the Owner field.
- The asterisk wildcard is supported in the Sender, Recipient, and Sender or Recipient fields.

For information on using asterisk wildcards in the Sender Domain and Recipient Domain fields, refer to “Performing domain searches” on page 265.
Searching on keywords

Note: This section applies to both editions of Discovery Manager.

To search the subject, body, or attachments, you can use:

- The Subject, Body, or Attachment Body fields. To add them to your search criteria, refer to “Adding search fields” on page 240.
- The Search Expression field. Refer to “Using the Search Expression Field” on page 279.
- The keyword field, as described in the following procedure.

To search on a keyword:

1. Enter all or some of the characters of the keyword in the keyword field (the unlabeled field at the top of the search criteria area).
   Refer to “Searching for words and phrases” on page 243 for details.
2. Click Find.

Words entered in the keyword field are ORed. To AND keywords, refer to “How to AND and OR search terms” on page 250.

Cutting and pasting paragraphs in text fields

Note: This section applies to both editions of Discovery Manager.

You can cut and paste paragraphs into search fields of the Text data type. Refer to “Descriptions of search criteria fields” on page 411 for a list of Text fields.
IMPORTANT
Do not copy text from HTML sources into search fields. Certain characters (such as double quotes) will display correctly after pasting; however, they include HTML codes that will result in incorrect search results. SourceOne only supports keyboard-generated double quotes or other special characters.

After you paste paragraphs into a text field:
- All new line characters are replaced with spaces (which is the delimiter between search terms in text fields).
- The field displays a scrollbar so that you can scroll the text.
- When you hover the mouse over the field, a tooltip displays the complete text.

Note: For ID fields, only alphanumeric characters are valid.

How to AND and OR search terms

Note: This section applies to both editions of Discovery Manager.

Note: This section does not apply to the Search Expression field, described in “Using the Search Expression Field” on page 279.

By default:
- Values within a field are ORed automatically. For example, if you enter the words sales quota in the same text field, then messages matching either of the words will be returned. There is no way to OR values across different search fields. Refer to “Searching for words and phrases” on page 243 for more information.
- Values across all search fields are ANDed. For example, if you specify a recipient in the Recipient field, and a date in the Date field, then only those messages that match both the recipient and the date will be returned. There is no precedence when values are ANDed.

Note: The words AND and OR do not act as operators.
To AND search terms for the same field, add a duplicate search field. For example, you can do this to specify ranges for the Size field. Refer to:

- “Adding search fields” on page 240
- “Specifying an item size” on page 272

**Note:** A search on multiple Sender fields against an EmailXtender archive is not supported as of SourceOne 6.5.2.

---

**Specifying attachment name**

**Note:** This section applies to both editions of Discovery Manager.

To search by file extension in the Attachment Name search field, type the period followed by the file extension. A wildcard is valid but not necessary. For example, to find items that have attachments with the TXT file extension, type either of the following entries:

```
.txt
*.txt
```

You can use wildcards to search for partial names. For example, for an attachment with the name `Q2FinanceReport.pdf`, the following wildcard usage would be valid:

```
*FinanceReport.pdf
Q2FinanceReport.*
```

Searching for the text "unknown" in the Attachment Name field may return results for items that have attachments (or embedded messages that have attachments) with no name, in addition to finding items that do have attachments containing the name "unknown."

**Note:** The Does Not Contain operator (-) does not work in the Attachment Name field.
Specifying recipient, sender, or owner for email items

Note: This section applies to both editions of Discovery Manager.

This section describes how to use the **Sender**, **Recipient**, **Owner**, and **Sender Or Recipient** address fields.

For information on using the Sender Domain and Recipient Domain fields, refer to "Performing domain searches" on page 265.

To search on route metadata, refer to "Searching on custom route metadata" on page 274.

Refer to:

- "General considerations and limitations" on page 252
- "About the "Always search full text indexes" checkbox" on page 191
- "Best practices for specifying addresses in search fields" on page 252
- "Using the "Sender or Recipient" field or the Owner field" on page 253
- "Methods to specify addresses in search fields" on page 254
- "About indexes and address searches" on page 256
- "Selecting names from the Address Book or specifying identities" on page 256
- "Entering names manually" on page 262
- "Differentiating among duplicate names" on page 262

General considerations and limitations

Address fields (**Sender**, **Recipient**, **Owner**, and **Sender Or Recipient**) do not support the Does Not Contain operator (-).

Best practices for specifying addresses in search fields

Note: This section applies to both editions of Discovery Manager.
Specifying recipient, sender, or owner for email items

- Select names from the Address Book dialog box using identities as the source, to ensure that the search includes historical as well as current addresses. Use identities even if the user is still in the address book. Use identities to search on messages belonging to users after they leave the company and are no longer in the address book.
- Create an identity record for each custodian (sender, recipient, and owner) in the matter.
- You can search on an SMTP address by typing it in an address field (Sender, Recipient, or Sender or Recipient), but best practice is to use an identity that includes the SMTP address instead.

Using the "Sender or Recipient" field or the Owner field

**Note:** This section applies to both editions of Discovery Manager.

**Note:** The limitations described in this section for the Sender or Recipient field also apply to the Recipient field.

In SourceOne 6.7x and prior, the Sender or Recipient field produced different results depending on whether the mail was archived using historical archiving or journaling.

When mail that was sent to distribution lists is archived through historical archiving, the Sender or Recipient field may produce incomplete search results.

The problem occurred because the distribution list is not expanded when mail that was sent to a distribution list is archived from a mailbox. With historical archiving (unlike journaling), the archive does not know the valid members of the distribution list when the message was sent. As a result, the person is marked as an Owner of the messages in the mailbox but not as a recipient. If the person’s name is found in the To and/or the Cc fields, that person is marked as a recipient as well as an Owner.

When historical archiving is used to archive messages, the Sender or Recipient field will work for mail sent by the person being searched or received by them explicitly. But the searches will not return mail that the person received through a distribution list or BCC. To search for that mail, you must use the Owner field.
With the introduction of SourceOne Email Management 6.8, "Sender or Recipient" email searches will return emails where the specified recipients were BCC’d or a member of a Distribution List.

Methods to specify addresses in search fields

Note: This section applies to both editions of Discovery Manager.

There are several ways to specify addresses in the address fields (Sender, Recipient, Sender or Recipient, or Owner). Each method generates a different type of search. Refer to:

- “Address book” on page 254
- “Manual entry” on page 254

Also refer to:

- “Selecting names from the Address Book or specifying identities” on page 256
- “Searching on custom route metadata” on page 274

Address book

Note: This section applies to both editions of Discovery Manager.

When you select an address from the address book, an.Equals (exact) search is generated for the selected address. Only messages with that exact address will be returned. The search will include all the addresses known by the mail server for the user.

For example, if you select Alana E Raysor from the address book in the Recipient field, then only messages received by that person will be returned. Messages from other users with the name Alana will not be returned.

Manual entry

Note: This section applies to both editions of Discovery Manager.

Search terms are interpreted differently in address fields than in text fields. Refer to:

- “Single search term” on page 255
- “Multiple search terms” on page 255
Specifying Search Criteria

- “Wildcards” on page 255

Also refer to “Entering names manually” on page 262 for additional guidelines.

**Single search term**

When you manually type a single search term in the Recipient, Sender, or Sender or Recipient field, a CONTAINS (partial) search is generated. Messages with addresses that contain the specified address will be returned. For example, if you manually type the single search term *Alana* in the Recipient field, then messages whose recipients are Alana E Gaymon and Alana E Raysor are returned.

You can manually type an address in the Owner field to search for messages belonging to a user who is no longer in the address book. Best practice is to use identities.

**Note:** If you type an address in the Owner field, you must enter the full address exactly as it was journaled. Unlike other address fields, partial searches are not performed on the Owner field.

The maximum number of characters you can type in an address field is 255, but for optimal display, you should not exceed 80-100 characters.

**Multiple search terms**

You must separate multiple search terms with semicolons (Exchange/Outlook) or commas (Domino/Notes).

For example, to search on the recipients *Alana E Gaymon* and *Allan E Cluff* in an Exchange environment, type:

```
Alana E Gaymon;Allan E Cluff
```

**Note:** Multiple addresses in the same field are ORed.

**Wildcards**

You can use wildcards in the Sender, Recipient, or Sender or Recipient fields, according to the guidelines in “Using wildcards” on page 245.
Specifying Search Criteria

About indexes and address searches

Note: This section applies to both editions of Discovery Manager.

When you manually type an address in the **Sender**, **Recipient**, or **Sender or Recipient** field (a CONTAINS search), the full-text indexes are searched.

If indexing is not enabled, a search of the full-text indexes is not possible.

To search on addresses if indexing is not enabled, you must select addresses from the address book. The value specified must be an exact match of the address that was stored for the ingested email.

Note: Indexes are enabled by the EMC SourceOne Email Management administrator, as described in the *EMC SourceOne Email Management Administration Guide*.

Selecting names from the Address Book or specifying identities

Note: This section applies to both editions of Discovery Manager.

Refer to:

- “Basic Find” on page 256
- “Advanced Find” on page 261

**Basic Find**

To select a recipient, sender, or owner from the address book, or to specify identities:

1. Click the address book icon next to the **Recipient**, **Sender**, **Sender or Recipient**, or **Owner** field.

![Example: Address book icon in Owner field](image)

The Address Book dialog box opens.
2. In the **Source** field, select the source of the name:

   - **Exchange**
   - **Domino**

   **Note:** In a Domino environment that uses the Domino native directory, this address type is labelled Domino <Choose Directory>. If you chose Domino <Choose Directory> previously, then the first Domino directory is selected by default.

   - **Identities**
   - **Metadata** - Continue to “Searching on custom route metadata” on page 274.

   **Note:** You can have names from different sources in the same address field. Use the Source field in the Address Book to switch sources.

   **Note:** The last source that you select becomes the default for the rest of the session.

3. In a Domino environment that uses the Domino native directory, in the **Source** field under **Domino <Choose Directory>**, select a Domino directory.
4. Do one of the following steps:
   - If you selected Exchange or Domino in step 2, type the complete or partial name in the **Search** field.
     
     **Note:** In a Domino environment that uses the Domino native directory, you are searching the display name, which is listed by last name. If you type the person’s first name, you will not get any results. If you type the last name, the name of the person is returned.
   
   - If you selected Identities in step 2, do one of the following steps in the **Search** field:
     - To view all identities, leave the **Search** field blank.
     - To filter identities, type the full or partial name of the person.

5. Do one of the following steps:
   - Click **Find**.
   - With the focus in the Search field, press **Enter**.

The possible results are:
   - If a name is found that exactly matches your criteria, then the name is added to the list automatically. The Search field regains focus and the Search field clears so that you can look up multiple entries quickly.
Icons indicate whether an address selected from a Domino directory is a person or a group.

- If no name matches your criteria, then click OK at the No Entries Were Found prompt. The Search field regains focus, but the Search value remains.
- If multiple names match your criteria, then the Select Address dialog box opens. Icons indicate whether an address selected from a Domino directory is a person or a group.

![Select Address](image)

**Figure 117** Select Address

- Select the names.

**Table 34** Selecting names

<table>
<thead>
<tr>
<th>To select</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single name</td>
<td>Click</td>
</tr>
<tr>
<td>Multiple contiguous names</td>
<td>Shift-Click</td>
</tr>
<tr>
<td>Multiple non-contiguous names</td>
<td>Ctrl-Click</td>
</tr>
<tr>
<td>All names</td>
<td>Ctrl-A</td>
</tr>
<tr>
<td>All names from current selection to end of list</td>
<td>Click-Shift-End</td>
</tr>
<tr>
<td>All names from current selection to beginning of list</td>
<td>Click-Shift-Home</td>
</tr>
</tbody>
</table>
Specifying Search Criteria

b. Click **OK** to copy the selected names to the Address Book dialog box and to close the Select Address dialog box.

6. To see details about the user, double-click the name in the Address Book dialog box.

   The User Info dialog box opens.

   The General tab displays information about the user, if that information is stored in the mail system address book.

   ![User Info - General tab](image)

   **Figure 118**  **User Info - General tab**

   The Email Addresses tab shows all the known email addresses for the user.

   ![User Info - Email Addresses tab](image)

   **Figure 119**  **User Info - Email Addresses tab**
7. To remove names from the Address Book dialog box, select the names, then press the **Delete** key.

8. When you finish searching for names in the Address Book dialog box, do one of the following steps to close the Address Book dialog box:
   - Click **OK**.
   - With the focus on either the OK button or in the list of names, press **Enter**.

   The selected names are displayed above the appropriate search field in the Discovery Manager window.

---

**Figure 120 Example: Selected names displayed above address field**

Icons indicate whether an address selected from a Domino directory is a person or a group.

---

**Figure 121 Example: Person and group icons (Domino)**

---

**Advanced Find**

**Note:** This section applies to both editions of Discovery Manager.

**Note:** The Advanced Find dialog box is only available for Exchange environments and for Domino environments that use LDAP. It is not available for Identities or for Domino environments that use the Domino native directory.

To search for names using additional fields:

1. Click the dropdown arrow next to Find, then select **Advanced Find**.

2. In the Advanced Find dialog box, type your search criteria, then click **OK**.
Specifying Search Criteria

Matching names are copied to the Address Book dialog box.

**Entering names manually**

*Note:* This section applies to both editions of Discovery Manager.

To enter names manually, type display names in the **Recipient**, **Sender**, or **Sender or Recipient** field.

- Separate display names with semicolons (Exchange/Outlook) or commas (Domino/Notes).
- If a display name contains semicolons or commas (for example "John’s Mailbox"), you must select the user from the address book.

**Differentiating among duplicate names**

*Note:* This section applies to both editions of Discovery Manager.

In Exchange and Domino LDAP environments, to differentiate among duplicate names displayed above the address fields (Sender, Recipient, Owner, Sender or Recipient), do one of the following steps to see the display name and the distinguished name:

- Move the mouse over the name to see a tooltip.
Double-click the name to open the User Info dialog box.

Figure 123  Address fields - duplicate names

Figure 124  User Info - duplicate names
Searching for archived files using the Owner field

Note: This section applies to the full edition of Discovery Manager.

When you select All or the File content type in the Search field, the Owner search criteria field is available.

For archived files, an “owner” is the UNC path from which the file was originally archived.

To use the Owner field to search for archived files, use one of the following methods:

◆ In the Owner field, type the UNC path from which the file was archived.

◆ In the Owner field, select an identity that includes a File Location entry:
  1. Click the address book icon next to the Owner field.
     The Address Book dialog box opens.
  2. In the Source field, select Identities.
  3. Do one of the following steps in the Search field:
     – To view all identities, leave the Search field blank.
     – To filter identities, type the full or partial name of the person.
  4. Do one of the following steps:
     – Click Find.
     – With the focus in the Search field, press Enter.
  5. Select the appropriate identity that includes a file location.

To specify File Locations in an identity record, refer to “Specifying a file location as an identity element” on page 122.
Performing domain searches

Note: This section applies to both editions of Discovery Manager.

Use domain searches to find email that was sent to or from external domains through SMTP addresses.

To search on a domain, use one or both of the following search fields:

◆ Sender Domain
◆ Recipient Domain

These fields are not displayed by default. Add them as described in “Adding search fields” on page 240.

When you manually type a single search term in the Sender Domain or Recipient Domain field, a CONTAINS (partial) search is generated. Messages with addresses that contain the specified domain will be returned.

The domain search fields are available for the following item types that you can select in the Search field: Email Message, Task, Task Request, Other, Calendar Item (Meeting, Appointment, Notice), Instant Message, Reports (Delivery Report, Read Report, Other Report).

You can use the domain fields with any other search criteria fields, including the Search Expression field.

Refer to:

◆ “Prerequisites: domain searches” on page 265
◆ “Considerations and limitations: domain searches” on page 266
◆ “Specifying multiple search terms in domain fields” on page 267
◆ “Using wildcards in domain searches” on page 268
◆ “Examples of domain searches” on page 268

Prerequisites: domain searches

◆ Domain searches require that the content you are searching has been full-text indexed in the archive. Your SourceOne system administrator configures full-text indexing.
In Search Properties, you do not have to enable the Search Full Text Indexes option. Specifying domain search criteria automatically forces a full-text index search.

---

**Considerations and limitations: domain searches**

*Note: This section applies to both editions of Discovery Manager.*

- The domain search fields support manual input only. You cannot select addresses from an address book.
- Enter only the domain portion of an email address. Do not enter any of the user name portion or the “at” character (@). An invalid domain search term will not produce an error message, but will produce unexpected or incomplete search results. Refer to “Examples of domain searches” on page 268 for valid and invalid examples.
- The Does Not Contain operator (-) is not supported in the Sender Domain and Recipient Domain fields.
- Domain searches for senders and recipients in embedded messages are not supported.
- The maximum total number of addresses allowed in a domain search against EMC SourceOne Native Archives is 700,000. If the specified domain search terms expand to more than this limit, the following error message will be shown to the user: “The specified domain search criteria resulted in a query that was too large to execute.” If specifying multiple domains either manually or by using wildcards, try breaking the search up into several smaller searches to get the desired result.
- Domain searches may take a long time. Test domain searches on a small date range, even a single day, to estimate execution time before you run the search for a full date range.
- Domain searches against EmailXtender archives:
  - Support only the indexes generated by EmailXtender 4.3 or later.
  - Are subject to EmailXtender limitations. When you perform domain searches from SourceOne against an EmailXtender archive, the restrictions that apply to the Sender and Recipient fields in the EmailXtender Search Plug-in also apply to the Sender Domain and Recipient Domain fields in SourceOne.
Specifying Search Criteria

The following address field combinations are not supported in SourceOne searches against EmailXtender archives:

- Recipient field and Recipient field
- Sender field and Sender field
- Owner field and Owner field
- Owner field and Sender field
- Owner field and Recipient field

Similarly, the following domain search combinations are not supported in SourceOne searches against EmailXtender archives:

- Recipient field and Recipient Domain field
- Sender or Recipient field and Recipient Domain field
- Recipient Domain field and Recipient Domain field
- Sender field and Sender Domain field
- Sender or Recipient field and Sender Domain field
- Sender Domain field and Sender Domain field
- Owner field and Sender Domain field
- Owner field and Recipient Domain field

- Limitations on domain searches against EmailXtender archives also apply to EmailXtender archives that were migrated using the In Place Migration (IPM) utility.
- Domains are searchable but are not returned as information in search results. For example, if you perform a valid wildcard search in a domain field, the results grid does not include a column that lists the matching domains for each result.

Specifying multiple search terms in domain fields

Note: This section applies to both editions of Discovery Manager.

You can type multiple search terms in the domain fields. Use the appropriate delimiter between search terms:

- Microsoft Exchange - Use a semicolon (;).
- IBM Lotus Domino - Use a comma (,).
Using wildcards in domain searches

Note: This section applies to both editions of Discovery Manager.

Note: Using an asterisk wildcard at the beginning of a search term may increase the search time significantly.

You can use the asterisk wildcard to search for:

- The subdomains of a domain
  Example: *domain.com
- Substrings in a domain
  Examples:
  - *domain*
  - *do*ai*
- Domain extensions
  Example: domain.*

Examples of domain searches

Note: This section applies to both editions of Discovery Manager.

Valid domain searches

The following table provides examples of valid domain searches.

Table 35 Examples: Valid domain searches

<table>
<thead>
<tr>
<th>Valid input</th>
<th>Matches</th>
<th>Does not match</th>
</tr>
</thead>
<tbody>
<tr>
<td>domain.com</td>
<td>domain.com</td>
<td>sub.domain.com</td>
</tr>
<tr>
<td></td>
<td></td>
<td>otherdoamin.com</td>
</tr>
</tbody>
</table>
Performing domain searches

Specifying Search Criteria

The following table provides examples of invalid domain searches.

<table>
<thead>
<tr>
<th>Invalid input</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="mailto:user@domain.com">user@domain.com</a></td>
<td>Any portion of the user name is invalid. The &quot;at&quot; character (@) is invalid.</td>
</tr>
<tr>
<td>*<a href="mailto:name@domain.com">name@domain.com</a></td>
<td>Any portion of the user name is invalid. The &quot;at&quot; character (@) is invalid.</td>
</tr>
<tr>
<td>*@domain.com</td>
<td>The &quot;at&quot; character (@) is invalid.</td>
</tr>
<tr>
<td>@domain.com</td>
<td>The &quot;at&quot; character (@) is invalid.</td>
</tr>
<tr>
<td>~domain.com</td>
<td>The Does Not Contain operator (-) is invalid.</td>
</tr>
</tbody>
</table>

Table 35 Examples: Valid domain searches

<table>
<thead>
<tr>
<th>Valid input</th>
<th>Matches</th>
<th>Does not match</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.domain.com</td>
<td>sub.domain.com othersub.domain.com</td>
<td>domain.com otherdoamin.com</td>
</tr>
<tr>
<td><em>domain.</em></td>
<td>domain.com domain.net otherdomain.com sub.domain.net</td>
<td>domain2.com</td>
</tr>
<tr>
<td>dom<em>in</em>,.*</td>
<td>domain.com domino.net</td>
<td>otherdomain.com</td>
</tr>
</tbody>
</table>
Specifying Search Criteria

Specifying a date

**Note:** This section applies to both editions of Discovery Manager, except where noted.

The Date field is a default search field for all item types except for Contacts. This date represents the "most significant" date for the item type that you selected in the Search field.

In Discovery Manager full edition, depending on the item type that you select in the Search field, additional date fields are available to use as search criteria (such as Date Sent, Start Date, Creation Date, and Last Date Modified). Refer to “Search Criteria Fields” on page 401 for descriptions of the date fields available for each item type.

**Note:** The date is displayed according to the date format specified in regional settings on the Discovery Manager server.

Refer to:

- “About searching on message dates in embedded messages” on page 270
- “Procedure: Specifying a date or date range” on page 271

About searching on message dates in embedded messages

**Note:** This section applies to both editions of Discovery Manager.

Due to the way the EMC SourceOne Native Archive indexes messages by date, search results may be inconsistent if you use the Date field to search embedded messages in the Native Archive.

The Native Archive indexes message dates based on the date of the primary message (the message that contains the embedded message). The date of the embedded message is indexed only under the primary message, as if the date were body text.

**Examples**

For these examples, assume the following two messages are in the Native Archive:
Specifying Search Criteria

- Message1 has a message date of 1/2/08, and contains an embedded message with a date of 2/1/07.
- Message2 has a message date of 1/1/08, and does not contain an embedded message.

Example 1
If you specify On 1/1/08 in the Date field, then only Message2 is returned, which is expected.

Example 2
If you specify On 2/1/07 in the Date field, then no results are returned. Although the date of the embedded message is 2/1/07, the Native Archive treats it as body text, not as the message date, so it cannot be found using the Date field.

Procedure: Specifying a date or date range

To specify a date or date range:

1. In the first part of the date field, select one of the following options:
   - on - Use to specify a single date. When you select the on operator, you cannot select a time. The on operator searches between 12:00 AM and 11:59:59 PM on the date you specify.
   - on or after - Use to specify the start date for an open-ended date range.
   - on or before - Use to specify the end date for an open-ended date range. When you select the on or before operator:
     - The time defaults to 11:59 PM.
     - When the search runs, 59 seconds are added so that the default time is 11:59:59 PM.
   - between - Use to specify a closed date range. When you select the between operator, the default values are:
Specifying Search Criteria

- Start on today’s date at 12:00 AM
- End on today’s date at 11:59:59 PM
  Although seconds are not available for selection, 59 seconds are added to the end time.

2. In the second part of the date field, click the dropdown arrow, then select a date from the calendar.

   The default is today’s date. The minimum date is January 1, 1970. The maximum date is January 1, 2038.
   If you enter an invalid date, then the date reverts to its original valid value when you click Find.

Note: You are not prevented from creating an illogical search that can never return any results.
For example, assume you search using two date fields, with one field set to on or after tomorrow and the other field set to on or before yesterday. There are no possible matches, so no results will be returned.
Similar cases are possible with the Size field.

Specifying an item size

Note: This section applies to both editions of Discovery Manager.

To specify an item size:

1. In the first part of the Size field, select one of the following options:
   • equals - Use to specify a size.
   • greater than - Use to specify the smallest size for an open-ended size range.
   • less than - Use to specify the largest size for an open-ended size range.

2. In the second part of the Size field, enter a size in bytes.

To specify a range between two sizes:

1. Add another Size field. Refer to “Adding search fields” on page 240.
2. In the first **Size** field, select **greater than** and specify the smallest size.

3. In the second **Size** field, select **less than** and specify the largest size.

---

**Using "Indexing Error" and "Any Unindexed Content"**

*Note: This section applies to both editions of Discovery Manager.*

Search not only finds and returns content that was indexed, but also finds items that could not be indexed. Search results can include:

- Items that were indexed.
- Items that match the ownership criteria, but could not be indexed due to encryption (for example, a message body that is encrypted).
- Items that match the ownership criteria, but have attachments that could not be indexed due to encryption or password protection.
- Items (and their attachments) that match the ownership criteria, but that could not be indexed due to an indexing error.

To find items that could not be indexed, use one of the following search fields:

- **Any Unindexed Content** - Set to **True** to find items that could not be indexed for any reason (encryption or password protection or indexing errors).
- **Indexing Error** - Set to **True** to find items that could not be indexed due to indexing errors only, not due to encryption or password protection.
Specifying Search Criteria

Searching on custom metadata

Note: This section applies to both editions of Discovery Manager.

Metadata is information associated with a message that is not part of the message itself. Custom metadata is site-specific information. For example, a contract number or employee ID could be associated with a message. Custom metadata can make it easier to search for specific messages. Custom metadata may have been applied during archiving or during later processing.

You can search for messages based on the two types of custom metadata that can be associated with a message: route metadata and message metadata.

Refer to:
- “Searching on custom route metadata” on page 274
- “Searching on custom message metadata” on page 276

Searching on custom route metadata

Route metadata:
- Refers to the owner, sender, or recipient of the message. An example is Employee ID.
- Has already been applied to messages in SourceOne, not in Discovery Manager.

In Discovery Manager full edition, an Identity Administrator can add route metadata as an identity element to an identity record, so that the route metadata is automatically included as search criteria.

To search on route metadata:

1. Click the address book icon next to the Recipient or Sender field.
2. In the upper right corner of the Address Book dialog box, select Metadata from the Source field.
Searching on custom metadata

Specifying Search Criteria

3. In the **Field name** field, select the route metadata field on which to search.
4. In the **Comparison** field, select one of the following conditions:
   - Equals
   - Not Equals
5. In the **Value** field, type the value for the metadata.
Specifying Search Criteria

6. Do one of the following steps to add the metadata search criteria to the list:
   - Click Add.
   - With the focus in the Value field, press Enter.
   A funnel icon indicates a metadata entry.
7. Repeat steps 3 through 6 for each metadata field you want to specify.
8. To close the Address Book, do one of the following steps:
   - Click OK.
   - With the focus on either the OK button or in the list of names, press Enter.
   The information from the Address Book displays above the appropriate address field in the search criteria area of the Discovery Manager window.

Searching on custom message metadata

Note: This section applies to both editions of Discovery Manager.

Custom message metadata:
- Is information about the message.
- Has already been applied to messages in SourceOne, not in Discovery Manager.

Refer to:
- “Procedure: Searching on custom message metadata” on page 276
- “Searching on multiple Metadata values” on page 277

Procedure: Searching on custom message metadata
To search on custom message metadata:
1. Add the Metadata search field. Refer to “Adding search fields” on page 240.
2. In the first field, select the message metadata on which to search.
3. In the second field, type the value on which to search.

Searching on multiple Metadata values

- To search on multiple values, type a space between each pair of values.
- Multiple values in the same field are ORed.

For example, the following entry means "Find matches that do not contain 12345, or that contain 45678, or that end with 23, or that start with 32."

- "12345" 45678 *23 32* 

To AND message metadata, add another Metadata field to the search criteria area.

For example, assume your site associates a contract number and a claim number with each message. To search on both pieces of metadata, add two Metadata fields, one for contract number and another for claim number.
Clearing values from all search fields

Note: This section applies to both editions of Discovery Manager.

You can clear the values from all search fields in a search that has not yet run.

To clear values from all search fields, including the keyword field:
1. Click the dropdown arrow next to the keyword field.
2. Select **Clear criteria values** from the dropdown menu.

Figure 129  Clear criteria values
This chapter contains the following topics:

- Introduction ................................................................. 280
- Adding the Search Expression field .............................. 280
- Best practices: Search Expression field ....................... 281
- Using the proximity operator in the Search Expression field.... 281
- Using Boolean operators in the Search Expression field .......... 283
- Using the tense conflation operator in the Search Expression field 284
- Using wildcards in the Search Expression field .............. 286
- Reserved words ............................................................... 287
- Specifying multiple words in the Search Expression field ...... 288
- Precedence of operators in the Search Expression field .......... 289
- Using parentheses in the Search Expression field ................ 289
- Using quotation marks in the Search Expression field .......... 291
- Characters ................................................................. 292

Note: The Search Expression field is available in both editions of Discovery Manager.
Using the Search Expression Field

Introduction

Note: This section applies to both editions of Discovery Manager.

Use the Search Expression field to perform full-text index searches on the subject, body, or attachments of archived email using complex search expressions.

Figure 130 Search Expression field

You can use combinations of:

- proximity operator - Refer to “Using the proximity operator in the Search Expression field” on page 281
- Boolean operators - “Using Boolean operators in the Search Expression field” on page 283
- tense conflation operator - “Using the tense conflation operator in the Search Expression field” on page 284
- wildcards - “Using wildcards in the Search Expression field” on page 286
- parentheses - “Using parentheses in the Search Expression field” on page 289

Adding the Search Expression field

Note: This section applies to both editions of Discovery Manager.

Considerations and limitations

When you add the Search Expression field, all other search fields are disabled except for address fields, date fields, and domain fields. The Sender, Recipient, Owner, Sender Or Recipient, Date, Recipient Domain, and Sender Domain fields are not disabled.

Procedure

To add the Search Expression field, select it from the Add Criteria dropdown.
Best practices: Search Expression field

Note: This section applies to both editions of Discovery Manager.

The construction of complex search expressions requires a thorough understanding of both indexing and searching. You should build and test search expressions term-by-term to ensure that they work as intended.

IMPORTANT
You must enclose the search expression in parentheses.

Using the proximity operator in the Search Expression field

Note: This section applies to both editions of Discovery Manager.

You can use the proximity operator to find items in which both search terms are in the same paragraph. The order of appearance in the paragraph is not relevant.

You can use the following variations of the NEAR BY proximity operator between pairs of search terms in a search expression:

- \(/\) - Finds items in which the two search terms appear in the same paragraph.
- \(/n/\) - Finds items in which the two search terms appear within a specified number of words (\(n\)) of each other in the same paragraph.
- \(/n,m/\) - Finds items in which the two search terms appear within a range of words (no fewer than \(n\) words and no more than \(m\) words of each other) in the same paragraph.
### Examples: Proximity operator in the Search Expression field

**Note:** This section applies to both editions of Discovery Manager.

<table>
<thead>
<tr>
<th>Search expression</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>trade // closed</td>
<td>Finds items containing both <em>trade</em> and <em>closed</em>, in the same paragraph.</td>
</tr>
<tr>
<td>trade /5/ closed</td>
<td>Finds items containing both <em>trade</em> and <em>closed</em>, in which the search terms appear within 5 words of each other in the same paragraph.</td>
</tr>
<tr>
<td>trade /5,10/ closed</td>
<td>Finds items containing both <em>trade</em> and <em>closed</em>, in which the search terms appear within 5 to 10 words of each other in the same paragraph.</td>
</tr>
</tbody>
</table>
Using Boolean operators in the Search Expression field

Note: This section applies to both editions of Discovery Manager.

You can use the following Boolean operators between pairs of search terms in a search expression:

- **AND** - Finds only those items that contain both search terms
- **OR** - Finds items that contain either or both search terms.
- **NOT** - Finds items in which the first search term occurs but not the second search term.

**IMPORTANT**
The words **AND**, **OR**, and **NOT** are reserved words in EMC SourceOne. Refer to “Reserved words” on page 287.

Examples: Boolean operators in the Search Expression field

Note: This section applies to both editions of Discovery Manager.

<table>
<thead>
<tr>
<th>Search expression</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>trade AND closed</td>
<td>Finds items containing the words <strong>trade</strong> and <strong>closed</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Entering <strong>trade closed</strong> as a search expression does not find items where the words <strong>trade</strong> and <strong>closed</strong> both occur. It only returns items that include the exact phrase <strong>trade closed</strong>.</td>
</tr>
<tr>
<td>trade AND closed AND management</td>
<td>Finds items containing the words <strong>trade</strong> and <strong>closed</strong> and <strong>management</strong>.</td>
</tr>
<tr>
<td>trade OR closed</td>
<td>Finds items containing either the word <strong>trade</strong> or the word <strong>closed</strong>, as well as messages that contain both words.</td>
</tr>
<tr>
<td>trade OR closed OR management</td>
<td>Finds items containing either the word <strong>trade</strong> or the word <strong>closed</strong> or the word <strong>management</strong>, or any combination of the three words.</td>
</tr>
<tr>
<td>trade NOT closed</td>
<td>Finds items that contain the word <strong>trade</strong> but that do not contain the word <strong>closed</strong>.</td>
</tr>
</tbody>
</table>
To control the order in which operators are processed in search expressions, use parentheses. Refer to:

- “Precedence of operators in the Search Expression field” on page 289
- “Using parentheses in the Search Expression field” on page 289

**Using the tense conflation operator in the Search Expression field**

*Note:* This section applies to both editions of Discovery Manager.

You can use the tense conflation operator (~) in search expressions to search for variants of a root verb that begin or end with the same word stem.

- Trailing conflation involves the use of a ~ at the end of a word.
- Leading conflation involves the use of a ~ at the beginning of a word.

*Note:* Although you can use tense conflation, you should use the wildcard (*) character instead because it is simpler and more predictable.
Examples: Tense conflation operator in Search Expression field

Note: This section applies to both editions of Discovery Manager.

<table>
<thead>
<tr>
<th>Search expression</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>manage~</td>
<td>Finds items containing variants of the verb manage. For example, items containing managed and managing would be returned.</td>
</tr>
<tr>
<td>~install</td>
<td>Finds items containing words that have install as the ending verb root. For example, items containing uninstall and reinstall would be returned.</td>
</tr>
<tr>
<td>manage~ AND tools</td>
<td>Finds items containing both tools and any variants of the verb manage.</td>
</tr>
</tbody>
</table>
Using wildcards in the Search Expression field

Note: This section applies to both editions of Discovery Manager.

You can use the asterisk wildcard character (*) in search expressions to search for variants of a word. The asterisk wildcard searches for any number of significant characters.

IMPORTANT
Only the asterisk is supported as a wildcard. Do not use other reserved characters (such as question marks) as wildcards in a search term, otherwise unintended results may be returned. Refer to “Characters” on page 292 for a list of reserved characters.

You can use an asterisk wildcard:

- At the end of a word - Finds all words that start with the specified letters.
- At the beginning of a word - Finds all words that end with the specified letters.

Note: Using asterisk wildcards at the beginning of words may increase the search time significantly.

Best practices: Asterisk wildcards in Search Expression field

Note: This section applies to both editions of Discovery Manager.

- Use narrowly scoped searches when using asterisk wildcards.

  When you perform a search that includes the asterisk wildcard character, you should avoid performing wildcard searches that are not scoped in some way, as these searches may take a large amount of time to complete. For example, searching through all attachments for all users for all time periods would take a large amount of time to complete.

  A narrowly scoped search is more effective and completes more quickly. If you use asterisk wildcards in the Search Expression field, also use the Sender, Recipient, and Message Date fields to narrow the scope of the search.
Reserved words

Note: This section applies to both editions of Discovery Manager.

Reserved words are used by the SourceOne for certain search operations and may produce unintended results when used in a search expression. To search for a reserved word, precede the word with an insignificant character, such as a single quote, to indicate that the word should be processed as ordinary text and not processed as an operator.

For example, to indicate that the Boolean operator AND should be interpreted as ordinary text, precede it with a single quote:

'and

The following table lists the reserved words that should be preceded by an insignificant character if you want to process them as ordinary text. For a list of insignificant characters, refer to “Insignificant characters” on page 293.

Note: Although the range keywords (AFTER, BEFORE, GE, LE, or TO) are reserved, SourceOne does not support search expressions containing range keywords. SourceOne does not support the positional operators IN and LABEL. SourceOne does not support the Boolean operator EXCEPT.

<table>
<thead>
<tr>
<th>Reserved Word</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>AFTER</td>
<td>Range keyword</td>
</tr>
<tr>
<td>AND</td>
<td>Boolean operator</td>
</tr>
<tr>
<td>BEFORE</td>
<td>Range keyword</td>
</tr>
<tr>
<td>EXCEPT</td>
<td>Boolean operator</td>
</tr>
<tr>
<td>GE</td>
<td>Range keyword</td>
</tr>
<tr>
<td>IN</td>
<td>Positional operator</td>
</tr>
<tr>
<td>LABEL</td>
<td>Positional operator</td>
</tr>
<tr>
<td>LE</td>
<td>Range keyword</td>
</tr>
</tbody>
</table>
Using the Search Expression Field

Specifying multiple words in the Search Expression field

Note: This section applies to both editions of Discovery Manager.

You can search for exact phrases by creating search expressions containing a maximum of 8,000 characters.

You are not required to enclose phrases in double or single quotes, but doing so is also valid. For more information, refer to “Using quotation marks in the Search Expression field” on page 291.

Punctuation characters are treated as white space.

Examples: Multiple words in Search Expression field

Note: This section applies to both editions of Discovery Manager.

<table>
<thead>
<tr>
<th>Search expression</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>find a new broker</td>
<td>Finds items containing the exact phrase.</td>
</tr>
<tr>
<td>abc def</td>
<td>Finds items containing abc def but not abcd.</td>
</tr>
<tr>
<td>a b c</td>
<td>Finds items containing a b c but not abc.</td>
</tr>
<tr>
<td>financial advi*</td>
<td>Finds items containing financial advice, financial adviser.</td>
</tr>
</tbody>
</table>

Table 40  Reserved Words (continued)

<table>
<thead>
<tr>
<th>Reserved Word</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOT</td>
<td>Boolean operator</td>
</tr>
<tr>
<td>OR</td>
<td>Boolean operator</td>
</tr>
<tr>
<td>TO</td>
<td>Range keyword</td>
</tr>
</tbody>
</table>

Table 41  Examples: Multiple words in Search Expression field
Precedence of operators in the Search Expression field

Note: This section applies to both editions of Discovery Manager.

The precedence of operators determines the order in which complex search expressions are processed.

For search expressions that include more than one search term, words and operators are processed in the following order:

1. Phrases
2. // (The proximity NEAR BY operator)
3. AND OR NOT (The Boolean operators)

When a search expression contains several operators of the same precedence, the system processes the operators from left to right.

To override the order of precedence, use parentheses. Refer to “Using parentheses in the Search Expression field” on page 289.

Using parentheses in the Search Expression field

Note: This section applies to both editions of Discovery Manager.

Use parentheses in search expressions to group search terms and operators, to override the default order of precedence. Parentheses change how the expression is interpreted, and affect the results.

IMPORTANT
You must enclose the search expression in parentheses, especially when you use the Search Expression field with an address search field.

Examples:
- When using a Boolean operator between two words, enclose the entire expression in parentheses:
  (corporate OR corp)
◆ When using a Boolean operator between two phrases, enclose each phrase in parentheses and enclose the entire expression in parentheses:

\[((\text{corporate identity}) \text{ OR } (\text{corp ident}))\]

**Examples: Parentheses in the Search Expression field**

*Note: This section applies to both editions of Discovery Manager.*

<table>
<thead>
<tr>
<th>Search expression</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>(trade AND (closed OR management))</td>
<td>Finds items containing both trade and closed, as well as those containing trade and management.</td>
</tr>
<tr>
<td>(fiduciary /5/ (Acme OR Global))</td>
<td>Finds items containing both fiduciary and Acme, or both fiduciary and Global, in which the search terms appear within 5 words of each other in the same paragraph.</td>
</tr>
</tbody>
</table>
Using quotation marks in the Search Expression field

Note: This section applies to both editions of Discovery Manager.

Refer to:
- “Quotation marks in non-nested search terms” on page 291
- “Quotation marks in nested search terms” on page 291

Quotation marks in non-nested search terms
In the Search Expression field, for non-nested search terms:
- Quotation marks are optional.
- You may use double quotes or single quotes in a search expression to make the expression easier to read.

Examples
The following examples of non-nested search terms produce the same results:
- ("John Doe" AND "Q1 Sales")
- (John Doe AND Q1 Sales)

Quotation marks in nested search terms
In the Search Expression field, the correct usage of quotation marks in nested search terms depends on which archive you are searching from SourceOne:
- Case 1: Only the SourceOne archive
- Case 2: Both the SourceOne archive and the EmailXtender archive in coexistence
- Case 3: Only the EmailXtender archive that is in coexistence
In case 2 and case 3, you must not use quotation marks in nested search terms, otherwise an error occurs.

Examples
The following example of nested search terms works correctly in all three cases:
- (John Doe OR (Mary Smith AND Q1 Sales))

The following example of nested search terms causes an error in case 2 and case 3, but works correctly in case 1:
Using the Search Expression Field

◆ ("John Doe" OR ("Mary Smith" AND "Q1 Sales"))

Characters

Note: This section applies to both editions of Discovery Manager.

Some characters are not indexed by EMC SourceOne, so you cannot search on those characters. Other characters are reserved by EMC SourceOne, so you should not search on those characters, otherwise you may get unintended results.

Refer to:
◆ “Characters that are indexed and are searchable” on page 292
◆ “Characters that are not indexed and are not searchable” on page 293
◆ “Reserved characters” on page 293

Characters that are indexed and are searchable

Note: This section applies to both editions of Discovery Manager.

Basic characters
Basic characters are always indexed. The basic character set includes:

a b c d e f g h i j k l m n o p q r s t u v w x y z
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

Significant characters
Significant characters are indexed as standard alphanumeric characters. You can search for these characters if they are included as part of a word, or if they are a word by themselves. The significant character set includes:

$ % & - 0 1 2 3 4 5 6 7 8 9 @ _ Š Œ š œ Ÿ À Á Â Ñ Ô Õ Æ Ç È É Ê Ë Ì Í Î Ï Ð Ñ Ò Ó Ô Õ Ö Ø Ù Ú Û Ü Ý Þ ß à á â ã ä å æ ç è é ê ë ì í î ï ð ñ ò ó ô õ ö ø ù ú û ü ý ŷ
Using the Search Expression Field

Characters that are not indexed and are not searchable

**Note:** This section applies to both editions of Discovery Manager.

**Insignificant characters**
Insignificant characters are not indexed and are automatically removed from a search string. The insignificant character set includes:

' / ` ' 

**Punctuation**
Punctuation characters are not indexed; they are treated as white space. The period is treated as a punctuation character, and produces the same search results as other punctuation characters, unless a period occurs within a word. When a period occurs within a word, it is treated like an alphanumeric character. The punctuation character set includes the following characters:

< > ( ) { } [ ] | \ ; : 

**Mathematical symbols**
Mathematical symbols are not indexed, including the following symbols:

∂ ∆ ∏ ∑ − / · √ ∞∟∩∫≈≠≡≤≥

**Reserved characters**

**Note:** This section applies to both editions of Discovery Manager.

Reserved characters have special meaning in EMC SourceOne. Using any of these characters unintentionally in a search may produce unintended results. Reserved characters include:

* ? ! ~ ( ) \ / . . . . + ' ` ' 

The asterisk (*) is the wildcard character.

In the Search Expression field:

- The tilde (−) is the tense conflation operator.
- Parentheses are used to group search terms and to change the order of operator precedence.
- Two forward slashes (/ /) are used as the NEAR BY proximity operator.
Using the Search Expression Field
This chapter contains the following topics:

- Introduction ................................................................. 296
- Prerequisites ................................................................. 296
- Viewing messages assigned to a standard matter .......... 296
- Applying tags to items ................................................... 298
- Assigning custodians to items ....................................... 302
- Working with in-matter searches ................................. 306
- Removing items from Matter Review ............................ 315
- Viewing status of pending actions in Matter Review ....... 317

Note: Matter review (including custodians, tagging, and assigning messages to matters) is available in the full edition of Discovery Manager.
**Introduction**

*Note: Matter Review is available in the full edition of Discovery Manager.*

To review content in a matter, you can:

- View the list of items assigned to a matter.
- Preview and open items.
- Apply tags to items and remove tags from items.
- Assign custodians to selected items and remove custodians from items.
- Perform an in-matter search (search within the content assigned to the standard matter).
- Delete items from the standard matter

To assign content to a standard matter, refer to Chapter 8, *Collecting Content for Matters.*

*Note: For review results created before Discovery Manager 7.0, source folders for instances of items assigned to a matter are not known. A best efforts scan of collection search information in the matter is used to present metadata.*

**Prerequisites**

*Note: Matter Review is available in the full edition of Discovery Manager.*

To review content in a standard matter, you must have the Investigator role.

**Viewing messages assigned to a standard matter**

*Note: Matter Review is available in the full edition of Discovery Manager.*

Refer to:
Viewing the list of items assigned to a standard matter

Note: Matter Review is available in the full edition of Discovery Manager.

To view the list of items assigned to a standard matter, in the navigation pane:
1. Click the My Matters button.
2. Expand the matter.
3. Expand the Matter Review node.
4. Click the All Items node.

Figure 131  Matter Review - All Items

The work pane lists all the messages assigned to the matter.

Items assigned to a standard matter are automatically de-duplicated.

The default view displays the following information for each item:
1. Basic item metadata appropriate for the item type.
2. Tags and custodians assigned to the item. Refer to “Applying tags to items” on page 298 and “Assigning custodians to items” on page 302.
3. All item types display a Status column, described in “Understanding status” on page 230.
Reviewing Content in Matters

Customizing display of item list in Matter Review

Note: Matter Review is available in the full edition of Discovery Manager.

To customize the display of the list of items in Matter Review, refer to “Customizing display of search results” on page 217.

Previewing items in Matter Review

Note: Matter Review is available in the full edition of Discovery Manager.

You must have the Investigator role to preview items.

To preview an item, select it in the list.

If custodians and tags are assigned to an item, then they are displayed in the metadata section of the preview pane.

Opening items in Matter Review

Note: Matter Review is available in the full edition of Discovery Manager.

To open an item in Matter Review, double-click the item.

Refer to “Opening email messages” on page 224 for more information.

Applying tags to items

Note: Matter Review and tags are available in the full edition of Discovery Manager.

You can apply one or more tags to an item to indicate the results of a review. For example, you could apply the Responsive tag to a message to indicate that the message is relevant to the standard matter.

To apply tags to items:

1. Expand the standard matter’s Matter Review > All Items node.
Applying tags to items

2. Select the items, as described in “Selecting results” on page 226.
3. Refer to:
   - “Applying a review tag” on page 299
   - “Specifying a Quick Click tag” on page 300
   - “Clearing all tags” on page 302

Applying a review tag

Note: Matter Review and tags are available in the full edition of Discovery Manager.

To apply a review tag:
1. Select the items, as described in “Selecting results” on page 226.
2. Do one of the following steps:
   - Right-click and select Tags > tag.
     
     Note: In the shortcut menu, only the first six tags are listed. To see more tags, click All Tags.
   - Right-click and select Tags > All Tags.
     In the All Tags dialog box, select tags to apply, then click OK.
     (To select all tags, select the Name checkbox.)
Reviewing Content in Matters

Figure 133 All Tags

The *Adding tags to items* progress bar appears. The applied tags are displayed in the preview pane when you select the item.

Figure 134 Applied tags displayed in preview pane

**Specifying a Quick Click tag**

*Note:* Matter Review and tags are available in the full edition of Discovery Manager.

After you specify a Quick Click tag, you just click on a selected item to apply that tag to the item. Discovery Manager saves the Quick Click tag you specify so that it will be available in future sessions, until you change it. Quick Click tags are saved by matter. You can specify a different Quick Click tag for each standard matter.
Note: By design, the names and descriptions of the default tags listed in Quick Click are not localized, to prevent edited tags from being overwritten if you change language packs.

To specify a Quick Click tag:

1. Right-click anywhere in the list of items and select **Tags > Set Quick Click**.

   The Set Quick Click dialog box opens.

2. Click the dropdown arrow.

3. Select one of the tags in the dropdown list.

4. Click **OK**.

The Quick Click tag is a toggle:

- To apply the Quick Click tag to an item, click the Tags column for that item.
- To remove the Quick Click tag from an item, click the Tags column for that item.
Clearing all tags

Note: Matter Review and tags are available in the full edition of Discovery Manager.

To clear all tags from selected items in the standard matter:
1. Select items, as described in “Selecting results” on page 226.
2. Right-click on the selected items and select Tags > Clear Tags.

Assigning custodians to items

Note: Custodians are available in the full edition of Discovery Manager.

A custodian is a legal discovery term that refers to the “owner” of a document or piece of evidence. The custodian is unique to a given type of content/evidence. For example, a custodian of an email message is frequently, but not always, the sender or a recipient of that message. The term custodian can also apply in the case of a PST or a archived email that is assigned to another employee. (For example, the original employee left the company and his email was assigned to another employee).

You can apply one or more custodian tags to selected items during review.

Refer to:

- “Assigning custodians” on page 303
- “Specifying a Quick Click custodian” on page 304
- “Clearing all custodians” on page 305

Note: You can also assign custodians when you assign collection search results to a matter, as described in “Assigning collection search results to a standard matter” on page 227.
Assigning custodians

Note: Custodians are available in the full edition of Discovery Manager.

To assign custodians to items:
1. Expand a standard matter’s Matter Review > All Items node.
2. Select the items, as described in “Selecting results” on page 226.
3. Right-click the selected items to display a shortcut menu.

4. Select one of the following options from the shortcut menu:
   - Name of a custodian - Applies the custodian immediately to the selected items.
   - All Custodians - Opens the All Custodians dialog box.

Note: The custodians were created by the Matter Manager in Matter Properties.
Reviewing Content in Matters

To select custodians from the All Custodians dialog box:

a. Select the checkboxes of the custodians that you want to assign.

b. Clear the checkboxes of the custodians that you do not want to assign.

c. Click OK.

Specifying a Quick Click custodian

Note: Matter Review and custodians are available in the full edition of Discovery Manager.

After you specify a Quick Click custodian, you just click on a selected item to apply that custodian to the item. Discovery Manager saves the Quick Click custodian you specify so that it will be available in future sessions, until you change it. Quick Click custodians are saved by matter. You can specify a different Quick Click custodian for each standard matter.

To specify a Quick Click custodian:

1. Right-click anywhere in the list of items and select Custodians > Set Quick Click.

   The Set Quick Click dialog box opens.
Assigning custodians to items

2. Click the dropdown arrow.
3. Select one of the custodians in the dropdown list.

![Figure 138 Set Quick Click - Custodians](image)

4. Click OK.

The Quick Click custodian is a toggle:
- To apply the Quick Click custodian to an item, click the Custodians column for that item.
- To remove the Quick Click tag from an item, click the Custodians column for that item.

Clearing all custodians

Note: Custodians are available in the full edition of Discovery Manager.

To clear all custodians from selected items in a standard matter:
1. Select items, as described in “Selecting results” on page 226.
2. Right-click the selected items and select Custodians > Clear Custodians.
Working with in-matter searches

Note: In-matter searches (review searches) are available in the full edition of Discovery Manager.

To filter the list of items already assigned to a standard matter, you can perform an in-matter search.

Creating an in-matter search in the Matter Review node is similar to creating a collection search in the Collection Area node. You can also create organizational folders for in-matter searches. Refer to Chapter 8, “Collecting Content for Matters” for information about creating searches and organizational folders.

However, there are some differences between in-matter searches and collection searches. Refer to:

- “Considerations and limitations of in-matter searches” on page 306
- “About in-matter searches and hold folders” on page 307
- “Viewing list of in-matter searches” on page 307
- “Creating an in-matter search” on page 308
- “Using folders to organize review searches” on page 309
- “Searching on tags” on page 312
- “Searching on custodians” on page 314

Considerations and limitations of in-matter searches

Note: In-matter searches (review searches) are available in the full edition of Discovery Manager.

- The fields on which you can search depend on whether or not the standard matter has an associated hold folder. Refer to “About in-matter searches and hold folders” on page 307.
- There may be a delay indexing items in a hold folder, which can affect your search results.
- Before running a review search on a hold folder, wait until all of the items have the “On hold” state. Otherwise, you will get different search results each time.
In the Matter Review node (unlike the Collection Area node), you can modify a search that has run. After the items have been assigned to the matter, tracking every instance of a matter review search is not required to account for chain of custody. As a result, searches in Matter Review do not display subnodes for past occurrences of the search.

About in-matter searches and hold folders

Note: In-matter searches (review searches) are available in the full edition of Discovery Manager.

If a standard matter has an associated hold folder, then the fields on which you can search are the same as for collection searches. In addition, the Tags, Exclude Tags, Custodians, and Exclude Custodians fields are also available.

If a matter does not have an associated hold folder, then the fields on which you can search are limited to Tags, Exclude Tags, Custodians, Exclude Custodians, and Date. In addition, the Show field is set to All and cannot be changed.

For all search fields to be available in an in-matter search, the standard matter must have an associated hold folder, and the items in that hold folder must be full-text indexed.

Best practice: The EMC SourceOne Email Management administrator should ensure that the EMC SourceOne archive folders used for legal hold are full-text-indexed.

Viewing list of in-matter searches

Note: In-matter searches (review searches) are available in the full edition of Discovery Manager.

To view the list of existing in-matter searches for a standard matter, in the navigation pane:

1. Click the My Matters button.
2. Select the matter.
3. Click the Matter Review node.
The following table describes the information shown for each search in the Matter Review node.

### Table 43  Matter Review columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the review search.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the review search:</td>
</tr>
<tr>
<td></td>
<td>• Created - The new search has not been run or scheduled to run.</td>
</tr>
<tr>
<td></td>
<td>• Waiting - The search is waiting to start processing items.</td>
</tr>
<tr>
<td></td>
<td>• Queued - The search has been queued due to backend load.</td>
</tr>
<tr>
<td></td>
<td>• Running - The search is actively processing items.</td>
</tr>
<tr>
<td></td>
<td>• Suspended - The running search has been paused.</td>
</tr>
<tr>
<td></td>
<td>• Resuming - The suspended search is continuing.</td>
</tr>
<tr>
<td></td>
<td>• Stopping - The running search is in the process of being terminated.</td>
</tr>
<tr>
<td></td>
<td>• Stopped - The running search has been terminated.</td>
</tr>
<tr>
<td></td>
<td>• Stopped due to search limits - The running search has been terminated</td>
</tr>
<tr>
<td></td>
<td>because the maximum number of search results was returned.</td>
</tr>
<tr>
<td></td>
<td>• Incomplete - The search returned incomplete results.</td>
</tr>
<tr>
<td></td>
<td>• Complete - The search finished successfully.</td>
</tr>
<tr>
<td></td>
<td>• Failed - The search was unable to finish successfully.</td>
</tr>
<tr>
<td></td>
<td>• Deleting - The search is in the process of being deleted.</td>
</tr>
<tr>
<td></td>
<td>• Unknown - The status of the search is not known.</td>
</tr>
</tbody>
</table>

**Note:** To update grids, navigate away from the grid (for example, select another search node), and then navigate back to the grid.

<table>
<thead>
<tr>
<th>Creation Date</th>
<th>Date and time on which the review search was created</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items Processed</td>
<td>Total number of items returned in search results.</td>
</tr>
</tbody>
</table>

### Creating an in-matter search

**Note:** In-matter searches (review searches) are available in the full edition of Discovery Manager.

To create an in-matter search, in the navigation pane:

1. Click the **My Matters** button.
2. Select the standard matter for which you want to create an in-matter search.

3. Do one of the following steps:
   - Right-click the Matter Review node, then select New Search.
   - Click the Matter Review node, then in the ribbon pane, click Search/Export tab > Search.
   - Under the Matter Review node, right-click a folder used to organize searches, then select New Search.

   A new search named New Search appears in the navigation pane, under the Matter Review node.

4. Edit the name of the New Search folder under the Matter Review node, then press Enter.

5. In the work pane, specify search criteria. Refer to:
   - “Specifying Search Criteria” on page 233
   - “Searching on tags” on page 312
   - “Searching on custodians” on page 314

---

**Using folders to organize review searches**

*Note:* Folders to organize review searches are available in the full edition of Discovery Manager.

To organize review searches, you can create folders under the Matter Review node in the navigation pane.

These organizing folders:
- Are optional
- Can be only one level deep (no nested folders)

You can:
- Create organizing folders at any time.
- Rename organizing folders.
- Drag-and-drop searches from one organizing folder to another within a matter:
Reviewing Content in Matters

- You can drag a collection search from one folder to another folder in the Collection Area.
- You can drag a review search from one folder to another folder in the Matter Review area.
- You cannot drag a collection search from the Collection Area to Matter Review, or a review search from Matter Review to the Collection Area.
- You cannot drag searches from one matter to another matter.

Refer to:
- “Creating folders to organize searches: Matter Review” on page 310
- “Renaming organizing folders: Matter Review” on page 311
- “Deleting organizing folders: Matter Review” on page 311

Creating folders to organize searches: Matter Review

Note: Folders to organize review searches are available in the full edition of Discovery Manager.

To create a folder to organize review searches, in the navigation pane:
1. Click the My Matters button or the All Matters button.
   
   Note: The All Matters button is available in the full edition of Discovery Manager.

2. Expand the matter for which you want to create the folder.
3. Do one of the following steps:
   - Click the Matter Review node in the navigation pane, then select Matter tab > New Folder.
     If there are no organizing folders or searches, then you can do one of the following steps:
     - Click the New Folder (Ctrl-F) link in the work pane.
     - Click in the work pane, then press Ctrl-F.
   - Right-click the Matter Review node, then select New Folder.

A folder named New Folder appears in the navigation pane, under the Matter Review node.
4. Edit the name of the new folder.

   **Note:** The names of organizing folders do not have to be unique within the Matter Review area of a matter.

5. Press **Enter**.

**Renaming organizing folders: Matter Review**

   **Note:** Folders to organize review searches are available in the full edition of Discovery Manager.

To rename a folder used to organize review searches:

1. Click the **My Matters** button or the **All Matters** button.

   **Note:** The All Matters button is available in the full edition of Discovery Manager.

2. Expand the matter and the **Matter Review** node containing the folder you want to rename.

3. Right-click the folder, then select **Rename**.

4. Edit the highlighted name of the folder.

5. Press **Enter**.

**Deleting organizing folders: Matter Review**

   **Note:** Folders to organize review searches are available in the full edition of Discovery Manager.

   **Note:** You can delete empty organizing folders. You cannot delete organizing folders that contain searches.

To delete a folder used to organize review searches, in the navigation pane:

1. Click the **My Matters** button or the **All Matters** button.

   **Note:** The All Matters button is available in the full edition of Discovery Manager.
2. Expand the matter and the **Matter Review** node containing the folder you want to delete.
3. Right-click the folder, then select **Delete**.

**Searching on tags**

*Note:* In-matter searches (review searches) and tags are available in the full edition of Discovery Manager.

You can assign tags to items in Matter Review, as described in “Applying tags to items” on page 298.

You can search for items that have specific tags assigned by using the Tags field. You can search for items that do not have specific tags assigned by using the Exclude Tags field.

To search for items based on tags:

1. To add the **Tags** search field or the **Exclude Tags** search field:
   a. Click **Add Criteria**.
   b. Select **Tags** or **Exclude Tags**.

   *Note:* You can also change one field to another, as described in “Changing existing search fields” on page 240.

2. In the **Tags** field or the **Exclude Tags** field:
   a. Click the icon next to the field label.

   ![Tags field and Exclude Tags field](image)

   The All Tags dialog opens.

   b. Specify tags:
      - Select the tags on which to search.
      - Deselect the tags that you do not want to search.
c. Click **OK** to close the All Tags dialog.

The selected tags are listed in the Tags field or the Exclude Tags field, as appropriate.

**Note:** Multiple tags in the same Tags field or in the same Exclude Tags field are automatically ORed. To AND tags, add more Tags fields or Exclude Tags fields, as described in step 1.

**Note:** The Tags field and the Exclude Tags fields are read-only. To add or remove tags, refer to step 2.
Searching on custodians

Note: In-matter searches (review searches) and custodians are available in the full edition of Discovery Manager.

You can assign custodians to items in Matter Review, as described in “Assigning custodians to items” on page 302.

Note: You can also assign custodians when you assign collection search results to a standard matter, as described in “Assigning collection search results to a standard matter” on page 227.

You can search for items that have specific custodians assigned by using the Custodians field. You can search for items that do not have specific custodians assigned by using the Exclude Custodians field.

To search based on custodians:

1. To add the Custodians search field or the Exclude Custodians search field:
   a. Click Add Criteria.
   b. Select Custodians or Exclude Custodians.

   Note: You can also change one field to another, as described in “Changing existing search fields” on page 240.

2. In the Custodians field or the Exclude Custodians field:
   a. Click the icon next to the field label.

   Figure 141 Custodians field and Exclude Custodians field

   The All Custodians dialog opens.

   b. Specify custodians:
      – Select the custodians on which to search.
      – Deselect the custodians that you do not want to search.
Reviewing Content in Matters

Figure 142 All Custodians dialog

c. Click OK to close the All Custodians dialog.

The selected custodians are listed in the Custodians field or the Exclude Custodians field, as appropriate.

**Note:** Multiple custodians in the same Custodians field or in the same Exclude Custodians field are automatically ORed. To AND custodians, add more Custodians fields or Exclude Custodians fields as described in step 1.

**Note:** The Custodians field is read-only. To add or remove custodians, refer to step 2.

---

Removing items from Matter Review

**Introduction**

**Note:** Matter Review is available in the full edition of Discovery Manager.

You can remove items from a standard matter (for example, items that are not relevant).

Assigning an item to a standard matter changes the item from unassigned to either assigned or ultimately on hold. Removing an item from a standard matter simply puts it back to assigned, and
deletes the item from the hold folder if the standard matter has a hold folder.

Removing an item from a standard matter does not delete it from a search result set.

**Note:** You can remove items that do not have tags. You cannot remove an item that has a tag. If you select multiple items and any of the selected items have tags, then none of the selected items will be removed from the standard matter. You must remove all tags from an item before you can remove the item from Matter Review.

If you remove an item from a matter, the state of the item changes to Deleting. The item is still listed, but is displayed in gray, which indicates that it is unavailable. The right-click menu is disabled for the item. You cannot open the item.

It may take a few minutes for the items to be removed from the index that is associated with the hold folder. If you run a full-text index review search after you remove messages from a matter, but before the index is updated, the search may return results that include the removed messages.

### Procedure

To remove items from a matter review:

1. In the My Matters area in the navigation pane, expand the **Matter Review > All Items** node for the standard matter.
2. Select the items, as described in “Selecting results” on page 226.
3. Right-click, then select **Remove Results From Matter** from the shortcut menu.
4. At the confirmation prompt, do one of the following steps:
   - Click Yes to confirm the removal.
   - Click No to cancel the removal.
5. If you attempt to remove an item that has tags, then an error displays: *Items with tags applied cannot be deleted.* Click **OK** to close the error dialog.
Viewing status of pending actions in Matter Review

Note: Matter Review is available in the full edition of Discovery Manager.

To view the status of pending actions for a standard matter in Matter Review, refer to “Monitoring status of operations for a matter” on page 230.
This chapter contains the following topics:

- Introduction ......................................................... 320
- Content types and export containers ....................... 321
- Specifying results to export .................................... 322
- Specifying export settings ....................................... 325
- About export processing ......................................... 331
- Viewing status of pending exports for a matter .......... 331
- Viewing export information and contents ................ 332
- Using folders to organize exports ......................... 360
- Deleting an export ............................................... 362
Introduction

Use Discovery Manager (full edition or express edition) to export archived content and metadata in response to legal or regulatory notice, or corporate policy complaint.

You can:

- Export all results or selected results from a search in the Collection Area node or, with the full edition of Discovery Manager, from the Matter Review node.
- Export content and/or metadata. Refer to “Content types and export containers” on page 321.

**Note:** The full edition of Discovery Manager 7.0 supports EDRM XML 1.0 for email and EDRM XML 1.2 for email, files, and SharePoint. EDRM XML 1.0 will not be supported in future releases.

- Specify the destination of the exported file.
- Schedule an export.

**Note:** Scheduling exports is available in the full edition of Discovery Manager.

- Remove duplicates.
- Split export files by size and/or custodian for Native, PST, and NSF container types.

**Note:** Split By Custodian is available in the full edition of Discovery Manager.

Limitations: Export in Discovery Manager express edition

In Discovery Manager express edition:

- You can export archived email content. You cannot export archived files or archived SharePoint content.
- You can export email metadata to TSV format. You cannot export email metadata to CSV format or EDRM XML format.
- You can export email to all container types (Native, NSF, PST, and File System), as appropriate for the email item’s platform type.
Content types and export containers

To export mixed content to native container files, select Native Container as the container type. Exchange mail items will export to PSTs. Domino/Notes mail items will export to NSFs. Files and SharePoint items will export to the File System container type.

The following table indicates the valid container types for each content type.

- "Yes" indicates that the content type can be exported to that container type.
- "No" indicates that the content type cannot be exported to that container type, and an error will occur.

<table>
<thead>
<tr>
<th>Content type</th>
<th>PST</th>
<th>NSF</th>
<th>File System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email: Exchange</td>
<td>Yes</td>
<td>Yes*</td>
<td>Yes</td>
</tr>
<tr>
<td>Email: Domino</td>
<td>Yes**</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Files</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>SharePoint</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

- * Exporting Exchange calendar items to a Domino NSF file is not supported.
- ** If you export Domino/Notes items to a PST container, then all of the item types may not be exported. Both editions of Discovery Manager can convert Notes messages to PST format for export.
- IBM Lotus Domino items cannot be output to the File System container type.

When you export to the File System container type, the files retain their original names. The file extensions depend on the content type:

- Microsoft Exchange messages are output as .msg files.
- Archived files are output as .extension.
Exporting Content and Metadata

- Each SharePoint item is output as an .xml file, which is a SharePoint item blob, also called SourceOne SharePoint XML.

Specifying results to export

In both editions of Discovery Manager, you can export results from a current or past search in the Collection Area node.

In the full edition of Discovery Manager, you can also export results from:
- A current search in the Matter Review node
- The All Items node under Matter Review

**Note:** Matter Review is available in the full edition of Discovery Manager.

Refer to:
- “Considerations and limitations” on page 322
- “Specifying all results to export” on page 323
- “Selecting results to export” on page 323

Considerations and limitations

- You are not able to export items from a search that is still running. You must wait until a search completes before you can export results from that search.
- Export to EDRM XML 1.0 and 1.2 is available in the full edition of Discovery Manager.
- The Split By Custodian option is available in the full edition of Discovery Manager.

The Split By Custodian option is not available for exports from collection searches in the Collection Area.

The Split By Custodian option is available only when all of the following conditions are true:
- The standard matter contains custodians.
- You export from a review search in the Matter Review area, or from the Matter Review > All Items area.
- You select the Native Container, PST, or NSF export file type.
Specifying results to export

By default, the Additional Routes and Metadata section that you can display for previewed messages is not exported. Your Discovery Manager administrator may choose to allow the export of that information.

Exporting duplicates:
- If you display duplicates in collection search results, then you can export the duplicates. To display duplicates in the collection search, refer to “Displaying duplicates in search results” on page 215.
- If you do not display duplicates in collection search results, then the results will be deduplicated in the output files produced by export. Metadata is rolled up for all instances and, if you choose to export metadata, will be output with the instance you selected.
- In the Matter Review area, search results are always deduplicated.

Specifying all results to export

To export all results from the Collection Area or Matter Review:

1. In the navigation pane, right-click on the appropriate search node, then select Export all results.

Note: You cannot export all results in one step from the Matter Review > All Items node. Refer to “Selecting results to export” on page 323. Matter Review is available in the full edition of Discovery Manager.

The Export dialog box opens.

2. Continue to “Specifying export settings” on page 325.

Selecting results to export

To export selected results:

1. Display the results that you want to select.

In both editions of Discovery Manager, the results can be from a collection search. In Discovery Manager full edition, the results can also be from a review search (an in-matter search) or the All Items grid.
Note: Matter Review is available in the full edition of Discovery Manager.

2. You can sort the results (for example, by tag, custodian, or date).

3. Select the results that you want to export, as described in the following table.

<table>
<thead>
<tr>
<th>To select</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single result</td>
<td>Click</td>
</tr>
<tr>
<td>Multiple contiguous results</td>
<td>Shift-Click</td>
</tr>
<tr>
<td>Multiple non-contiguous results</td>
<td>Ctrl-Click</td>
</tr>
<tr>
<td>All results</td>
<td>Ctrl-A</td>
</tr>
<tr>
<td>All results from current selection to end of set</td>
<td>Click-Shift-End</td>
</tr>
<tr>
<td>All results from current selection to beginning of set</td>
<td>Click-Shift-Home</td>
</tr>
</tbody>
</table>

4. Right-click on the grid, then select Export.

The Export dialog box opens.

5. Continue to “Specifying export settings” on page 325.
Specifying export settings

Introduction

In the Export dialog box, specify the name, container type, metadata type, and other settings for the export file.

You can choose to export only content, only metadata, or both content and metadata. The first time you open the Export dialog, the defaults are:

- Container type: None
- Metadata type: None

![Figure 143 Export defaults - None (content type), None (metadata type)](Image)

Expand the Advanced section to see additional options. The available options depend on the container type and metadata type that you selected, as described in Table 46, “Export settings”.
Exporting Content and Metadata

Figure 144  Example - Export to container and metadata, Advanced options

Procedure  
1. Specify settings for the export, as described in Table 46, “Export settings”.
2. Click OK to close the Export dialog box.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
</table>
| Name             | Displays the first 30 characters of the matter name. You can edit this name, up to a maximum of 30 characters. You may want to use a code name or naming convention, particularly if the matter is sensitive. If the name of the matter contains invalid characters, then:  
  - An error dialog box appears: *The matter name contains one or more of the following illegal characters*: / : * ? “ < > | Name of the matter |
|                  |   - The export name will default to New Export. Click OK to close the error dialog box.                                                                                                                                                                                                                                                        |                          |
| Container type   | Select the type of container in which to export content:  
  - None - Select this option if you want to export only metadata, not content. Ensure that you select a metadata type in the Metadata Type field.  
  - Native Container - Exports mail items to a native container. Exchange mail types will be exported to a PST file. Domino/Notes mail types will be exported to an NSF file.  
  - PST - Exports mail items to Microsoft Outlook Personal Folders file format.  
  - NSF - Exports mail items to IBM Lotus Notes database file format.  
  - File System - Exports items to a file system.  
  
**Note:** Non-native items that cannot be exported to the selected container type will be skipped.  
**Note:** Containers do not include Discovery Manager metadata such as tag information or chain of custody information. To export metadata, use the Metadata Type field. | None (first time you open the Export dialog)  
  - Displays the last container type that you selected. |
### Exporting Content and Metadata

#### Metadata type
Select the type of metadata to export:
- **None** - Select this option if you want to export only content, not metadata. Ensure that you select a container type in the Container Type field.
- **EDRM XML** - Allows litigation support software that complies with this standard transport format to import Discovery Manager output, with full metadata and chain of custody information intact. EDRM XML format is available in the full edition of Discovery Manager.

**Note:** EDRM 1.0 XML is available if you selected only email messages. EDRM 1.2 XML is available for all item types.

- **CSV** - Exports metadata to a comma-separated values file. CSV format is available in the full edition of Discovery Manager.
- **TSV** - Exports metadata to a tab-separated values file.

#### File location
To specify the export location, do one of the following steps:
- Click Browse, then select the destination folder for the export file. The destination must be a UNC shared folder on the network.
- Type a UNC path to a shared folder on the network, in the format: `\server\share\shared_folder`

The maximum number of characters in the UNC path is 110 characters. This is due to the Windows limit of 260 characters for a complete file path, which includes export file names of approximately 150 characters.

If you do not specify a UNC path, then an error message displays: **The UNC path should be of the form \server\share.**

**Note:** EDRM 1.2 XML is available for all item types.

#### Start date
Schedule the export by selecting the date and time on which to start the export.

**Note:** Scheduling exports is available in the full edition of Discovery Manager.

**Advanced** (click the + sign to expand the Advanced section)

---

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Metadata type</strong></td>
<td>Select the type of metadata to export:</td>
<td>• None (first time you open the Export dialog)</td>
</tr>
<tr>
<td></td>
<td>• EDRM XML - Allows litigation support software that complies with this</td>
<td>• Displays the last metadata type that you</td>
</tr>
<tr>
<td></td>
<td>standard transport format to import Discovery Manager output, with full</td>
<td>selected.</td>
</tr>
<tr>
<td></td>
<td>metadata and chain of custody information intact.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CSV - Exports metadata to a comma-separated values file. CSV format</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is available in the full edition of Discovery Manager.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TSV - Exports metadata to a tab-separated values file.</td>
<td></td>
</tr>
<tr>
<td><strong>File location</strong></td>
<td>To specify the export location, do one of the following steps:</td>
<td>Blank or last valid export location</td>
</tr>
<tr>
<td></td>
<td>• Click Browse, then select the destination folder for the export file.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The destination must be a UNC shared folder on the network.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Type a UNC path to a shared folder on the network, in the format:</td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>\server\share\shared_folder</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The maximum number of characters in the UNC path is 110 characters.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This is due to the Windows limit of 260 characters for a complete file path,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>which includes export file names of approximately 150 characters.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If you do not specify a UNC path, then an error message displays: **The</td>
<td></td>
</tr>
<tr>
<td></td>
<td>UNC path should be of the form <code>\server\share</code>.**</td>
<td></td>
</tr>
<tr>
<td><strong>Start date</strong></td>
<td>Schedule the export by selecting the date and time on which to start the</td>
<td>As soon as possible</td>
</tr>
<tr>
<td></td>
<td>export.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Scheduling exports is available in the full edition of Discovery Manager.</td>
<td></td>
</tr>
</tbody>
</table>
### Exporting Content and Metadata

#### Specifying export settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Split by file size</strong></td>
<td>Available for Native Container, PST, and NSF container types. Available for EDRM XML metadata-only export. Specify the maximum file size in MB. In previous releases, if you specified an NSF export file size that was less than the default NSF size on the client computer (typically around 15-25 MB), Discovery Manager created one job for every message. To prevent this from happening, the current release sets the minimum size for NSF export files to 50 MB. To export to NSF, the value in the Split by file size field must be greater than 49 MB and less than or equal to 4700 MB. (SDR 36569) If you export metadata at the same time that you export to a container, then the metadata will be split into files using the same file size that you specified in this field for the container. If you export metadata only to EDRM XML, then you can specify a maximum metadata file size in this field.</td>
<td>4700 MB (default and maximum)</td>
</tr>
<tr>
<td><strong>Include Tags and Custodians</strong></td>
<td>Available in the full edition of Discovery Manager. Available if you select any metadata type. Select this option if you want to include tags and custodians in the metadata files.</td>
<td>Cleared</td>
</tr>
<tr>
<td><strong>Split by custodian</strong></td>
<td>Available in the full edition of Discovery Manager for Native Container, PST, and NSF container types. Optional. The Split by custodian checkbox is available only if a standard matter has custodians. To create a container file for each custodian assigned to the items, and that is no larger than the maximum size, select the Split by custodian checkbox. If multiple custodians were assigned to a single item, then that item will be written to each container file. The Split by file size value also applies to custodian splits. If you select Split by custodian, then items that do not have custodians assigned will be put into a separate &quot;no custodian&quot; container file.</td>
<td>Cleared</td>
</tr>
<tr>
<td><strong>Include custodian name in export filename</strong></td>
<td>Available in the full edition of Discovery Manager for Native Container, PST, and NSF container types. Optional. Available when the Split by custodian option is selected. To include the name of the custodian in the name of each container file for that custodian, select the Include custodian name in export filename checkbox.</td>
<td>Cleared</td>
</tr>
</tbody>
</table>
### Export settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Row count</strong></td>
<td>Available for TSV and CSV metadata types, when you export to metadata only. If you export metadata-only to these formats, you must specify the maximum size for each metadata export file based on row count. This is due to limitations with the applications used to view TSV and CSV files. Each row contains the metadata for one item. The total number of rows equals the total number of items selected for metadata export. Specify the maximum number of rows per exported metadata file. Valid values: 1000 - 1000000 (rows)</td>
<td>65535 (rows)</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If you select a container type other than None, then this option is not available and Split By Size is available. In this case, the file size dictates the number of output files. Each container will have a matching TSV/CSV file.</td>
<td></td>
</tr>
<tr>
<td><strong>Include all columns</strong></td>
<td>Available for TSV and CSV metadata types. Select this option if you want all available columns to be exported to the metadata file.</td>
<td>Cleared</td>
</tr>
</tbody>
</table>
About export processing

- Export processing occurs at the date and time that you specified in the Export dialog box. The default is As soon as possible.

  **Note:** Scheduling exports is available in the full edition of Discovery Manager.

- You can continue working in Discovery Manager (full edition or express edition) during export processing.

- If an infected file is exported to the export location and then anti-virus software removes the infected file, the export summary report counts that file as successfully exported even though the infected file no longer exists at the export location.

- Export processing will complete even if you close the matter or close the Discovery Manager (full edition or express edition) application.

- If the error message *Discovery Manager Server cannot write to ‘share path’* displays during export processing, consult your system administrator.

Refer to.

- “Viewing status of pending exports for a matter” on page 331
- “Viewing export information and contents” on page 332

Viewing status of pending exports for a matter

To view the status of pending exports for a matter, refer to “Monitoring status of operations for a matter” on page 230.
Exporting Content and Metadata

Viewing export information and contents

In the navigation pane, use the Export node to view and manage exports.

Refer to:

- “Viewing list of exports” on page 333
- “Naming conventions for export subdirectories and export files” on page 335
- “Viewing an export summary report” on page 344
- “Viewing list of items that were selected for export” on page 352
- “Viewing list of all container files and metadata files produced by an export” on page 354
- “Viewing list of successfully exported items in a container file” on page 354
- “Viewing list of items that failed to export” on page 355
- “Retrying export of failed items” on page 357
Viewing list of exports

To view a list of exports, in the navigation pane, click the Export node under the matter (My Matters > matter > Export).

The name of each export is listed under the Export node and in the work pane.

Note: Retried exports are not listed under the Export node, but are listed in the export summary report. Refer to “Retrying export of failed items” on page 357.
The work pane lists details about the exports for the matter, as described in the following table.

### Table 4  Columns displayed in list of exports

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the export as specified in the Name field of the Export dialog box, plus the date and time on which the export is scheduled to run in the format <code>year-month-day-hour-minute-seconds-milliseconds</code>. By default, the name of the export is the same as the name of the matter. If the matter name contains invalid characters, then the default name of the export is <code>New Export</code>.</td>
</tr>
<tr>
<td>Status</td>
<td>• Created - The new export has not been run or scheduled to run. &lt;br&gt; • Waiting - The export is waiting to start processing items. &lt;br&gt; • Queued - The export has been queued due to backend load. &lt;br&gt; • Running - The export is actively processing items. &lt;br&gt; • Suspended - The running export has been paused. &lt;br&gt; • Resuming - The suspended export is continuing. &lt;br&gt; • Stopping - The running export is in the process of being terminated. &lt;br&gt; • Stopped - The running export has been terminated. &lt;br&gt; • Stopped due to export limits. &lt;br&gt; • Incomplete - The export returned incomplete results. &lt;br&gt; • Complete - The export finished successfully. &lt;br&gt; • Failed - The export was unable to finish successfully. &lt;br&gt; • Deleting - The export is in the process of being deleted. &lt;br&gt; • Unknown - The status of the export is not known.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>The date and time on which the export was created.</td>
</tr>
<tr>
<td>Items Expected</td>
<td>The number of items estimated for processing, based on the number of items selected for export and the options selected in the Export dialog, such as Split By Custodian.</td>
</tr>
<tr>
<td>Items Succeeded</td>
<td>The number of items that exported successfully.</td>
</tr>
</tbody>
</table>

**Note:** To update grids, navigate away from the grid (for example, select another search node), and then navigate back to the grid.

To change the columns that are displayed:

1. Select the Export node.
2. In the ribbon, select Home tab > Field Chooser.
3. In the Field Chooser dialog box:
a. To add a column, select the checkbox next to the name of the column.

b. To remove a column, clear the checkbox next to the name of the column.

4. To close the Field Chooser dialog box, click the X in the upper right corner.

### Naming conventions for export subdirectories and export files

Refer to:

- “Naming convention for export subdirectory” on page 335
- “Naming conventions for PST and NSF output” on page 336
- “Naming conventions for File System output” on page 337
- “Naming conventions for CSV and TSV output” on page 339
- “Naming conventions for EDRM XML output” on page 341
- “Example: Export of mixed content with multiple custodians” on page 342

### Naming convention for export subdirectory

A subdirectory is created in the export location that you specified in the File Location field in the Export dialog:

```
\FileLocation\subdirectory
```

The name of the export subdirectory is based on the **Name** field and the **Start date** field in the Export dialog:

```
\FileLocation\Name-yyyy-mm-dd-hh-mm-ss-ccc
```

where:

- `yyyy` = year
- `mm` = month
- `dd` = day
- `hh` = hour
- `mm` = minutes
- `ss` = seconds
- `ccc` = milliseconds
Note: SourceOne may shorten the Name portion so that the total number of characters in the subdirectory name does not exceed the maximum allowed by the operating system.

Example

Assume you specified the following information in the Export dialog box:

- File Location: \work01\Export
- Name: InsiderTrading
- Start Date: As soon as possible (on January 10, 2013, 3:35:19:451 PM)

Based on that information, the export subdirectory would be:
\work01\Export\InsiderTrading-2013-01-10-15-35-19-451

Depending on the type of container or metadata, custodian options, and split options that you selected in the Export dialog, there may be additional subdirectories, as described in the following sections.

Naming conventions for PST and NSF output

- When you clear the split options and custodian options, then the name of the container file is sequentially numbered
  \( n-1.\text{extension} \), where:
    - \( n \) starts at 0
    - \text{extension} is the container extension (NSF or PST)

Each container file is located in a subdirectory with the same sequential number, below the export subdirectory. The export name and start date is not included in the container name.

Example

Assume that:

- The items you selected for export include both Microsoft Exchange messages and IBM Lotus Domino messages.
- In the Container type field, you selected Native Container.

Result:

There will be two container files, located in two subfolders below the export subdirectory:

- Export_subdirectory\0\0-1.pst
- Export_subdirectory\1\1-1.nsf
When you select both the **Split by custodian** option and the **Include custodian name in export files** option, then there is one container file for each container type for each custodian. The container files are named **Custodian_n-1.extension**, where:

- *n* starts at 0
- *extension* is the container extension (NSF or PST)

Each container file is located in a subfolder with the custodian name and sequential number, below the export subdirectory. The export name and start date is not included in the container name.

**Example**

Assume that:

- There is one custodian assigned to the items: John Doe.
- The items you selected for export include both Microsoft Exchange messages and IBM Lotus Domino messages.
- In the **Container type** field, you selected **Native Container**.
- You selected the **Split by custodian** option.
- You selected the **Include custodian name in export files** option.

**Result:**

There will be two container files, located in two subfolders below the export subdirectory, one for each content type (PST and NSF):

- `Export_subdirectory\John Doe_0\John Doe_0-1.pst`
- `Export_subdirectory\Doe, John_1\Doe, John_1-1.nsf`

The custodian name used for naming subfolders and output files is the user display name from the mail platform or Active Directory.

**Naming conventions for File System output**

**File naming**

When you export to the File System container type, the files retain their original names. The file extensions depend on the content type:

- Microsoft Exchange messages are output as `.msg` files.
- Archived files are output as `.extension`.
- Each SharePoint items is output as an `.xml` file, which is a SharePoint item blob, also called SourceOne SharePoint XML.

IBM Lotus Domino items cannot be output to the File System container type.
**Subfolder naming**

The naming convention for the subfolders in which the files are output depend on the options that you select in the Export dialog.

- When you clear the split options and custodian options, then the output files are located in a subfolder named 0\0000, below the export subdirectory.
  
  **Example:**
  
  \Export_subdirectory\0\0000\n
- When you select the **Split by custodian** option, but not the **Include custodian name in export files** option, then there is one subfolder for each custodian, below the export subdirectory. The subfolders are numbered sequentially starting at 0.
  
  **Example**

  Assume that:
  
  - There are two custodians assigned to the items.
  - In the **Container type** field, you selected **File System**.
  - You selected the **Split by custodian** option.
  
  Result:

  There will be two subfolders below the export subdirectory, one for each custodian:

  \Export_subdirectory\0\0000\n  \Export_subdirectory\1\0000\n
- When you select both the **Split by custodian** option and the **Include custodian name in export files** option, then there is one subfolder for each custodian, below the export subdirectory. The subfolders are named for each custodian, and sequentially numbered starting at 0.
  
  **Example**

  Assume that:

  - There are two custodians assigned to the items: John Doe and Mary Smith.
  - In the **Container type** field, you selected **File System**.
  - You selected the **Split by custodian** option.
You selected the Include custodian name in export files option.

Result:

There will be two subfolders below the export subdirectory:

- `Export_subdirectory\John Doe_0\0000\`
- `Export_subdirectory\Mary Smith_1\0000\`

**Naming conventions for CSV and TSV output**

- When you export metadata for a single content type and you clear the split options and the custodian options:
  - If you selected **CSV** for the **Metadata type**, then one CSV file is created named `0.csv`.
  - If you selected **TSV** for the **Metadata type**, then one TSV file is created named `0.tsv`.

  The CSV or TSV file is located in a subfolder named `0`, below the export subdirectory.

  Example:

  - `Export_subdirectory\0`

- When you export metadata for multiple content types and you clear the split options and the custodian options:
  - If you selected **CSV** for the **Metadata type**, then one CSV file is created for each content type, named `n.csv`.
  - If you selected **TSV** for the **Metadata type**, then one TSV file is created for each content type, named `n.tsv`.

  The CSV or TSV file is located in a corresponding subfolder named `n`, below the export subdirectory.

  Numbering is sequential starting at 0.

  Example

  Assume that:

  - The items you selected include two content types: Microsoft Exchange messages and IBM Lotus Domino messages.
  - In the **Container type** field, you selected **None**.
  - In the **Metadata type** field, you selected **CSV**.

  Result:

  There will be two CSV files, located in two subfolders below the export subdirectory, one for each content type:
When you export metadata for a single content type and you select the **Split by custodian** option, but not the **Include custodian name in export files** option:

- If you selected **CSV** for the **Metadata type**, then one CSV file is created for each custodian, named `n.csv`.
- If you selected **TSV** for the **Metadata type**, then one TSV file is created for each custodian, named `n.tsv`.

The CSV or TSV file is located in a corresponding subfolder named `n`, below the export subdirectory.

Numbering is sequential starting at 0.

**Example**

Assume that:

- The items you selected include only one content type, such as Microsoft Exchange messages.
- In the **Container type** field, you selected **None**.
- In the **Metadata type** field, you selected **CSV**.
- There are two custodians assigned to the items.
- You selected the **Split by custodian** option.
- You did not select the **Include custodian name in export files** option.

**Result:**

There will be two CSV files, located in two subfolders below the export subdirectory, one for each custodian:

```
Export_subdirectory\0\0.csv
Export_subdirectory\1\1.csv
```

When you export metadata for a single content type and you selected both the **Split by custodian** option and the **Include custodian name in export files** option:

- If you selected **CSV** for the **Metadata type**, then one CSV file is created for each custodian, named `Custodian_n.csv`.
- If you selected **TSV** for the **Metadata type**, then one TSV file is created for each custodian, named `Custodian_n.tsv`. 
The CSV or TSV file is located in a corresponding subfolder named Custodian_n, below the export subdirectory.

Numbering is sequential starting at 0.

Example

Assume that:

- The items you selected include only one content type, such as Microsoft Exchange messages.
- In the Container type field, you selected None.
- In the Metadata type field, you selected CSV.
- There are two custodians assigned to the items: John Doe and Mary Smith.
- You selected the Split by custodian option.
- You selected the Include custodian name in export files option.

Result:

There will be two CSV files, located in two subfolders below the export subdirectory, one for each custodian:

Export_subdirectory\John Doe_0\John Doe_0.csv
Export_subdirectory\Mary Smith_1\Mary Smith_1.csv

Naming conventions for EDRM XML output

- When you clear the split options and custodian options, then the name of the EDRM XML file is the same as the name of the export subdirectory in which it is located, appended with -1.xml:
  
  Name-yyyy-mm-dd-hh-mm-ss-ccc-n-1.xml

  Example:


  The single XML file includes metadata for all items that were exported.

- When you select the Split by custodian option, but not the Include custodian name in export files option, then there is one XML file for each custodian. The XML files are sequentially numbered starting at 0. Each XML file is located in a subdirectory with the same sequential number, below the export subdirectory. The export name and start date is not included in the XML name.

  Example
Assume that:

- There are two custodians assigned to the items.
- You selected the **Split by custodian** option.
- You did not select the **Include custodian name in export files** option.

Result:

There will be two EDRM XML files located in two subdirectories below the export subdirectory, one for each custodian:

- `Export_subdirectory\0\0.xml`
- `Export_subdirectory\1\1.xml`

- When you select both the **Split by custodian** option and the **Include custodian name in export files** option, then there is one XML file for each custodian. The XML files are named for each custodian, and sequentially numbered starting at 0. Each XML file is located in a subdirectory with the custodian name and sequential number, below the export subdirectory. The export name and start date is not included in the XML name.

**Example**

Assume that:

- There are two custodians assigned to the items: John Doe and Mary Smith.
- You selected the **Split by custodian** option.
- You selected the **Include custodian name in export files** option.

Result:

There will be two EDRM XML files located in two subdirectories below the export subdirectory, one for each custodian:

- `Export_subdirectory\John Doe_0\John Doe_0.xml`
- `Export_subdirectory\Mary Smith_1\Mary Smith_1.xml`

**Example: Export of mixed content with multiple custodians**

Assume that:

- The items you selected for export include all platform types (Exchange, Domino, archived files, and SharePoint).
- Three custodians were assigned to the selected items:
• John Doe was assigned to the archived files and Domino items.
• Mary Smith was assigned to the SharePoint items.
• Ted Pipes was assigned to the Exchange items.

◆ In the Container type field, you selected Native.
◆ In the Metadata type field, you selected CSV.
◆ You selected the Split by custodian option.
◆ You selected the Include custodian name in export files option.

Result:
The following table lists the subfolders and output files. The subfolders are below the export subdirectory.

<table>
<thead>
<tr>
<th>Subfolders</th>
<th>Output files</th>
</tr>
</thead>
<tbody>
<tr>
<td>\John Doe_0</td>
<td>John Doe_0.csv</td>
</tr>
<tr>
<td>\John Doe_0\0000</td>
<td>*.csv extension</td>
</tr>
<tr>
<td>\Mary Smith_1</td>
<td>Mary Smith_1.csv</td>
</tr>
<tr>
<td>\Mary Smith_1\00000</td>
<td>*.xml (SharePoint item blob)</td>
</tr>
</tbody>
</table>
| \Doe, John_2 | Doe, John_2.csv
Doe, John_2-1.nsf |
| \Ted Pipes_3 | Ted Pipes_3.csv
Ted Pipes_3-1.pst |
Viewing an export summary report

Refer to:
- “Accessing an export summary report” on page 344
- “Printing an export summary report” on page 346
- “Information in export summary report” on page 347
- “Understanding sizes of export files” on page 351

Accessing an export summary report

To access an export summary report, use either of the following methods.

**Method 1**
1. In the navigation pane, click the Export node under the matter (My Matters > matter > Export).
2. In the top work pane, select an export from the list.
   - If a scheduled export has not run, then a message displays stating that the export has not yet run.
   
   **Note:** Scheduling exports is available in the full edition of Discovery Manager.

   - If the export has run, then the export summary report displays in the bottom work pane.
Exporting Content and Metadata

3. The export report is refreshed every five seconds. To display the refreshed report, do one of the following steps:
   - Select the export in the list in the work pane.
   - Select the export node.

**Method 2**

1. In the navigation pane, expand the **Export** node under the matter (My Matters > matter > Export).
2. In the navigation pane under the Export node, select an export.
3. In the work pane, click the Summary tab.
   - If a scheduled export has not run, then a message displays stating that the export has not yet run.

---

**Figure 147** Sample export summary report

---

Viewing export information and contents
If the export has run, then the export summary report displays.

- Scheduling exports is available in the full edition of Discovery Manager.

**Note:**

If the export has run, then the export summary report displays.

![Figure 148 Export - Summary tab](image)

**Printing an export summary report**

Use the icons in the toolbar above the export summary report to refresh the report, save the report as an XPS file, print the report, or display a print preview.

![Figure 149 Report toolbar](image)
Information in export summary report

Note: In Discovery Manager 7.0, the export summary report is significantly refactored, and some fields will display “data unavailable” for older export records. Export share filesystem and naming conventions have changed. Older data will be presented as recorded, but no tracking of older export files to the share are checked or validated. Results will appear different for newer exports.

The title of the export summary report is the name of the export and the datetime on which the export was created.

The export summary report is refreshed if the export is no longer running. As a result, the export summary report displays the current state at the time when the report was generated. The state automatically refreshes in the export grid, but the state remains unchanged in the export summary report. After the export completes, the export summary report updates once to reflect the final status of the export operation, which should match the grid.

The export summary report displays the following information:

<table>
<thead>
<tr>
<th>Area</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created by</td>
<td>Created by Name of the</td>
<td>Name of the Discovery Manager user who created the export.</td>
</tr>
<tr>
<td>Creation date</td>
<td>Creation date The date</td>
<td>The date and time on which the export was created.</td>
</tr>
<tr>
<td>Finish date</td>
<td>Finish date The date and</td>
<td>The date and time at which the export completed.</td>
</tr>
<tr>
<td>State</td>
<td>State The status of the</td>
<td>The status of the export:</td>
</tr>
<tr>
<td></td>
<td>export:</td>
<td>• Complete</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Partially complete</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Failed</td>
</tr>
<tr>
<td>Export data location</td>
<td>Export data location The UNC path to the destination for the export files, as specified in the File Location field in the Export dialog.</td>
<td>• If the export was successful, then you can click on this link to go to the export location.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the export failed, then the link is not available.</td>
</tr>
</tbody>
</table>
Exporting Content and Metadata

### Table 48  Information in export summary report (continued)

<table>
<thead>
<tr>
<th>Area</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export Results</td>
<td>Submitted</td>
<td>The number of items selected for export.</td>
</tr>
<tr>
<td></td>
<td>Expected</td>
<td>The number of items estimated for processing, based on the Submitted count and the options selected in the Export dialog, such as Split By Custodian.</td>
</tr>
<tr>
<td></td>
<td>Succeeded</td>
<td>The number of items that were exported successfully.</td>
</tr>
<tr>
<td></td>
<td>Failed</td>
<td>The number of items that failed to export. Refer to “Viewing list of items that failed to export” on page 355 and “Retrying export of failed items” on page 357.</td>
</tr>
</tbody>
</table>
|               | Output files| The number of files in the File Location folder produced as a result of the export. This count is a sum of:  
|               |             | • Number of container files (PSTs, NSFs). For the File System container type, this is a count of the individual files.  
|               |             | • Number of metadata files.  
|               |             | If you specified the Split By Custodian option in the Export dialog, the number of Output Files may be greater than the number of Submitted items. |
|               | Total size on disk | The total amount of disk space occupied by all of the export files, in KB.  
|               |             | **Note:** This number is rounded.                                                                                                             |
### Table 48  Information in export summary report (continued)

<table>
<thead>
<tr>
<th>Area</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export Configuration</td>
<td></td>
<td>Lists the export settings that were specified in the Export dialog box.</td>
</tr>
<tr>
<td></td>
<td>Container type</td>
<td>The container type, as specified in the Container Type field in the Export dialog (None, Native Container, PST, NSF, or File System).</td>
</tr>
<tr>
<td></td>
<td>Metadata type</td>
<td>The metadata type, as specified in the Metadata Type field in the Export dialog (None, CSV, TSV, EDRM XML 1.0, or EDRM XML 1.2).</td>
</tr>
<tr>
<td></td>
<td>Maximum file size</td>
<td>The maximum size of each export file, as specified in the Split By File Size (MB) checkbox in the Export dialog.</td>
</tr>
</tbody>
</table>
|                       | Separate by custodian           | The state of the Split By Custodian option in the Export dialog: **Yes = selected**  
|                       |                                 | **No = cleared**                                                                                                                                 |
|                       | Include custodian name in export filename | The state of the Include Custodian Name In Export Filename option in the Export dialog:  
|                       |                                 | **Yes = selected**  
|                       |                                 | **No = cleared**                                                                                                                                 |
|                       | Include tags and custodians     | The state of the Include Tags And Custodians option in the Export dialog:  
|                       |                                 | **Yes = selected**  
|                       |                                 | **No = cleared**                                                                                                                                 |
### Table 48 Information in export summary report (continued)

<table>
<thead>
<tr>
<th>Area</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executions</td>
<td>Run by</td>
<td>The name of the Discovery Manager user who ran the export.</td>
</tr>
<tr>
<td></td>
<td>When</td>
<td>The date and time on which the export ran.</td>
</tr>
<tr>
<td></td>
<td>Status</td>
<td>The status of the export:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Complete</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Partially complete</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Failed</td>
</tr>
<tr>
<td></td>
<td>Failed</td>
<td>The number of items that failed to export.</td>
</tr>
<tr>
<td></td>
<td>Succeeded</td>
<td>The number of items that exported successfully.</td>
</tr>
<tr>
<td>Containers and Metadata Files</td>
<td>Containers and Metadata Files</td>
<td>The names of the container files and metadata files output to the specified File Location.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the export was successful, then you can click on the link to go to the export location.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the export failed, then the link is not available.</td>
</tr>
<tr>
<td></td>
<td>Item Count</td>
<td>The number of items in each container file. For the File System container type, this is a count of the individual files.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The number of items described in each metadata file.</td>
</tr>
<tr>
<td>Errors and warnings</td>
<td></td>
<td>Lists errors and warnings associated with this export.</td>
</tr>
</tbody>
</table>

#### Custodians

- **Note:** Custodians are available in the full edition of Discovery Manager.

To display this section, click the arrow button on the right. If the Split By Custodian option was selected in the Export dialog, then this section displays the following information for each custodian.

<table>
<thead>
<tr>
<th>Area</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Name</td>
<td>The name of each custodian associated with items in this export.</td>
</tr>
<tr>
<td>Containers and Metadata Files</td>
<td>Containers and Metadata Files</td>
<td>The names of the container files and metadata files output to the specified File Location for each custodian.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the export was successful, then you can click on the link to go to the export location.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the export failed, then the link is not available.</td>
</tr>
<tr>
<td></td>
<td>Item Count</td>
<td>The number of items in each container file for the custodian. For the File System container type, this is a count of the individual files.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The number of items described in each metadata file, for the custodian.</td>
</tr>
</tbody>
</table>
Understanding sizes of export files

Why is the actual maximum file size smaller than the "Split by file size" value?
In the Export dialog box, the Split by file size value specifies the maximum size for an export file for Native Container, PST, and NSF container types and for EDRM XML metadata-only export. However, the actual maximum size depends on the export format:

- The actual maximum size of an exported PST file is 90% of the Split by file size value. For example, if you specify a Split by file size value of 100 MB, then the actual maximum size of an exported PST file would be 90 MB.

- The actual maximum size of an exported NSF file is much closer to the Split by file size value.

Why aren’t small export files combined into large export files?
A single export operation may be processed by several jobs. Each job produces one or more export files. The jobs are not aware of each other. Small export files produced by several jobs are not combined into large export files.

Example
Assume that:

- The Split by file size value is 100 MB.
- The results produced by a single export operation include the following file sizes: 60 MB, 10 MB, 5 MB, and 90 MB.

Theoretically, the small files (60 MB, 10 MB, and 5 MB) could be combined into a large file without exceeding the Split by file size value. However, small files are not combined into large files during the export operation.
Viewing list of items that were selected for export

To view a list of all items that were selected for export:

1. In the navigation pane:
   a. Expand the Export node under the matter (My Matters > matter > Export).
   b. Select an export.
      A progress indicator informs you that the item list is being retrieved.

2. If you want to cancel the list retrieval, click the Cancel button.
   In the work pane, the grid under the Items tab displays Document retrieval was canceled.

3. If you did not cancel the list retrieval, in the work pane, the grid under the Items tab lists all items that were selected for the export.
The grid displays the same columns as the search grid, with the addition of the following columns.

Table 49  List of items selected for export - additional columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Indicates the current export status of the item:</td>
</tr>
<tr>
<td></td>
<td>• Item exported successfully</td>
</tr>
<tr>
<td></td>
<td>• Item failed to export</td>
</tr>
<tr>
<td>Container Name</td>
<td>The name of container file that contains the successfully exported item. If</td>
</tr>
<tr>
<td></td>
<td>the item has not been successfully exported, or if the export was</td>
</tr>
<tr>
<td></td>
<td>configured to be metadata-only, then this column is empty.</td>
</tr>
<tr>
<td>Metadata File</td>
<td>The name of the metadata file, if the export was configured to export</td>
</tr>
<tr>
<td></td>
<td>metadata. If the export was configured to be content-only, then this</td>
</tr>
<tr>
<td></td>
<td>column is empty.</td>
</tr>
</tbody>
</table>

4. To filter the list by output file, select the container file or metadata file from the Show field at the top of the grid.

![Export - Show field](image)

**Note:** This list is a snapshot of the contents of the container file when the export finished, and it is not intended to represent the current contents of the container file. This list will not change if a user moves or deletes a container file or changes the contents of the container file.

5. To preview an item, select it in the grid.

6. To update the list, right-click the export in the navigation pane and select **Refresh**.
Viewing list of all container files and metadata files produced by an export

To view a list of all container files and metadata files that were produced by an export:

1. In the navigation pane, select an export.
2. Do one of the following steps:
   - View the Executions section in the export summary report. Refer to “Viewing an export summary report” on page 344.
   - In the work pane, click the Items tab. The State column indicates whether each item exported successfully or failed.

Viewing list of successfully exported items in a container file

To view a list of items that were successfully exported to a specific container file:

1. In the navigation pane, select an export.
2. In the work pane, click the Items tab.
   - By default, the item list shows all items that were successfully exported for the selected export.
3. In the Show field, select the name of a container file.
4. Sort on the State column.

Note: This list is a snapshot of the contents of the container file when the export finished, and it is not intended to represent the current contents of the container file. This list will not change if a user moves or deletes a container file or changes the contents of the container file.
**Viewing list of items that failed to export**

**Introduction**

The Failures tab displays for each export even if there were no failures. While an export operation is running, the Failures tab does not display the count of failures. After an export operation is finished:

- If all items exported successfully, then the Failures tab shows a count of 0 and the list of failed items will be empty.
- If not all items exported successfully, then the Failures tab shows the count of failed items and the list of failed items.

Export data is maintained after an upgrade to Discovery Manager 7.0. However, Discovery Manager 7.0 requires that each item has platform information to support the Native container export option. Results created before Discovery Manager 7.0 do not have platform information. If an export contains items without platform information, then the export of those items fails with the following error: “Unknown platform type found and corrected. Retry this item to complete the export.”

Retry of exports that failed for other reasons is not available for export data created before Discovery Manager 7.0.

**Procedure**

To view a list of items that failed to export:

1. In the navigation pane:
   a. Expand the Export node under the matter (My Matters > matter > Export).
   b. Select an export.

2. In the work pane, click the Failures tab.

   If there were failed items, then the label on the Failures tab is red. The number next to the Failures tab indicates the number of failed items.

   The work pane lists the failed items for the export.
3. To preview an item, select it in the work pane. The reason for the failure is displayed in the preview pane. A failure to copy a container file to the network share is considered a failure for each item in the container file.
Retrying export of failed items

**Introduction**

You can retry exporting items that failed to export. The retry uses the original export criteria.

Depending on the reason why an item failed, the item may continue to fail if you retry with the same export criteria. For certain failed items, you may have to create a new export with different criteria. The following table lists the error messages, reasons for failure, and the steps you, your Discovery Manager Application Administrator, or your SourceOne system administrator should take to successfully export the items.

<table>
<thead>
<tr>
<th>Error message</th>
<th>Reason and solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Error parsing export job parameters. Job failed to start.</em></td>
<td></td>
</tr>
<tr>
<td><em>Error initializing job threads. Job failed to start.</em></td>
<td></td>
</tr>
<tr>
<td><em>Unable to initialize connection SourceOne Archive.</em></td>
<td>The SourceOne system administrator should ensure that Discovery Manager computers and SourceOne workers can connect to the SourceOne archive.</td>
</tr>
</tbody>
</table>
| *The number of failures has exceeded the Maximum failure limit. Export processing has stopped.* | The Discovery Manager Application Administrator should:  
  - Review the system errors or infrastructure errors that occurred and fix those issues.  
  - If desired, increase the value of the Maximum Errors Allowed Per Export Job setting in Configuration > Export. |
| *The Item was exported to the container file but encountered errors inserting item into the metadata file. Export processing stopped.* | |
| *Database connectivity errors were encountered. Export was unable to continue.* | The SourceOne system administrator should ensure that the Discovery Manager computers and SourceOne workers can connect to the Discovery Manager database. |
| The container or metadata file could not be copied to the share. Access denied. | |
| The container or metadata file could not be copied to the share. Share not accessible. | The SourceOne system administrator should ensure that the share used for exports is accessible on the network to Discovery Manager computers and SourceOne workers. |
| *Export was stopped or terminated by the user.* | |
To retry all failed items in an export:

1. In the navigation pane:
   a. Expand the Export node under the matter (My Matters > matter > Export).
   b. Select an export.

2. Do one of the following steps:
   - In the ribbon, select Search/Export tab > Retry all.
   - Right-click on the export and select Retry all from the shortcut menu.

To retry selected failed items in an export:

1. In the navigation pane:
   a. Expand the Export node under the matter (My Matters > matter > Export).
b. Select an export.

2. In the work pane, click the Failures tab.

3. In the Failures grid, select the items that you want to retry.

4. Do one of the following steps:
   - Right-click on the grid and select **Retry failed items** from the shortcut menu.
   - In the ribbon, select Results tab > **Retry failed items**.

The Executions section of the export summary report updates to list the new export. To view the report, refer to “Viewing an export summary report” on page 344.

The Failures tab updates to display the number of failed items in this retry. The list of failed items updates.

The selected items are exported to a new container and/or metadata file. The status of these items changes to reflect the last retry attempt. A new instance of the export is not added to the navigation pane. Items that successfully exported as a result of the retry are removed from the Failures tab. For an export operation, only one retry instance is displayed regardless of how many retries you have performed.
Using folders to organize exports

Note: Folders to organize exports are available in the full edition of Discovery Manager.

To organize exports, you can create folders under the Export node in the navigation pane.

These organizing folders:

◆ Are optional
◆ Can be only one level deep (no nested folders)

You can:

◆ Create organizing folders at any time.
◆ Rename organizing folders.
◆ Drag-and-drop exports from one organizing folder to another within a matter.

Refer to:

◆ “Creating folders to organize searches: Exports” on page 360
◆ “Renaming organizing folders: Exports” on page 361
◆ “Deleting organizing folders: Exports” on page 361

Creating folders to organize searches: Exports

Note: Folders to organize exports are available in the full edition of Discovery Manager.

To create a folder to organize exports, in the navigation pane:

1. Click the My Matters button or the All Matters button.

Note: The All Matters button is available in the full edition of Discovery Manager.

2. Expand the matter for which you want to create the folder.

3. Do one of the following steps:
• Click the Export node in the navigation pane, then select Matter tab > New Folder.

If there are no organizing folders or exports, then you can do one of the following steps:
  – Click the New Folder (Ctrl-F) link in the work pane.
  – Click in the work pane, then press Ctrl-F.
• Right-click the Export node, then select New Folder.
A folder named New Folder appears in the navigation pane, under the Export node.

4. Edit the name of the new folder.

  **Note:** The names of organizing folders do not have to be unique within the Export area of a matter.

5. Press Enter.

**Renaming organizing folders: Exports**

To rename a folder used to organize exports:

1. Click the My Matters button or the All Matters button.

  **Note:** The All Matters button is available in the full edition of Discovery Manager.

2. Expand the matter and the Export node containing the folder you want to rename.

3. Right-click the folder, then select Rename.

4. Edit the highlighted name of the folder.

5. Press Enter.

**Deleting organizing folders: Exports**

  **Note:** Folders to organize exports are available in the full edition of Discovery Manager.
Exporting Content and Metadata

Note: You can delete empty organizing folders. You cannot delete organizing folders that contain exports.

To delete a folder used to organize exports, in the navigation pane:
1. Click the My Matters button or the All Matters button.

   Note: The All Matters button is available in the full edition of Discovery Manager.

2. Expand the matter and the Export node containing the folder you want to delete.
3. Right-click the folder, then select Delete.

Deleting an export

You can delete an export that has completed. If you delete an export that is running, then the export stops and it is deleted.

To delete an export from a matter, in the navigation pane:
1. Click the My Matters button.
2. Select the matter.
3. Expand the Export node.
4. Do one of the following steps:
   - Right-click the export, then select Delete from the shortcut menu.
   - Select the export, then select Home tab > Delete.
This chapter contains the following topics:

- **Introduction: Discovery Manager utilities** .................................. 364
- **Prerequisites: Discovery Manager utilities** .................................. 364
- **Permissions: Discovery Manager utilities** .................................... 365
- **Discovery Manager workflows** .................................................. 366
- **Syntax common to all Discovery Manager utilities** .................... 368
- **Creating identity records** .............................................................. 370
- **Creating custodians** ................................................................. 377
- **Collecting email for custodians** .................................................. 381

**Note:** The utilities are available in the full edition of Discovery Manager.
Using Discovery Manager Utilities

Introduction: Discovery Manager utilities

You can use the full edition of Discovery Manager to manually create the following items one at a time: identities, custodians and collection searches for each custodian.

To perform the same operations in bulk, use the Discovery Manager command line utilities. The utilities achieve the same results as if you had performed the operations manually in the client application.

The utilities are:

- **DMIdentity** - Creates identity records from an input file containing information about each user.
- **DMCustodian** - Creates custodians in a matter from an input file containing the names of identities.
- **DMCollect** - Collects mail for all custodians defined in a matter, using the dates, keywords, and the folders to search that were defined in the matter properties.

Run the utilities from a Windows command window (Start > Run > cmd).

Prerequisites: Discovery Manager utilities

You must have EMC SourceOne Email Management and the full edition of EMC SourceOne Discovery Manager installed.

The command line utilities depend on the Discovery Manager Web service and other SourceOne and Discovery Manager components. The Discovery Manager database stores the data created by the utilities.
Using Discovery Manager Utilities

Installation: Discovery Manager utilities

Copy the utilities to a computer in your EMC SourceOne Discovery Manager environment:

1. Navigate to the Utility directory in the EMC SourceOne Discovery Manager software kit.
2. Copy the following utility executables to any directory on any computer in the EMC SourceOne Discovery Manager environment:
   - DMColl. exe
   - DMCustodian. exe
   - DMIdentity. exe
   - GOSPPresentationCommon. dll (required by the DMColl utility)

Permissions: Discovery Manager utilities

To run the Discovery Manager utilities, you must have the same permissions needed to perform the actions in the Discovery Manager client application.

In the Discovery Manager client application, the User Administrator must add you as a Discovery Manager user, and assign the roles listed in the following table.

Table 51 Utilities and required roles

<table>
<thead>
<tr>
<th>Utility</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMIdentity</td>
<td>Identity Administrator</td>
</tr>
<tr>
<td>DMCustodian</td>
<td>Matter Manager in the matter</td>
</tr>
<tr>
<td>DMColl</td>
<td>Investigator in the matter</td>
</tr>
</tbody>
</table>

Refer to the EMC SourceOne Discovery Manager User Guide or online help for information about roles.
**Discovery Manager workflows**

You can use either the full edition of the Discovery Manager client application or the Discovery Manager command line utilities to collect mail for each custodian. The advantage of using the utilities is that you can perform bulk operations.

However, the workflow for using the command line utilities is different than the workflow for using the client application.

Refer to:
- “Client application workflow” on page 366
- “Utilities workflow” on page 367

**Client application workflow**

Using the full edition of the Discovery Manager client application, the steps to collect mail for each custodian are:

1. Create the matter, and optionally specify date ranges and keywords for the collection searches.

2. For each custodian:
   a. Determine the appropriate set of email addresses to use to get accurate results. Use either address book entries (if the custodians are current employees) or Identity records.
   b. Add the custodian to the matter.
   c. Create a collection search, specifying addresses in the Sender or Recipient search fields.
   d. Run the collection search.
   e. Assign the results to the matter, and specify the custodian.

Refer to the *EMC SourceOne Discovery Manager User Guide* or online help for details about using the Discovery Manager client application.
Using Discovery Manager Utilities

Utilities workflow

Using the Discovery Manager command line utilities, the steps to collect mail for each custodian are:

1. Create a file containing identifying information for each user. (This information might have been supplied to you in a document or spreadsheet.) Refer to “Creating the input file for the DMIdentity utility” on page 370.

2. Use the DMIdentity utility to create identities for each user, using the file created in the previous step. Refer to “Using the DMIdentity Create command” on page 371.

3. In the Discovery Manager client application, create the matter, specifying date ranges and keywords for the collection searches. Refer to the EMC SourceOne Discovery Manager User Guide or online help.

4. Create a file containing the identity names for each custodian. Use the DMIdentity utility to produce a file containing all identity names, if desired. (You can use this output file as input for the next step.) Refer to “Creating the input file for the DMCustodian utility” on page 377.

5. Use the DMCustodian utility to create all of the custodians, using the file created in the previous step as input. Refer to “Using the DMCustodian utility” on page 379.

6. Use the DMCCollect utility to create and run the collection searches for all custodians defined in a matter, and to assign the results to the matter. Refer to “Collecting email for custodians” on page 381.
Using Discovery Manager Utilities

Syntax common to all Discovery Manager utilities

Refer to:
- “Common command line syntax” on page 368
- “Common input file syntax” on page 369
- “Common error reporting” on page 369

Common command line syntax

- The command line includes a command and a list of arguments, some of which include values.
- To view the help for a utility, enter the name of the utility followed by a space and the Help command. An example is:

  DMIdentity Help

- You can abbreviate all commands and options as long as the abbreviation is unique. Option abbreviations only need to be unique to the command on which they are used.
- All commands and options are case-insensitive.
- You can precede all options by either one of the following characters:
  - (hyphen)
  - / (forward slash)
  Refer to the “Example” on page 369.
- You can specify options in any order, but you must specify the command first.
- To separate option values from the option name, use any one of the following characters:
  - A space
  - A colon (:)
  - An equal sign (=)
  Refer to the “Example” on page 369.
- Enclose values that contain spaces and special characters in double quotes.
You can specify a /Verbose option with most commands to produce additional output for informational purposes and for troubleshooting.

**Example**

Each utility requires that the command line specify the name of the Discovery Manager server.

For example, if you run the utilities on the Discovery Manager server, equivalent ways of specifying the server name are:

```
/ServerName localhost
-server localhost
/serv=localhost
/s=localhost
```

**Common input file syntax**

Input files are text files (.txt) with a carriage return delimiter, like files created by Notepad.

If the name of the input file contains spaces, then enclose the name in double quotes.

For more information about each input file, refer to:

- “Creating the input file for the DMIdentity utility” on page 370
- “Creating the input file for the DMCustodian utility” on page 377

**Common error reporting**

Each utility:

- Reports the first syntax error immediately, and does not perform any processing if one occurs.
- Identifies where it encountered the first problem. There may be other errors on the same command line that are not reported.
- Attempts to continue if a non-syntax error occurs, although that may not always be possible.
Creating identity records

To create identity records:

1. Create an input file containing information for each identity, as described in “Creating the input file for the DMIdentity utility” on page 370. (This information might have been supplied to the investigator in a document or spreadsheet.)

2. Use the DMIdentity utility to create identities, using the input file created in the previous step. Refer to “Using the DMIdentity Create command” on page 371.

Creating the input file for the DMIdentity utility

Create a text file (.txt) containing the user names for which you want to create identities. The names can be Windows account names, Exchange display names, or Notes display names.

Note: Refer to “Using /Type options for DMIdentity Create” on page 373 for information about how the DMIdentity utility interprets the user names.

If the name of the input file contains spaces, then enclose the name in double quotes.

Refer to:

- “Format 1: One name per line” on page 370
- “Format 2: Multiple names per line” on page 371

Format 1: One name per line

If the user names contain semicolons, put each user name on a separate line in the input file. End each line with a Return.

Name<Return>

Each line can contain a description and comments, separated by tabs:

Name<Tab>Description<Tab>Comments_ignored<Return>

The comments after the second tab are ignored by the DMIdentity utility.
Creating identity records

If your input file has one name per line and the names contain semicolons, use the /OnePerLine option when you run the DMIdentity Create command. This option prevents the semicolons in the names from being incorrectly interpreted as separators between multiple names.

Format 2: Multiple names per line

If the names do not contain semicolons, then you can put multiple entries on the same line. Use a semicolon to separate entries. End each line with a Return.

Name1;NameN<Return>

Each entry can contain a description and comments, separated by tabs:

Name1<Tab>Description1<Tab>Comments1_ignored;NameN<Tab>DescriptionN<Tab>CommentsN_ignored<Return>

The comments after the second tab in each entry are ignored by the DMIdentity utility.

If your input file has multiple names per line, do not use the /OnePerLine option when you run the DMIdentity Create command. If you use this option, then the semicolon separators will be ignored, and each line in the input file will be interpreted as a single name, not multiple names.

Using the DMIdentity Create command

Use the DMIdentity utility’s Create command to create identities from an input file of user names.

Refer to:
- “Required permissions for DMIdentity utility” on page 372
- “Overview of DMIdentity Create command” on page 372
- “Using /Type options for DMIdentity Create” on page 373
- “Using the /OnePerLine option” on page 375
Using Discovery Manager Utilities

- “Using the /Domain Name option” on page 375
- “Using the /AddressBook option” on page 376
- “Results of DMIdentity Create command” on page 376

Required permissions for DMIdentity utility

To run the DMIdentity utility, you must have the Identity Administrator role assigned to you by the Discovery Manager User Administrator. Refer to the EMC SourceOne Discovery Manager User Guide or online help for information about assigning roles.

Overview of DMIdentity Create command

The help for the DMIdentity utility displays the following information for the Create command:

Usage: DMIdentity <command> [options]

Commands:

Create

/ServerName value /InputFile file.ext /Type list-value [/OnePerLine] [/DomainName value] [/AddressBook value] [/AppendUID] [/Verbose]

Create identities from an input file

/ServerName Server name or IP
/InputFile Input file name
/Type Specifies the type of the entries in the input file

DominoDisplay Domino NAB display name
ExchangeDisplay Exchange GAL display name
WindowsAccount Windows Active Directory account name

/OnePerLine Each line in the input file only contains one entry (optional)
/DomainName Windows domain name (only used with type WindowsAccount (optional)
/AddressBook Domino Address Book (only used with type DominoDisplay when LDAP is turned off) (optional)
/AppendUID Appends the account name from the input file to the display name to make the identity name unique. Only valid with /Type WindowsAccount (optional)
/Verbose Display verbose output (optional)
Required command line parameters for DMIdentity utility

The following table describes the required parameters for the DMIdentity utility.

Table 52  DMIdentity utility - required parameters

<table>
<thead>
<tr>
<th>Required parameter</th>
<th>Valid values</th>
</tr>
</thead>
<tbody>
<tr>
<td>/ServerName</td>
<td>Host name or IP address of the Discovery Manager server.</td>
</tr>
<tr>
<td>/InputFile</td>
<td>Name of the input text file: filename.txt. If the name of the input file contains spaces, then enclose the name in double quotes.</td>
</tr>
<tr>
<td>/Type</td>
<td>Refer to “Using /Type options for DMIdentity Create” on page 373.</td>
</tr>
</tbody>
</table>

Using /Type options for DMIdentity Create

The DMIdentity Create command interprets the user names in the input file based on the /Type option in the command line:

Table 53  DMIdentity Create /Type options

<table>
<thead>
<tr>
<th>/Type option</th>
<th>Description</th>
</tr>
</thead>
</table>
| DominoDisplay      | Each Name value in the input file is interpreted as a Domino display name, and a lookup is performed on it.  
• If exactly one match is found, then the addresses are obtained and used to create the identity.  
• If more than one match is found, an error is displayed, stating that the value is ambiguous. |
| ExchangeDisplay    | Each Name value in the input file is interpreted as an Exchange display name, and a lookup is performed on it.  
• If exactly one match is found, then the addresses are obtained and used to create the identity.  
• If more than one match is found, an error is displayed stating that the value is ambiguous. |
| WindowsAccount     | Each Name value in the input file is interpreted as a Windows account name.  
If an "@" character is included in the entry, the entry is used as a Windows UPN.  
If a "\" character is not included in the entry and the /DomainName option is specified, then the domain name is prepended to the entry with a "\" separator. This value is then used to look up the user in the Active Directory to obtain the user's Exchange alias. |

Note: If EMC SourceOne Email Management is configured to use the Domino Directory, then you must also supply the /AddressBook command option. This option is not required if the system is configured to use LDAP.

For examples of /Type options in DMIdentity command lines, refer to:
Using Discovery Manager Utilities

- “/Type ExchangeDisplay” on page 374
- “/Type DominoDisplay (LDAP environments)” on page 374
- “/Type DominoDisplay (Domino Directory environments)” on page 374
- “/Type WindowsAccount (without /DomainName option)” on page 374
- “/Type WindowsAccount (with /DomainName option)” on page 374
- “/Type WindowsAccount (with /AppendUID)” on page 375

/Type ExchangeDisplay
In the following example, the /Type ExchangeDisplay option specifies that the user names in the input file are to be interpreted as Exchange display names:

DMIdentity Create /ServerName DMgrServer /InputFile Names.txt /Type ExchangeDisplay

/Type DominoDisplay (LDAP environments)
In the following example, the /Type DominoDisplay option specifies that the user names in the input file are to be interpreted as Domino display names. This command line is for Domino environments that use LDAP:

DMIdentity Create /ServerName DMgrServer /InputFile Names.txt /Type DominoDisplay

/Type DominoDisplay (Domino Directory environments)
In the following example, the /Type DominoDisplay option specifies that the user names in the input file are to be interpreted as Domino display names. The /AddressBook option, along with the name of a Domino Directory, is required for Domino environments that use Domino Directory:

DMIdentity Create /ServerName DMgrServer /InputFile Names.txt /Type DominoDisplay /AddressBook GlobalDirectory

/Type WindowsAccount (without /DomainName option)
In the following example, the /Type WindowsAccount option specifies that the user names in the input file are to be interpreted as Window account names:

DMIdentity Create /ServerName DMgrServer /InputFile Names.txt /Type WindowsAccount

/Type WindowsAccount (with /DomainName option)
In the following example, the /Type WindowsAccount option specifies that the user names in the input file are to be interpreted as
Window account names. If you also use the /DomainName option and specify a domain name, then the DMIdentity utility:

- Prepends the domain name to the entries in the input file that do not include a backslash character (\).
- Uses the modified entries to look up the Exchange aliases in Active Directory.

```
DMIdentity Create /ServerName DMgrServer /InputFile Names.txt /Type WindowsAccount
/DomainName emc
```

**/Type WindowsAccount (with /AppendUID)**

In the following example, the /Type WindowsAccount option specifies that the user names in the input file are to be interpreted as Window account names. If you also use the /AppendUID option, then the DMIdentity utility appends the account name from the input file to the display name from Active Directory to make the identity name unique.

```
DMIdentity Create /ServerName DMgrServer /InputFile Names.txt /Type WindowsAccount
/AppendUID
```

**CAUTION**

Be consistent when using /Append UID. Either use it all the time or not at all. Inconsistent use could result in duplicate identities (one identity with the UID and another identity without it).

**Using the /OnePerLine option**

Whether or not you should use the /OnePerLine option depends on the format of the input file:

- If your input file has one name per line and the names contain semicolons, use the /OnePerLine option when you run the utility. This option prevents the semicolons in the names from being incorrectly interpreted as separators between multiple names.
- If your input file has multiple names per line, do not use the /OnePerLine option when you run the utility. If you use this option, then the semicolon separators will be ignored, and each line in the input file will be interpreted as a single name, not multiple names.

**Using the /Domain Name option**

You can use the /DomainName option with the /Type WindowsAccount option.
If a backslash character (\) is not included in an entry in the input file, and if you specify the /DomainName option and a domain name on the command line, then the domain name is prepended to the entry with a backslash (\) separator. This value is then used to look up the user in the Active Directory to obtain the user’s Exchange alias.

Refer to “/Type WindowsAccount (with /DomainName option)” on page 374 for an example.

Using the /AddressBook option

The /AddressBook option, along with the name of a Domino Directory, is required for Domino environments that use Domino Directory.

If the name of the Domino Directory contains spaces, enclose it in double quotes.

Refer to “/Type DominoDisplay (Domino Directory environments)” on page 374 for an example.

Results of DMIdentity Create command

For each name in the input file, the DMIdentity utility creates an identity and adds the appropriate addresses to it.

Using the DMIdentity List command

Refer to “Method 2: Generating the input file for the DMCustodian utility” on page 378.
Creating custodians

To create custodians:

1. In the full edition of the Discovery Manager client application, create the matter, specifying date ranges and keywords for the collection searches. Refer to the *EMC SourceOne Discovery Manager User Guide*.

2. Create an input file containing the identity names for each custodian. Refer to “Creating the input file for the DMCustodian utility” on page 377.

3. Use the DMCustodian utility to create all of the custodians, using the file created in the previous step as input. Refer to “Using the DMCustodian utility” on page 379.

Creating the input file for the DMCustodian utility

To create an input file containing the identity name for each custodian, use one of the following methods:

- Method 1: Create the input file manually. Refer to “Method 1: Manually creating the input file for the DMCustodian utility” on page 377.

- Method 2: Use the DMIdentity utility’s List command to produce a file containing all identity names. Refer to “Method 2: Generating the input file for the DMCustodian utility” on page 378.

Note: The identity names in the input file must exactly match existing identities in the Discovery Manager database, except for the case. The DMCustodian utility is case-insensitive in regard to identity names.

Method 1: Manually creating the input file for the DMCustodian utility

Create a text file (.txt) containing the identity name for each custodian. If the name of the input file contains spaces, then enclose the name in double quotes.

Put each identity name on a separate line. End each line with a Return.

IdentityName<Return>
Using Discovery Manager Utilities

Each line can contain a description and comments, separated by tabs:

IdentityName<Tab>Description<Tab>Comments_ignored

The comments after the second tab are ignored by the DMCustodian utility.

**Method 2: Generating the input file for the DMCustodian utility**

You can use the DMIdentity utility to generate a list of all identities that have been defined. Use this method when you want to input all or most identities to the DMCustodian utility. You can delete identities from the generated file.

(To create identities, use either the full edition of the Discovery Manager client application or the DMIdentity utility.)

Refer to:
- “Required permissions for DMIdentity utility” on page 372
- “Overview of DMIdentity List command” on page 378
- “Example of DMIdentity List command line” on page 378
- “Results of DMIdentity List command” on page 379

**Overview of DMIdentity List command**

Use the DMIdentity utility’s List command to produce a file containing all of the identity names that are stored in the Discovery Manager database.

The help for the DMIdentity utility displays the following information for the List command:

```bash
List

/ServerName value /OutputFile file.ext [/Verbose]

List all identities

/ServerName  Server name or IP
/OutputFile  Output file name
/Verbose    Display verbose output (optional)
```

**Example of DMIdentity List command line**

```
DMIdentity List /ServerName DMgrServer /OutputFile Identities.txt
```
**Results of DMIdentity List command**

The DMIdentity List command produces an output file that includes each identity name, one per line.

Each line also includes the description and ID number, both separated by tab characters.

```
IdentityName<Tab>Description<Tab>ID_Number
```

---

**Using the DMCustodian utility**

Use the DMCustodian utility’s Create command to create custodians from an input file of identity names.

Refer to:
- “Required permissions for DMCustodian utility” on page 379
- “Overview of DMCustodian Create command” on page 379
- “Example of DMCustodian Create command line” on page 380
- “Using the /OnePerLine option” on page 375
- “Results of DMCustodian Create command” on page 380

**Required permissions for DMCustodian utility**

To run the DMCustodian utility, you must have the Matter Manager role for the matter assigned to you by the Matter Owner. Refer to the EMC SourceOne Discovery Manager User Guide for information about assigning matter-specific roles.

**Overview of DMCustodian Create command**

The help for the DMCustodian utility displays the following information:

Usage: DMCustodian <command> [options]

Commands:

Create /MatterName value /ServerName value /InputFile file.ext [/OnePerLine] [/Verbose]

Create custodians from an input file

/MatterName  Matter name
/ServerName  Server name or IP
/InputFile   Input file name
/OnePerLine  Each line in the input file only contains one entry (optional)
/Verbose     Display verbose output (optional)
Required command line parameters for DMCustodian utility

The following table describes the required parameters for the DMCustodian utility.

<table>
<thead>
<tr>
<th>Required parameter</th>
<th>Valid values</th>
</tr>
</thead>
<tbody>
<tr>
<td>/MatterName</td>
<td>Name of the matter for which you want to create custodians.</td>
</tr>
<tr>
<td>/ServerName</td>
<td>Host name or IP address of the Discovery Manager server.</td>
</tr>
<tr>
<td>/InputFile</td>
<td>Name of the input text file: <code>filename.txt</code>. If the name of the input file contains spaces, then enclose the name in double quotes.</td>
</tr>
</tbody>
</table>

Example of DMCustodian Create command line

```
DMCustodian Create /MatterName Case2 /ServerName DMgrServer /InputFile Identities.txt
```

Results of DMCustodian Create command

If a an identity name in the input file exactly matches an existing identity in the Discovery Manager database, then the DMCustodian Create command:

- Creates a custodian using the name (and optional description) from the input file.
- Links the custodian to the corresponding identity, and adds the link details to the description.
Collecting email for custodians

To collect mail for each custodian:
1. If you have not done so already:
   a. Create identities, as described in “Creating identity records” on page 370.
   b. Use identities to create custodians for a matter, as described in “Creating custodians” on page 377.
2. Use the DMCollect utility to create and run the collection searches for all custodians defined in a matter, and to assign the results to the matter. Refer to “Using the DMCollect Collect command” on page 381.

Using the DMCollect Collect command

Use the DMCollect Collect command to:

- Create one Owner search per custodian, with the dates and keywords from the matter properties.

  Note: For information on why DMCollect creates an Owner search, rather than a Sender or Recipient search, refer to “Using the ‘Sender or Recipient’ field or the Owner field” on page 253.

- Create the searches in a specified organizing folder.
- Run each search.
- Assign the results to the matter, with the appropriate custodian.

Refer to:

- “Required permissions for DMCollect utility” on page 382
- “Overview of DMCollect Collect command” on page 382
- “Required command line parameters for DMCollect utility” on page 383
- “Using the /FolderName option” on page 383
- “Using the /Threads option” on page 384
Using Discovery Manager Utilities

- “Using the /AlwaysSearchEmbeddedMessages option” on page 384
- “Details of DMCollect Collect processing” on page 385
- “Results of DMCollect Collect command” on page 386

IMPORTANT

You can run one instance of the DMCollect utility on a matter and organizing folder at a time. Running multiple instances of the DMCollect utility on the same matter and organizing folder is not supported.

You can run multiple instances of the DMCollect utility on different matters or on different organizing folders.

Required permissions for DMCollect utility

To run the DMCollect utility, you must have the Investigator role for the matter assigned to you by the Matter Owner. Refer to the EMC SourceOne Discovery Manager User Guide or online help for information about assigning matter-specific roles.

Overview of DMCollect Collect command

The help for the DMCollect utility displays the following information for the Collect command:

Usage: DMCollect <command> [options]

Commands:

Collect /MatterName value /ServerName value [/FolderName value] [/Threads number] [/AlwaysSearchEmbeddedMessages list-value] [/Verbose]

Collect the matter scope (create searches, run them and assign the results

/MatterName Matter name
/ServerName Server name or IP
/FolderName Folder name in the matter (optional)
/Threads Maximum number of searches to run simultaneously (optional)
/AlwaysSearchEmbeddedMessages Always search embedded messages (force full text search) (optional)
/Verbose Display verbose output (optional)
Required command line parameters for DMCollect utility

The following table describes the required parameters for the DMCollect utility.

<table>
<thead>
<tr>
<th>Required parameter</th>
<th>Valid values</th>
</tr>
</thead>
<tbody>
<tr>
<td>/MatterName</td>
<td>Name of the matter for which you want to create collection searches.</td>
</tr>
<tr>
<td>/ServerName</td>
<td>Host name or IP address of the Discovery Manager server.</td>
</tr>
</tbody>
</table>

Using the /FolderName option

Refer to:

- “Using /FolderName option with DMCollect Collect command” on page 383
- “Using /FolderName option with DMCollect Rerun command” on page 383

Using /FolderName option with DMCollect Collect command

To have the DMCollect Collect command create the collection searches in a specified organizing folder, use the /FolderName option, for example:

```
DMCollect Collect /MatterName Case8630 /ServerName DMgrServer /FolderName NewYork
```

If the specified organizing folder does not exist, then the DMCollect will create the folder. After you run the DMCollect utility, the Discovery Manager client application will display the new folder under the matter’s Collection Area node in the navigation pane.

Using /FolderName option with DMCollect Rerun command

To have the DMCollect Rerun command rerun the collection searches in a specified organizing folder, use the /FolderName option, for example:

```
DMCollect Rerun /MatterName Case8630 /ServerName DMgrServer /FolderName NewYork
```

Refer to “Using the DMCollect Rerun command” on page 387 for more information about the Rerun command.
Using Discovery Manager Utilities

**Using the /Threads option**

By default, the DMCollect utility can run a maximum of five multiple searches at the same time.

To specify a different maximum, use the /Threads option, for example:

```
DMCollect Collect /MatterName Case8630 /ServerName DMgrServer /Threads 10
```

The /Threads value must be greater than zero (0). The maximum value is 10.

**Using the /AlwaysSearchEmbeddedMessages option**

The /AlwaysSearchEmbeddedMessages option determines whether or not the DMCollect utility forces a full-text index search to find items containing embedded messages.

This option is the equivalent to the following settings in the Discovery Manager client application:

- Search Embedded Messages option on the Configuration screen.
- Always Search Embedded Messages checkbox in the Search Properties dialog box.

If you omit the /AlwaysSearchEmbeddedMessages option, then the DMCollect utility uses the Search Embedded Messages setting.

If you use the /AlwaysSearchEmbeddedMessages option, then you override the settings in the Discovery Manager client application. The valid values are:

- **Yes** - The DMCollect utility forces a full-text index search.
- **No** - The DMCollect utility does not force a full-text index search.

Refer to the following topics in the *EMC SourceOne Discovery Manager User Guide* or online help for more information about the settings in the Discovery Manager client application:

- "About the ‘Always search embedded messages’ checkbox”
- "Configuring Discovery Manager” (Search Embedded Messages setting)
Details of DMCollect Collect processing

Processing by the DMCollect utility consists of two stages. Refer to:

1. “Creating searches” on page 385
2. “Running searches” on page 385

Creating searches

If the search does not already exist in the specified organizing folder, then the DMCollect utility creates an Owner search for each custodian that has a linked identity.

In the Discovery Manager client application, the name of the search displays as the name of the custodian and the Created state, separated by a tilde character (~). An example is: Alana E Gaymon ~ Created.

If the search does exist in the specified organizing folder, then the utility determines if it created the search.

If the specified organizing folder does not exist, then the utility creates it.

After the utility creates all of the searches, then the utility runs the searches, as described in “Running searches” on page 385.

Running searches

The DMCollect utility looks at all searches in the specified organizing folder, and processes the searches that it created. The utility processes a search based on its state, as described in the following table.

<table>
<thead>
<tr>
<th>Search state</th>
<th>Description of processing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created or Rerun</td>
<td>The search starts and the state in the search name changes to “Running”.</td>
</tr>
<tr>
<td>Running</td>
<td>The utility waits for the search to complete, then changes the state in the search name to “SearchComplete”.</td>
</tr>
<tr>
<td>SearchComplete</td>
<td>The utility assigns all of the results from the last search instance to the matter, then assigns the custodian to all of the messages. The state in the search name changes to “Assigned”.</td>
</tr>
<tr>
<td>Assigned</td>
<td>No processing is performed. The collection search is complete.</td>
</tr>
</tbody>
</table>
Using Discovery Manager Utilities

Results of DMCollect Collect command

Refer to:

- “Information displayed in Discovery Manager client application” on page 386
- “Information not displayed in Discovery Manager client application” on page 386

Information displayed in Discovery Manager client application

The full edition of the Discovery Manager client application displays the collection searches created by the DMCollect Collect command.

The name of each collection search consists of the custodian name and the current state of the search, separated by a tilde character (~).

CustodianName ~ CurrentState

The states change during processing.

The state is maintained so that if you stop the DMCollect utility while the Collect command is being processed, later you can resume processing from where it left off by specifying the Collect command again.

The following table lists the possible current states:

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created</td>
<td>The search has been created but has never run.</td>
</tr>
<tr>
<td>Running</td>
<td>The search is currently running.</td>
</tr>
<tr>
<td>SearchComplete</td>
<td>The search has completed running.</td>
</tr>
<tr>
<td>Assigned</td>
<td>The results have been assigned to the matter.</td>
</tr>
<tr>
<td>Rerun</td>
<td>The search has been run once, the results have been assigned, and the user has requested that the search be run again.</td>
</tr>
</tbody>
</table>

Information not displayed in Discovery Manager client application

Additional information is stored in the search description field in the database, and is not displayed in the Discovery Manager client application. The value stored in this field consists of the prefix DMCollect, followed by a tilde character (~), the custodian ID, another tilde character, and the identity ID:
**Using Discovery Manager Utilities**

**DMCollect ~ CustodianID ~ IdentityID**

The prefix DMCollect identifies those searches that the DMCollect Collect command created.

When the DMCollect utility examines existing searches, it only processes searches that have a description field that starts with the prefix DMCollect. If a user modifies the search name in the Discovery Manager client application, then the search description field in the database is cleared. In that case, the DMCollect utility no longer recognizes the search as one it created, and the utility will not process that search.

---

**Using the DMCollect Rerun command**

Use the DMCollect Rerun command to rerun collection searches that were created by the DMCollect Collect command and that have the Assigned state.

Refer to:
- “Required permissions for DMCollect utility” on page 382
- “Overview of DMCollect Rerun command” on page 387
- “Required command line parameters for DMCollect utility” on page 383
- “Example of DMCollect Rerun command line” on page 388
- “Using /FolderName option with DMCollect Rerun command” on page 383
- “Using the /Threads option” on page 384
- “Details of DMCollect Rerun processing” on page 388

**Overview of DMCollect Rerun command**

The help for the DMCollect utility displays the following information for the Rerun command:

Usage: DMCollect <command> [options]

Commands:

```
Rerun /MatterName value /ServerName value [/FolderName value] [/Threads number] [/Verbose]
```

Rerun existing searches and assign the results
Using Discovery Manager Utilities

/MatterName  Matter name
/ServerName  Server name or IP
/FolderName  Folder name in the matter (optional)
/Threads  Maximum number of searches to run simultaneously (optional)
/Verbose  Display verbose output (optional)

Example of DMCollect Rerun command line

DMCollect Rerun /MatterName Case3961 /ServerName DMgrServer /FolderName NewYork

Details of DMCollect Rerun processing

For all searches in the specified folder that the DMCollect utility created and that are in the "Assigned" state, the DMCollect Rerun command:

1. Changes the state in the search name to "Rerun."
2. Runs the searches, as described in “Running searches” on page 385.
This chapter contains the following topics:

- Accessibility features .................................................. 390
- Keyboard shortcuts ...................................................... 391
Accessibility Features for Discovery Manager

Accessibility features

The following accessibility features are provided in EMC SourceOne Discovery Manager:

- Circular tabbing sequence in windows and dialog boxes, including reports
- Keyboard shortcuts for the most commonly used controls, as described in “Keyboard shortcuts” on page 391
- Support for screen reader software
Keyboard shortcuts

Refer to:

◆ “General keyboard shortcuts” on page 391
◆ “Keyboard shortcuts for the main ribbon” on page 393
◆ “Keyboard shortcuts for the Identity ribbon in the Identity window” on page 399

General keyboard shortcuts

The following table lists keyboard shortcuts for Discovery Manager windows and dialog boxes.

Note: Some functions are available only in the full edition of Discovery Manager.

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
</table>
| ALT or F10 | Displays the top-level keyboard shortcuts for the ribbon. Refer to “Keyboard shortcuts for the main ribbon” on page 393 and “Keyboard shortcuts for the Identity ribbon in the Identity window” on page 399 for more information.  
  • Displays the keyboard shortcut (Z or Z1) for the help icon in the current window or dialog box.  
  • Displays the keyboard shortcut (Z2) for the View icon (View dropdown menu) in the Select Hold Folder dialog box and the Select Users dialog box. The keyboard shortcuts for the options on the View dropdown menu are:  
    D = Details  
    I = Icons  
    L = List  
    T = Tiles  
    H = Thumbnails |
| ALT-A | Keyboard equivalent for the Add button in dialog boxes. |
| ALT-B | Keyboard equivalent for the Browse button or the Back button in dialog boxes. |
| ALT-C | Keyboard equivalent for the Cancel button in dialog boxes. |
| ALT-F | Keyboard equivalent for the Finish button in dialog boxes. |
| ALT-N | Keyboard equivalent for the Next button in dialog boxes. |
## Accessibility Features for Discovery Manager

### Table 58  General keyboard shortcuts (continued)

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT-O</td>
<td>Keyboard equivalent for the OK button in dialog boxes.</td>
</tr>
<tr>
<td>ALT-R</td>
<td>Keyboard equivalent for the Remove button in dialog boxes.</td>
</tr>
<tr>
<td>ARROW KEYS</td>
<td></td>
</tr>
</tbody>
</table>
* Navigate through the nodes in the navigation pane.  
* Navigate through the tabs in the Matter Properties dialog box.  
* For the Identities Current View options, toggle between the Summary option and the Detailed option. |
| CTRL-F   | New Folder. Creates a new organizing folder for searches in the Collection Area. |
| CTRL-I   | New Identity. Opens the Identity window. |
| CTRL-K   | Submits manually entered data in certain fields, such as manually entered addresses in the Identity Elements field. |
| CTRL-S   | New Search. Creates a new search in the Collection Area. |
| DELETE   | Deletes certain selected objects, such as identity records or custodians. |
| DOWN ARROW | Displays dropdown menus in fields.  
Also refer to the entry in this table for ARROW KEYS. |
| ENTER    | 
* Displays the selected search result in the native viewer.  
* Opens certain selected objects for editing, such as an identity record.  
* Submits manually entered data in certain fields, such as renamed searches or manually entered addresses in the Identity Elements field.  
* Executes the command on the currently selected button, such as OK or Cancel.  
* Equivalent to the Find button in the Address Book dialog box. |
| ESC      | Closes the current window or dialog box. |
| SHIFT-F10 | Displays context menus (right-click menus) in the following areas:  
* The selected node in a matter in the navigation pane  
* The selected row in the search results grid  
* The selected row in the Identities grid in the Identities screen  
* The selected row in the Identity Elements grid in the Identity window  
* The selected row in the Users grid in the User Manager screen |
| SPACE BAR | Activates the selected Identities Current View option (Summary or Detailed). |
| TAB      | Navigates through a window or dialog box in circular tab order. |
Keyboard shortcuts for the main ribbon

The main Discovery Manager window displays a ribbon.

To display the top-level keyboard shortcuts for the main ribbon, press and release the ALT key or the F10 key.

To access an item on a ribbon tab, press the key for the appropriate ribbon tab, then press the key for the item. For example, to execute the New Search command on the Search/Export tab, the complete key sequence is:

1. Press and release ALT or F10 to display the top-level keyboard shortcuts in the ribbon.
2. Press and release S to access the Search/Export tab on the ribbon.
3. Press and release N to execute the New Search command.

Table 59  Keyboard shortcuts for main ribbon

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT</td>
<td>Toggles the display of the top-level keyboard shortcuts in the ribbon. Moves focus to the ribbon.</td>
</tr>
<tr>
<td>F10</td>
<td>Same as ALT.</td>
</tr>
<tr>
<td>LEFT ARROW or RIGHT ARROW</td>
<td>Moves focus through the tabs in the ribbon.</td>
</tr>
<tr>
<td>TAB or SHIFT-TAB or ARROW keys</td>
<td>Moves focus through the items in the current tab in the ribbon.</td>
</tr>
<tr>
<td>ENTER or SPACE BAR</td>
<td>Activates, executes, or opens an item in the ribbon.</td>
</tr>
<tr>
<td>CTRL-F1</td>
<td>Toggles the display of the ribbon.</td>
</tr>
</tbody>
</table>

The following section lists the complete key sequences for the main ribbon, starting with ALT. The comma between pairs of keys means that you release the previous key before pressing the next key. Do not press the comma key. Do not press and hold all of the keys at the same time.

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT, A</td>
<td>Moves focus to the Administration tab and displays the keyboard shortcut for each item on the Administration tab.</td>
</tr>
</tbody>
</table>

Table 59  Keyboard shortcuts for main ribbon
### Accessibility Features for Discovery Manager

#### Table 59  Keyboard shortcuts for main ribbon (continued)

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT, A, M</td>
<td>Remove Tag (on the Administration tab). Available for Tag Administrators. Use to remove a selected tag from the Administration &gt; Tag Manager screen.</td>
</tr>
<tr>
<td>ALT, A, R</td>
<td>Remove User (on the Administration tab). Available for User Administrators. Use to remove a selected user from the Administration &gt; User Manager screen.</td>
</tr>
<tr>
<td>ALT, A, T</td>
<td>Add Tag (on the Administration tab). Available for Tag Administrators. Opens the Tag Create dialog box. Use to create tags in the Administration &gt; Tag Manager screen.</td>
</tr>
<tr>
<td>ALT, F</td>
<td>Moves focus to the File tab and displays the keyboard shortcut for each item on the File tab.</td>
</tr>
<tr>
<td>ALT, F, E</td>
<td>Exit Discovery Manager. Closes the Discovery Manager application.</td>
</tr>
<tr>
<td>ALT, F, H</td>
<td>Displays the Help submenu.</td>
</tr>
<tr>
<td>ALT, F, H, H</td>
<td>Opens the online help for Discovery Manager.</td>
</tr>
<tr>
<td>ALT, F, H, A</td>
<td>Displays the About Discovery Manager information.</td>
</tr>
<tr>
<td>ALT, F, N</td>
<td>Displays the New submenu.</td>
</tr>
<tr>
<td>ALT, H</td>
<td>Moves focus to the Home tab and displays the keyboard shortcut for each item on the Home tab.</td>
</tr>
<tr>
<td>ALT, H, D</td>
<td>Delete (on the Home tab). Use to delete any selected object in Discovery Manager that can be deleted, such as matters, identities, searches, users, and exports.</td>
</tr>
<tr>
<td>ALT, H, F</td>
<td>Field Chooser (on the Home tab). Opens the Field Chooser dialog box. Use to add or remove columns in grids.</td>
</tr>
<tr>
<td>ALT, H, O</td>
<td>Sort Z to A (on the Home tab). Sorts in descending order.</td>
</tr>
<tr>
<td>ALT, H, P</td>
<td>Displays the Preview Pane submenu.</td>
</tr>
<tr>
<td>ALT, H, B</td>
<td>Preview Bottom (on the Home tab). Displays the preview pane.</td>
</tr>
</tbody>
</table>
### Table 59  Keyboard shortcuts for main ribbon (continued)

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT, H, O</td>
<td>Preview Off (on the Home tab). Hides the preview pane.</td>
</tr>
<tr>
<td>ALT, H, R</td>
<td>Remove Sorting (on the Home tab). Removes the last-applied sort order.</td>
</tr>
<tr>
<td>ALT, H, U</td>
<td>Displays the Duplicates submenu.</td>
</tr>
<tr>
<td>ALT, H, U, S</td>
<td>Duplicates &gt;Show (on the Home tab). Use to display duplicate messages in collection search results.</td>
</tr>
<tr>
<td>ALT, I</td>
<td>Moves focus to the Identities tab and displays the keyboard shortcut for each item on the Identities tab.</td>
</tr>
<tr>
<td>ALT, M</td>
<td>Moves focus to the Matter tab and displays the keyboard shortcut for each item on the Matter tab.</td>
</tr>
<tr>
<td>ALT, M, A</td>
<td>State (on the Matter tab). Use to change the state of a matter (Open or Closed). Available to the Matter Manager.</td>
</tr>
<tr>
<td>ALT, M, C</td>
<td>Copy (on the Matter tab). Use to create a new search by copying a selected search.</td>
</tr>
<tr>
<td>ALT, M, E</td>
<td>New Folder (on the Matter tab). Use to create a folder to organize searches.</td>
</tr>
<tr>
<td>ALT, M, K</td>
<td>Keywords (on the Matter tab). Opens the Matter Properties dialog box to the Keywords tab. Available to the Matter Manager.</td>
</tr>
</tbody>
</table>
## Accessibility Features for Discovery Manager

### Table 59  Keyboard shortcuts for main ribbon (continued)

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT, M, R</td>
<td>Rename (on the Matter tab). Use to rename a selected search.</td>
</tr>
<tr>
<td>ALT, R</td>
<td>Moves focus to the Result Actions/Results tab (available when you select an item in search results) and displays the keyboard shortcut for each item on the Result Actions/Results tab.</td>
</tr>
<tr>
<td>ALT, R, A</td>
<td>Assign results to matter (on the Result Actions/Results tab). Available for items that have the Unassigned state. Use to assign results to the matter.</td>
</tr>
<tr>
<td>ALT, R, C</td>
<td>Custodians (on the Result Actions/Results tab). Available in Matter Review. Displays the Custodians submenu. Use to assign custodians to selected items.</td>
</tr>
<tr>
<td>ALT, R, C, C</td>
<td>Custodians &gt; Clear Custodians (on the Result Actions/Results tab). Available in Matter Review. Use to remove custodians from selected items.</td>
</tr>
<tr>
<td>ALT, R, C, key tip</td>
<td>Custodians &gt; custodian name (on the Result Actions/Results tab). Available in Matter Review. Use to assign a specific custodian to selected items. These key tips are generated dynamically.</td>
</tr>
<tr>
<td>ALT, R, C, U</td>
<td>Custodians &gt; All Custodians (on the Result Actions/Results tab). Available in Matter Review. Opens the All Custodians dialog. Use to specify custodians for the selected items.</td>
</tr>
<tr>
<td>ALT, R, C, S</td>
<td>Custodians &gt; Set Quick Click (on the Result Actions/Results tab). Available in Matter Review. Opens the Set Quick Click dialog. Use to specify a Quick Click custodian.</td>
</tr>
<tr>
<td>ALT, R, E</td>
<td>Export (on the Result Actions/Results tab). Opens the Export dialog box. Use to export selected items.</td>
</tr>
<tr>
<td>ALT, R, G</td>
<td>Tags (on the Result Actions/Results tab). Available in Matter Review. Displays the Tags submenu. Use to apply tags to selected items.</td>
</tr>
<tr>
<td>ALT, R, G, C</td>
<td>Tags &gt; Clear Tags (on the Result Actions/Results tab). Available in Matter Review. Use to remove tags from selected items.</td>
</tr>
<tr>
<td>ALT, R, G, R</td>
<td>Tags &gt; Responsive (on the Result Actions/Results tab). Available in Matter Review. Use to apply the Responsive tag to selected items.</td>
</tr>
<tr>
<td>ALT, R, G, N</td>
<td>Tags &gt; Non-responsive (on the Result Actions/Results tab). Available in Matter Review. Use to apply the Non-responsive tag to selected items.</td>
</tr>
</tbody>
</table>
### Keyboard shortcuts for main ribbon (continued)

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT, R, G, P</td>
<td>Tags &gt; Proprietary (on the Result Actions/Results tab). Available in Matter Review. Use to apply the Proprietary tag to selected items.</td>
</tr>
<tr>
<td>ALT, R, G, B</td>
<td>Tags &gt; Bookmark (on the Result Actions/Results tab). Available in Matter Review. Use to apply the Bookmark tag to selected items.</td>
</tr>
<tr>
<td>ALT, R, G, J</td>
<td>Tags &gt; Junk Mail (on the Result Actions/Results tab). Available in Matter Review. Use to apply the Junk Mail tag to selected items.</td>
</tr>
<tr>
<td>ALT, R, G, A</td>
<td>Tags &gt; All Tags (on the Result Actions/Results tab). Available in Matter Review. Opens the All Tags dialog. Use to apply tags to selected items.</td>
</tr>
<tr>
<td>ALT, R, G, S</td>
<td>Tags &gt; Set Quick Click (on the Result Actions/Results tab). Available in Matter Review. Opens the Set Quick Click dialog. Use to specify a Quick Click tag.</td>
</tr>
<tr>
<td>ALT, R, R</td>
<td>Remove results from matter (on the Result Actions/Results tab). Available for items that have the Assigned state. Use to remove assigned items from the matter.</td>
</tr>
<tr>
<td>ALT, R, S</td>
<td>Assign results to matter with custodians (on the Result Actions/Results tab). Available for items that have the Unassigned state. Use to assign results to the matter with custodians.</td>
</tr>
<tr>
<td>ALT, R, T</td>
<td>Retry failed items (on the Result Actions/Results tab). Use to retry exporting selected failed items from the export's Failures list.</td>
</tr>
<tr>
<td>ALT, S</td>
<td>Moves focus to the Search/Export tab and displays the keyboard shortcut for each item on the Search/Export tab. The Search/Export tab is available for Investigators. Some options are also available for Personal Matters.</td>
</tr>
<tr>
<td>ALT, S, A</td>
<td>Assign all results to matter (on the Search/Export tab). Use to assign all items in the current search results to the matter.</td>
</tr>
<tr>
<td>ALT, S, E</td>
<td>Expand/Collapse (on the Search/Export tab). Toggles the display of the search criteria area.</td>
</tr>
<tr>
<td>ALT, S, I</td>
<td>Assign all results to matter with custodians (on the Search/Export tab). Use to assign all items in the current search results to the matter, with custodians.</td>
</tr>
<tr>
<td>ALT, S, N</td>
<td>New Search (on the Search/Export tab). Use to create a new search.</td>
</tr>
<tr>
<td>ALT, S, O</td>
<td>Stop (on the Search/Export tab). Stops the current export.</td>
</tr>
</tbody>
</table>
### Accessibility Features for Discovery Manager

**Table 59**  
Keyboard shortcuts for main ribbon (continued)

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT, S, R</td>
<td>Retry all (on the Search/Export tab). Available if there are items that failed to export. Use to retry exporting all failed items for the selected export.</td>
</tr>
<tr>
<td>ALT, S, S</td>
<td>Start (on the Search/Export tab). Starts a selected search.</td>
</tr>
<tr>
<td>ALT, S, T</td>
<td>Stop (on the Search/Export tab). Stops a selected search.</td>
</tr>
</tbody>
</table>
Keyboard shortcuts for the Identity ribbon in the Identity window

The Identity window has its own ribbon with one Identity tab. To display the top-level keyboard shortcuts in the Identity ribbon, press and release the ALT key or the F10 key.

To access an item on the Identity tab, press the key for the Identity tab, then press the key for the item. For example, to delete a selected identity record, the complete key sequence is:

1. Press and release ALT or F10 to display the top-level keyboard shortcuts in the Identity ribbon.
2. Press and release I to access the Identity tab on the ribbon.
3. Press and release D to execute the Delete command.

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT</td>
<td>Toggles the display of the top-level keyboard shortcuts in the ribbon. Moves focus to the ribbon.</td>
</tr>
<tr>
<td>F10</td>
<td>Same as ALT.</td>
</tr>
<tr>
<td>TAB or SHIFT-TAB or ARROW keys</td>
<td>Moves focus through the items in the Identity ribbon.</td>
</tr>
<tr>
<td>ENTER or SPACE BAR</td>
<td>Activates, executes, or opens an item in the Identity ribbon.</td>
</tr>
<tr>
<td>CTRL-F1</td>
<td>Toggles the display of the Identity ribbon.</td>
</tr>
</tbody>
</table>

The following section lists the complete key sequences for the ribbon in the Identity window, starting with ALT. The comma between pairs of keys means that you release the previous key before pressing the next key. Do not press the comma key. Do not press and hold all of the keys at the same time.

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT, F</td>
<td>Moves focus to the File tab in the Identity window and displays the keyboard shortcut for each item on the File tab.</td>
</tr>
<tr>
<td>ALT, F, E</td>
<td>Exit. Closes the Identity window.</td>
</tr>
<tr>
<td>ALT, I</td>
<td>Displays the keyboard shortcut for each item on the Identity tab. The Identity tab is available for Identity Administrators.</td>
</tr>
<tr>
<td>ALT, I, D</td>
<td>Delete. Deletes the selected identity records.</td>
</tr>
</tbody>
</table>
Table 60  Keyboard shortcuts for Identity ribbon in Identity window (continued)

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT, I, E</td>
<td>Element View. Use to select the view of identity elements (Summary or Detailed).</td>
</tr>
<tr>
<td>ALT, I, I</td>
<td>Edit Element Dates. Opens the Edit Dates dialog box for the selected identity element.</td>
</tr>
<tr>
<td>ALT, I, L</td>
<td>Delete Element. Deletes the selected identity elements from the identity record.</td>
</tr>
<tr>
<td>ALT, I, S</td>
<td>Save &amp; Close. Saves changes to the current identity and closes the Identity window.</td>
</tr>
<tr>
<td>ALT, Z</td>
<td>Help. Opens the help window.</td>
</tr>
</tbody>
</table>
This appendix contains the following sections:

- Introduction ................................................................. 402
- Search criteria fields by content type ............................. 403
- Descriptions of search criteria fields .............................. 411
Introduction

Starting with EMC SourceOne Discovery Manager 7.0, you can search for the following archived content types, depending on the SourceOne components installed at your site:

- Email
- Files
- SharePoint

The tables in this appendix:

- List the search criteria fields available for each content type.
- Provide a description of each search criteria field.
Search criteria fields by content type

The following tables list the search criteria fields that are available for each content type:

- “Search criteria fields for Email and File content types” on page 403
- “Search criteria fields for SharePoint content types” on page 407

The letter "D" indicates that the search criteria field is displayed by default.

A plus sign (+) indicates that the search criteria field is available for the content type.

Search criteria fields for Email and File content types

Table 61 Search criteria fields for Email and File content types

<table>
<thead>
<tr>
<th>Search criteria fields</th>
<th>Appointment</th>
<th>Calendar Item</th>
<th>Contact</th>
<th>Email Message</th>
<th>Files</th>
<th>Instant Message</th>
<th>Journal/Notebook Entry</th>
<th>Meeting</th>
<th>Notice</th>
<th>Other</th>
<th>Posted Note</th>
<th>Reports</th>
<th>Sticky Note</th>
<th>Task</th>
<th>Task Request</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any Unindexed Content</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>Archive Time</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Attachment Content</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>Attachment Name</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>Body</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>D</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>D</td>
<td>+</td>
<td>D</td>
<td>+</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>Category</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Checkin Comments</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company City</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Search Criteria Fields

Table 61  Search criteria fields for Email and File content types (continued)

<table>
<thead>
<tr>
<th>Search criteria fields</th>
<th>Appointment</th>
<th>Calendar Item</th>
<th>Contact</th>
<th>Email Message</th>
<th>Files</th>
<th>Instant Message</th>
<th>Journal/Notebook Entry</th>
<th>Meeting</th>
<th>Notice</th>
<th>Other</th>
<th>Posted Note</th>
<th>Reports</th>
<th>Sticky Note</th>
<th>Task</th>
<th>Task Request</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company Country</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company Name</td>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company State</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Created By</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Creation Date</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Date</td>
<td>D</td>
<td>D</td>
<td>+</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
</tr>
<tr>
<td>Date Picture Taken</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date Sent</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Document ID</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Due Date</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Email 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Encrypted</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>End Date</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Entry ID</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Expires</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>File Content</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>File Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>File Type</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>First Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
</tbody>
</table>

EMC SourceOne 7.0 Discovery Manager User Guide
### Table 61  Search criteria fields for Email and File content types (continued)

<table>
<thead>
<tr>
<th>Search criteria fields</th>
<th>Appointment</th>
<th>Calendar Item</th>
<th>Contact</th>
<th>Email Message</th>
<th>Files</th>
<th>Instant Message</th>
<th>Journal/Notebook Entry</th>
<th>Meeting</th>
<th>Notice</th>
<th>Other</th>
<th>Posted Note</th>
<th>Reports</th>
<th>Sticky Note</th>
<th>Task</th>
<th>Task Request</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Name</td>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Has Attachments</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Indexing Error</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Issue ID</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Item Type</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keyword</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Last Access Time</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Last Modified By</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Last Modified Date</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Last Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Meeting Workspace</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Metadata</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Owner</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Password Protected Attachment</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Path Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Person Title</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Picture Height</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Picture Width</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Platform Type</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Search Criteria Fields

**Table 61  Search criteria fields for Email and File content types (continued)**

<table>
<thead>
<tr>
<th>Search criteria fields</th>
<th>Appointment</th>
<th>Calendar Item</th>
<th>Contact</th>
<th>Email Message</th>
<th>Files</th>
<th>Instant Message</th>
<th>Journal/Notebook Entry</th>
<th>Meeting</th>
<th>Notice</th>
<th>Other</th>
<th>Posted Note</th>
<th>Reports</th>
<th>Sticky Note</th>
<th>Task</th>
<th>Task Request</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post Title</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Predecessors</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Priority</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recipient</td>
<td>+</td>
<td>D</td>
<td>D</td>
<td>+</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recipient Domain</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Related Issues</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Search Expression</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sender</td>
<td>+</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>+</td>
<td>D</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sender Domain</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sender or Recipient</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sensitivity/Mood</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Size</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Source Location</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Source Type</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start Date</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subject</td>
<td>D</td>
<td>+</td>
<td>+</td>
<td>D</td>
<td>+</td>
<td>+</td>
<td>D</td>
<td>+</td>
<td>D</td>
<td>D</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tags</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task Group</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>URL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Search criteria fields for SharePoint content types

**Table 61** Search criteria fields for Email and File content types (continued)

<table>
<thead>
<tr>
<th>Search criteria fields</th>
<th>Content types</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Appointment</td>
</tr>
<tr>
<td>Version</td>
<td>+</td>
</tr>
<tr>
<td>Workflow Outcome</td>
<td>+</td>
</tr>
</tbody>
</table>

**Search criteria fields for SharePoint content types**

**Table 62** Search criteria fields for SharePoint content types

<table>
<thead>
<tr>
<th></th>
<th>Announcement</th>
<th>Comment</th>
<th>Document</th>
<th>Document Set</th>
<th>Issue</th>
<th>Link</th>
<th>Picture</th>
<th>Post</th>
<th>SharePoint Item</th>
<th>Wiki</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any Unindexed Content</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Archive Time</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Attachment Content</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Attachment Name</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Body</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>D</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Checkin Comments</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company City</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company Country</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company State</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 62
**Search criteria fields for SharePoint content types (continued)**

<table>
<thead>
<tr>
<th>Field</th>
<th>Announcement</th>
<th>Comment</th>
<th>Document</th>
<th>Document Set</th>
<th>Issue</th>
<th>Link</th>
<th>Picture</th>
<th>Post</th>
<th>SharePoint Item</th>
<th>Wiki</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created By</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>D</td>
</tr>
<tr>
<td>Creation Date</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Date</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
</tr>
<tr>
<td>Date Picture Taken</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date Sent</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Document ID</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Due Date</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Encrypted</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>End Date</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Entry ID</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Expires</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>D</td>
</tr>
<tr>
<td>File Content</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>File Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>File Type</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>First Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Full Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Has Attachments</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Indexing Error</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Issue ID</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>Item Type</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
</tr>
</tbody>
</table>
Table 62  Search criteria fields for SharePoint content types (continued)

<table>
<thead>
<tr>
<th>Search Criteria Fields</th>
<th>Announcement</th>
<th>Comment</th>
<th>Document</th>
<th>Document Set</th>
<th>Issue</th>
<th>Link</th>
<th>Picture</th>
<th>Post</th>
<th>SharePoint Item</th>
<th>Wiki</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyword</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Last Access Time</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Last Modified By</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Last Modified Date</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Last Name</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Meeting Workspace</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Metadata</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Owner</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Password Protected Attachment</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Path Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Person Title</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Picture Height</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Picture Width</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Platform Type</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Post Title</td>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Predecessors</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Priority</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recipient</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recipient Domain</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Related Issues</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Search Expression</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
</tbody>
</table>
### Search criteria fields for SharePoint content types (continued)

<table>
<thead>
<tr>
<th></th>
<th>Announcement</th>
<th>Comment</th>
<th>Document</th>
<th>Document Set</th>
<th>Issue</th>
<th>Link</th>
<th>Picture</th>
<th>Post</th>
<th>SharePoint Item</th>
<th>Wiki</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sender</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sender Domain</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sender or Recipient</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sensitivity/Mood</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Size</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Source Location</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Source Type</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Start Date</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subject</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
</tr>
<tr>
<td>Tags</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task Group</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>URL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>D</td>
<td></td>
</tr>
<tr>
<td>Version</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Workflow Outcome</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Descriptions of search criteria fields

The following table describes all of the search criteria fields.

<table>
<thead>
<tr>
<th>Search field</th>
<th>Description</th>
<th>Data type, valid values and operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any Unindexed Content</td>
<td>Use to search for items that have unindexed content. Refer to “Using &quot;Indexing Error&quot; and &quot;Any Unindexed Content&quot;” on page 273.</td>
<td>Select a value:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• blank = Exclude this field from the search.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• True = Search for items that have unindexed content.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• False = Search for items that do not have unindexed content.</td>
</tr>
<tr>
<td>Archive Time</td>
<td>The date and time the file was archived.</td>
<td>Date</td>
</tr>
<tr>
<td>Attachment Content</td>
<td>Use to search for items based on text in the attachment. Refer to “Summary: How to search for text” on page 242.</td>
<td>Text. Maximum 255 characters.</td>
</tr>
<tr>
<td>Attachment Name</td>
<td>Use to search for items based on text in the name of the attachment. Refer to “Specifying attachment name” on page 251.</td>
<td>Text. Maximum 255 characters.</td>
</tr>
<tr>
<td>Body</td>
<td>Use to search for items based on text in the body. For a wiki item, this is the same as the WikiField property in SharePoint. For a picture, this is the same as the Description property in SharePoint.</td>
<td>Text. Maximum 255 characters.</td>
</tr>
<tr>
<td>Category</td>
<td>The category of the issue.</td>
<td>Text</td>
</tr>
<tr>
<td>Checkin Comments</td>
<td>Comments associated with a document, wiki item, or picture when it was checked in to SharePoint.</td>
<td>Text</td>
</tr>
<tr>
<td>Comments</td>
<td>Comments associated with an issue.</td>
<td>Text</td>
</tr>
<tr>
<td>Company City</td>
<td>City in which the contact's company is located.</td>
<td>Text</td>
</tr>
<tr>
<td>Company Country</td>
<td>Country in which the contact's company is located.</td>
<td>Text</td>
</tr>
<tr>
<td>Company Name</td>
<td>Name of the contact's company.</td>
<td>Text</td>
</tr>
<tr>
<td>Company State</td>
<td>State in which the contact's company is located.</td>
<td>Text</td>
</tr>
</tbody>
</table>
### Table 63  Descriptions of search criteria fields (continued)

<table>
<thead>
<tr>
<th>Search field</th>
<th>Description</th>
<th>Data type, valid values and operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created By</td>
<td>Name of person who created the item. This may be the same as owner. SharePoint content types have only one owner per item.</td>
<td>Text</td>
</tr>
<tr>
<td>Creation Date</td>
<td>The date/time when the item was created.</td>
<td>Date</td>
</tr>
</tbody>
</table>
| Date         | Use to search for content based on the "most significant" date for the content type. Refer to "Specifying a date" on page 270. | In the first part of the Date field, select a value:  
• On  
• On or after  
• On or before  
• Between  
Specify a date in the second part of the Date field. If you selected Between, also specify the end date of the range in the third part of the Date field. |
| Date Picture Taken | Date and time on which the image was created. | Date                                 |
| Date Sent    | The date on which an item was sent.                                         | Date                                 |
| Document ID  | The ID of certain SharePoint items.                                          | Text                                 |
| Due Date     | The date on which a task, task request, or issue is due.                    | Date                                 |
| Email        | Primary email address of a contact.                                          | Text                                 |
| Email 2      | Secondary email address of a contact.                                        | Text                                 |
| Email 3      | Additional email address of a contact.                                       | Text                                 |
| Encrypted    | Use to search for messages that are encrypted.                              | Select a value:  
• blank = Exclude this field from the search.  
• True = Search for messages that are encrypted.  
• False = Search for messages that are not encrypted. |
| End Date     | The date on which a task, task request, or calendar item ended.             | Date                                 |
| Entry ID     | ID of the item.                                                             | Text                                 |

**Note:** You cannot use wildcards.
<table>
<thead>
<tr>
<th>Search field</th>
<th>Description</th>
<th>Data type, valid values and operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expires</td>
<td>The date on which an announcement expires.</td>
<td>Date</td>
</tr>
<tr>
<td>File Content</td>
<td>Use to search for files based on text in the file.</td>
<td>Text. Maximum 255 characters.</td>
</tr>
<tr>
<td>File Name</td>
<td>The name of the file.</td>
<td>Text</td>
</tr>
<tr>
<td>File Type</td>
<td>The file type of a picture, such as BMP, GIF, TIF.</td>
<td>Text</td>
</tr>
<tr>
<td>First Name</td>
<td>The first name of the contact.</td>
<td>Text</td>
</tr>
<tr>
<td>Full Name</td>
<td>The full name (first and last name) of the contact.</td>
<td>Text</td>
</tr>
<tr>
<td>Has Attachments</td>
<td>Use to search for items that have attachments.</td>
<td>Select a value:&lt;br&gt;• blank = Exclude this field from the search.&lt;br&gt;• True = Search for items that have attachments.&lt;br&gt;• False = Search for items that do not have attachments.</td>
</tr>
<tr>
<td>Indexing Error</td>
<td>Use to search for items that have indexing errors.  Refer to “Using “Indexing Error” and “Any Unindexed Content”” on page 273.</td>
<td>Select a value:&lt;br&gt;• blank = Exclude this field from the search.&lt;br&gt;• True = Search for items that have indexing errors.&lt;br&gt;• False = Search for items that do not have indexing errors.</td>
</tr>
<tr>
<td>Issue ID</td>
<td>The ID of the issue.</td>
<td>Number (integer)</td>
</tr>
</tbody>
</table>
### Search Criteria Fields

<table>
<thead>
<tr>
<th>Search field</th>
<th>Description</th>
<th>Data type, valid values and operators</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Item Type</strong></td>
<td>Use to search for items based on the item type or message class.</td>
<td>Select a value:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Message</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Contact</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Appointment</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Task/To Do</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Task Request</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Posted Note</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Journal /Notebook Entry</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Sticky Note</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Meeting</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Notice</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Document (a SharePoint item type)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Delivery Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Read Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Other Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Other</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- SharePoint Item</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Wiki (a SharePoint item type)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Issue (a SharePoint item type)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Picture (a SharePoint item type)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Announcement (a SharePoint item type)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Post (a SharePoint item type)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Comment (a SharePoint item type)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Link (a SharePoint item type)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Document Set (a SharePoint item type)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- File</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Instant Message (FaceTime, Bloomberg, Akonix, IMlogic, MindAlign, UBS Chat)</td>
</tr>
<tr>
<td><strong>Keyword</strong></td>
<td>By default, an unlabeled keyword field is displayed at the top of the search criteria area. In Discovery Manager full edition, if the Matter Manager specified keywords for a standard matter, then the keywords display in the keyword field.</td>
<td>Text</td>
</tr>
<tr>
<td></td>
<td>Refer to “Searching on keywords” on page 249.</td>
<td></td>
</tr>
<tr>
<td><strong>Last Access Time</strong></td>
<td>The last date and time the file was accessed.</td>
<td>Date</td>
</tr>
<tr>
<td><strong>Last Modified By</strong></td>
<td>Name of the person (editor) who last changed the item.</td>
<td>Text</td>
</tr>
</tbody>
</table>
Table 63  Descriptions of search criteria fields (continued)

<table>
<thead>
<tr>
<th>Search field</th>
<th>Description</th>
<th>Data type, valid values and operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Modified Date</td>
<td>The date/time when the item was last modified.</td>
<td>Date</td>
</tr>
<tr>
<td>Last Name</td>
<td>The last name of the contact.</td>
<td>Text</td>
</tr>
<tr>
<td>Location</td>
<td>The place where a meeting or appointment is scheduled to occur.</td>
<td>Text</td>
</tr>
<tr>
<td>Meeting Workspace</td>
<td>A meeting workspace is an ad-hoc SharePoint site created specifically in support of a meeting or event (appointment).</td>
<td>URL of SharePoint site</td>
</tr>
<tr>
<td>Metadata</td>
<td>Use to search for custom message metadata. Refer to “Searching on custom message metadata” on page 276.</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Name of the item.</td>
<td>Text</td>
</tr>
<tr>
<td>Owner</td>
<td>Use to search for items based on the owner.</td>
<td>Address (route) for email item types. You can select a value from the address book, specify an identity, or type a value. Maximum 255 characters for manually entered values.</td>
</tr>
<tr>
<td></td>
<td>Refer to “Specifying recipient, sender, or owner for email items” on page 252.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For SharePoint item types (SharePoint Item, Contact, Wiki, Discussion (Posted Note), Picture, and Document, the Author property is mapped to Owner. For the File content type, refer to “Searching for archived files using the Owner field” on page 264.</td>
<td></td>
</tr>
</tbody>
</table>
| Password Protected Attachment | Use to search for items that have password-protected attachments. It searches for the password-protected flag, not in the actual attachment. Note: Search results indicate which attachments are password protected only if the archive folder that you are searching has the Attachment Indexing option enabled. | Select a value:  
  • blank = Exclude this field from the search.  
  • True = Search for messages that have password-protected attachments.  
  • False = Search for messages that do not have password-protected attachments. |
## Search Criteria Fields

**Path Name**
The location of the file from which it was archived, as a full path name.

- **Description:**
  - Performs an EQUALS search. You must specify the exact name of each folder in the path.
  - Partial folder names and wildcards are not supported.
  - Required: Two leading slashes (\)
  - Optional: Single slashes in the path. They do not affect search results.

You can search for any valid path or sub path. For example, if an item was archived from `\MyMachine\ParentFolder\InnerFolder\`, then the following values in the Path Name field are valid:
- `\MyMachine`
- `\MyMachine\`
- `\MyMachine\ParentFolder`
- `\MyMachine\ParentFolder\`
- `\MyMachine\ParentFolder\InnerFolder`
- `\MyMachine\ParentFolder\InnerFolder\`

The following examples are invalid values that are not supported:
- `\MyMachine\ParentFolder\InnerFolder*` (no support for wildcards)
- `\MyMachine` (leading slashes to form a valid path are required)

**Person Title**
Job title of the contact.

**Picture Height**
Height of a picture

**Picture Width**
Width of a picture

**Platform Type**
The type of system (platform) that was the source of the content.

- **Description:**
  - Select a value:
    - SMTP
    - Exchange
    - Domino
    - SharePoint
    - File
    - Unknown

### Table 63 Descriptions of search criteria fields (continued)

<table>
<thead>
<tr>
<th>Search field</th>
<th>Description</th>
<th>Data type, valid values and operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path Name</td>
<td>The location of the file from which it was archived, as a full path name.</td>
<td>Text</td>
</tr>
<tr>
<td></td>
<td>Performs an EQUALS search. You must specify the exact name of each folder in the path. Partial folder names and wildcards are not supported. Required: Two leading slashes () Optional: Single slashes in the path. They do not affect search results.</td>
<td></td>
</tr>
<tr>
<td>Person Title</td>
<td>Job title of the contact.</td>
<td>Text</td>
</tr>
<tr>
<td>Picture Height</td>
<td>Height of a picture</td>
<td>Text</td>
</tr>
<tr>
<td>Picture Width</td>
<td>Width of a picture</td>
<td>Text</td>
</tr>
<tr>
<td>Platform Type</td>
<td>The type of system (platform) that was the source of the content.</td>
<td>Select a value: SMTP Exchange Domino SharePoint File Unknown</td>
</tr>
</tbody>
</table>
### Table 63 Descriptions of search criteria fields (continued)

<table>
<thead>
<tr>
<th>Search field</th>
<th>Description</th>
<th>Data type, valid values and operators</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Post Title</strong></td>
<td>The title of a comment.</td>
<td>Text</td>
</tr>
<tr>
<td><strong>Predecessors</strong></td>
<td>The predecessors of a task.</td>
<td>Text</td>
</tr>
<tr>
<td><strong>Priority</strong></td>
<td>Use to search for items based on the priority (importance).</td>
<td>Select a value:</td>
</tr>
<tr>
<td></td>
<td>• Low</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Normal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• High</td>
<td></td>
</tr>
<tr>
<td><strong>Published Date</strong></td>
<td>The date on which a post was published.</td>
<td>Date</td>
</tr>
<tr>
<td><strong>Recipient</strong></td>
<td>Use to search for items based on the recipient. Refer to “Specifying recipient, sender, or owner for email items” on page 252.</td>
<td>Address (route).</td>
</tr>
<tr>
<td></td>
<td>Select a value from the address book or type a value.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Maximum 255 characters for manually entered values.</td>
<td></td>
</tr>
<tr>
<td><strong>Recipient Domain</strong></td>
<td>Use to search for email items based on the domain of the recipient. Refer to “Performing domain searches” on page 265.</td>
<td></td>
</tr>
<tr>
<td><strong>Related Issues</strong></td>
<td>Issues related to the primary issue.</td>
<td>Text</td>
</tr>
<tr>
<td><strong>Search Expression</strong></td>
<td>Use to search for items using expressions, including proximity operators. Refer to “Using the Search Expression Field” on page 279.</td>
<td></td>
</tr>
<tr>
<td><strong>Sender</strong></td>
<td>Use to search for items based on the sender. Refer to “Specifying recipient, sender, or owner for email items” on page 252.</td>
<td>Address (route).</td>
</tr>
<tr>
<td></td>
<td>Select a value from the address book, specify an identity, or type a value.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Maximum 255 characters for manually entered values.</td>
<td></td>
</tr>
<tr>
<td><strong>Sender Domain</strong></td>
<td>Use to search for email items based on the domain of the sender. Refer to “Performing domain searches” on page 265.</td>
<td></td>
</tr>
<tr>
<td><strong>Sender or Recipient</strong></td>
<td>Use to search for items based on the sender or the recipient. Refer to “Specifying recipient, sender, or owner for email items” on page 252.</td>
<td>Address (route).</td>
</tr>
<tr>
<td></td>
<td>Select a value from the address book, specify an identity, or type a value.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Maximum 255 characters for manually entered values.</td>
<td></td>
</tr>
</tbody>
</table>
### Search Criteria Fields

**Table 63** Descriptions of search criteria fields (continued)

<table>
<thead>
<tr>
<th>Search field</th>
<th>Description</th>
<th>Data type, valid values and operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensitivity/Mood</td>
<td>Use to search for items based on sensitivity/mood.</td>
<td>Select a value:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• None</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Personal</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Private</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Confidential</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Flame (for Notes)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Good job (for Notes)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Joke (for Notes)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Reminder</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Question (for Notes)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Thank you (for Notes)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• FYI (for Notes)</td>
</tr>
<tr>
<td>Size</td>
<td>Use to search for items based on size, in bytes. Refer to &quot;Specifying an item size&quot; on page 272.</td>
<td>In the first part of the Size field, select a value:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Equals</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Greater than</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Less than</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In the second part of the Size field, enter the size in bytes. The maximum number of digits is 20.</td>
</tr>
<tr>
<td>Source Location</td>
<td>The URL of the host server, web site, or SharePoint farm where the item originated. Use this field to search for the full path of a SharePoint item, or any of the paths in the path hierarchy. For example, assume an item was archived from: <a href="http://SharePointServer/sites/MySite">http://SharePointServer/sites/MySite</a></td>
<td>Text</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The following entries would be valid values in the Source Location field:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><a href="http://SharepointServer">http://SharepointServer</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td><a href="http://SharepointServer/sites">http://SharepointServer/sites</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td><a href="http://SharepointServer/sites/MySite">http://SharepointServer/sites/MySite</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td><a href="http://SharepointServer/sites/MySite/">http://SharepointServer/sites/MySite/</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td>The trailing slash is optional.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Source ID is still used as a result column for displaying the URL. Source Location is not available as a result column.</td>
</tr>
<tr>
<td>Source Type</td>
<td>The original content type of the item.</td>
<td>Text</td>
</tr>
</tbody>
</table>
### Table 63  Descriptions of search criteria fields (continued)

<table>
<thead>
<tr>
<th>Search field</th>
<th>Description</th>
<th>Data type, valid values and operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Date</td>
<td>The date on which a task, task request, or calendar item started.</td>
<td>Date</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the task, task request, or issue. Refer to “Status values for Task, Task Request, and Issues” on page 420 for details.</td>
<td>In the blank field next to Status, click the dropdown arrow, then select a value.</td>
</tr>
<tr>
<td>Subject</td>
<td>Use to search for items based on text in the subject. Refer to “Summary: How to search for text” on page 242.</td>
<td>Text. Maximum 255 characters.</td>
</tr>
<tr>
<td>Tags</td>
<td>There are two different Tags fields:</td>
<td>• In a Collection search: Text</td>
</tr>
<tr>
<td></td>
<td>• In a Collection search for the Picture item type, Tags is the same as the Keywords property in SharePoint.</td>
<td>• In a Review search: Tags selected from the All Tags dialog</td>
</tr>
<tr>
<td></td>
<td>• In a Review search, use the Tags field to search for items based on the review tags that were applied to those items.</td>
<td></td>
</tr>
<tr>
<td>Task Group</td>
<td>The task group to which a task belongs. (A task group is a collection of tasks that can be worked on in parallel.)</td>
<td>Text</td>
</tr>
<tr>
<td>Title</td>
<td>Display title of the item, which may differ from the name of the item.</td>
<td>Text</td>
</tr>
<tr>
<td>URL</td>
<td>The URL for a link.</td>
<td>Text</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the item.</td>
<td>Text</td>
</tr>
<tr>
<td>Workflow Outcome</td>
<td>For a task, the status of item in the workflow, such as Accept or Reject.</td>
<td>Text</td>
</tr>
</tbody>
</table>
## Status values for Task, Task Request, and Issues

The following table lists the values in the Status search field. A plus sign (+) indicates that the value is available for a content type.

<table>
<thead>
<tr>
<th>Status</th>
<th>Exchange (Task)</th>
<th>Domino (Task)</th>
<th>SharePoint (Task)</th>
<th>SharePoint (Issue)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Started</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>In Progress/Active</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Completed/Closed</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Deferred</td>
<td>+</td>
<td>+</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>Waiting</td>
<td>+</td>
<td>+</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>Overdue</td>
<td></td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rejected</td>
<td></td>
<td></td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td></td>
<td></td>
<td></td>
<td>+</td>
</tr>
</tbody>
</table>
This appendix contains the following sections:

◆ Introduction ................................................................. 422
◆ Columns in search results .............................................. 423
◆ Information in preview pane .......................................... 431

Note: The Encrypted and Password Protected columns are no longer available for display in search results generated before Discovery Manager 7.0. You can copy and rerun searches in 7.0 to show the details, which will be instance-specific.
Introduction

The tables in this appendix:

- List the columns available in search results for each content type.
- List the information displayed in the preview pane for each content type.
The following tables list the columns that display in search results:

- "Columns for Email and File content types" on page 423
- "Columns for SharePoint content types" on page 427

The letter "D" indicates that the column is displayed by default for the content type.

A plus sign (+) indicates that the column is available for the content type.

Also refer to "Icons displayed in result columns" on page 430.

### Columns for Email and File content types

#### Table 64 Columns for Email, File, and "All" content types

<table>
<thead>
<tr>
<th>Column in search results</th>
<th>All</th>
<th>Appointment</th>
<th>Calendar Item</th>
<th>Contact</th>
<th>Email Message</th>
<th>Files</th>
<th>Instant Message</th>
<th>Journal/Notebook Entry</th>
<th>Meeting</th>
<th>Notice</th>
<th>Other</th>
<th>Posted Note</th>
<th>Reports</th>
<th>Sticky Note</th>
<th>Task</th>
<th>Task Request</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive Time</td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td></td>
<td></td>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CC</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comments Number</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company City</td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company Country</td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company Name</td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company State</td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Complete</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Columns in search results
### Table 64  Columns for Email, File, and "All" content types (continued)

<table>
<thead>
<tr>
<th>Column in search results</th>
<th>Content types</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>All</td>
</tr>
<tr>
<td>Created By</td>
<td>+   +   +   +</td>
</tr>
<tr>
<td>Creation Date</td>
<td>+   +   +   +   +   +   +   +   +   +   +   +   +   +</td>
</tr>
<tr>
<td>Date</td>
<td>D   D   D   D   D   D   D   D   D   D   D   D   D   D   D</td>
</tr>
<tr>
<td>Date Picture Taken</td>
<td></td>
</tr>
<tr>
<td>Date Sent</td>
<td>+   +   +   +   +   +   +   +   +   +   +   +   +   +</td>
</tr>
<tr>
<td>Document ID</td>
<td></td>
</tr>
<tr>
<td>Due Date</td>
<td>+</td>
</tr>
<tr>
<td>Encrypted</td>
<td>+   +   +   +   +   +   +   +   +   +   +   +   +   +   +   +   +</td>
</tr>
<tr>
<td>End Date</td>
<td>+   +   +   +   +   +   +   +   +   +   +   +   +   +   +   +   +</td>
</tr>
<tr>
<td>Entry ID</td>
<td>+   +   +   +   +   +   +   +   +   +   +   +   +   +   +   +   +</td>
</tr>
<tr>
<td>External Participant</td>
<td></td>
</tr>
<tr>
<td>External Participant Reason</td>
<td>+</td>
</tr>
<tr>
<td>Expires</td>
<td></td>
</tr>
<tr>
<td>File Name</td>
<td>+</td>
</tr>
<tr>
<td>First Name</td>
<td>+</td>
</tr>
<tr>
<td>File Type</td>
<td></td>
</tr>
<tr>
<td>From</td>
<td>+   D   D   D</td>
</tr>
<tr>
<td>Full Name</td>
<td>+</td>
</tr>
<tr>
<td>Has Attachments</td>
<td>D   D   D   +   D</td>
</tr>
<tr>
<td>(paperclip icon)</td>
<td></td>
</tr>
<tr>
<td>Issue ID</td>
<td></td>
</tr>
</tbody>
</table>
### Table 64  Columns for Email, File, and "All" content types (continued)

<table>
<thead>
<tr>
<th>Column in search results</th>
<th>All</th>
<th>Appointment</th>
<th>Calendar Item</th>
<th>Contact</th>
<th>Email Message</th>
<th>Files</th>
<th>Instant Message</th>
<th>Journal/Notebook Entry</th>
<th>Meeting</th>
<th>Notice</th>
<th>Other</th>
<th>Posted Note</th>
<th>Reports</th>
<th>Sticky Note</th>
<th>Task</th>
<th>Task Request</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Type</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
</tr>
<tr>
<td>Last Access Time</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Last Date Modified</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Last Modified By</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Last Name</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Owner</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Password Protected Attachment</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Percent Complete</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Person Title</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Picture Height</td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Picture Width</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Platform Type</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Post Title</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Predecessors</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Priority</td>
<td>+</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
</tr>
<tr>
<td>Published Date</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Result ID</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sensitivity/Mood</td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Size</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 64  Columns for Email, File, and "All" content types (continued)

<table>
<thead>
<tr>
<th>Column in search results</th>
<th>All</th>
<th>Appointment</th>
<th>Calendar Item</th>
<th>Contact</th>
<th>Email Message</th>
<th>Files</th>
<th>Instant Message</th>
<th>Journal/Notebook Entry</th>
<th>Meeting</th>
<th>Notice</th>
<th>Other</th>
<th>Posted Note</th>
<th>Reports</th>
<th>Sticky Note</th>
<th>Task</th>
<th>Task Request</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source ID</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Source Type</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Start Date</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
</tr>
<tr>
<td>Status</td>
<td>+</td>
<td></td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td></td>
</tr>
<tr>
<td>Subject</td>
<td>+</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td></td>
</tr>
<tr>
<td>Task Group</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>To</td>
<td></td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>URL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Version</td>
<td>+</td>
<td>+</td>
<td>D</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Workflow Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Workflow Outcome</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Columns for SharePoint content types

### Table 65  Columns for SharePoint content types

<table>
<thead>
<tr>
<th>Columns in search results</th>
<th>Announcement</th>
<th>Comment</th>
<th>Document</th>
<th>Document Set</th>
<th>Issue</th>
<th>Link</th>
<th>Picture</th>
<th>Post</th>
<th>SharePoint Item</th>
<th>Wiki</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive Time</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>D</td>
</tr>
<tr>
<td>CC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comments Number</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>Company City</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company Country</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company State</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Complete</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Created By</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>D</td>
</tr>
<tr>
<td>Creation Date</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>D</td>
</tr>
<tr>
<td>Date</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>D</td>
<td>+</td>
</tr>
<tr>
<td>Date Picture Taken</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>Date Sent</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Document ID</td>
<td></td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Due Date</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Encrypted</td>
<td></td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>End Date</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Entry ID</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>External Participant</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Table 65: Columns for SharePoint content types (continued)

<table>
<thead>
<tr>
<th>Columns in search results</th>
<th>Content types</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Announcement</td>
</tr>
<tr>
<td>External Participant Reason</td>
<td></td>
</tr>
<tr>
<td>Expires</td>
<td>+</td>
</tr>
<tr>
<td>File Name</td>
<td></td>
</tr>
<tr>
<td>First Name</td>
<td></td>
</tr>
<tr>
<td>File Type</td>
<td></td>
</tr>
<tr>
<td>From</td>
<td></td>
</tr>
<tr>
<td>Full Name</td>
<td></td>
</tr>
<tr>
<td>Has Attachments</td>
<td>+</td>
</tr>
<tr>
<td>(paperclip icon)</td>
<td></td>
</tr>
<tr>
<td>Issue ID</td>
<td></td>
</tr>
<tr>
<td>Item Type</td>
<td>D</td>
</tr>
<tr>
<td>Last Access Time</td>
<td></td>
</tr>
<tr>
<td>Last Date Modified</td>
<td>+</td>
</tr>
<tr>
<td>Last Modified By</td>
<td>+</td>
</tr>
<tr>
<td>Last Modified By</td>
<td></td>
</tr>
<tr>
<td>Last Name</td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td></td>
</tr>
<tr>
<td>Owner</td>
<td></td>
</tr>
<tr>
<td>Password Protected Attachment</td>
<td></td>
</tr>
<tr>
<td>Percent Complete</td>
<td></td>
</tr>
<tr>
<td>Person Title</td>
<td></td>
</tr>
<tr>
<td>Picture Height</td>
<td></td>
</tr>
<tr>
<td>Picture Width</td>
<td></td>
</tr>
</tbody>
</table>
Table 65  Columns for SharePoint content types (continued)

<table>
<thead>
<tr>
<th>Columns in search results</th>
<th>Content types</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Announcement</td>
</tr>
<tr>
<td>Platform Type</td>
<td>+</td>
</tr>
<tr>
<td>Post Title</td>
<td>D</td>
</tr>
<tr>
<td>Predecessors</td>
<td></td>
</tr>
<tr>
<td>Priority</td>
<td>D</td>
</tr>
<tr>
<td>Published Date</td>
<td></td>
</tr>
<tr>
<td>Result ID</td>
<td>+</td>
</tr>
<tr>
<td>Sensitivity/Mood</td>
<td></td>
</tr>
<tr>
<td>Size</td>
<td>+</td>
</tr>
<tr>
<td>Source ID</td>
<td>+</td>
</tr>
<tr>
<td>Source Type</td>
<td>+</td>
</tr>
<tr>
<td>Start Date</td>
<td>+</td>
</tr>
<tr>
<td>State</td>
<td>D</td>
</tr>
<tr>
<td>Status</td>
<td></td>
</tr>
<tr>
<td>Subject</td>
<td>D</td>
</tr>
<tr>
<td>Task Group</td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>+</td>
</tr>
<tr>
<td>To</td>
<td></td>
</tr>
<tr>
<td>URL</td>
<td></td>
</tr>
<tr>
<td>Version</td>
<td>D</td>
</tr>
<tr>
<td>Workflow Name</td>
<td></td>
</tr>
<tr>
<td>Workflow Outcome</td>
<td></td>
</tr>
</tbody>
</table>
Icons displayed in result columns

Some result columns are labeled with icons, or contain icons, as described in the following table.

<table>
<thead>
<tr>
<th>Result column</th>
<th>Description</th>
</tr>
</thead>
</table>
| Exclamation point icon | Priority. Displays an icon that indicates the priority (importance) of the message:  
| !                 | • ↓ = Low  
|                   | • blank = Normal  
|                   | • ? = High  |
| Page icon         | Item type. Displays an icon that indicates the type of item (message class), for example:  
|                   | • ✉ = Email Message  
|                   | • ☎ = Contact  
|                   | • ☠ = Appointment, schedule entry  
|                   | • ⌚ = Task/To Do  
|                   | • 📄 = Posted note, sticky note  
|                   | • 📑 = Journal entry  
|                   | • 📄 = Document  
|                   | • 📁 = Delivery report, read report, other report  
|                   | • 📧 = Instant message  
|                   | • blank = Other  |
| Paper clip icon   | Has Attachment. Displays a paper clip icon if the message has an attachment. |
The following table lists the information displayed in the preview pane. A plus sign (+) indicates that the information is available for the content type.

<table>
<thead>
<tr>
<th>Information in preview pane</th>
<th>All</th>
<th>Appointment</th>
<th>Calendar Item</th>
<th>Contact</th>
<th>Document</th>
<th>Email Message</th>
<th>Files</th>
<th>Instant Message</th>
<th>Issue</th>
<th>Journal/Notebook Entry</th>
<th>Meeting</th>
<th>Notice</th>
<th>Other</th>
<th>Picture</th>
<th>Posted Note</th>
<th>Reports</th>
<th>SharePoint Item</th>
<th>Sticky Note</th>
<th>Task</th>
<th>Task Request</th>
<th>Wiki</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive Time</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Attachment Name</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Attachments</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Body</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CC</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Checkin Comments</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company Assistant</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company City</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company Country</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company Phone</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Information in preview pane</td>
<td>Content type</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company State</td>
<td>All</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company Street</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Created By</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Creation Date</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date Last Modified</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date Picture Taken</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date Sent</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delegator</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Due Date</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>End Date</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Entry ID</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>External Participant</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>External Participant Reason</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 67: Information in preview pane by content type (continued)
### Table 67 Information in preview pane by content type (continued)

<table>
<thead>
<tr>
<th>Information in preview pane</th>
<th>Content type</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>All</td>
</tr>
<tr>
<td>File Content</td>
<td></td>
</tr>
<tr>
<td>File Name</td>
<td></td>
</tr>
<tr>
<td>First Name</td>
<td></td>
</tr>
<tr>
<td>Folder</td>
<td>+</td>
</tr>
<tr>
<td>From</td>
<td>+</td>
</tr>
<tr>
<td>Full Name</td>
<td></td>
</tr>
<tr>
<td>Has Attachments</td>
<td>+</td>
</tr>
<tr>
<td>Issue ID</td>
<td></td>
</tr>
<tr>
<td>Item Type</td>
<td>+</td>
</tr>
<tr>
<td>Last Access Time</td>
<td></td>
</tr>
<tr>
<td>Last Modified By</td>
<td>+</td>
</tr>
<tr>
<td>Last Name</td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td>+</td>
</tr>
<tr>
<td>Meeting Workspace</td>
<td></td>
</tr>
<tr>
<td>Middle Name</td>
<td></td>
</tr>
<tr>
<td>Mobile Phone</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td></td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>Owner</td>
<td>+</td>
</tr>
</tbody>
</table>
### Table 67  Information in preview pane by content type (continued)

<table>
<thead>
<tr>
<th>Information in preview pane</th>
<th>All</th>
<th>Appointment</th>
<th>Calendar Item</th>
<th>Contact</th>
<th>Document</th>
<th>Email Message</th>
<th>Files</th>
<th>Instant Message</th>
<th>Issue</th>
<th>Journal/Notebook Entry</th>
<th>Meeting</th>
<th>Notice</th>
<th>Other</th>
<th>Picture</th>
<th>Posted Note</th>
<th>Reports</th>
<th>SharePoint Item</th>
<th>Sticky Note</th>
<th>Task</th>
<th>Task Request</th>
<th>Wiki</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pager</td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Password Protected Attachment</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Path Name</td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Percent Complete</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Person Title</td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Picture Height</td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Picture Width</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Platform Type</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Priority</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Recipient</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Related Issues</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sender</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Sensitivity</td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Size</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Start Date</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subject</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Tags</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 67 Information in preview pane by content type (continued)

<table>
<thead>
<tr>
<th>Information in preview pane</th>
<th>All</th>
<th>Appointment</th>
<th>Calendar Item</th>
<th>Contact</th>
<th>Document</th>
<th>Email Message</th>
<th>Files</th>
<th>Instant Message</th>
<th>Issue</th>
<th>Journal/Notebook Entry</th>
<th>Meeting</th>
<th>Notice</th>
<th>Other</th>
<th>Picture</th>
<th>Posted Note</th>
<th>Reports</th>
<th>SharePoint Item</th>
<th>Sticky Note</th>
<th>Task</th>
<th>Task Request</th>
<th>Wiki</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Group</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>To</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Version</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td>+</td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Workflow Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Workflow Outcome</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
</tr>
</tbody>
</table>
This appendix lists the features available in each edition of Discovery Manager.

- Features in Discovery Manager editions ........................................ 438
## Features in Discovery Manager editions

The following table lists the features available in each edition of Discovery Manager (full edition and express edition).

A plus sign (+) indicates that the feature is available in that edition.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Functionality</th>
<th>Discovery Manager full edition</th>
<th>Discovery Manager express edition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Packaging</td>
<td>Software kits</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td></td>
<td>Licensing</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>Roles</td>
<td>Application Administrator</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td></td>
<td>User Administrator</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td></td>
<td>Identity Administrator</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Tag Administrator</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Backup Operator</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td></td>
<td>Matter Owner</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Matter Manager</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Investigator</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Search &amp; Export</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Identity management</td>
<td>Create identity records</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>View and edit identity records</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Delete identity records</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Modify identity elements in identity records</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Tag management</td>
<td>Create, edit, and delete custom default tags</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Create, edit, and delete matter-specific tags</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Functionality</td>
<td>Discovery Manager full edition</td>
<td>Discovery Manager express edition</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>-------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Matter management</td>
<td>Personal matters</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td></td>
<td>Delete personal matters</td>
<td>+ (by User Admin)</td>
<td>+ (by User Admin)</td>
</tr>
<tr>
<td></td>
<td>Standard matters</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Delete standard matters</td>
<td>+ (by user who is both the Matter Owner and the Matter Manager)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>View matters in All Matters area</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>View matters in My Matters area</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td></td>
<td>Add/remove matters in My Matters area</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Edit matter properties</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Legal hold folders</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Close and reopen matters</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Matter summary report</td>
<td>+</td>
<td>+ (Limited)</td>
</tr>
</tbody>
</table>
### Table 68  Features in Discovery Manager editions (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Functionality</th>
<th>Discovery Manager full edition</th>
<th>Discovery Manager express edition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collection searches</td>
<td>Full-text-index searches (embedded messages)</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Edit search properties</td>
<td></td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Select folders to search</td>
<td></td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Add/remove search criteria fields</td>
<td></td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Search Expression field</td>
<td>(includes proximity operators and tense conflation operators)</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Domain searches</td>
<td></td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Wildcards</td>
<td></td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Identities in address fields</td>
<td></td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Schedule collection searches</td>
<td></td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Copy collection searches</td>
<td></td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Rename collection searches</td>
<td></td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Organizing folders (to organize searches)</td>
<td></td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Run and rerun collection searches</td>
<td></td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Search for archived content types:</td>
<td>(All)</td>
<td>+</td>
<td>+ (Limited)</td>
</tr>
<tr>
<td>Email</td>
<td></td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Files</td>
<td></td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>SharePoint</td>
<td></td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Other</td>
<td></td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Show duplicates</td>
<td></td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Add/remove grid columns</td>
<td></td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Change order of grid columns</td>
<td></td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Preview items</td>
<td></td>
<td>+</td>
<td>+ (Email content)</td>
</tr>
<tr>
<td>Open items natively</td>
<td></td>
<td>+</td>
<td>+ (Email content)</td>
</tr>
<tr>
<td>Feature</td>
<td>Functionality</td>
<td>Discovery Manager full edition</td>
<td>Discovery Manager express edition</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------------------------------------</td>
<td>--------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Matter review</td>
<td>Assign items to / remove items from matter</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Apply custodians to / remove custodians from assigned items</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Apply tags to / remove tags from assigned items</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>In-matter search (search assigned items in Matter Review area)</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Functionality</td>
<td>Discovery Manager full edition</td>
<td>Discovery Manager express edition</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------------------------------------</td>
<td>-------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Export</td>
<td>Export from collection search</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td></td>
<td>Export from review search</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Export duplicates (from collection searches)</td>
<td>+ (from collection searches)</td>
<td>+ (from collection searches)</td>
</tr>
<tr>
<td></td>
<td>Export tags</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Export custodians</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Split by size</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td></td>
<td>Split by custodian</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Schedule exports</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Export summary report</td>
<td>+</td>
<td>+ (Limited)</td>
</tr>
<tr>
<td>Delete exports</td>
<td></td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Content types:</td>
<td></td>
<td>+ (All)</td>
<td>+ (Limited)</td>
</tr>
<tr>
<td></td>
<td>Email</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td></td>
<td>Files</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SharePoint</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Container types:</td>
<td></td>
<td>+ (All)</td>
<td>+ (All)</td>
</tr>
<tr>
<td></td>
<td>Native</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td></td>
<td>PST</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td></td>
<td>NSF</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td></td>
<td>File System</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Metadata types:</td>
<td></td>
<td>+ (All)</td>
<td>+ (Limited)</td>
</tr>
<tr>
<td></td>
<td>CSV</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>TSV</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td></td>
<td>EDRM</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Functionality</td>
<td>Discovery Manager full edition</td>
<td>Discovery Manager express edition</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------</td>
<td>-------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Database</td>
<td>Matter-based partitioning</td>
<td>+</td>
<td>+ (Limited)</td>
</tr>
<tr>
<td></td>
<td>Size-based partitioning</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Utilities</td>
<td>DMIdentity</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DMCustodian</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DMCollect</td>
<td>+</td>
<td></td>
</tr>
</tbody>
</table>
This glossary contains terms related to Discovery Manager.

Note: Some definitions in this glossary are based on information in *A Practical Enterprise Methodology for Addressing the Compliance Challenges of eDiscovery, eRetention Management, and Defensible Disposition* available on http://www.EMC.com.

A

**Administration button**

Used by *Application Administrators* to access role administration and default tag management. Refer to Chapter 2, ”Managing Users and Application-Wide Roles” and Chapter 6, ”Managing Default Tags.”

Note: Tags are available in the full edition of Discovery Manager.

**All Matters button**

Use to view a list of all matters. Refer to Chapter 7, ”Managing Matters.”

Note: The All Matters button/area is available in the full edition of Discovery Manager.

**Application Administrator**

One of the default *application-wide roles* in Discovery Manager express edition and the full edition of Discovery Manager. This role can configure settings for the application.

Refer to Chapter 2, ”Managing Users and Application-Wide Roles.”
### Glossary

| **application-wide role** | A role that is not specific to a matter, but that means the same across all matters in which that role is used. Refer to Chapter 2, "Managing Users and Application-Wide Roles." |
| **audit** | A record of significant activity that was performed in the system, including who performed what operations in the system, what searches were performed, and the history of tags on a message. |

| **B** |
| **bookmark** | A tag indicating that further review is required. Refer to Chapter 6, "Managing Default Tags" and Chapter 11, "Reviewing Content in Matters". |

**Note:** Tags are available in the full edition of Discovery Manager.

| **C** |
| **case** | Another term for a matter or investigation. |
| **chain of custody** | A legal term that refers to being able to track the movement and integrity of information as it goes through the legal discovery process. |
| **collect** | To find information for a matter. Refer to Chapter 8, "Collecting Content for Matters". |
| **collection** | The act of or result of collecting information for a matter. Refer to Chapter 8, "Collecting Content for Matters". |
| **Collection Area node** | Use to create and run searches to find content for a matter. Refer to Chapter 8, "Collecting Content for Matters". |
| **collection search** | Use to find messages for a matter. Refer to Chapter 8, "Collecting Content for Matters". |
| **collection summary** | A list that includes the name, status, and creation date of each search in a matter. To display the collection summary, click the Collection Area node in a matter. Refer to Chapter 8, "Collecting Content for Matters". |
**copy for hold**  The process of copying messages from their source to the matter *hold folder* to prevent them from being deleted when their retention expires in the archive.

*Note:* Hold folders are available in the full edition of Discovery Manager.

**custodian**  A legal discovery term that refers to the "owner" of a document or piece of evidence. The custodian is unique to a given type of content/evidence. For example, a custodian of a mail message is frequently, but not always, the sender or a recipient of that message. Refer to Chapter 7, "Managing Matters" and Chapter 11, "Reviewing Content in Matters."

*Note:* Custodians are available in the full edition of Discovery Manager.

**custom metadata**  Customized information about messages (message metadata) or about senders, recipients, or owners (route metadata). An example of custom route metadata is employee ID. Custom metadata is:

- Applied to messages and routes by the email archiving system, not by Discovery Manager express edition or by Discovery Manager.

- Available in Discovery Manager as search criteria. The Matter Manager can specify custom metadata on which to search, and Investigators can include the custom metadata criteria in collection or review searches.

**date range**  The start and end dates associated with the matter. Many investigations request all mail for certain people in a given date range. Refer to Chapter 7, "Managing Matters."

*Note:* Date range as a matter property is available in the full edition of Discovery Manager.

**discovery**  The process of finding, reviewing and producing information that is relevant to a given investigation.

**Discovery Manager editions**  There are two editions of Discovery Manager:
• A subset of Discovery Manager functionality is provided with EMC SourceOne Email Management. For clarity, the documentation refers to this edition as “Discovery Manager express edition.” All screens are labeled “Discovery Manager.”

• The full edition of Discovery Manager requires a separate license. You can upgrade to the full edition from Discovery Manager express edition.

Refer to “Discovery Manager Editions” on page 437 for more information.

**Discovery Manager database**

A SQL database that contains information about the matter and the items that are part of the matter. The database does not contain the actual items.

**eDiscovery**

Electronic discovery is discovery performed on electronically stored information, such as email.

**evidence**

Information that is collected for an investigation. For Discovery Manager, evidence is electronic mail.

**export**

The process of exporting information from a search or matter into one or more files for use by another person or application.

**Export node**

Use to export messages from search results. Refer to Chapter 12, “Exporting Content and Metadata.”

**folder**

The full edition of Discovery Manager use several types of folders for a collection search:

• Organizing folders are used to organize collection and review searches within a matter.

• *Search folders* (required) contain the messages on which you perform collection searches.

• *Hold folders* (recommended) are used to retain messages found during a collection search, to prevent them from being deleted when their retention expires. Messages are copied to the hold folder.
Discovery Manager express edition uses only search folders. Refer to Chapter 8, "Collecting Content for Matters."

**full-text index**

An index of all available text within the header, message, or attachment of an archived email.

**full-text index search**

A search performed on a full-text index. Some search fields require that messages be full-text-indexed (for example, Body, Keyword, and Attachment).

**H**

**hold**

A message is on hold if it is in a folder with no retention period. It will not be deleted from the hold folder when its normal retention expires.

*Note:* Hold folders are available in the full edition of Discovery Manager.

**hold folder**

An EMC SourceOne Legal Hold folder where copies of messages are retained to prevent them from being deleted when their retention expires. Refer to Chapter 7, "Managing Matters." EMC SourceOne system administrators create Legal Hold folders.

*Note:* Hold folders are available in the full edition of Discovery Manager.

**I**

**identity element**

A specific address (such as last_first@emc.com) added to an identity record.

*Note:* Identities are available in the full edition of Discovery Manager.

**identity record**

A collection of addresses (identity elements) used as an alias in searches. Create identity records to maintain a complete and consistent set of addresses to enable investigators to reliably find all mail for a person or group.

*Note:* Identities are available in the full edition of Discovery Manager.

**identity management**

The process of managing identity records and their identity elements.
Glossary

Identity Administrator

An application-wide role. A person who has the role/permissions to perform identity management.

Note: Identity Administrator is available in the full edition of Discovery Manager.

In-matter search

Filtering content already in a matter and in a hold folder. Also called a review search. Refer to Chapter 11, ”Reviewing Content in Matters.”

Note: In-matter searches (review searches) and hold folders are available in the full edition of Discovery Manager.

Investigator

A person who has the matter-specific role to collect, review and produce content for a matter. Every matter must have an Investigator. Refer to Chapter 7, ”Managing Matters,” Chapter 8, ”Collecting Content for Matters,” Chapter 11, ”Reviewing Content in Matters,” and Chapter 12, ”Exporting Content and Metadata.”

Note: The Investigator role is available in the full edition of Discovery Manager.

Keyword

Terms that will be searched for in a matter. For example, a company might receive an SEC request for all mail that includes the word “stock.” In Discovery Manager, the Matter Manager can specify keywords as a matter property. Refer to Chapter 7, ”Managing Matters.”
**legal discovery**

The process of lawyers responding to subpoenas or other discovery requests in government investigations and lawsuits by collecting and reviewing relevant documents.

**matter**

Another term for investigation or case.

There are two types of matters:

- **Personal Matters** - In Discovery Manager express edition, each user has one Personal Matter, which only that user can work on. In the full edition of Discovery Manager, Personal Matters are optional.

- **Standard matters** - In the full edition of Discovery Manager, standard matters can be shared among several Investigators.

**matter properties**

For standard matters in the full edition of Discovery Manager, matter properties include the information required to create the matter (matter name, hold folder, matter users) plus the search folders, keywords, dates, tags, custodians, and metadata.

For Personal Matters in Discovery Manager express edition and in Discovery Manager, only the search folders property is available.

**matter folder**

See hold folder.

**Matter Manager**

In the full edition of Discovery Manager, a person who has the matter-specific role to define, refine, view, assign resources to, and manage matters. A matter can have more than one Matter Manager.

**Matter Owner**

In the full edition of Discovery Manager, a person who has the application-wide role to create and delete matters.

**Matter Review node**

Use to review and tag content collected for a matter. Refer to Chapter 11, “Reviewing Content in Matters.”

**matter-specific role**

A role that applies only to the current matter. In Discovery Manager, the two matter-specific roles are Matter Manager and Investigator.
### Glossary

**matter-specific tag**
A tag whose value applies to the item only in the current matter. For example, a message that is considered Responsive in one matter may be irrelevant in another. Refer to Chapter 11, "Reviewing Content in Matters."

**matter state**
A matter may have a state of Open or Closed. The state of a new matter is Open by default. In Discovery Manager, a Matter Manager can create a matter, close a matter, re-open a matter, or delete a matter.

**metadata**
Information about a message, such as its subject, received date, or sender. Standard metadata, as opposed to custom metadata, is present in the message, is created by the email system, and is captured by journaling or archiving.

**My Matters button**
Use to view and work with matters you created or have been assigned. Refer to Chapter 7, "Managing Matters."

**P**

**Personal Matter**
A type of matter created automatically for each user in Discovery Manager express edition. Personal Matters are optional in the full edition of Discovery Manager.

**produce**
The process of exporting information from a matter for use by another person or application. See export.

**R**

**relational search**
A search performed against the database rather than the full-text index. Some search fields that search the database rather than the index include Item Type and Has Attachments.

**responsive**
Information that is relevant to a matter.

**review**
Examining information in a matter to see if it is responsive. This process usually involves viewing messages and tagging them appropriately. Refer to Chapter 11, "Reviewing Content in Matters."
ribbon pane  The area at the top of the Discovery Manager express edition window and the Discovery Manager window containing tabs and commands. Refer to Chapter 1, “Introduction.”

role  Defines the rights and responsibilities of a user. Specifies the actions a user is allowed to perform and the information a user is allowed to see. There are two types of roles: application-wide roles and matter-specific roles. Refer to Chapter 2, “Managing Users and Application-Wide Roles” and Chapter 7, “Managing Matters.”

search  The process of finding items for a matter or within a matter. Refer to Chapter 8, “Collecting Content for Matters” and Chapter 11, “Reviewing Content in Matters.”

Note: Review searches are available in the full edition of Discovery Manager.

Search and Export role  A role automatically assigned to users in Discovery Manager express edition for use with Personal Matters. The role is not listed in the User Manager > Users grid, but is displayed in matter reports.

search criteria  The set of fields and their values defined in a search.

search folder  The location(s) being searched, specifically one or more EMC SourceOne archive folders or EmailXtender 4.8 archive folders.

spoliation  Wrongful or inadvertent destruction of evidence.

tag  Flags applied to items in a matter to indicate the results of a review. Refer to Chapter 6, “Managing Default Tags” and Chapter 11, “Reviewing Content in Matters.” See matter-specific tag.

Note: Tags are available in the full edition of Discovery Manager.
<table>
<thead>
<tr>
<th><strong>Glossary</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tag Administrator</strong></td>
</tr>
<tr>
<td><strong>Note:</strong> Tag Administrator is available in the full edition of Discovery Manager.</td>
</tr>
<tr>
<td><strong>User Administrator</strong></td>
</tr>
</tbody>
</table>
Assign All Messages to Matter with Custodians 227
Assign Message to Matter 227
Assign Message to Matter with Custodians 227
assigning
  application-wide roles 67
  search results to matter 227
asterisk 245
Attachment field 411
Attachment Name field 411

B
Backup Operator role 24
best practices
  identities 104
  managing matters 139
Body field 411
Boolean operators
  Search Expression field 283

C
changing
  search field 240
characters
  insignificant 293
  not searchable 293
  reserved 293
  searchable 292
  searching on 292
  significant 292
checklist
  collecting content for a matter 180
Clear criteria values 278
clearing
search criteria 278

closing
matter 177

Collection Area node 51, 182
collection search
creating 188
viewing 201
collection summary report 186
columns 217
Configuration node 55, 74
Connected status 56
copying
search 202
creating
collection search 188
in-matter search 308
matter 140
credentials login 77
Ctrl-F 33, 217
custodian
adding 165
definition 164
deleting 172
editing 171
Custodian Create dialog box 165
Custodian Edit dialog box 171
custodians
assigning to message 302
clearing from message 305
collecting mail using DMCollect utility 381
creating using DMCustodian utility 377
searching on 314
Custodians field 314
Custodians tab
Matter Properties 164
custom metadata
search 274
customizing
search fields 240
search results 217

D
Date field 412
date range
identity element 124

matter 158

Dates tab
Matter Properties 157
deleting
custodian 172
export 362
folder 206, 311, 362
identity element 125
identity record 112
matter 177
matter-specific tag 162
search 229
tags 133
detailed view
identity records 106
DMCollect Collect 381
DMCollect utility 364, 381
DMCustodian utility 364, 377
DMIdentity utility 364, 370
Does Not Contain operator 244
double quotes 243
due date
matter 159

E
Edit Dates dialog box 124
editing
custodian 171
identity record 111
matter properties 148
matter-specific tag 161
search properties 191, 193
tags 132
embedded messages 270
Encrypted field 412
error bar
search 210
errors 210
startup 28
exact phrases
Search Expression field 288
exact word or phrase
searching for 243
Exclude Custodians field 314
Exclude Tags field 312
exiting Discovery Manager 28

456 EMC SourceOne 7.0 Discovery Manager User Guide
export
   deleting 362
   jobs 333
   naming convention 335
   status 331
Export dialog box 325
Export node 51
export processing 331
export summary report 344
exporting
   messages 322

F
F10 key 32
failed operations 231
Field Chooser dialog box 190
first user 62
   adding 63
folder
   deleting 206, 311, 362
   renaming 205, 311, 361
full-text index search 192

G
General tab
   Matter Properties 150

H
Has Attachments field 413
hold folder 307
hold folders 137
Home tab 36

I
identities
   best practices 104
Identities button 52, 105
Identities tab 43
Identity Administrator role 23, 103
identity element
   adding to identity record 113
   date range 124
   definition 103
   deleting 125
   effective dates 124
   metadata 121
   identity elements
      viewing 122
   identity record
      adding 108
      definition 102
      deleting 112
      editing 111
      naming 110
   identity records
      creating using DMIdentity utility 370
      Detailed view 106
      Summary view 106
      viewing 105
   Identity window 108
   in-matter search 306
      creating 308
   Insert Trusted Sites Zone 76, 78
   insignificant characters 293
   Investigator role 296
   Item Type field 414

K
Key Tips 32
Keyword field 249
keyword search 249
Keywords tab
   Matter Properties 163

L
language packs 27
licensing 16
lifecycle, matter 19
Limited Availability status 56

M
matter
   best practices 139
   closing 177
   creating 140
   deleting 177
   due date 159
   lifecycle 19
   placing in My Matters 146, 147
Index

prerequisites 138
properties, editing 148
removing from My Matters 146, 147
reopening 177
subnodes 50
suggested collection date range 158
Matter Creation wizard 141, 143
Matter Manager role 25
Matter Owner role 24
Matter Properties
  Custodians tab 164
  Dates tab 157
  General tab 150
  Keywords tab 163
  Metadata tab 156
  Search Folders tab 154
  Tags tab 160
  User Management tab 152
Matter Review node 51, 297
matter summary report 173
Matter tab 38, 148
matter-specific roles 24
matter-specific tag
  adding 160
  deleting 162
  editing 161
Maximum Export Split Size option 83
Maximum Message Assignment Count 76
Maximum Message Retrieval Count 76
Maximum Search Hits 81
Maximum search results 194
message
  opening 224
  previewing 220
message metadata 276
Message Size field 272, 418
messages
  removing from Matter Review 315
metadata
  identity element 121
  message 276
  route 274
Metadata search field 276
Metadata tab
  Matter Properties 156
Minimize the Ribbon 33
minus sign 244
monitoring
  search 208
multiple words
  Search Expression field 288
multiple words or phrases
  searching for 243
My Matters area 49
My Matters button 49

N
naming
  identity record 110
navigation pane 29
  customizing 47
  menu 47
  overview 47
Navigation Pane Options 48
Navigation Pane Options dialog box 48
No Entries Found dialog box 119, 170
NOT operator (-) 244

O
opening
  message 224
OR search terms 250
organizing folders 203, 309, 360
Owner field 415

P
parentheses
  Search Expression field 289
Password Protected field 415
phrase
  search 243
placing
  matter in My Matters 146, 147
precedence of operators
  Search Expression field 289
preview pane 29
previewing
  message 220
Priority field 417
proximity operator
  SearchExpression field 281
punctuation
Index

S
Schedule Search dialog box 199
searching
addresses 252
copying 202
deleting 229
embedded messages by date 270
eroof bar 210
for text 242
history 213
keyword 249
monitoring 208
multiple words or phrases 243
past occurrences 213
phrase 243
renaming 202
re-running 207
results 215
running 207
scheduling 199
status, changing 209
stopping 209
word 243
Search Errors dialog box 211
Search Expression field 287
results 215
assigning to matter 227
customizing 217
Search Folders tab
Matter Properties 154
Search Full Text Indexes 82
search properties
editing 191, 193
Search Properties dialog box 98, 193, 197
searches
organizing 204, 310
Select Address dialog box 117, 168
Select Users dialog box 144

Q
Quick Access Toolbar 31
Quick Click tag 300, 304

R
Recipient field 417
refresh display 55
Remove from Quick Access Toolbar 32
removing
matter from My Matters 146, 147
messages from Matter Review 316
search field 241
users 66
renaming
folder 205, 311, 361
search 202
reopening
matter 177
Re-running
search 207
reserved characters 293
reserved words
Search Expression field 287
results 215
assigning to matter 227
customizing 217
ribbon pane 29
hiding 33
Home tab 36
Identities tab 43
Matter tab 38
navigating 33
overview 30
Search tab 41
tabs 31
roles 19, 23
application-wide 23
assigning 67
matter-specific 24
route metadata 274
running
search 207

in searches 293
Index

Sender field 417
Sender or Recipient field 417
Sensitivity Mood field 418
Show Fewer Buttons 48
Show More Buttons 48
significant characters 292
Size field 272
starting Discovery Manager 27
status
search, changing 209
Status column 230
Status Polling Interval option 76
stopping
search 209
Subject field 419
Summary view
identity records 106

T
Tag Administrator 128
Tag Administrator role 23
Tag Create dialog box 130, 160
Tag Edit dialog box 132, 161
Tag Manager node 55, 130
tags
applying to message 298
custom 130
default 129
deleting 133
editing 132
searching on 312
types 128
Tags field 312
Tags tab
Matter Properties 160
tense conflation operator
Search Expression field 284
text
search 242

U
User Administrator 62
User Administrator role 23
User Management tab
Matter Properties 152
User Manager node 55, 64, 66, 67, 70, 71
users
adding 64
removing 66
utilities
AddressBook option 376
AlwaysSearchEmbeddedMessages option 384
collecting mail for custodians 381
command line syntax 368
creating custodians 377
creating identity records 370
DMCollect 381
DMCollect Rerun 387
DMCustodian 377
DMCustodian Create 379
DMIdentity 370
DMIdentity Create 371
DMIdentity List 376, 378
Domain Name option 375
error reporting 369
FolderPath option 383
input file syntax 369
installation 365
OnePerLine option 375
permissions 365
prerequisites 364
Threads option 384
Type options 373

V
View running jobs 231
viewing
collection search 201
identity elements 122
identity records 105
messages assigned to a matter 297

W
wildcard 245
non-supported uses 247
supported uses 245
wildcards
Search Expression field 286
word
search 243
work pane 29